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License and Warranty 

  
License Agreement 

Copyright laws of the United States and international treaty protect this software. Verity 
Software House provides this software under the following conditions: 

Software is intended to be installed and used on one computer. An additional computer 
license is required for each additional installation. 

Network versions of software require one serial number for each simultaneous use. Network 
versions are intended for installation and use on a local area network; other uses are not 
supported. 

Backups of the software must be used only for archival purposes. 

Duplication of the manual is strictly prohibited without the expressed written permission of 
the copyright holder. 

If you transfer the use of this software to another party, that party must accept the terms of 
this agreement, and you must transfer all copies of the software or destroy them. 

Your license to use this software will terminate if you are found to be in violation of this 
agreement. 

The laws of the State of Maine and the United States of America govern this license. 
  
Limited Warranty 

Verity Software House (VSH) warrants the physical media and the physical documentation, if 
included, to be free of defects in materials and workmanship for a period of 30 days from 
date of purchase. If VSH receives notice of defects in materials or workmanship within the 
warranty period, VSH will replace the defective media or documentation. 

VSH makes no other warranties, either expressed or implied, with respect to this manual or 
with respect to the software described in this manual, its quality, performance, 
merchantability, or fitness for any particular purpose. VSH software is licensed "as is". The 
entire risk as to its quality and performance is with the buyer. Should the software prove 
defective following their purchase, the buyer (and not VSH, its distributor, or its retailer) 
assumes the entire cost of all necessary servicing, repair, or correction and any incidental or 
consequential damages. In no event will VSH be liable for direct, indirect, incidental, or 
consequential damages resulting from any defect in the software, even if VSH has been 
advised of the possibility of such damages. Some states do not allow the exclusion or 
limitation of implied warranties or liability for incidental or consequential damages, so some 
of the above limitations or exclusions may not apply to you. 
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Latest Versions 

  

To find the latest versions for this software and documentation, visit the Verity Software 
House web site at www.vsh.com. This site provides a complete version of the latest 
documentation, service packs, and technical support information for the program. 
  

You can also email us at verity@vsh.com to determine whether you have the latest version. 
Please include the version that appears on the start-up dialog box and the program file date 
for the program. 
  

WinList also has a Check for Updates command in the Help menu. Use this command 
periodically to see if there are updates for your software. 

http://www.vsh.com/
mailto:verity@vsh.com
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What's new? 

WinList 10.0 

Implemented Cen-se' dimensionality-reduction algorithm to produce structured nearest-
neighbor embedding with fantastic speed and resolution, and process all events in the FCS file 

Major performance improvements for t-SNE implementation, with the ability to process all 
events in the FCS file 

Reports update much faster and without interruption to the user interface 

Improve the drawing speed for 2P overlays using Dots. 

Revise the Compensation Page to provide a more efficient interface for working with high-
dimensional data files 

Improved transform defaults for high-resolution data from Helios, Aurora, and others 

Provide a means to apply a transform defined on one measurement to other measurements 

Provide more robust memory handling for large data files and low memory conditions 

Scrollable data source windows allow for better visualization of histograms 

Support for editing properties of individual overlay elements 

Display histograms on more than one page in a data source to facilitate gating 

Support import of tab-delimited text files containing listmode data 

Support for FCS 3.2 files 

Remove limitation on number of lines in a macro 

Add support for "contains" operator in text-based Alert conditions 

Improved support for high DPI monitors 

Improved network license manager 

Simplified registration for multiple users on the same computer 

All reported bugs for previous versions fixed 
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System Requirements 

  

Minimum System Configurations 

PC: Windows 10 or greater, 3GHz CPU or better, 8GB RAM or greater, 8 or more logical 
processors, 100MB free disk space for program files. 
  

Faster CPU with more cores, high-speed SSD drives, and greater RAM will improve 
performance, especially with large FCS files. 
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Installing and Running WinList 

  

IMPORTANT NOTES: 

• Stand-alone versions of the program are designed to be installed and 
registered on a single computer. 

• You must have administrative rights to the computer during installation and registration 
of the software. After registration, the program can be run by users with restricted 
access to the computer. 

• You will need to register the software with Verity Software House in order to unlock the 
program on the computer. This can be done using the online registration process or by 
contacting technical support. 

• If your program is an update version, you will need the serial number for the previous 
version in order to register and unlock the software. 

• If your program is an additional computer license, you will need the serial number for 
the primary license in order to register and unlock the software. 

  
  

Stand-Alone Version 

  

Stand-alone versions of the program are designed to be installed and registered on 

a single computer. 

  

Installation 

• Log on to your computer with an account that has Administrator privileges. You must 
have administrative rights during installation. 

• If you downloaded the software, extract the installation files from the download into a 
temporary folder.  If you have an installation CD, insert the program CD into the CD-
ROM drive.  

• Run the program named WinListSetup.exe. Follow the directions on the screen to 
complete the installation. 

• See the section on registering your software for information on how to register your 
software. 

  

Using the software 
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• Log on to your computer with your own user account. This should be the account that 
you normally use on the computer. 

• Open the Start menu and navigate to the Verity folder.  Choose WinList 3D 10.0. 

  

Network Version 

  

• Log on to the "server" computer with an account that has Administrator privileges. You 
must have administrative rights during installation. 

• If you downloaded the software, extract the installation files from the download into a 
temporary folder.  If you have an installation CD, insert the program CD into the CD-
ROM drive.  

• Double-click the InstallAll.vbs script to install all of the software components. 
• This will install WinList 3D as well as an application called the Network License 

Manager on the computer.  Alternatively, you can double-click each msi file that 
appears on the cd to install the Network License Manager and WinList. 

• See Using the Network Version for details on configuring and using the network version 
of the software. 
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Registering Your Software 

  

Why You Should Register 

Registration is a key step in setting up the software to run on your computer. In fact, your 
software may not be fully functional until you register. Here's why. 

This version of the program uses software security, which requires you to register your 
software in order to receive an Unlock Code to make the program fully functional. An 
unregistered installation will be fully functional for 30-days, and then become a "trial version" 
with limited functionality until it is registered. 

Of course, registration is useful for other reasons, too. We can inform you of bug fixes and 
updates, and provide you with better technical support. 
  

How to Register 

When you start the program for the first time, it will automatically display the Registration 
dialog box shown below. You can access this dialog at any time by pressing the Registration 
button on the dialog box that is displayed when the program starts up. 
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This dialog has three fields that you need to fill in: Serial #, CD Key, and Unlock Code. 

The Serial number and CD Key can be found on the outside of the program box or in email if 
the program was provided to you by download. Enter these exactly as they appear; they are 
case-sensitive. If you have lost or misplaced the Serial number or CD Key, contact Verity 
technical support at tech@vsh.com or (207) 729 6767. 
  

If the installation computer has Internet access 

Start by filling in the Serial Number and CD Key fields in the Register Software dialog. Use 
the Serial Number and CD Key that were provided with the software. 

Next, to receive an Unlock Code using the internet, click the Web Registration button on the 
dialog box. This button will launch your browser software and connect you to the registration 
web site. 

Follow instructions on the web site to register the product. If you are registering an update 
version, you will need the serial number of the previous version to complete the registration. 
If you are registering an additional user license, you will need the serial number of another 
copy of the program that is registered to your institution. If you have a network version - 
stop - you are in the wrong place. For network versions, see Using the Network Version . 

Getting an Unlock Code is a two-step process. First, you fill in and submit the registration 
form on the web site. The web site will generate an email to you with an Unlock Code.  

When you receive your Unlock Code email, copy it from the email message into the Unlock 
Code field in the Registration dialog box. When possible, use Copy and Paste to do this, to 
ensure that the characters are correct. Then click the OK button. 

Your program will become fully functional once the Unlock Code is entered correctly. 
  

If another computer has Internet access 

If the computer you installed the software on does not have internet access but another 
computer does have access, you can follow these steps to register. 

Write down the Program Name, Program Version, Computer ID, Serial number, and CD Key 
displayed in the Register Software dialog. 

Go to the computer that has internet access, launch the browser, and navigate to 
www.vsh.com. 

Follow the links to Register Software. 

Follow instructions on the web site to register the product. If you are registering an update 
version, you will need the serial number of the previous version to complete the registration. 
If you are registering an additional user license, you will need the serial number of another 
copy of the program that is registered to your institution. 

Getting an Unlock Code is a two-step process. First, you fill in and submit the registration 
form on the web site. The web site will generate an email to you with an Unlock Code.  

http://www.vsh.com/
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When you receive your Unlock Code email, copy it from the email message into the Unlock 
Code field in the Registration dialog box. When possible, use Copy and Paste to do this, to 
ensure that the characters are correct. Then click the OK button. 

Your program will become fully functional once the Unlock Code is entered correctly. 

  

If you have any questions, please contact us. See Contacting Verity Software House for 
phone numbers and addresses. 
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Contacting Verity Software House 

  

 

  

Mailing and Shipping Address: 

Verity Software House 
45A Augusta Road 
Topsham, ME 04086 
USA 
  

 

Web: www.vsh.com 

General Email: verity@vsh.com 

Tech Email: tech@vsh.com 

Sales Email: sales@vsh.com 

Developer Email: devteam@vsh.com 

Phone: (207) 729 6767 
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Tutorials 

WinList Basics 

  

A key component in the design of WinList is fast, efficient performance. This applies not only 
to the inner workings of the program, but also to the user-interface. Everything you do with 
the program is designed to be easy to understand and highly efficient. 
  

This introduction focuses on the fundamentals of working with WinList. In the course of the 
tutorial, you will see how quickly and easily you can create an analysis setup with WinList. 
Opening files, creating histograms, drawing regions and gates, and developing reports are all 
covered in this exercise. 
  
  

Open files 

1. Click the Open FCS File button on the ribbon bar. 
  

 
  

2. In the File Open dialog, navigate to the Samples folder located in the folder where WinList 
is installed. Select the three files BCell_BM_Tube_001.fcs, BCell_BM_Tube_002.fcs, 
and BCell_BM_Tube_003.fcs and click Open. 
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You can also drag and drop files from Windows Explorer onto WinList. See Drag and 
Drop for details. 

  

The Create Histograms dialog will appear. 
  
  

Create histograms 

This dialog allows you to create any number of histograms very quickly. We will create 
several 2P histograms. The dialog also allows you to create 1P and 3P histograms. 
  

3. Select FSC-A in the X Axis list, and SSC-A in the Y Axis list. Then click the Add to List 
button. 
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4. In the X Axis list, select CD10 PE Cy7, CD20 APC, and CD45 AmCyan. Enable the 
Combinations mode checkbox. Click the Add to List button. In this mode, histograms are 
created for all combinations of the selected parameters. 
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5. Click the OK button. 
  

You can also create one histogram at a time by clicking and dragging on a data 
source to define the area where you want the new histogram. The next tutorial 
illustrates this technique. 

  
  

Create a light scatter region 

Next, we'll draw a light-scatter gate on the FSC-A vs. SSC-A histogram. 
  

6. Click the title bar of the FSC-A vs. SSC-A histogram and select the Freehand region tool 
from the toolbar on the right side of the window. 
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The histogram toolbar has tools for creating other types of regions. 

  

7. Draw a region around the population shown. To finish drawing the region, click on the 
point that appeared when the drawing began. 
  

If you want to delete a region, click on the region's label and press the Delete key on 
the keyboard. 

  

 
  
  

Gate the histograms 

With the R1 region drawn, we can now gate the other histograms on R1. 
  

8. Click the mouse on the red bulls-eye in the middle of the R1 region. This is called the 
"cascade hotspot" and is used to apply the R1 gate to other histograms. 
  

9. Press the Shift key on the keyboard and click the title bar of each of the remaining 
histograms. As you click, the gate is applied to the histograms. 
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10. Press the Esc key on the keyboard to exit cascade gating mode. 
  
  

Create QuadStats for statistics 

Let's create QuadStats for each of the gated histograms. 
  

11. Click the Q button in the lower-left corner of each of the gated histograms. A QuadStat 
region will appear on each histogram, and a Results window for each QuadStat will be 
displayed. 
  

12. Arrange the Results windows so that they are visible and not covering the QuadStats. 

  

You can select the statistics that are shown in a Results window by double-clicking 
the title bar and selecting the stats.  This can be different for each Results 
window.  You can also save your preference for which statistics to show. 

  

13. Adjust each QuadStat. To move the QuadStat, click and hold on the region label in the 
center of the QuadStat, drag the label to a new position, and release the mouse. 
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NStat regions are like QuadStats, but are much more flexible and powerful. With 
NStat regions, you can have any number of rows and columns, and the vertices do 
not have to remain orthogonal. Use the NStat tool on the histogram toolbar to create 
an NStat region. 

  
  

Create a report 

At this point, we have a basic analysis setup in place. Let's create a report that can include 
these graphics and other elements in a page layout format. 
  

14. Click the Report button on the ribbon bar. Move and size the new report window so that 
it is not covering histograms and result windows. 
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15. Move the mouse over the icon on the left side of the first histogram's title bar. Drag and 
drop that icon onto the report. 
  

 
  

16. Add additional histograms in the same way, dragging and dropping each one onto the 
report. 
  

17. Drag and drop the results windows onto the report in the same manner. 

 
  

Reports can also contain keywords, text, alerts, and other graphics. They can be 
saved for future use, as well as exported to PDF format. See Creating Reports for 
more information. 

  
  

Process the files 

Since we selected several files for analysis, WinList has created a batch of files to analyze. 
The batch toolbar appears at the bottom of the WinList window whenever there is a batch of 
files selected. 
  

18. On the batch toolbar, click the Edit button to display the Edit Batch Options dialog. 
  

 
  

The options that appear in this dialog determine what happens when each new file is opened 
into the setup we have created. Review the options in this dialog. If connected to a printer, 
enable the Print Report option. Click OK to close the dialog. 
  

19. Click the Next batch item button on the batch toolbar to advance to the next listmode 
file. 
  

 
  

Elements on the report will update automatically as the new data is read in. 
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20. Adjust the gate in the FCS vs SSC histogram. 

21. Click the Next batch item button again to process the last file in the batch. 
  

Other buttons on the batch toolbar allow you to move forward and backward in the 
batch, as well as to auto-advance through the entire batch list. 

  

When you reach the last file in the batch, the Continue button is enabled.  

  

 

  

This allows you to make adjustments to the last file before the analysis is completed.  After 
making adjustments, click the Continue button to finalize the analysis, save and print reports, 
and perform other batch operations on the last batch item. 
  
  

Save the protocol 

Anytime that you have an analysis setup that you want to be able to re-open, use WinList's 
Save Protocol or Save Bundle command. 

The Save Protocol command creates an XML file that WinList uses to re-create the setup. If 
you want to be able to use this setup on other computers, the Save Bundle command creates 
a single file that also contains the listmode data file(s) currently opened and the WinList 
preferences. 

The bundle is also an excellent way to archive the analyses you perform. Simply use the 
Save As button and choose Save Bundle to archive each data file that you open and analyze. 
Even better, use the batch toolbar to process your files, and set its options up to save a 
bundle automatically. 
  
  

Summary 

This brief tutorial has demonstrated how quickly and efficiently WinList helps you to build an 
analysis setup. In just a few minutes, we were able to create histograms, draw regions, apply 
gates, and generate QuadStat statistics. We created a new report and dragged the elements 
we wanted onto the report. And finally, we processed a batch of files through the analysis 
setup. 

Try out some of the additional tutorials to get more details on the powerful features of 
WinList. 
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See also: 

Tutorials 

Cascade Gating and Boolean Gates 
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Cascade Gating and Boolean Gates 

  

Gating is a process of identifying subsets of populations in histograms. Regions are defined 
and used to "gate" the events that are displayed. Using Boolean expressions, gates can be 
created that are inclusive rather than restrictive in nature. 
  

WinList is designed to make the common task of creating restrictive gates simple and fast, 
while at the same time offering open-ended Boolean gating expressions that are flexible and 
powerful. This tutorial will explore the ease of creating restrictive, "cascade" gates, and look 
at how to use Boolean gate expressions to identify other populations. 
  
  

Open a file 

1. Click the Open FCS File button on the ribbon bar. 
  

 
  

2. In the File Open dialog, navigate to the Samples folder located in the folder where WinList 
is installed. Select BCell_BM_Tube_001.fcs and click Open. 
  

You can also drag and drop files from Windows Explorer onto WinList. See Drag and 
Drop for details. 

  

3. The Create Histograms dialog will appear. Click the Cancel button to open the file without 
creating any histograms. 
  
  

Draw a histogram and draw a region 

There are several ways that histograms can be created in WinList. We'll draw a histogram on 
this empty data source window to get started. 
  

4. Click and hold the mouse button in the data source window. With the mouse button down, 
move the mouse to define the size and location for a new histogram window. Release the 
mouse to finish the histogram drawing operation. 
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5. The Edit Histogram dialog is displayed. Choose FSC-A for the X Axis and SSC-A for the Y 
Axis, and then click OK. 
  

On any histogram window, you can click on the axis label and select a new 
parameter. You can also change the parameters that are displayed using the Edit 
Histogram dialog. 

  

6. Click the Freehand region tool in the histogram toolbar, and draw a region around the 
population as shown. To draw a freehand region, click next to the population of interest and 
hold the mouse button down. Drag the mouse around the population as shown. To finish 
drawing the region, click on the point that appeared when the drawing began. 
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Create a cascade-gated histogram 

Notice the red bull's eye in the middle of region R1. This is the "cascade gate" hotspot, used 
to gate another histogram on this region. 
  

7. Click the cascade gate hotspot in R1; the red hotspot will change to green. Move the 
mouse to an empty portion of the data source window. Click, hold, and drag to define a new 
histogram window. 
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8. Release the mouse button. In the Edit Histogram dialog, select CD10 PE Cy7 for the X 
Axis and CD20 APC for the Y Axis. Click OK. This new histogram will be gated on R1. 
  
  

Additional cascade-gated histogram 

Now, let's draw a region in this new histogram and use it to create another gated histogram. 
The new histogram will be gated on R1 and R2. 
  

9. Draw a freehand region in the CD10 PE Cy7 vs CD20 APC histogram to identify the CD20+ 
events in that histogram. 
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10. Click the cascade gate hotspot in R2. Move the mouse to an empty portion of the data 
source window. Click, hold, and drag to define a new histogram window. 
  

 
  

11. Release the mouse button. In the Edit Histogram dialog, select CD10 PE Cy7 for the X 
Axis and CD45 AmCyan for the Y Axis. Click OK. 
  

This new histogram is gated on R1 and R2, meaning that only the events that are in both R1 
and R2 will be displayed. If we continued creating regions and cascade gating in this manner, 
each new histogram would contain a smaller and smaller set of events. This is an example of 
restrictive gating. 
  
  

A Boolean "OR" gate 
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What events would we see in the CD10 PE Cy7 vs CD45 AmCyan histogram if we looked 
at events that are in R1 OR R2? The "OR" gate is sometimes called an "inclusive" gate, 
because events are accepted if they are in either part of the expression. It is often used to 
define "positives" for a fluorochrome, especially if the regions in the gate expression are 
parts of a QuadStat. 

To create this type of gating condition, we write our own gate expression. Let's create a new 
histogram and then use the Edit Gates dialog to define an inclusive gate expression. 
  

12. Click, hold, and drag in an empty portion of the data source window to define a new 
histogram window. 
  

13. Release the mouse button. In the Edit Histogram dialog, once again select CD10 PE Cy7 
for the X Axis and CD45 AmCyan for the Y Axis. Click OK. 

The new histogram is ungated at this point. We will use the Edit Gate dialog to create a gate 
expression for R1 OR R2. 
  

14. Click the Edit Gates button on the ribbon bar to display the Edit Gates dialog. 
  

 
  

15. Select the "G5" gate in the list. In the Equation edit box, type R1. Then click the Or 
button and type R2. Click the OK button to close the Edit Gate dialog. 
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You can also type the "|" character instead of clicking the "Or" button. Similarly, you 
can type the "&" character instead of clicking the "And" button, and type the "!" 
character instead of the "Not" button. 

  

At this point, we have edited the gate expression for gate G5 so that it will include any 
events that are in either R1 or R2. Now we need to apply this gate to our new histogram. 
  

16. Click the Gate tool button on the histogram toolbar and select the G5 gate from the list to 
apply the new gate. 
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There are other ways to apply a gate to a histogram. When the Edit Gate dialog is 
displayed, select the gate that you want to apply and then click the title bars of the 
histograms that you want to gate. This is a fast way to apply a gate to many 
histograms at once. 

  

As you might guess, the histogram gated on the "OR" gate contains more events because of 
the inclusive nature of this gating expression. 
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The Boolean "NOT" operator 

There are certain cases where it is easier to define what you want by defining what you don't 
want. For example, if you have drawn a region that identifies fragments of cells or debris, 
you might want to see all events that are not debris. This is where the Boolean "NOT" 
operator is used. 

Let's define a gate that includes all events that are not in R1. 
  

17. Click the Edit Gates button on the ribbon bar to display the Edit Gates dialog. 
  

18. Select the "G6" gate in the list. In the Equation edit box, delete the current equation. 
Click the Not button to insert the "NOT" operator. Type R1. Leave the dialog open. 
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19. With G6 selected in the Edit Gate dialog, click on the title bar of the last histogram. The 
histogram's title bar will change to show the new gate name. Click OK to close the Edit Gate 
dialog. 
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The events now shown in the histogram are all those that are not in region R1. 
  
  

More complex Boolean expressions 

We have barely scratched the surface of what you can do with Boolean gate expressions. For 
example, let's suppose that you want to exclude debris, defined by R1, and include events 
that are in either of 2 other regions, R2 and R3. The gating expression would be: 
  

Not R1 And (R2 Or R3) 

  

In WinList's syntax, this would be written: 
  

! R1 & (R2 | R3) 

  

WinList allows you to use parentheses to define the order of operations. 
  

Be aware that if you use "NOT" later in the gate expression, it is must be preceded by "OR" 
or "AND". For example, if we rearrange the expression above so that "!R1" is at the end of 
the expression, it would read this way: 
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(R2 | R3) & !R1 

  

You can also use other gates in a gate expression, which is very handy when your gate 
expressions are lengthy. For example, if you have gate G1 defined as: 
  

(R2 | R3) & !R1 

  

You can reference G1 in other gate expressions, such as this one for G2: 
  

G2 = G1 & R4 & R5 

  

The gate expression is expanded and surrounded with parentheses when it is evaluated. 
Here's the expanded form of G2 in this example: 
  

((R2 | R3) & !R1) & R4 & R5 

  

  

Summary 

In this section, we've taken a look at a number of ways that you can create and apply gates 
with WinList. Cascade gates are created and applied automatically when you click on a 
region's cascade hotspot and draw a new histogram (or click on an existing histogram). 
Cascade gates use the Boolean "And" to create restrictive gates. 
  

We also examined how you can define gate expressions that use the Boolean "Or" and "Not" 
operators, and how parentheses can be used to create sophisticated gating expressions. 
  

See also 

WinList Basics 

Edit Gates 
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Using Interactive N-Color Compensation ™ 

  
WinList's interactive N-Color Compensation ™ system performs color compensation of any 
number of parameters through a simple-to-use Compensation Toolbox. With both automatic 
and manual control, you can use the system to perform post-acquisition compensation and 
even adjust previously compensated samples. 
  

You should be familiar with the basics of working with WinList before performing this 
tutorial. You need to know how to open data files, draw regions, and apply gates to 
complete this tutorial. 

  
  

Overview of WinList's interactive N-Color Compensation ™ 

Unlike most compensation systems, WinList provides you with a graphical interface using 
compensation trace lines. Trace lines make it very easy to adjust compensation using 
multiple intensity controls. Probably the best way to explain how trace lines work is with an 
illustration. 
  

The following is an example of how to set up compensation for a four-color experiment. Data 
files for this tutorial were kindly provided by Teresa Hawley. The fluorochromes in this 
example are fluorescent proteins: CFP (Cyan), GFP (Green), YFP (Yellow), and dsRed (Red). 
We will open a single-color control file for each fluorochrome to set up the compensation. 
Then we'll open files with all four colors and apply the compensation to them. 
  

The strategy used in this example can be easily extended to any number of fluorochromes. 
  

Turn Off Auto-Compensation 

Before we get started, we need to make sure that WinList doesn't try to use compensation 
settings from keywords in these data files. We will need to turn off a preference; we can turn 
it back on at the end of the tutorial. 

1. Choose Options->Preferences, and select the Data Source branch of the Preferences tree. 
Look for an option named Auto-Compensation, make a note of the current settings, and 
then set it to Disable. 
  
  

Automatic compensation 

2. Click the Open FCS File button on the ribbon bar. 
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3. In the File Open dialog, navigate to the Samples folder located in the folder where WinList 
is installed. Select four files: SP2+CFP.fcs, SP2+DsRed.fcs, SP2+GFP.fcs and 
SP2+YFP.fcs. You can press the Ctrl key on the keyboard to select more than one file. Click 
Open. 

The first files selected are single-color control files for CFP, DsRed, GFP, and YFP, 
respectively. 
  

You can also drag and drop files from Windows Explorer or My Computer onto 
WinList. See Drag and Drop for details. 

  

4. In the Create Histograms dialog, select FSC-A in the X Axis list, SSC-A in the Y Axis 
list, and click Add to List. 
  

5. In the X Axis list, select CFP-A, GFP-A, YFP-A, DsRed-A. Enable the Combinations 
mode checkbox, and click Add to List. All combinations of the four fluorochromes will 
appear in the histogram list. Click the OK button. 
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The program will open the first file and display seven scatter plots. The batch toolbar will 
appear at the bottom of the application window. We're ready to let WinList determine the 
correct compensation settings by reading each of the control files. 
  

6. Draw a region around the cells of interest in the FSC-A vs SSC-A plot as shown. 
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7. Apply this gate to each of the remaining dot plots. 
  

8. Click the Compensation Toolbox button on the ribbon bar. The Compensation 
Normalization Toolbox will be displayed. 
  

 
  

9. In the Compensate listbox, click CFP-A, GFP-A, YFP-A, and DsRed-A measurements 
to enable them for compensation. Notice the label shows "On" in the listbox, and an entry 
appears in the Show plots for list for each enabled measurement. 
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Only enable the parameters that you want to compensate in the Compensate list. 

  
10. Next, click the Compensation page... button to create a page specifically designed for 
setting up compensation. Use this button any time you want to assign a gate to plots on the 
Compensation page.  A dialog is displayed to select a gate for this page.  Choose G1 and 
click OK. 
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The Compensation page (page 2) is created with three plots showing CFP-A on the X-axis. 
The Y-axis of each plot shows one of the other compensation measurements. The straight, 
horizontal lines on the plots are the trace lines.  In the next step, WinList will position the 
trace lines through the centers of the populations. 
  

 
  
11. Click CFP-A in the Show plots for listbox, and WinList performs a regression through 
the events.  It positions the trace lines through the median of the populations. This is 
WinList's automatic positioning routine at work.  
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Manual compensation adjustments 

With single-color controls, the program almost always does a better job of determining the 
correct slope than we can by eye. If, however, you need to make an adjustment to the trace 
lines, this is a simple drag operation. The square handles that appear at each end of the 
trace line are used for this purpose. 

 
 
The position of a trace line determines the slope and intercept of a line through the center of 
the data. Adjusting the handle in the low-intensity area sets the intercept, and the slope is 
determined by the position of the handle in the high-intensity area. As you move the slope 
handle toward the diagonal, you increase the amount of compensation that will be applied to 
the data. The intercept handle actually has very little impact on the compensation. 
  

In rare cases, you may need to apply more compensation than the trace lines 
normally permit. You can give greater freedom of movement to the trace lines by 
holding down the Shift key on the keyboard when moving its handles. This allows 
each trace line handle to move along two sides of the histogram, with slopes of 
greater than 1.0. 
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Processing the remaining control files 

With the first single-color control all set, let's process the remaining single-color control files. 
  

12. On the batch toolbar at the bottom of the application window, click the Next Batch 
Item button to read in the next file, SP2+DsRed.fcs.  You will see the title in the data 
source window change to show the new file name. 
  

 
  

13. Click the "DsRed-A" in the Show plots for listbox. WinList shows the correct plots for 
DsRed compensation and automatically positions the trace lines. 

 
14. Click the Next Batch Item button to read in the next file, SP2+GFP.fcs. Choose the 
"GFP-A" from the Show plots for  listbox. Once again, WinList automatically positions the 
Trace lines. 
  

15. And once more, click the Next Batch Item button to read in the next file, 
SP2+YFP.fcs. Choose the "YFP-A" from the Show plots for listbox to tell WinList to 
position the trace lines. 
  
  

Applying the compensation 

Believe or not, we just finished setting up the compensation! WinList did most of the work for 
us as each single color control was loaded and we selected the appropriate trace line option. 
Now that the spill coefficients have been determined for each fluorochrome, we are ready to 
apply the compensation. 
  

16. Click the Activate compensation checkbox. 
  

Two things will happen. First, the histograms will redraw to display the compensated data. 

Secondly, the trace lines will disappear, replaced with small + and - buttons on the 

histograms. These buttons allow you to adjust the compensation settings with the 
compensation system activated. To see all of the adjustment buttons, enable the Show all 
trace lines checkbox.  
 
Let's open a 4-color file and test the compensation settings. 
  

17. On the data source toolbar, click the "1" button to return to page 1. 
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18. Click the Next FCS File button on the ribbon bar. Choose Mix all.fcs and click Open. 

  

 

 
The newly-defined compensation is applied to the data in the new file as it is read, and we 
can see well-compensated populations in each plot. 
  

You may have noticed that the log axes on the histograms show values less than 
zero. WinList supports several log-like transformations that allow negative values to 
be displayed: HyperLog, Hyperbolic Sine, and VLog. These transforms are log-like, 
but do not have the limitations of the log transform, in which zero and negative 
values are undefined. 

  

When compensation is applied to events, it is possible for the value of a parameter to 
become zero or negative. Color compensation is a subtractive process, and when significant 
compensation levels are applied to low intensity events, the result is often a negative number 
- sometimes a large, negative number. 
  

You can toggle between transformations quickly using buttons that appear on the 
Transforms tab of the Compensation Toolbox. This tab also provides a control to Optimize 
transforms. 
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19. Let's save a protocol for this setup so that it can be used in the next tutorial.  Click the 
Save button and name the protocol "CompensationTutorial". 
  

Reset Auto-Compensation 

We need to restore your Auto-Compensation preference to its original setting. 

  

20. Choose Options->Preferences, and select the Data Source branch of the Preferences 
tree. Look for an option named Auto-Compensation and set it to your original setting. 
  
  

A few more notes 

If you want to apply the same compensation to a series of files, you can use the Next File 
button on the ribbon bar to open each file into the compensated data source window. 
  

Compensation is only active on the data source window that was used to set up the trace 
lines. Different data source windows can have different compensation settings.  

  

You can also use the compensation system to make adjustments to a previously 
compensated file. To do this, enable the parameters you want to adjust, select a 
measurement in the Show plots for list, and make the adjustments. When you are finished, 
turn on the compensation system by checking the Activate compensation checkbox. 
  
  

Summary 

WinList's N-Color Compensation system is very quick and easy to use. You can use it to 
compensate any number of fluorescent measurements for signal crossover. This is best 
accomplished through the use of single-color control files, which are read one at a time to 
determine the best compensation settings. 
  

Trace lines are graphical elements displayed in the histograms that you are compensating. 
WinList can automatically position trace lines using a robust fitting algorithm, and it uses the 
slopes of trace lines to set up a compensation matrix. 
  

See Also: 

Compensation Toolbox 

Compensation Trace Lines 
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Compensation Review Mode 

  

Cytometry assays continue to use more colors, providing a richer platform for understanding 
cells and biology.  At the same time, as the number of colors increases, so does the 
complexity of properly compensating for fluorescence crossover.  Let's explore a method for 
evaluating just how good your compensation setup is, confirming the strengths and revealing 
the weaknesses in a way the makes sense. 

  

Compensation Review Mode in WinList is a visual tool that makes this possible.  The process 
is simple: review each single-color control file, one by one, and examine how well the 
crossover values match the data.  Compensation Review Mode performs some optimizations 
to make this process possible. 

  

To use this mode you need a set of single-color control files that were used to set up the 
compensation.  You may also want to review one or more all-color files. 

  

Here's how it works.  We'll use the compensation that we set up in Using Interactive N-Color 
Compensation as a test case, so make sure you do that tutorial first. 

  

Open an all-color file 

We start by opening an all-color file and applying the compensation that we want to 
review.  That compensation might be loaded automatically by WinList by reading keywords 
from the file, or it may be compensation that you have set up in WinList.   

  

1. Click the Open Protocol button and select "CompensationTutorial" - the protocol that 
was saved in the Using Interactive N-Color Compensation tutorial. There should be a FSC vs 
SSC plot, and 6 other plots for the fluorochromes. 
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Turn on Compensation Review Mode 

2. In the Compensation Toolbox, click the Misc tab and enabled Compensation review. 

  

 

  

The display will change dramatically.  
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All of the plots that are normally showing a log-like axis will switch to a linear 
axis.  Compensation has been temporarily disabled.  In addition, the plots will "zoom" to the 
95th-percentile.  How is this going to help us review compensation?  Let's keep going and 
find out. 

  

Review the first control file 

3. Click the Next Batch button on the batch toolbar to read in the first single-color control 
file that we used to set up the compensation. 

 

  

4. On the Setup tab in the Show plots for list, select CFP-A, since this is the CFP-only 
control file.  This will select the Compensation page, and you should see something like this: 
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Only 3 plots are shown: the ones that involve CFP-A.  The X-axis for each plot is CFP-A, and 
the Y-axis shows one of the other fluorochromes.  The view is zoomed in on the 95th-
percentile, and we're looking at linear plots so there are no warping effects from log 
transformations. 

  

Most importantly, note the position of the trace lines in the plots.  If the compensation is set 
up properly, the trace lines will pass right through the center line of the data.  That appears 
to be the case here, so it looks like the CFP-A compensation is set correctly for the CFP 
control.   

  

Let's check the other 3 controls in the same manner. 

  

Review the other controls 

5. Click the Next Batch button on the batch toolbar to read in the next single-color control 
file. 

 

  

6. In the Show plots for list, select DsRed-A, since this is the DsRes-only control file.   
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Now we see DsRed-A on the X-axis plotted against each of the other markers.  The trace 
lines appear to pass through the center of the linear-displayed clusters, so the DsRed looks 
correct. 

  

7. Click the Next Batch button on the batch toolbar to read in the next single-color control 
file. 

 

  

8. In the Show options for list, select GFP-A for the GFP-only control file.   
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GFP also looks correct.  We've got one more to review. 

  

9. Click the Next Batch button on the batch toolbar to read in the last single-color control 
file. 

 

  

10. In the Show plots for  list, select YFP-A for the YFP-only control file.   
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Once again, the trace line passes smack through the center of the distributions. 

  

Interpretation 

In Compensation Review mode, you are looking to see that the trace lines for each single-
color control pass through the center (median) of the zoomed, linear distribution.  That's one 
of the things Compensation Review mode does automatically for us.  It's easier to see this 
when looking at linear axes with any high-end outliers clipped out.  To demonstrate that 
point, here's the YPF control unzoomed and with Hyberboline Sine axes: 
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With this display, it is difficult to see what was quite simple and obvious in the zoomed, linear 
display. 

  

You can also review the all-color file in Compensation Review mode. To do so, you open the 
all-color file and then use Show plots for  to show each of the markers in turn.   

  

11. When you finish with compensation review, uncheck the Compensation review option 
on the Misc tab of the Compensation Toolbox. Then switch back to page one of the data 
source to see all plots once again. 
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Summary 

Compensation Review mode is a tool that simplifies the process of assessing fluorescence 
compensation.  By switching transformations to linear and zooming in on the data, it 
becomes a simple task to determine whether a trace line passes through the center of a 
distribution.  It is best used with single-color controls, but can also be used to review 
compensation on an all-color file. 
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Creating Reports 

  

When you need to generate reports that contain graphics, text, and results, WinList's 
reporting system provides the tools to create multi-page documents with a professional, 
polished look. Reports are page layout windows that can contain any number of elements. 
These elements can update any time the data you are analyzing changes. Reports can be 
exported as PDF files so that you can easily share your analysis results with others who do 
not have access to WinList. 
  

This tutorial takes an in-depth look at the reporting features of WinList. In the process, you 
will become familiar with the simplicity and flexibility of reports, and learn how to use reports 
in your own analysis protocols. 
  

If you are unfamiliar with opening files and creating histograms with WinList, you 
might want to do the WinList Basics tutorial before continuing with this one. 

  
  

Setup 

We'll start by opening a listmode file and creating some histograms and results. 
  

1. Click the Open FCS button on the ribbon bar and navigate to the Samples folder located 
in the folder where WinList is installed. Select BCell_BM_Tube_003.fcs from the list and 
click Open. 
  

On the PC, you can also drag and drop files from Windows Explorer or My Computer 
onto WinList. See Drag and Drop for details. 

  

2. When the Create Histograms dialog appears, select CD45 AmCyan in the X Axis list, 
SSC-A in the Y Axis list, and click Add to List. Select CD10 PE in the X Axis list, CD20 APC 
in the Y Axis list, and click Add to List. Click OK. 
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3. Use the Contour region tool to create a box around the lymphocytes in the CD45 vs SSC 
histogram. 
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Contour regions are defined with a bounding rectangle. The contour region 
recomputes when data in the histogram changes. 

  

4. Use the cascade gate hotspot in the center of R1 to apply the R1 gate to the CD10 PE vs 
CD20 APC histogram. 
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5. Click the Q button in the lower-left corner of the CD10 PE vs CD20 APC histogram to 
create a QuadStat region. Adjust the QuadStat and move the associated Results window to a 
convenient location on the screen. 
  

 
  

Create the report 

Now that we have a simple analysis setup, let's create a report and add some elements to it. 
  

6. Click the New Report button on the ribbon bar to create a new, empty report window. 
Move and resize the new window so that you can see the histograms and results windows. 
  

 
  

Along the top of the report window is a toolbar containing commands to manage report files 
and to add objects to the report. Most of these commands also appear in the context menu 
for the report. 
  
  

Adding histograms to the report 

The easiest way to add objects to the report is to drag-and-drop them on the report. Each of 
WinList's windows has a drag-and-drop hotspot on the title bar. This is the small icon that 
appears on the top left of the title bar. 
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For a detailed explanation of drag-and-drop support, see the Drag and Drop section. 

  

7. Click and hold the mouse on the first histogram's drag-and-drop hotspot, drag it to the left 
side of the report page about an inch from the top, and release the mouse button. A copy of 
the histogram will appear on the report. 
  

Let's examine the properties of this new object. 
  

8. Double-click on the newly added histogram object on the report. The Edit Histogram 
Link dialog is displayed. 
  

 
  

This dialog allows you to choose the histogram that this report object is linked to. It also has 
combo boxes that control the caption style, graphic quality, and how it will update when the 
linked histogram changes. You can edit these properties at any time. For now, we will leave 
the settings just as they are. 
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9. Click the Cancel button to close the dialog without making changes. 
  

10. Use the same drag-and-drop technique to add the second histogram to the report, 
placing the new object below the first one. 
  

You can always adjust the size and position of objects after you've added them to a 
report. Click and drag and object to move it. When it is selected, use the sizing 
handles to re-size the object. 

  
  

Adding results to the report 

We could drag-and-drop the results window onto the report in the same manner, but let's 
use the report toolbar instead. 
  

11. Click the Results button on the Report toolbar. 
  

 
  

The Edit Results Link dialog is displayed. This is very similar to the Edit Histogram Link 
dialog, except that it allows us to select a Results window. There is also a Properties button 
that edits the font used by this object. 
  

12. Click the OK button to accept the selection and create the object. Drag the new results 
object next to the second histogram object. Re-size the results object if it is not large enough 
to see all of the results. 
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Adding FCS keywords to the report 

It is often useful to include on the report information contained in the FCS keywords from the 
listmode files that you analyze with WinList. The Keywords object makes it very simple to do 
this. 
  

13. Right-click to the right of the first histogram on the report. This will display the report 
context menu. 
  

14. Select Insert Keywords from the menu. The Edit Keyword Object is displayed. In 
the Keyword Groups tree on the left, under File Keywords choose DataSource 1. Notice 
that the Available Keywords list on the right fills with keywords contained in the file. 
  

15. Choose DS1:$CYT in the list and click Add. A new line is added to the Selected 
Keywords window at the bottom of the dialog. 
  

 
  

16. Use this same technique to add DS1:$DATE and DS1:TUBE NAME. You many need to 
scroll down in the Available Keywords list to locate these keywords. Click OK to add the 
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Keyword object to the report. Resize and adjust the position to show the content, if 
necessary. 
  
  

Adding a title area to the Master Page 

Let's add some text and graphics at the top of the report to make it look more professional. 
We'll put these on the "Master Page" of the report so that they appear on all other pages. 
  

Use the Master Page of the report to create header and footer items that should 
appear on all other pages of the report. 

  

17. At the bottom of the report window, click the Master Page tab. There is only one item 
on this page to start with, and that is the page numbering object at the bottom of the page. 
  

18. Click the Text tool on the report toolbar to create a new text object.  

 

  

In the Text field, type CD10/CD20 Report. Click the Font button, select a typeface that 
you like, and change the font to size 36. Change the Alignment to Center. Click OK. 
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19. Move the new text object to the top of the report page and stretch it across the width of 
the page. 
  

You can change the scaling of the report page by using the Zoom dropdown on the 
report toolbar. 

  

20. Click the Rectangle tool on the report toolbar. Position the new rectangle under the title 
text, and make it a narrow band that stretches across the report page,. 
  

21. Double-click the new rectangle object to display the Edit Properties for Rectangle 
dialog. Choose a Fill Color and Border Color that you like and click OK. 
  

22. Now, click the Page 1 tab at the bottom of the report window to see the items from the 
master page and page 1. The report should look similar to the one shown below at this point. 
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Adding your own graphics 

You can add your own graphics to your reports easily. Open the graphic you 
want to add in a graphics program and copy it to the clipboard. Then, activate 
the report window and paste the graphic by pressing Ctrl-V or using the right-
click context menu. 

  

Adding a gate legend and impressions 

The report can include a legend that explains the colors that are shown in the histograms. 
Let's add a gate legend object, and then another text object that will allow us to enter 
comments about the analysis. 
  

23. Right-click on the report page and choose Insert Gate Legend from the menu. Click 
OK in the Edit dialog. Move and size the new object on the report so that it doesn't obscure 
other objects. 
  

The Gate Legend object provides a key to the dot colors that appear in the 
histograms as well as statistics for each gate population. 

  

24. Right-click in the empty area near the bottom of the page and choose Insert Text from 
the menu. Type the word, "Impressions", and press the Enter key on the keyboard. An Edit 
dialog is displayed that allows you to type and view multiple lines of text. Press Enter again, 
and type "This analysis shows CD10 and CD20 expression for the selected lymphocytes."”  
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25. Click the OK button in the Edit dialog. 
  

Now, suppose that we want this text object to have a light gray background. There are two 
edits to the object's properties we need to make. 
  

26. Click the Background button, choose a light gray color from the color dialog, and click 
OK. Next, uncheck Transparent to disable transparency. 
  

27. Click OK again to close the Edit Properties for Text dialog. Stretch the new text object 
across the width of the report page. 
  

 
  

Updating report objects 
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Now that the report is complete, let's see how it updates when we change something in the 
source histograms. The histogram and results objects we added to the report are all set to 
update when the data changes. 
  

28. Move the R1 region on the first histogram window. Notice that after the histogram 
windows and results update, the objects on the report also update. Similarly, if you move the 
QuadStat region, the report will update to reflect the changes. 
  

Histogram and result objects on the report display a symbol in the upper left corner 
to indicate whether the object is actively linked or not. The symbol for a linked object 
is a green-filled circle. When the object is not linked, the symbol is disappears. 

  

Suppose that you want to make changes in the histograms and you do not want the report to 
change. This is easily accomplished by clicking the Active Links button on the report 
toolbar. 

  

 

  

This is a toggle button. In the depressed position, the report objects update automatically, 
and when it is not depressed, the objects do not update. 
  
  

Additional pages 

Reports can include any number of pages. The Pages button on the report toolbar displays a 
menu of page commands for adding, removing, and navigating pages in the report. 
  

29. At the bottom of the report window, click the <Add> tab. Click OK in the Add Page 
dialog to accept the default name for the new page. A new, empty page is displayed on the 
report. Notice that the items from the Master Page appear automatically. 
  

Let's use this new page to show a quick way of adding many histograms at once. Suppose 
that you want to add all of the histograms from a data source to a report. Here's the quick 
way to do it. 
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30. Move the mouse over the drag-and-drop icon for the data source window. Drag the icon 
onto the report and release the mouse button. Both histograms from the data source are 
added at once. Move them so that they do not obscure the title. 
  

You can navigate to the other report page by pressing the Page Up and Page Down keys on 
the keyboard, by clicking the Page tab at the bottom of the window, or by using commands 
in the Pages menu of the report toolbar. 
  
  

Saving and exporting the report 

When you save a protocol or bundle, the report is automatically saved for you.  The report 
will be reopened when the protocol or bundle is opened. You can also manually save a report 
file to use as a report template for other protocols.  

  

31. To save the report for use in another protocol, click the Save button on the report 
toolbar. Navigate to a location where you want to store the report. Type a name for the 
report and click Save. 
  

Notice that the title bar of the report window changes to show the new name you typed in. 
Exporting the report to PDF is just as simple. 
  

32. To export the report as a PDF, click the PDF button on the report toolbar. Navigate to a 
location where you want to store the PDF version of the report. Type a name for the PDF file 
and click Save. 
  
  

Summary 

Creating a report is a simple process of dragging elements onto a report page or adding 
elements using menus. Histograms, results, and keyword report objects automatically update 
when the source data changes, making the report a great tool for batch processing files. 
Reports can contain any number of objects and pages, so that even very large experiments 
are easily supported. 
  
  

See Also: 

Report Windows 

Report Toolbar 

Report Context Menu 

Report Page Menu 
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Using Overlays 

  

Overlay windows are a great tool for graphically comparing a set of 1P or 2P plots.  Offering 
different views and a wide variety of graphical options, overlays organize plots - typically 
from different files - so that you can easily see the similarities and differences among 
them.  This tutorial explores how to create overlays and some of the properties you may find 
most useful. 

  

If you are unfamiliar with opening files and creating histograms with WinList, you 
might want to do the WinList Basics tutorial before continuing with this one. 

  
  

Getting Started 

We'll start by opening a listmode file and creating some histograms. 
  

1. Click the Open FCS button on the ribbon bar and navigate to the Samples\AutoPosition 
folder located in the folder where WinList is installed. Select autoposition.015 from the list 
and click Open. 

2. In the Create Histograms dialog, select FL2 in the X Axis list and FL1 in the Y Axis 
list.  Click the Add to List button. 

3. Click the 1P Histograms tab in the dialog.  Choose FL2 in the X Axis list and click the 
Add to List button. 

4. Click OK to close the dialog and display the histograms. 
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We're going to look at a series of samples in which the intensity of the marker in FL2 
diminishes, and we will overlay the graphics to compare the changes.  Let's create two 
overlay windows, one for the 1P graphics and the other for 2P graphics. 

  

5. Click the Overlay button on the ribbon bar two times to create two overlay 
windows.  Move the windows to a convenient location on your screen. 

  

 

  

To add a histogram to an overlay, you simply drag-and-drop the histogram by the icon in the 
top left corner of its title bar. 

  

 

  

6. Drag-and-drop the 1P histogram onto the first overlay window, and then drag-and-drop 
the 2P histogram onto the second overlay. 
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The first element added to an overlay window determines several key properties for the 
overlay.  The overlay will become a 1P or 2P overlay depending on the type of histogram that 
is added.  The axis displayed for the overlay is based on the first element, too.  Let's add a 
couple more elements to each overlay. 

  

7. Click the Next FCS File button on the ribbon bar and select the next file in the folder: 
autoPosition.016.  Click Open to read the file into WinList. 

8. Drag-and-drop each histogram onto the associated overlay window to add new elements 
for this new data file. 

9. Click the Next FCS File button and select autoPosition.017.  Click Open to read the file. 

10. Drag-and-drop each histogram onto the associated overlay window.  You should now 
have 3 elements in each overlay window. 
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Editing Overlays 

Notice that the 1P overlay has a left-to-right arrangement, while the 2P overlay is a straight 
overlaid arrangement.  These are the default settings for each overlay type, but they can be 
changed.  We can also change other properties of the overlay and its elements.  Let's 
explore. 

  

11. Right-click inside the 1P overlay window and choose Edit from the context menu.  The 
Edit Properties dialog for the overlay is displayed.   

  

In this first panel of the dialog, we can change settings that affect the overall appearance of 
the overlay and some things common to all elements.  For example, we could change the 
transparency or the line weight of the histograms, the fonts used, or whether to show 
grids.  This is also where we can select the view of the overlay items. 

  

Let's look at the properties that can be changed on individual elements of the overlay. 

  

12. In the tree on the left side of the Edit Properties dialog, click the first element, 
autoposition.015.  The properties for this element are displayed. 

13. Edit the Label so that it reads Time=0h.  This label will now be used in the legend for 
the first item. 
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14. Select autoposition.016 in the tree on the left, and edit its label to Time=6h. 

15. Select autoposition.017 in the tree on the left, and edit its label to Time=12h. 

  

You can also change the color and line style with this editor.  Of special interest is the 
Update when histogram changes option.  With this option enabled, the element would 
update in the overlay any time that the histogram it came from changes - a very useful 
option for some or all elements in an overlay.  In our example here, however, we will leave 
the option unchecked because we want the elements to remain unchanged. 

  

16. Click OK to close the dialog and see the changes. 
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Did you notice the small handles on the right side of the axis in the 1P overlay?  They can be 
dragged to change the left-to-right perspective.  The lower handle moves left and right to 
adjust the width of the X-axis.  The back handle adjusts up and down to control the tilt of the 
arrangement.  These handles only appear in Left-to-Right view for an overlay. 

  

Let's take a look at the 2P overlay.  Suppose we want to change the order of the elements 
that we overlaid so that the first element was in the back of the stack and the last element 
was in the front.  We do that by dragging elements in the legend at the bottom of the 
window. 

  

17. Drag the autoposition.017 element in the legend to the top of the legend and drop 
it.  It becomes the front element in the stack. 

18. Drag the autoposition.015 element to the bottom of the legend and drop it.  It 
becomes the last in the overlay stack. 

  

Overlays are part of a WinList protocol file, so when you save your protocol, you save the 
overlays, too.  This means that you can set up overlays as part of your experiments, adding 
to them as you work on new samples.  Overlays can be copied in high-resolution to the 
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clipboard and pasted into other apps.  They can also be saved to disk in many popular 
graphics formats for use with publications. 

  

See also: 

Overlay Windows 

Overlay Context Menu 
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Using FCOM to enumerate phenotypes 

  
In this tutorial, we'll learn how to use the FCOM parameter to enumerate phenotypes. FCOM 
is defined as a calculated parameter function in WinList that analyzes any number of 
phenotypes defined by any number of gates. The best way of explaining this function is to 
use it. We'll start with a simple example and then discuss how you can extend it in more 
powerful ways. 
  
Here is the general concept. We are going to open a listmode file and display a few 
histograms. We will set up some gates to identify the positive events for CD4 PE, CD8 PerCP, 
and CD3 APC. Then we'll create the FCOM parameter to see the complete phenotype. 
  

Before you begin, make sure you understand the basics of working with WinList. The 
tutorial WinList Basics is a great place to start. 

  
  

Open a data file 

1. Click the Open FCS button on the ribbon bar and navigate to the Samples folder located 
in the folder where WinList is installed. Select FCOM_Example.fcs from the list and click 
Open. 
  

On the PC, you can also drag and drop files from Windows Explorer or My Computer 
onto WinList. See Drag and Drop for details. 

  

2. When the Create Histograms dialog appears, click Cancel. We will create the 
histograms one at a time by drawing them on the data source. 
  

This file does not contain any events with values less than 0, so in this case there is no utility 
to using the HyperLog transformation for it. Let's switch over to use the Log transform for all 
log-like parameters. 
  

3. Click the Comp button on the ribbon bar to display the Compensation Normalization 
Toolbox. Select the Transforms tab, and click the --> Log button. You can close the 
Compensation Toolbox at this point. 
  
  

Creating histograms and gates 
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Next, we'll draw 3 histograms on the empty data source window and gate them 
appropriately. 
  

4. Click, drag, and release the mouse on the data source window to define an area where we 
want to display a histogram. In the Edit Histogram dialog, choose FSC-Height and Side 
Scatter for the X- and Y-Axis respectively, then click OK. 
  

5. In this new histogram, draw a region around the cells of interest as shown below. You can 
use any region type to do this. 
  

 
  

6. Click R1's label to display the cascade hotspot (the red bull's eye in the center of the 
region), move the mouse to an empty portion of the data source window, and draw a second 
histogram. In the Edit Histogram dialog, select Side Scatter for the X Axis and CD3 APC for 
the Y axis, and then click OK. 
  

A new histogram gated on R1 is displayed. 
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Did you know that you can apply a cascade gate to any histogram by clicking on the 
region's hotspot and then clicking on the title bar of the histogram you want to gate? 
You can also hold down the Shift key if you want to apply a cascade gate to several 
histograms at once. 

  

7. Draw region R2 around the CD3-positive population in the new histogram. Click on the 
cascade hotspot for R2, move the mouse onto the data source window, and draw a third 
histogram.  

  

 
  
In the Edit Histogram dialog, select CD8 PerCP for the X Axis and CD4 PE for the Y axis, 
and then click OK. 
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8. Finally, draw two more regions: R3 to define the CD4 positives and R4 to define the CD8 
positives, as shown in the following picture. Note that we intentionally capture some events 
as CD4+CD8+ in this example. 
  

You can choose a different region drawing tool from the histogram toolbar to draw 
regions of different shapes. 

  

 
  
  

Creating the FCOM parameter 

OK, now for the fun part. Let's create the FCOM parameter. 
  

9. Click the Add Parameter button on the main ribbon bar.  Alternatively, you can right-click 
in the data source and choose Add Parameter from the context menu. 
  

 
  

10. Click the Add button in the Edit Calculated Parameters dialog to add a new parameter. 

  

Let's choose an example equation from the Functions list box. 
  

11. Select (FCOM(G1,G2,G3)+0.5)*1024/8+FRND(10) from the list of example 
equations. 
  

We need to edit this example equation to use gates G2, G3, and G4. 
  



Using FCOM to enumerate phenotypes 

84 

12. Edit the equation so that it reads (FCOM(G2,G3,G4)+0.5)*1024/8+FRND(10). Type 
FCOM in the Name edit box. 
  

 
  

This equation looks more complicated than it really is. The FCOM function can have any 
number of gates as arguments. The way it works is described in the reference section of the 
manual. Here is how it works with our example. Using the 3 gates "G2, G3, G4" as the 
arguments for our FCOM, there are 8 possible classifications for each event in the listmode 
file. An event can be negative for all gates, positive for all gates, or some other combination. 
The table below shows the possible FCOM values for the G2, G3, and G4 gates. 
  

G2 G3 G4 FCOM 
Value 

- - - 0 

+ - - 1 

- + - 2 

+ + - 3 

- - + 4 
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+ - + 5 

- + + 6 

+ + + 7 

  

FCOM converts gate combinations to a single number identifying the phenotype. The more 
gates in the expression, the more possible combinations there are. The rest of the equation 
spreads the populations so that we can visualize them more easily on a histogram display. 
  

13. Click OK to close the Edit Calculated Parameter dialog, and click OK again to close 
the Edit Calculated Parameters dialog. 
  

WinList creates the new, calculated, listmode parameter that can be used like any other 
parameter in the listmode file. Let's create a histogram to see what it looks like graphically. 
  

You can use FCOM parameters in 1P, 2P, and 3P histograms. You can plot it against 
another parameter in the listmode file to see the phenotype as a function of that 
parameter. 

  

14. In an empty portion of the data source window, draw a new histogram with the mouse. 
We want to make this window wide, so hold down the Alt key as you draw the 
histogram.  When you release the mouse, the Edit Histogram dialog is displayed. Choose 1P 
for the histogram type, and choose the last parameter in the list, FCOM, for the X Axis. Click 
OK. 
  

 
  

This new histogram has distinct peaks representing the eight possible states for events 
evaluated by gates G2, G3, and G4. The left-most peak represents events outside of all three 
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gates, the triple-negative events. The next peak contains events that are in G2 but not in G3 
or G4. The last peak represents triple-positive events in all gates. 
  
  

Statistics 

WinList makes it easy to get statistics for each phenotype and to see each distribution in the 
context of other histograms. To do this, we'll use the Create Region Array feature to create a 
set of regions and results. 
  

16. From the Insert tab of the ribbon bar, click the Region Array button. Click the 
checkbox labeled Create a region array for the FCOM peaks. This is a special option that 
only appears when the active histogram contains an FCOM parameter. 
  

 
  

The FCOM Region Array Options dialog appears. This dialog allows you to turn on color 
gating based on the FCOM peaks, and to choose the colors used for those gates. It also 
allows us to name the gates to make it easier to identify phenotypes. 
  

17. Type 3 in the G2 alias edit box, 4 in the G3 alias edit box, and 8 in the G3 alias edit 
box. 
  

 
  

18. Click OK to close the dialog. Click OK again to close the Create Region Array dialog. 
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WinList creates 8 regions and positions them on the FCOM peaks. The regions are labeled to 
show the phenotypes. A result window shows the statistics for each peak, along with the 
phenotype labels. Each population is color-coded in the histogram to make it easy to identify 
the phenotype. 
  

 
  
  

Extending this system 

Since the FCOM parameter can take any number of gates, you could look at all the 
combinations of four gates (16 combinations) or more. You can create more than one FCOM 
parameter, each with the phenotype of a different set of gates, and then display a 2P 
histogram of the two FCOM parameters. You can even save the FCOM parameter into a new 
FCS file using the Save Data Source option in the File menu. 
  
  

See Also: 

Enhanced Proliferation Analysis 

FCOM Background and Usage 
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Population Identification with Cen-se' and t-SNE 

  

A challenging aspect of modern cytometry is in how we deal with ever-increasing numbers of 
measurements and markers.  New instruments provide us with more colors so that we can 
learn more about the cells we analyze.  Traditional analysis strategies with 2P plots and gates 
become tedious, if not impossible - there are just too many combinations of markers to 
consider.  This is not a problem unique to cytometry data, and several methods have been 
proposed which do a pretty good job of addressing the challenges of high-dimensional data. 

  

In 2008, Laurens van der Maaten and G.E. Hinton proposed a method for visualizing high-
dimensional data called t-SNE . The name means "t-Distributed Stochastic Neighbor 
Embedding", and the method does a great job of reducing dimensionality to 2 or 3 
dimensions. At the same time, the commonality of similar data points is preserved, making it 
a great tool for cytometry data.  You can read more about this method on van der Maaten's 
web site: lvdmaaten.github.io/tsne. 

  

Verity Software House introduced a significant new dimensionality reduction algorithm 
derived from t-SNE called Cen-se' in 2019 (Bagwell, et al, Improving the t-SNE Algorithms 
for Cytometry and Other Technologies: Cen-Se′ Mapping). Cen-se′ (Cauchy Enhanced 
Nearest-neighbor Stochastic Embedding) corrects several issues with the t-SNE routine and 
provides better resolution of populations, along with greatly enhanced performance. 

WinList has integrated t-SNE and Cen-se' algorithms as calculated parameters, making it easy 
to generate these plots and explore your data.  Let's take a look at how to do this with an 
example file acquired on a Fluidigm Helios instrument with 48 measurements. 

  

Before you begin, make sure you understand the basics of working with WinList. The 
tutorial WinList Basics is a great place to start. 

  

Open the FCS file 

1. Click the Open FCS button on the ribbon bar and navigate to the Samples folder located 
in the folder where WinList is installed. Select Helios1.fcs from the list and click Open. 

  

2. In the Create Histograms dialog, switch to the 1P Histograms tab and select the CD4, 
CD8, and CD3 measurements.  The full names for these are 143Nd_CD4, 144Nd_CD8, and 
150Nd_CD3.  With these selected, click OK. 

  

https://lvdmaaten.github.io/tsne/
https://www.hilarispublisher.com/open-access/improving-the-tsne-algorithms-for-cytometry-and-other-technologies-cense-mapping.pdf
https://www.hilarispublisher.com/open-access/improving-the-tsne-algorithms-for-cytometry-and-other-technologies-cense-mapping.pdf
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Create the Cen-se' and t-SNE parameters 

Next, we want to create the Cen-se' and t-SNE calculated parameters.  To do this, we use 
the Add Parameter feature of WinList. 

  

3. Click the Add Parameter button on the main ribbon bar.  Alternatively, you can right-click 
in the data source and choose Add Parameter from the context menu. 
  

 
  

4. Click the Add button in the Edit Calculated Parameters dialog to add a new parameter. 
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Let's choose an example equation from the Functions list box.  The function we're looking for 
is actually FSNE as opposed to t-SNE.  All WinList function names start with the letter F and 
have a total of 4 letters, so t-SNE becomes FSNE. 
  

5. Select FSNE(P1,P2,P3,P4,P5,P6,G0,50,2) from the list of example equations.  This will 
get us started. 

  

 

  

The function has 3 important parts to it.  The first part is the list of parameters that we want 
t-SNE to evaluate.  This can be any number of parameters, starting with P1, separated by 
commas: 

FSNE(P1,P2,P3,P4,P5,P6,G0,50,2) 

  

After the parameters, there is a gate number in the expression. This gate is used to filter 
the events that t-SNE evaluates.  For example, you might have a gate the selects 
lymphocytes that you want to filter the events on.   For no gate, we enter G0.   

FSNE(P1,P2,P3,P4,P5,P6,G0,50,2) 

  

You probably will not edit the last two arguments to the FSNE function.  They relate to 
"perplexity" and the number of dimensions to return.  Perplexity sets the number of effective 
nearest neighbors, which has a default value of 50.  The number of return dimensions should 
be 2. 

FSNE(P1,P2,P3,P4,P5,P6,G0,50,2) 

  

Let's edit the example equation so that it suits our data file. This is easy to do with the 
Choose button that appears next to the Equation edit box. 

  

6. Click the Choose button.   
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The Select t-SNE Parameters dialog is displayed, showing two lists of parameters. The 
Available list on the left contains parameters we have not included, and the Selected list on 
the right contains those that we have added. To move an item from one list to the other, you 
simply click the item. 

  

7. Remove P1, P2, P3, and P4 from the Selected list by clicking each one. 

  

8. In the Available list, click p7, p8, p9, p10, p11, p18, p21, p25, p26, p27, p28, p31, 
p36, p37, p38, p46, and p47 to add them to the Selected list. The dialog will look 
something like this when you are finished. 

  

 

  

9. Click OK to close the dialog.  
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The Equation field in Edit Calculated Parameter will now contain this expression: 

FSNE(p5,p6,p7,p8,p9,p10,p11,p18,p21,p25,p26,p27,p28,p31,p36,p37,p38,p4
6,p47,G0,50,2) 

  

 
  

We are passing 19 ungated measurements to t-SNE and getting 2 dimensions in return. The 
measurements are CD45RA, CD20, CD33, CD28, CD24, CD161, CD38, CCR7, CD57, HLADR, 
CD19, CD4, CD8, CD3, CD16, CD27, CD14, CD56, and CD25. We will leave the gate at G0, 
and perplexity and dimensions at 50 and 2, respectively. 

  

10. Click OK to closed the Edit Calculated Parameter dialog. 

  

Next, we'll use the same process to add Cen-se'. 

  

11. In Edit Calculated Parameters dialog, click the Add button again to add another 
parameter. 
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This time the function we're looking for is FCEN for the Cen-se' algorithm.  
  

12. Select FCEN(P1,P2,P3,P4,P5,P6,G0,200,2) from the list of example equations.   

  

 

  

The function is almost identical to the FSNE function.  It starts with a list of parameters and 
then a gate.  Next is the number of nearest neighbors, which is 200 by default.  The last 
argument is always set to 2. 

  

13. Click the Choose button.  We'll select the same measurements that we used for the 
FSNE function. 

  

14. Remove P1, P2, P3, and P4 from the Selected list by clicking each one. 

  

15. In the Available list, click p7, p8, p9, p10, p11, p18, p21, p25, p26, p27, p28, p31, 
p36, p37, p38, p46, and p47 to add them to the Selected list.  
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16. Click OK to close the dialog.  

  

The Equation field in Edit Calculated Parameter will now contain this expression: 

FCEN(p5,p6,p7,p8,p9,p10,p11,p18,p21,p25,p26,p27,p28,p31,p36,p37,p38,p4
6,p47,G0,200,2) 
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17. Click OK in the Edit Calculated Parameter dialog. We now have two new calculated 
parameters. 
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18. Click OK in the Edit Calculated Parameters dialog.  

  

The program will begin to calculate the new parameters. Depending on your computer, this 
might take a few moments to a few minutes. 

  

 

  

Let's create 2P plots that will display the Cen-se' and t-SNE parameters. 

  

19. On the Insert tab of the ribbon bar, click the Dots button to add a dot plot to our 
layout. Move it and size it to your liking. You may want to increase the Dot size to 5 and 
change Dot order to Low frequency on top in the Edit Graphics dialog. These settings are 
helpful for t-SNE plots. 

  

20. Change the X-axis to display t-SNE_1 and the Y-axis to show t-SNE_2. 
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When the t-SNE function finishes computing, you should see a plot similar to this: 

 

  

21. Right-click in the new t-SNE plot and choose Clone from the context menu. 

  

 

  

This creates a copy of the t-SNE plot, which we can modify to show the Cen-se' 
measurements. 

  

22. Change the X-axis to display Cen-se_1 and the Y-axis to show Cen-se_2. 
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In both plots, we can see some distinct groups of events and some continuous distributions, 
but we have no idea what they mean. How does this help us understand our data? Well, it's 
always useful to start with something we know. Let's see where the CD3, CD4, and CD8 cells 
are in this plot. 

  

Using other plots to understand Cen-se' and t-SNE 

Our workspace has 5 plots on it: 1P plots for CD3, CD4, and CD8, and 2P plots for t-SNE and 
Cen-se'. Let's put some regions on the 1P plots to see where the positives are the 2P plots. 

  

23. Draw a region on the CD3 positive events in the 1P plot, and observe where they fall in 
the t-SNE and Cen-se' plots. 
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24. Draw a region on the CD4 positive events in the 1P plot and notice where they are in the 
t-SNE and Cen-se'. 
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25. Draw region on the CD8 positive events. This should account for most of the remaining 
portion of the CD3 events in t-SNE and Cen-se' plots. 
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So we can see event coloring and gating in t-SNE and Cen-se' and figure out what the 
different populations relate to. Since these plots can change shape and location from file to 
file, this is always a good way to get started. It provides a backbone of information to help 
relate the plots to what we know about our data. 

  

Using Cen-se' and t-SNE to understand other plots 

The most exciting part of t-SNE and Cen-se' is that they reveal populations detected in multi-
dimensional space. What can we learn if we draw a region around one of those 
populations? Let's find out.   

  

26. On the Insert tab of the ribbon, click the Multiple button to display the Create 
Histograms dialog. Add 2P histograms for these markers: 

164Dy_CD20 vs 142Nd_CD19 

162Dy_CD45RA vs 175Lu_HLADR 

154Sm_CD14 vs 166Er_CD33 

149Sm_CD16 vs 174Yb_CD56 
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27. Click OK to create the histograms. Arrange the histograms to your liking. 

  

We'll use the Cen-se' plot to explore the additional populations. 

  

28. Draw a region on the Cen-se' plot around the population in the left top of the plot. 
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The events that light up are CD20+ CD19+ CD45RA+ and HLADR+. They are probably 
mature B-cells. We can also see where they fall in the t-SNE plot. 

  

29. Move or redraw the region over the population in the top center. 

  

 

  

We see the CD14+ CD33+ HLADR+ events light up, making these likely to be monocytes. 

  

30.  Finally, redraw the region around the remaining large distribution on the plot. 
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These are probably NK cells, as they are CD16+ CD56+ CD45RA+. 

  

If you want to see the region events more dramatically in the other plots, you can 
right-click the region label and choose Highlight events in R4. 

  

We're only displaying a few histograms in this tutorial to make the point, but you can see the 
power of the t-SNE and Cen-se' functions. They are good at finding related events and 
allowing us to see what they have in common by looking at the markers in our sample. As 
you probe the islands of events in Cen-se and t-SNE plots and see where they fall in other 
plots, you'll find some surprises and confirm some things that you already know.   

  

Summary 

WinList includes powerful Cen-se and t-SNE functions that take high-dimensional data and 
flattens it into 2-dimensional space so that it can be visualized in conventional 2P plots. Cen-
se' is computed using the FCEN calculated parameter, and FSNE is WinList's implementation 
of t-SNE.  You can display the measurements created by the functions as 2P plots that work 
just like any other 2P plots.  
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Sticky Regions and Magic Contours 

  

You can probably think of cases where you wanted to have a set of regions sharing common 
vertices so that they fit perfectly together.  It is difficult to create regions that do that, 
especially if you also want to be able to make adjustments.  WinList simplifies this task with 
its ability to create "sticky regions" quickly and easily.  It allows you to stick regions together, 
and just as easily to unstick them.   

  

Similarly, there are times when you want a region to adjust its size and shape based on the 
data beneath it.  For example, as you read a new file into an analysis setup, it would be 
really helpful if the lymphocyte gate would auto-adjust to the new distribution.  The "magic 
contour" region in WinList does exactly this. 

  

This short tutorial will introduce these new region capabilities so that you can add them into 
your own analysis protocols. 

If you are unfamiliar with opening files and creating histograms with WinList, you 
might want to do the WinList Basics tutorial before continuing with this one. 

  

Open the FCS file 

1. Click the Open FCS File button on the ribbon bar. 
  

 
  

2. In the File Open dialog, navigate to the Samples folder located in the folder where WinList 
is installed. Select the BCell_BM_Tube_001.fcs and click Open. 

  

3. In the Create Histograms dialog, add FSC-A vs SSC-A and CD38 vs CD10 histograms 
and click OK. 

  

Create a contour region 

4. Click the title bar of the FSC vs SSC plot to activate it, the click the Contour region tool 
in the histogram toolbar. 
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5. Click and drag to draw a box around the low SSC-A events.  When you release the mouse, 
a contour region will be created from the data within the box you drew. 

  

 

  

If you move the region (by dragging the label), the contour region will recompute on the 
data in the new location.  Sometimes the resulting contour does not change because the 
bounding box contains the same probability distribution.  For example, in the illustration 
above, moving one of the left handles to the left would not change the contour. 
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6. Right-click the region label and choose Edit Properties. The properties that relate to the 
contour region are grouped together.  Edit the Contour Probability to be 0.95 and click 
OK. 

  

 

  

The contour on the histogram will get a little bigger as a result of the edit, encompassing 
95% of the events inside the contour region's bounding box. 

  

Create sticky regions 

4. Click the title bar of the CD38 vs CD10 plot to activate it, the click the Freehand region 
tool in the histogram toolbar. 
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Let's create 3 adjacent regions in this plot using the point and click technique. 

  

5. Click and hold the mouse for a second next to the CD10+ CD38- population, then release 
the mouse button.  Move and click the mouse to define 6 or 7 points to surround the 
population, clicking back on the first point to close region R2.   

  

6. Right click the region label and choose Show Vertices. 

  

 

  

7. Click and hold the mouse for a second next to the CD10- CD38 dim population, then 
release the mouse button.  Move and click the mouse to define points in the region, and 
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make sure to click on top of the vertices at the bottom of R2.  Click on the first point 
of R3 to finish the region.   

  

8. Right click the region label and choose Show Vertices. 

  

 

  

9. Click and hold the mouse for a second next to the CD101 CD38+ population, then release 
the mouse button.  Move and click the mouse to define points in the region, and make sure 
to click on top of the vertices at the top of R3.  Click on the first point of R4 to finish 
the region.   

  

10. Right click the region label and choose Show Vertices. 
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So at this point, we have a set of adjacent regions that are completely independent of one 
another.  If you move a region or common vertex, the other regions will be 
unaffected.  We're about to change that. 

  

Make it "sticky" 

11. Right click the R2 region label and choose Stick to Neighbor Regions. 

  

 

  

A toast message will display indicating that 3 connections were made. 
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12. Repeat this for regions R3 and R4. 

  

Now your regions are dependent on one another.  The common vertices are truly common: 
when you move a common vertex, all regions that share the vertex will be affected.  Try it 
out. 

  

 

  

If you move one of these regions (by the region label), the regions sharing vertices will be 
pulled to stay connected. You can also move individual vertices, and the connected vertices 
will move with them. This is a great tool for making sure that you single-count events and 
maintain adjacency even as you make adjustments to the regions. 

  

Summary 

This tutorial introduced the contour region and sticky regions.  Contour regions are dynamic: 
they recompute the region whenever the data beneath them changes.  They are a perfect 
tool for parts of your analysis where you want to reduce subjectivity in region placement and 
size, because they are computed based on probability. 

  

Sticky regions make it possible to create a set of adjacent regions that maintain adjacency 
even if you move one region, or a vertex of a region. 



Kinetic Analysis with Excel 

112 

Kinetic Analysis with Excel 

  

This tutorial will introduce kinetic analysis of calcium flux experiments using WinList and 
Microsoft Excel. The first section of the tutorial shows how this can be done manually by 
copying results from WinList into a special Excel worksheet designed for kinetics. At the end 
of the tutorial, we will show how the process can be automated with a WinList macro and an 
Excel Visual Basic script. 
  

In order to perform this tutorial, you need WinList and Microsoft Excel installed on your 
computer. You will also need sample files that can be found in WinList's Samples\Kinetics 
folder. 
  
  

Set up Excel 

1. Start Microsoft Excel. 
  

2. From Excel's file menu, choose Open. Navigate to the folder in which WinList is installed, 
and into the Samples\Kinetics folder. Select the file WinListKinetics.xls. 
  

3. Click the Open button. 
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You may need to adjust the macro security settings in Excel to enable macros in this 
worksheet. Talk with your IT specialist to determine if this is appropriate for your 
institution. 

  

This worksheet contains two charts, one showing calcium concentration for all cells, and a 
second showing the calcium response of responder cells. The charts plot data from two sets 
of results pasted from WinList. You will be pasting new results into this worksheet to update 
the charts with your analysis of a sample file. 

  

If Excel displays a security warning, you will need to choose to Enable Content in order for 
the sheet to work properly. 
  
  

Set up WinList 

4. Start WinList, and click Open FCS on the ribbon bar. The Open FCS File dialog is 
displayed. 
  

5. Navigate to the folder in which WinList is installed, and into the Samples\Kinetics folder. 
Select the file calcium sample file.fcs, and click the Open button. 
  

The Create Histograms dialog is displayed. We want to create two copies of Time vs. 
F32-Ratio at a resolution of 1024 channels. 
  

6. Set the Resolution dropdown list to 1024. 
  

7. Select Time in the X Axis list, F32-Ratio in the Y Axis list, and then click Add to List two 
times. You should see two entries in the Added Histograms list. Click OK to close the 
dialog and display the histograms. 
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We need to display all dots, and turn off contours if they are enabled. 
  

8. Right-click the mouse on one of the histograms. 
  

9. From the popup menu, choose Graphics. Select Dots in the tree on the left and make 
sure Dots are enabled. Check the Show all dots option. Select Contours in the tree and 
make sure that the Contours property is disabled. Scroll to the bottom of the property list and 
check Apply to All. Click OK to apply the changes to both histograms. 
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Create regions and results 

Next, we need to create a set of regions on each histogram to provide statistics on the 
kinetics. In the histogram on the left, we will gather statistics about all cells, and in the right 
histogram, we will look at statistics for a subset of cells. We will use the Create Region Array 
option to simplify the process of creating 48 adjacent regions on each histogram. 
  

10. Click the title bar of the histogram on the left to activate it. From the Insert tab on the 
ribbon bar, click Region Array. 
  

We want to create 48 regions on the X-axis, each one being 10 channels wide. 
  

11. In the On X-Axis group, enter 48 for the Number of regions. Enter 0 for Starting at, 
and 480 in the Ending at edit box. Click OK. 
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After a moment or two, a results window containing results for the 48 regions will appear. 
We need to choose the statistics to display. 
  

12. Right-click on the results window and choose Edit from the context menu. Enable the 
following options, and disable all others: 

ID Field1 

ID Field2 

Percent Gated 

MeanX 

MeanY 

Use Geo Mean 

Use Robust SD 

Fields in Columns 

Click OK to close the dialog. 
  

You can set the preferences for the results that you want in a new results window by 
clicking the Save As Preference button in the Edit Results dialog. 
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Next, we will repeat the process for the second histogram. This time, however, we will create 
slightly different regions. 
  

13. Click the title bar of the histogram on the right to activate it. From the Insert tab on the 
ribbon bar, click Region Array. 
  

14. In the On X-Axis group, enter 48 for the Number of regions. Enter 0 for Starting at 
and 480 in the Ending at edit box. In the On Y-Axis group, enter 250 for the Ending at 
edit box. These regions will capture the non-responders. Click OK. 
  

 
  

A second Results window will appear. Once again, we need to choose the statistics to display. 
  

15. Right-click on the new Results window and choose Edit. Enable the following options 
again, and disable all others: 

ID Field1 

ID Field2 

Percent Gated 

MeanX 
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MeanY 

Use Geo Mean 

Use Robust SD 

Fields in Columns 

Click OK to close the dialog. 
  
  

 
  

WinList is all set and ready to go. If you want to keep this setup as a protocol, use the Save 
Protocol option on the Home tab of the ribbon. 
  
  

Copying results into Excel 

We need to update the statistics for the entire file, and then copy the two sets of results into 
the Excel worksheet. 

16. Click the Replay button on the Home tab of the ribbon bar. 
  

17. Right click inside the first Results window. Choose Copy. 
  

The first set of results is now in the clipboard, available to Excel. We need to paste these 
results into the correct cells in the Excel worksheet. 
  

18. Activate Microsoft Excel. Select cell B25 and then Paste the results. 
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Now, we repeat the process for the second set of results. 
  

19. Activate WinList. Right click inside the second Results window. Choose Copy. 
  

The second set of results is now in the clipboard, ready to paste into Excel. 
  

20. Activate Microsoft Excel. Select cell G25 and Paste the results. 

 

 
  

The Excel worksheet now displays two charts of the results you have just pasted into it. The 
chart on the left shows the Calcium concentration for all cells, and the chart on the right is 
for the "responder" cells. Notice that there is also a column of numbers that displays the 
percentage of responders for each time slice. 
  
  

Automating the process 

Since WinList and Excel both have automation capabilities, you can streamline the process of 
getting results into Excel. The best way to do this is with a Remote connection between each 
Result window and the Excel worksheet. 
  

21. Activate WinList, right-click the first Results window, and choose Edit. 
  

22. In the Edit Results dialog, enable the Remote checkbox and then click Edit Remote. 
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23. The Edit Remote Link dialog is displayed.  Select "Excel" in the Link To list, and then 
type "ca worksheet" for the Topic. 
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24. Next, select the first command in the Commands list, edit "SHEET1" to "ca worksheet", 
and then click the Replace button. 
  

25. Select the second command in the Commands list, edit the text to 
"POKE(R25C2:R76C5,TEXT)", and then click the Replace button.  This tells Excel where to 
put the results data that WinList will send to it. 
  

26. Select the last command and click the Delete button.  
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Click OK to close the dialog. 

  

We have edited the script so that any time our data changes, WinList will send the new 
results to the correct location on the Excel spreadsheet.  Let's make a similar connection for 
the second Results window. 
  

27. Right-click the second Results window and choose Edit.  Enable the Remote checkbox, 
and click Edit Remote. 
  

28. Edit the Topic to "ca worksheet" and revise the script commands as shown.  Note the 
text of the POKE command is different than the previous script: 
"POKE(R25C7:R76C10,TEXT)". 

  

 

  

29. Click OK to close the dialog, and click OK again to close the Edit Results dialog.   
  

You now have a fully automated connection between Excel and WinList for both of the Result 
windows.  Any time you load a new file or change a gate, WinList will send the new Results 
to Excel using the scripts we just created.  If you save your protocol, the remote scripts will 
be stored and connections will be made automatically when the protocol is re-opened. 
  
  

Summary and discussion 
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This tutorial introduced kinetic analysis using WinList and Microsoft Excel. We constructed a 
protocol in WinList that extracted statistics from 48 time slice regions in each of two 
histograms. We opened an Excel spreadsheet that is supplied with WinList, and then pasted 
two sets of results into the worksheet. 

We streamlined the process of copying and pasting results by creating Remote connections 
between the Result windows and Excel. 

  



Enhanced Proliferation Analysis 

124 

Enhanced Proliferation Analysis 

  

Features in ModFit LT and WinList provide unparalleled capabilities to analyze cell 
proliferation. 

ModFit LT performs sophisticated least squares analysis in just a few clicks of a mouse and 
reveals the secrets of the proliferation data: proliferation index, non-proliferative fraction, 
and precursor frequency, and fractions for each proliferating generation. The proliferation 
results can be exported so that other applications can extend the analysis. 

Enter WinList. NStat regions can import the proliferation results from ModFit LT, and then 
partition the generations according to the proliferation analysis. This enhancement sets the 
stage for exciting new analysis capabilities. 

This tutorial will explore these new features to examine a CFSE-stained sample containing 
several other markers. 
  
  

The big picture 

From the Proliferation Wizard in ModFit LT... 
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... into WinList for exciting, new explorations of proliferation. 
  

 
  
  

Getting started 

To start, we will use the Proliferation Wizard in ModFit LT and export its results. Then, you 
will set up WinList to import those results into an NStat region. 
  

You will need both ModFit LT and WinList for this tutorial. ModFit LT must be at least 
version 3.2.1. 

  

1. Launch WinList and pass through the opening dialogs. 
  

2. Launch ModFit LT and pass through the opening dialogs. 
  

3. Using ModFit LT's Open FCS command, navigate to the Samples folder located in the 
WinList application folder. Select "CFSE sample.fcs" and click Open.  Note, the dialog may 
look different than the one shown below, depending on the version of ModFit LT you are 
using.  If you have ModFit set up to show histogram channels, the X-axis will not match what 
is shown below, but the connection with WinList will still work fine. 
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4. Choose "FL1-H-CFSE" as the analysis parameter. Next, right-click on the histogram and 
choose Edit X Parameter. Choose Log for the Transform and click OK. 

  



WinList User Guide 

127 

 

  

5. Click OK to close the Analysis Setup dialog. 
  

6. On ModFit's home tab choose Cell Track Wizard. 
  

7. In the Cell Tracking Wizard dialog, click the Generations tab and choose the "Floating" 
model option from the drop-down list. Click the Other tab, and enable Export partition 
table and Prompt for file name checkboxes. These options will cause the program to 
create the export file after analysis and allow you to enter a name for the export file. Finally, 
click the Analyze button to perform the analysis. 
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8. When the analysis is complete, the Choose Location to Save Partitions dialog is displayed. 
You can save the file to any location. For this tutorial, save the export file to the desktop so 
that it's easy to find in later steps. 
  

When you choose the Export option for the Cell Tracking Wizard, the program 
determines the boundaries between adjacent generations and writes that information 
to the export file. The boundaries are the points of intersection between the Gaussian 
components in the model. 
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Setting up WinList 

9. Activate WinList and click the Open FCS button on the ribbon bar. 
  

10. Navigate to the Samples folder located in the WinList application folder. Select the "CFSE 
sample.fcs" file and click Open. 
  

11. In the Create Histograms dialog, select CFSE in the X Axis list and CD69 PE in the Y 
Axis list. Click Add to List two times. This will create two copies of CFSE vs. CD69 PE. Click 
OK to close the dialog. 
  

 
  

You can change the graphical display for the histograms you've just created. Right 
click on the histogram and choose Graphics. Try out the different display options to 
see what you like best.. 
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For this analysis we need to use a standard Log transform for the X and Y axis because the 
exported information from ModFit LT is in Log units. 
  

12. Move the mouse over the CFSE label on the X-axis and click the small triangle that 
appears.  Select Log from the list of transformations.  Repeat this for the CD69 Y-axis. 

  

 
  

13. Click on the title bar of the first dot plot to activate it. Click the  NStat region tool in the 
histogram toolbar. 
  

14. In the NStat Properties dialog, click the Import button. 
  

 
  

15. Navigate to the Desktop folder and select CellTrackingWizardPartitions.txt and click 
Open. 
  

16. Edit the NStat rows to 1 and check the Show Vertices, Results, and Enable gates 
checkboxes. The number of columns should already be 10 from the Import.  Click OK. 
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WinList creates the NStat partitions using the imported Cell Tracking information and displays 
a results window with statistics. 
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Isolating the generations 

At this point, you have completed the basic import process. Let's extend the WinList analysis 
to explore other markers as a function of the proliferation analysis. 
  

17. Click the title bar of the second histogram, and click the NStat region tool button to 
create another NStat. For this one, set NStat rows to 2 and NStat columns to 1.  Check the 
Enable gates option and uncheck other options. Click OK. 

  

 
  

Now, one of the histograms contains an NStat that shows the proliferation partitions, and the 
other histogram has an NStat that will allow us to define the CD69 negatives and positives. 
  

18. Drag the region by the label to adjust the second NStat so that it approximately divides 
the two major populations in the second histogram, as shown. 

  

You can change the graphics for any histogram by choosing Graphics from the 
right-click context menu for a histogram. Try using Color Density with Rainbow colors 
for this one. 
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To analyze and visualize the generations better, we will create a calculated parameter using 
the FCOM function. This function creates a new parameter that will allow us to look at each 
population independently. It uses gates as input, and we'll use the gates from the NStat 
regions we just created. 
  

Let's create a few FCOM calculated parameters to help isolate the generations. 

19. Click the Add Parameter button on the main ribbon bar.  Alternatively, you can right-
click in the data source and choose Add Parameter from the context menu. 
  

 
  

20. Click the Add button in the Edit Calculated Parameters dialog. 

  

21. Type Proliferation in the Name edit box.  Type or copy this expression into the 
Equation edit box, and then click OK. 

FLOG(FCOM(G1,G2,G3,G4,G5,G6,G7,G8,G9,G10)+0.5)*256/FLOG(1024)+FRN
D(3) 

  

This expression deserves some explanation. Let's break it apart, starting with the FCOM 
portion. FCOM is a "gate combination" function. It takes any number of gates as arguments; 
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the result of the equation depends on how many gates are in the expression. With a single 
gate, there are 2 possible event classifications: an event is "in" or "not in" the gate. With two 
gates, there are 4 possible event classifications. With the ten gates in our expression, FCOM 
can produce 1024 different event states. 

However, since these gates do not overlap at all, most of the 1024 possible states have no 
events in them. In fact, the only states that contain events are the 10 single-positive event 
states, resulting in values of 1, 2, 4, 8, 16, 32, 64, 128, 256, and 512. If we plotted the result 
of the FCOM function as a histogram, we would see 10 spikes of events, and the spikes 
would be exponentially spaced. 

Our goal is to see these 10 spikes evenly spaced across the histogram. This is where the 
FLOG function comes in. By taking the log of the FCOM output and scaling it by 1024, we 
redistribute the 10 FCOM values evenly across 256 channels. The final portion of the 
expression, "+FRND(3)", changes the spikes of events into Gaussian distributions so that 
they can be better visualized. 
  

Take a look at the reference section on Add Parameters and FCOM for details on the 
complete set of WinList functions. 

  

22. Once again, click the Add button in the Edit Calculated Parameters dialog. 

  

23. Type CD69 Expression in the Name edit box.  Type or copy this expression, and click 
OK. 

(FCOM(G11)+0.5)*256/2+FRND(3) 

  

 
  

24. Click OK. 
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CD69 expression as a function of proliferation 

We're now ready to explore this data file in really interesting ways. Wouldn't it be nice to see 
CD69 as it relates to proliferation, viewing each generation as a discrete cluster? Could we 
quantify the CD69 expression of CD69-positive cells for each generation? Yes and yes. 
  

25. From the Insert tab on the ribbon bar, click the Density plot. This creates a Density 
plot in a default location on the data source.  Click the X Axis label and choose Proliferation. 
Click the Y Axis label and choose CD69 PE. 
  

Let's create another histogram to isolate the CD69 positives and negatives. 
  

26. Right-click on the histogram that we just created and choose Clone from the context 
menu.  A duplicate copy of the histogram is created. 

  

27. Change the Y Axis to show CD69 Expression. 

  

 

  

In the graphics we can see the generations separated into discrete populations along the X-
axis. That's the first FCOM function we created. The Parent generation has the highest 
intensity.   

  

The Y-axis shows the continuous CD69 parameter in the histogram on the left. We can see 
that the parent generation had the greatest expression of CD69, with diminishing expression 
for each subsequent daughter generation.  In the second plot. the CD69 positives and 
negatives are distinctly separated using the CD69 Expression FCOM parameter that we 
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created. This makes it very easy to get statistics on the "CD69-activated" cells for each 
generation by simply creating regions on the subsets. 

  

You can, of course, explore how other parameters relate to cell proliferation. Simply create 
additional histogram to display the parameter combinations you are interested in. 
  

 
  
  

Making life easier 

You have done the real work in setting things up with this tutorial. If you save this setup as a 
WinList protocol or protocol bundle, the calculated FCOM parameters, NStat regions, and 
selected histogram can be recalled very easily from disk. 

When you analyze new data files with ModFit LT's Proliferation Wizard, you can export new 
partition files. Then, open the same data file into your WinList protocol and import the 
partitions into the NStat region as we have demonstrated in this tutorial. All of the calculated 
parameters will update based on the new data and partitions. 
  
  

See also: 

How to use FCOM parameter to enumerate phenotypes 

FCOM Background and Usage 

Edit Properties for NStat Region 
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Remote connection to ModFit LT 

  

This feature is only available on PC platforms. ModFit version 3.2.1 or greater is required. 
  

In this tutorial we will connect WinList to ModFit LT for enhanced DNA analysis. You will see 
how easily ModFit LT can be integrated into WinList. You will be using file cho445.fcs from 
the WinList sample files. 
  

Before beginning, ModFit LT 3.2.1 or greater must be installed on your computer. 

  
  

Set up 

1. Start ModFit LT and pass through its opening dialogs. Minimize the program to clean up 
the desktop. 
  

2. Start WinList. 
  

3. Click the Open FCS button on the ribbon bar and navigate to the Samples folder located 
in the folder where WinList is installed. Select cho445.fcs from the list and click Open. 
  

You can also drag and drop files from Windows Explorer or My Computer onto 
WinList. See Drag and Drop for details. 

  

2. In the Create Histograms dialog, select FL2 vs FL1 and click Add to List. 
  

3. Click the 1P Histograms tab. Select FL2 in the list, and click Add to List. 
  

4. Click OK to open the data source and create the histograms. You should have two 
histograms displayed. 
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Making the remote connection 

Next, let's link the 1P FL2 histogram to ModFit. Here's how. 
  
5. Double-click the title bar of the FL2 histogram. The Edit Histogram dialog box will 
appear. 
  
6. Enable the Remote check box, and then click the Remote button. 
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The Edit Remote Link dialog box will appear. WinList assumes that you want to link to 
ModFit LT, and we do not need to make any changes to this dialog for this example. 
  

 
  
7. Click OK in the Edit Remote Link dialog box. WinList will make connection with ModFit 
LT and return us to the Edit Histogram dialog box. 
  

If WinList cannot find ModFit LT, you receive an error message at this point. Make 
sure that ModFit LT is running, and repeat the last two steps. Remember that you 
need ModFit 3.2.1 or newer. 

  

8. Click OK in the Edit Histogram dialog box. 
  

Here's what happens. WinList begins to execute each command in the remote script for the 
histogram. That script tells WinList to send histogram data to ModFit LT and tells ModFit LT 
to Auto-Analyze the data. Next, the script tells WinList to copy ModFit's graphical and textual 
results and display them in the histogram window. WinList will update the analysis anytime it 
detects that the data for this histogram has changed. You could apply a gate to the DNA 
histogram, and any time a gate region is adjusted, the remote script would fire off, updating 
the ModFit analysis. You can modify a remote script using the Edit Remote Link dialog box. 
  

9. To view the ModFit LT analysis, click the "I" button in the lower left corner of FL2 
histogram. A window will appear, displaying the contents of the analysis results. 
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Modifying the update frequency 

Depending on how WinList is set up, the analysis we just performed might not have sent all 
of the events for the FL2 histogram to ModFit LT. WinList only sends the number of events in 
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one of WinList's packets. Packet size is defined in Edit Program Controls, and determines the 
number of events WinList will keep in memory for quick analysis and gating. 
  

Let's suppose that you want ModFit LT to see all of the events for FL2. The way to do this is 
to change the update frequency for the remote link. Here's how. 
  

10. Double click the title bar of the FL2 histogram to show the Edit Histogram dialog. Click 
the Remote push button to display the Edit Remote Link dialog box. 
  

11. Notice the Update group box, which contains several radio buttons. Click On replay. 
This tells WinList that the only time this link will update is when this file is replayed from disk. 
This ensures that all the data will be shipped to ModFit. 
  

12. Click OK in the Edit Remote Link dialog box to accept the change, and click OK in the 
Edit Histogram dialog box. 
  

13. Click the Replay button on the ribbon bar. 

WinList will update the remote link with data that represents the entire listmode file. This 
technique has two distinct advantages: it allows ModFit LT to work with the full data set and 
it updates less frequently. 
  
  

Summary 

In this tutorial, we demonstrated how to use WinList's remote link capabilities to connect with 
ModFit LT. ModFit LT performed an Auto-Analysis of the data WinList sent to it, and WinList 
displayed ModFit's results. 
  

To establish remote links, select Edit Histogram, and check the Remote check box. Then, 
click the Remote push button. The update frequency of the link, as well as the commands 
which are executed, can be edited in the Edit Remote Link dialog box. 
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Using MultiGraphs 

  

MultiGraph windows can contain graphic and text elements from histogram and results 
windows, and allow you to display and print the collection in various views. They have a 
more restricted format than reports and do not update elements when data changes. 
However, they are a useful tool for creating summary information about experiments in a 
graphical record. In this tutorial, you will review how to open a listmode data file, create 
histograms, and learn how to select histograms and results for inclusion in a MultiGraph 
window. 
  

Before you begin, make sure you understand the basics of working with WinList. The 
tutorial WinList Basics is a great place to start. 

  
  

Setting up 

1. Click the Open FCS button on the ribbon bar. Navigate to the Samples folder, select 
1091901.fcs in the list, and then click Open. 
  
2. Use the Create Histograms dialog to create several 1P and 2P histograms. Click OK. 
  
3. Click the Q button in the lower left corner of each of the 2P histograms. This will create a 
QuadStat region, and automatically display a results window for it. Adjust the QuadStats. 
  
  

Creating the MultiGraph 

At this point, we have created what we want to store in the MultiGraph. Next, we will create 
the MultiGraph and add this information to it. 
  
4. Click the MultiGraph button on the ribbon bar. The Edit MultiGraph dialog box will 
appear. The dialog box displays all of the items that you can add into the MultiGraph in the 
Available Items list. As we add items, they will appear in the MultiGraph Items list. 
  
5. In the Available Items list box, select all entries, except for BLANK. Click the Add 
button. 
  

"BLANK" is always the first entry in the Available Items list box. It allows you to 
put a placeholder, of sorts, into the MultiGraph. It is useful when attempting to keep 
elements in proper columns and rows. 
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6. In the Viewing Options section, click Tiled, and enter 3 and 4 in the Columns and 
Rows edit boxes, respectively. This means that we will display the elements in a 3 x 4 array. 
If we were to add more than 12 elements, additional pages would be created automatically. 
  

 
  

7. Click OK to close the dialog box and create the MultiGraph. 
  

The MultiGraph will show the histograms and results that we added. Elements in the 
MultiGraph will not change, even if the histograms from which they were generated do. This 
means that you can use the MultiGraph to archive graphical and statistical information. You 
can also add elements from numerous data files to a single MultiGraph. 

  

Note, the item label that is shown on each element of the MultiGraph is set by a 
setting in MultiGraph Preferences.  By default it is set to the $SAMPLE keyword, 
which the FCS file we have opened does not contain, so the label shows 
$SAMPLE in this case.  Set the preference to a keyword that provides useful 
information for your FCS files. 

  
  

Changing the arrangement 
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You can move elements around on a MultiGraph page by using the mouse. 
  

8. Click and hold the mouse on one of the elements in the MultiGraph. Move the mouse to a 
new location in the MultiGraph, and release the button. The element will move to the new 
position, and other elements will adjust to accommodate the change. 
  

 
  
  

Summary 

In this tutorial, we introduced the MultiGraph, a type of window that can contain graphics 
and text from histogram and result windows. MultiGraphs can collect elements from 
numerous data files, display them in one window, and print them.  The can also be exported 
to PDF format. 
  

The Edit MultiGraph dialog box allows selection of new elements, editing of labels, and a 
choice of viewing options. MultiGraphs can also be saved to disk and opened from disk in this 
dialog box. 
  

As with other types of windows in WinList, double-clicking on the title bar of the MultiGraph 
window is a shortcut to the Edit MultiGraph dialog box. There are also shortcuts for adding 
histograms and results windows to MultiGraphs. 
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MultiGraphs have a popup menu that allows you to perform common MultiGraph tasks 
quickly. In addition, tiled MultiGraphs allow you to move elements by a click-hold-and-drag 
technique. 
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Reference 

Main Window 

  

WinList offers two interfaces for the main window.  The Ribbon Bar provides easy access to 
the most common commands without having to drill down in menus.  The Toolbar with Menu 
interface is a good option for users familiar with legacy versions of WinList. 

  

The User Interface property in Miscellaneous Preferences controls which interface the 
program will use.  It can also be changed on the View tab of the ribbon or the View menu of 
the Toolbar.  The program must be restarted when changing from one to the other. 

  

Main window with Ribbon Bar 
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Main window with Toolbar and Menu 

 
  

See Also: 

Ribbon Bar 
Toolbar 
Status Bar 
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Ribbon Bar 

  

The Ribbon Bar provides easy access to the most common commands without having to drill 
down in menus.  It is divided up into tabs that group commands based on function. 

  

File (Application) Menu 

This menu is accessed by clicking the WinList icon at the left side of the ribbon bar.  It 
contains commands to open and save protocols, to open report and MultiGraph files, to 
export files, and to print. 

  

 

  

Command Description 

New Protocol Creates a new protocol, closing all open windows. 

Open Protocol Opens a protocol file. 

Open Bundle Opens a protocol bundle file. 

Save Protocol Saves a protocol. 

Save Protocol As... Saves a protocol with a new name. 
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Save Bundle Saves a protocol bundle file. 

    

Open Report Opens a report file. 

Open MultiGraph Opens a MultiGraph file. 

    

Export Listmode 

Saves a new listmode file in FCS or Text format based on the 
active data source. 

Export Merge Files Merge FCS files into one output FCS file. 

Export Histogram 

Saves a new histogram file in FCS format based on the active 
histogram. 

Export Histogram Graphic Saves the active histogram as a graphic file format. 

Save MultiGraph Graphic Saves the active MultiGraph as a graphic file format. 

Export Report Graphic Saves the active Report as a graphic file format. 

Export MultiGraph PDF Saves the active MultiGraph in PDF format. 

Export Report PDF Saves the active report in PDF format. 

Export Results Saves the active results window in text format. 

    

Print Screen Prints the screen. 

Print Report Prints the active report. 

Print MultiGraph Prints the active MultiGraph. 

Print Overlay Prints the active overlay. 

Print Histogram Prints the active histogram. 

Print Data Source Prints the active data source window. 

Print Setup Displays the Printer Setup dialog. 

    

Preferences  Displays the Preferences dialog. 

    

Recent Files 
Displays a list of recently opened protocols. Click an entry to 
open. 
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Home Tab 

 

  

Clipboard 
panel 

Protocol 
panel 

FCS Data Insert Gate Arrange 

Paste Open Open FCS 2P Regions Scale to Fit 

Copy Open Bundle Next 1P Gates Tile 

Copy Special New Replay 3P Color Mode   

  Save Batch Report Inverse Palette   

  Save As Comp MultiGraph Gate Statistics   

  Save Bundle As   Overlay     

      Results     

      Parameter     

  

  

Insert Tab 

 

  

Plots Objects Data Source 

1P Report Duplicate Data Source 

Index Analysis MultiGraph Add Parameter 

Multiple Overlay   

Dots Results   

Density Region Array   

Contours     

  

  
  

file:///C:/VshHelpProjects/WinList/HTMLHelp/html/Add%20Parameter
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Edit Tab 

 

  

Information Gating Databases   

Undo Regions Setup   

Logging Gates Add Record   

Program Controls Palette Database Wizard   

User Keywords   Auto-open   

User Equations       

Alerts       

  

  

View Tab 

 

  

Tools Arrange Navigate   

Status Bar Scale to Fit Next DS   

Histogram Titles Tile Previous DS   

Gate Statistics Vertical     

Inverse Palette Horizontal     

Spots Close All     

Switch to Toolbar Show All     

  Hide All     
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Options Tab 

 

  

Settings Replay and Update Utility Actions   

Preferences  Replay Add to Report   

Palette Enrich Add to MultiGraph   

Wildcards and Paths Auto-update     

  Update Now     

  Update Remote Links     

        

  

  

Macro Tab 

 

  

Macro Toolbox Macro File Record and Run   

Show Toolbox Open Run   

Edit Toolbox Save Record   

  Edit Pause   

  Clear     

  Batch     

  Change paths     
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Help Tab 

 

  

Online Learn   

Check for Updates User Guide   

Visit the web site About WinList   

  

  

Quick Access Toolbar 

 

  

The Quick Access Toolbar appears at the top left of the main window.  Customize the 
commands that appear in this tool to include those that you need constant access to. 

To customize the commands, click the down-arrow button on the right side of the toolbar. 
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Toolbar 

  

The toolbar is displayed across the top of the application window, below the menu bar. The 
toolbar provides quick mouse access to common WinList functions. 

To hide or display the Toolbar, choose Toolbar from the View menu. 
  

The buttons appearing in the WinList Toolbar are shown below along with an explanation of 
the functions they perform. 

 
  

Button Function 

 
  

Opens a protocol. This is 
equivalent to choosing Open 
Protocol from the File menu. 

 
  

Saves a protocol. This is 
equivalent to choosing Save 
Protocol from the File menu. 

 
  

Opens a listmode file. This is 
equivalent to choosing Open FCS 
File from the File menu. 

 
  

Opens the next file. This is 
equivalent to choosing Next FCS 
File from the File menu. 

To open the next file without 
displaying the File Open dialog, 
hold down the Shift key while 
clicking the button. 
  

 
  

Replays the active data source. 
This is equivalent to choosing 
Replay Active Data Source from 
the Replay menu. 

To replay all data sources, hold 
down the Shift key while clicking 
the button. 
  

 
  

Enrich the sampled data based on 
a selected gate. 

 
  

Displays the Edit Gates dialog. 
This is equivalent to choosing 
Gate List from the Options menu. 
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Displays the region list dialog. This 
is equivalent to choosing Region 
List from the Options menu. 

 
  

Displays the N-Color 
CompensationTM Toolbox. This is 
equivalent to choosing 
Compensation from the Options 
menu. 
  

 

Creates a new MultiGraph 
window. This is equivalent to 
choosing Create MultiGraph from 
the Create menu. 
  

 

Creates a new Report window. 
This is equivalent to choosing New 
Report from the Report menu. 
  

 

Displays the on-line help system. 
This is equivalent to choosing 
Index from the Help menu. 

 

Selects the coloring mode used by 
WinList. 

 

Edits the current coloring mode. 
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Status Bar 

  

The status bar is displayed across the bottom of the main window. It displays prompts on the 
leftmost pane, and information about WinList objects in other panes. 

  

 

  

Pane Meaning 

Left-most Information about the current menu selection or operation. 

1 Name of the current protocol 

2 File name and ID for the active data source 

3 File index and size of the batch, if batch processing 

4 Number of events in the current file for the active data source 

5 Name and ID of the active histogram 

6 Name of the active results window 
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Open Protocol 

  

 
  
This command is found on the Home tab of the ribbon bar, or in the File menu when using 
the toolbar and menu display.  It is used to open protocol files you have saved to set up an 
analysis in WinList. Protocols are created using the Save Protocol option. 
  
You can also open Protocol Bundle files with this dialog by changing the filter drop-down to 
show Protocol Bundles. 
  
The Open Protocol command displays the file open dialog box, allowing you to select a 
protocol (wlx or mac file) or a protocol bundle (wlb file). Select a protocol from the list and 
then click the Open button. Alternately, you can double-click the file in the list. The protocol 
will set up the screen, gates, regions and other components of the display. 
  

 
  
Drag and Drop 
You can drag and drop a protocol file from the file system onto WinList to open a protocol. 
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Open Bundle 

  

 
  

This command is found on the Home tab of the ribbon bar, or in the File menu when using 
the toolbar and menu display.  It displays the Open Protocol dialog with the file type 
selection set for protocol bundle files. See Save Bundle for a description of the protocol 
bundle file. 
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Save Protocol 

  

 
  

This command is found on the Home tab of the ribbon bar, or in the File menu when using 
the toolbar and menu display.  It is saves the current WinList analysis setup so that it can be 
reopened at a later time. 

  

If the protocol has already been saved, this command updates the file on disk with the new 
setup. If the protocol has not yet been saved, it displays the Save Protocol As... dialog.   

  

The function of this button is also controlled by several preferences.  See Miscellaneous 
Preferences for additional information. 
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Save Protocol As... 

  

 
  

This command is found on the Home tab of the ribbon bar, or in the File menu when using 
the toolbar and menu display.   

  

Sometimes the analysis you perform with WinList is something you use over and over again. 
In cases like this, it would be nice to save an analysis setup so that you can quickly 
reconstruct it and load new data files into it for analysis. This is where WinList protocols are 
used. 
  

There are two kinds of protocols that WinList creates. The first is an XML-formatted protocol 
file that contains a complete description of the analysis you have setup. This kind of protocol 
requires that the FCS data files used in the setup are in the exact locations as they were 
when the protocol was saved. 
  

A second type of protocol is called a protocol bundle. The protocol bundle stores an XML 
protocol file described above in a Zip-compatible file. In addition, the protocol bundle 
includes copies of the FCS files displayed in the protocol. Protocol bundles are convenient 
when you need to move protocols from one computer to another or to create an archive of 
your analysis. See Save Bundle for additional details. 
  

This command displays the Save dialog box. Enter a name for the protocol, navigate to the 
folder where you want to save the protocol, and click the Save button. 
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Several aspects of the WinList setup are not stored in protocols, including histogram 
subtraction and 3D viewer windows. These windows need to be re-created after you open 
your saved protocol. 
  

Drag and Drop 

You can drag and drop a protocol file from the file system onto WinList to open the protocol. 
  

See Also: 

Save Protocol Bundle 

Open Protocol 
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Save Bundle 

  

 
  

This command is found on the Home tab of the ribbon bar, or in the File menu when using 
the toolbar and menu display. 

  

This command creates a single, compressed file in Zip-compatible format that contains all 
information needed to reconstruct your analysis setup. It is similar to the Save Protocol 
command, but has several key differences that make it more powerful for some situations. 
  

The significant differences between Save Protocol and Save Bundle are that Save Bundle 
creates a single file that contains the XML protocol and the FCS listmode files that the 
protocol uses. This makes the protocol bundle a better choice when you need to move a 
protocol from one place to another or to create an archive of your analysis. 
  

To open a protocol bundle file, use the Open Protocol dialog and change the Files of Type 
selection to show Protocol Bundles. 
  

Drag and Drop 

You can drag and drop a protocol bundle file from the file system onto WinList to open a 
protocol. 
  

See Also: 

Save Protocol 

Open Protocol 
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Data Source Windows 

  

WinList creates a data source window for each open listmode file. These windows are 
moveable and sizable within the confines of WinList's main window. Data source windows are 
automatically closed when WinList closes. They can contain any number of histograms and 
multiple pages of histograms. 

  

To create a new data source window, click the Open FCS button on the ribbon or toolbar. 

  

To read a new data file into an existing data source window, click the Next FCS button on the 
ribbon or toolbar. 
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A toolbar is positioned on the right edge of the data source window to provide quick access 
to many common commands. For details, see Data Source Toolbar. 
  

A data source window can be dragged and dropped onto a Report window to add all of its 
histograms to the report. The drag-and-drop hotspot is the upper-left portion of the title bar. 
  

To edit a data source window, select Edit Data Source from the Edit menu. Alternately, 
you can double-click its title bar or click the Edit button on the data source toolbar. 
  

Right-click a data source window to display its context menu. 
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Data Source Toolbar 

  

This toolbar appears inside the right edge of the active data source window. Each icon 
represents a tool, described below. 
  

 
  

Many of these commands are explained elsewhere, but a few are only available through the 
toolbar. These are explained in more detail below. 
  

Compensation Page 

This button creates a special page in the data source for compensation. The compensation 
page shows histograms for one measurement at a time and is used when setting up N-Color 
compensation. 

When you click the Compensation Page button on the toolbar, you can choose a gate to 
apply to the histograms on the compensation page.  
  

Page menu 

The page menu allows you to add, rename, and delete pages in the data source. Use pages 
to group histograms when there are too many to display at once.  

The page menu also allows you to select a page to view. This can also be done by clicking on 
the title bar of the data source and using the PgUp and PgDn keys on the keyboard. 
  

Context menu 
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The context menu for the data source window contains many common commands. It can be 
displayed by clicking the Context menu button on the data source toolbar, or by right-clicking 
inside the data source window. 

For more information, see Data Source Context Menu . 
  

Snap 

This button enables or disables snap-to-grid moving and sizing of histograms within a data 
source. With the option enabled, histogram windows move and size based on the background 
grid displayed on the data source. This makes it easy to create histograms that are the same 
size and to align them neatly. With snapping disabled, histograms can be moved and resized 
without constraint. 
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Data Source Context Menu 

  

 
  

The context menu for the data source window contains many common commands. It can be 
displayed by clicking the Context menu button on the data source toolbar, or by right-clicking 
inside the data source window. 
  

Edit 

This command displays the Edit Data Source dialog. 

  

Keywords 

This command displays a list of all FCS keywords found in the current data file. 

  

Transformations 

This command displays the Edit Transformations dialog. 

  

Add Parameter 
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Displays the Add Parameters dialog to create calculated parameters. 
  

Print 

This command prints the histograms on the current page of the data source. 
  

Add Histograms to Report 

This command adds the histograms on the current page of the data source to the active 
report. The histograms on the report are arranged in the same way they are on the data 
source window. 

  

Show Gate Statistics 

This command displays the Gate Statistics window. 
  

Add Page 

This command adds a new, blank page to the data source. 
  

Rename Page 

This command renames a page. 
  

Delete Page 

This command deletes a page and the histograms it contains. 
  

Next Page 

This command displays the next page in the data source. 
  

Previous Page 

This command displays the previous page in the data source. 
  

Move Histograms to Page 
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This command moves the histograms on the current page to another page in the data 
source. 

  

Copy Histograms to Page 

This command copies the histograms on the current page to another page in the data 
source. 
  

Copy Histograms with region 

This command copies the histograms as well as the regions they contain to another page in 
the data source. 
  

Delete Histograms 

This command deletes the histograms on the current page. 
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Open FCS File 

  

 

  

This command is found on the Home tab of the ribbon bar, or in the File menu when using 
the toolbar and menu display. 

  

Use this option to select an FCS listmode or delimited text file you want to open into WinList 
for display and analysis. When selected, the Open dialog box appears, allowing you to 
navigate to the correct folder to select files. 
  

The dialog allows you to select one or more files from a folder. If you select more than one 
file, the program automatically creates a"batch" containing the selected files. When the Open 
button is clicked, the first file will be read. To process the additional files, use the Next Batch 
File and Previous Batch File commands, or edit the batch with the Open Batch command. 
  

If the listmode file contains more than one dataset, the Choose Dataset dialog is displayed to 
select the dataset of interest. When there is only one dataset in the file, the Choose Dataset 
dialog does not appear. 

  

If the selected file is a text file (comma- or tab-delimited), WinList will attempt to translate 
the file into an FCS file.  For information about supported formats, see Reading Delimited 
Text Files, 
  

After selecting a file to open, the Create Multiple Histograms dialog box is displayed to 
provide a quick and efficient means for selecting any number and types of histograms for 
display. This dialog can simply be canceled if you prefer to create histograms one at a time. 
  

You can select Open FCS File more than once to display more than one file at a time, or 
multiple copies of the same file. WinList is designed to handle any number of data sources. 
Your computer's memory, disk resources, and the demands of other applications that may be 
running limit the actual number you can display. 
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Open Dialog Box 

  

This dialog box is common to most file opening operations in WinList. The tree on the left 
allows you to select the folder where files of interest are located. A list on the right displays 
files for the selected folder. A drop down list below the file list displays the types of files (file 
filters) that you see in the list. Buttons on the bottom allow you to open the file, view 
keywords stored in the file, or cancel the operation. 
  

When opening listmode data files, this dialog allows you to select more than one file at a 
time. If you select more than one file, a batch is automatically created for you, and a 
convenient toolbar appears at the bottom of the main window to allow easy navigation 
through the batch. See Batch toolbar for details. 
  

 
  
  

Drag and Drop 

You can drag and drop listmode files from the file system onto an existing data source 
window to add files to a batch. 
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Choose Dataset 

  

This dialog appears when WinList detects more than one dataset in an FCS listmode file. It 
allows the user to select which dataset to read. The dialog displays a list of all datasets in the 
listmode file, along with the FCS version and two keywords. The keywords displayed are 
user-programmable in the Miscellaneous Preferences dialog. 
  

 
  

To select a dataset, click the radio button next to it in the dialog and click OK. 
  

When you need WinList to display several datasets from the same file at the same time, open 
the file with Open FCS File and select a different dataset each time. 
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Next FCS File 

  

 

  

This command is found on the Home tab of the ribbon bar, or in the File menu when using 
the toolbar and menu display. 

  

This menu option is used to replace the data file for the current data source with another 
data file on disk. 
  

The Open dialog box is displayed so that you can select a new file. To open the new file, 
select it in the list box and click Open. 
  

This dialog allows you to select more than one file at a time. If you select more than one file, 
a batch is automatically created for you, and a convenient toolbar appears at the bottom of 
the main window to allow easy navigation through the batch. See Batch toolbar for details. 
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Previous FCS File 

  

This menu option is used to replace the data file for the current data source with another 
data file on disk. It operates the same way as the Next FCS File, except that it selects the 
previous file from the list. 
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Duplicate Data Source 

  

 

  

This command is found on the Insert tab of the ribbon bar, or in the Edit menu when using 
the toolbar and menu display. 

  

This command creates a copy of the data source window, duplicating the properties of the 
active data source and its histograms, regions, and gates. This provides a convenient means 
of setting up for multiple file analysis and keeping the setup of each data source consistent 
with the one from which it was created. One common use for this is in histogram subtraction, 
where one file contains control data and another file contains test data. 
  

The layout of histograms, regions, and gates are replicated in the new data source window. 
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Edit Data Source 

  

This dialog is displayed by choosing Edit in the data source context menu or by double-
clicking on the Data source title bar. 
  

 
  

Name and ID 

The field displays the name and ID of the file data source. The ID is initially assigned by 
WinList, but it can be edited by the user. Each data source must have a unique ID. 
  

Alias 

Each data source has an alias that is displayed on its titlebar. By default, the alias is [FILE], 
which is a keyword that returns the name of the data file currently opened. You can enter 
another keyword or text in this field. 
  

Events and Parameters 
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This displays the total number of events and the number of parameters stored in the data 
source listmode file. 
  

Parameter listbox 

This list shows the parameter names stored in the data file. 
  

Add Parameters 

This option allows you to add calculated parameters to the data source. See Add New 
Parameter for more. 

When a parameter is added or deleted, the Edit Data Source dialog is automatically closed. 

  

Transformations 

This option is allows you to select how each parameter is displayed in WinList. See Edit 
Transformations for more. 

  

Names and Resolutions 

This button displays parameter names and resolutions for the data file. This also allows the 
user to adjust the log decades, if any, in the event that WinList was not able to automatically 
detect them correctly. See Names and Resolutions for more. 
  

Quantitation 

Selecting this option allows you to convert results values into quantitative units. See 
Quantitation for more. 
  

Dataset 

The option is enabled if the FCS file contains more than one dataset. It allows you to select 
which dataset to read and analyze with WinList.   

When a new dataset is selected, the Edit Data Source dialog is automatically closed. 

  

Protect histograms 
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When this option is enabled, histograms in the data source are protected from being deleted 
by the user. 

  

OK 

Accepts changes to the data source and closes the dialog box. 
  

Cancel 

This option closes the dialog box with no changes to the data source. 
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Add Parameters 

  
This option allows you to create additional "calculated" parameters based on the native 
parameters of your listmode files. Calculated parameters can be displayed and manipulated 
just like native parameters. In addition to parameter ratios, WinList provides mathematical 
functions which can be applied to parameters. 
  
All calculated parameters in WinList are computed in floating-point. They have a user-defined 
resolution, and can be computed using compensated or uncompensated data. 
  

 
  
Display this dialog by clicking the Add Parameter button on the main ribbon bar or 
choosing the Add Parameter from the data source context menu.  There is also a button in 
the Edit Data Source dialog box that shows this dialog. 
  

 
  
  

Add 

Adds a new calculated parameter to the data source. The Edit Calculated Parameter dialog 
will be displayed. 
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Delete 

Deletes the currently selected calculated parameter in the list. 
  

Edit 

Displays the selected calculated parameter in the Edit Calculated Parameter dialog for editing. 
  

Open 

Opens a previously saved set of equations. The files have the default suffix of equ. 
  

Save 

Saves the current set of equations to disk. 
  

OK 

Closes the dialog and accepts the changes.  This causes all calculated parameters to be re-
evaluated and the workspace will be updated. 
  
  

See also: 

Edit Calculated Parameter 
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Edit Calculated Parameter 

  

This dialog is used to create and edit calculated parameters.  It is displayed from the Add 
Parameters dialog. 

  

One of the best ways to get started with a calculated parameter is to review the list of 
examples in the Functions listbox and select one that is similar to what you want to 
create.  With an example selected, it is a simple matter to edit the specifics of the equation 
for your data. 

  

The Measurement Name  field can be any text you want.  This is the name that will be 
displayed for this new calculated parameter on histograms and in parameter lists  Some 
functions (FSNE and FCEN) create two measurements, and a second name field appears for 
those functions. 

  

 

  

  

Equation 
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Type an equation or select one from the example list to set this field. The equation can 
include parentheses for grouping, and supports +, -, *, and / operators. The parameters and 
their names are shown in a separate list box. The parameter and function letters are not case 
sensitive. For example, p1*2.5 is the same as P1*2.5. 
  
When the Equation field contains FCEN or FSNE functions, the Choose... button is 
displayed next to the edit box. This button allows the user to select parameters for the FCEN 
or FSNE function quickly and efficiently. 
  

Choose... 

When the Equation field contains FCEN or FSNE functions, the Choose button is displayed 
next to the edit box. It allows you to select measurements to be used by the functions. 
  

Parameters dialog box 

A separate dialog box will be displayed showing the available measurements. The dialog will 
automatically be put away when you select either Cancel or OK. 
  
Functions 

All functions and examples are shown in this list box. A drop-down list allows you to show 
functions, examples, or both in the function list. Notice that all the functions start with the 
letter F. 

  

FCOM(g1, g2,…gn) Gate combination function. The argument is a list of 
any number of gates separated by commas. See FCOM 
Background for further explanation. 

FTIM(adcResolution) Creates a chronological time variable over the number 
of channels, adcResolution, specified in the 
argument. This parameter allows you to gate out bad 
runs with DNA or to even perform kinetics calculations 
(assuming you are not interested in absolute time). 

FSNE(p1,p2,...,g0,50,2) This function creates "t-SNE" (t-Distributed Stochastic 
Neighbor Embedding) parameters.  The t-SNE function 
does a great job of reducing dimensionality to 2 
dimensions. 

One FSNE equation will create 2 t-SNE parameters in 
the output. 

The first "p" arguments are parameters for the t-SNE 
function.  Next is the "g" argument, which specifies a 
gate.  Perplexity (50) sets the number of effective 
nearest neighbors.  The last argument is 2, specifying 
the number of dimensions to return. 
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See Population Identification with Cen-se' and t-SNE 
for further explanation. 

FCEN(p1,p2,...,g0,200,2) This function creates "Cen-se" (Cauchy Enhanced 
Nearest-neighbor Stochastic Embedding) 
parameters.  The function is a significant enhancement 
of the t-SNE algorithm, producing better resolution of 
clusters with more separation. 

One FCEN equation will create 2 Cen-se parameters in 
the output. 

The first "p" arguments are parameters for the FCEN 
function.  Next is the "g" argument, which specifies a 
gate.  The number of nearest neighbors to consider 
(200) is the next argument.  The last argument is 2, 
specifying the number of dimensions to return. 

See Population Identification with Cen-se' and t-SNE 
for further explanation. 

FLOG(param) Returns the natural log of param. Negative numbers 
and zero are evaluated to 0 since they are illegal 
values for log functions. 

FL10(param) Returns the log to the base 10 of param. Negative 
numbers and zero are evaluated to 0 since they are 
illegal values for log functions. 

FEXP(param) Raises natural log to the param power. 

FE10(param) Raises 10 to the param power. 

FSQR(param) Returns the square of param. 

FCUB(param) Returns the cube of param. 

FPWR(base, power) Returns the value of base to the power. 

FRND(variance) Returns a random number with variance variability. If 
zero is entered as the argument, then it returns a 
uniform random number between 0 and 1. 

FSIN(x) returns the sine of x, where x is in radians. 

FCOS(x) returns the cosine of x, where x is in radians. 

FTAN(x) returns the tangent of x, where x is in radians. 

FCTN(x) returns the cotangent of x, where x is in radians. 

FASN(x) returns the arcsine of x, where x ranges from -1.0 to 
1.0. Values for x outside of this range are forced to the 
nearest limit. 

FACS(x) returns the arccosine of x, where x ranges from -1.0 to 
1.0. Values for x outside of this range are forced to the 
nearest limit. 
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FATN(x) returns the arctangent of x. 

FACN(x) returns the arccotangent of x, equivalent to arctangent 
of 1/x. 

FV2S(param) Returns param to the 2/3's power. Negative numbers 
and zero are evaluated to 0 since they are illegal 
values for log functions. 

FS2V(param) Returns param to the 3/2's power. Negative numbers 
and zero are evaluated to 0 since they are illegal 
values for log functions. 

    

  

Transform 

Sets the transform to be used for displaying the calculated parameter. 
  

Source 

In most cases, the calculated parameter can be computed on compensated or 
uncompensated data.  A few functions (FCOM, FSNE, FTIM) ignore of this setting. 
  

Resolution 

Choose a resolution to use for the new calculated parameter.  The list of resolutions is limited 
to the resolutions of parameters in the data file. 
  

OK 

Accepts the changes to the equation and other settings and closes the dialog. 
  

Cancel 

Cancels the changes to the question.  If the equation is being created, clicking the Cancel 
button will flag the equation to be deleted. 
  

See also: 

FCOM Background and Usage 

Population Identification with Cen-se' and t-SNE 
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FCOM Background and Usage 

  

FCOM is a calculated parameter that can be used to classify events based on combinations of 
selected gates. It is commonly used in phenotypic analysis. You can create FCOM parameters 
using the Add New Parameters dialog box, accessed from the Edit Listmode File Data Source 
dialog box. 
  

To understand how this powerful function works, you must first understand something about 
binary numbers. A binary number is represented with only two digits: 0 and 1. A binary 
number is formatted similarly to a decimal number using powers of 2 instead of powers of 
10. An example of a binary number is 1110. The decimal equivalent to this number is 0 + 2 
+ 4 + 8 = 14 
  

The lowest four digit binary number is 0000 (0 decimal) and the highest four digit binary 
number is 1111 (15 decimal). Thus, a four digit binary number can encode 16 different 
numbers (0,1,...15). The number of encoded different numbers (n) is related to the number 
of binary digits (d) by the function n=2 to the d power. Thus, for this example, d=4 and 
n=16. 
  

What does this all have to do with the FCOM parameter? Plenty! Since an event is either 
inside or outside a gate, its state can be represented by a single digit, 0=outside and 
1=inside. Suppose we have two gates, G1 and G2. We can represent all possible 
combinations of gate states by simply forming a binary number where the first digit 
represents the state of G1 and the second digit represents the state of G2. Thus if we have 
two gates, then the binary number 01 represents an event outside G1 and inside G2. 
Similarly, 11 represents an event inside G1 and inside G2. The FCOM function assigns each 
event a decimal number reflecting the gate combination for that event. Thus, in the case of 2 
gates, G1 and G2, FCOM will return a value of 0, 1, 2, or 3 depending on the particular gate 
combination satisfied. 
  

If we multiply this FCOM number by a scaling value and we display the result as a single 
parameter histogram in WinList, we will see a number of spikes with the FCOM parameter on 
the X-axis. The height of each spike tells us how many events satisfy that particular gate 
state. Typically, we add a small random number to each FCOM number (e.g. FRND(10)), so 
that instead of spikes we see Gaussian distributions which are more familiar to us. 
  

How do you know what combination corresponds to each peak? Easy! You just count in 
reverse binary, which is to say evaluate from left to right.”  Let's do a three gate example 
(e.g. FCOM(G1,G2,G3)). 
  

G1 G2 G3 FCOM 
Derivation 

Calculated FCOM 
value 

0 0 0 0 + 0 + 0 = 0 

1 0 0 1 + 0 + 0 = 1 
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0 1 0 0 + 2 + 0 = 2 

1 1 0 1 + 2 + 0 = 3 

0 0 1 0 + 0 + 4 = 4 

1 0 1 1 + 0 + 4 = 5 

0 1 1 0 + 2 + 4 = 6 

1 1 1 1 + 2 + 4 = 7 

  
OK, that's not so easy after all.  It would be better if the program figured out which 
population was which and labeled them for us.  This is something that the Create Region 
Array command does nicely.  There's an example of that in the tutorial Using FCOM to 
enumerate phenotyptes. 
  

You can create additional FCOM calculated parameters with different gate combinations to 
display two parameter dot plots. With some creativity on your part, you can readily visualize 
and analyze complex phenotypes with relatively little effort. 
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Edit Transformations 

  

This dialog allows you to select linear parameters to convert from linear to log and log-like 
transforms. 
  

 
  

Most flow cytometers store data in linear format, even if you view the data on log-like scale 
during acquisition and analysis. This dialog allows you to convert linear parameters to log-like 
for display and analysis in WinList. 
  

Scaling 

Number of Decades 

This option determines how many log decades WinList will transform the linear data values 
into. 

Choose Computed to allow the program to determine automatically the number of decades. 
With this option selected, the program computes the number of decades by taking the log of 
the ADC resolution of the parameter. For example, if the ADC resolution is 262144, the 
log10(262144) is approximately 5.42 decades. 
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Choose 4-decades to force the program to map the linear data into 4-decades. This option 
allows comparisons with other software that only permits 4-decade displays. In the example 
above, compressing 262144 channels into 4-decades of log space compresses the data by 
1.42 decades. 
  

Measurements 

For each measurement in the file, you can set several properties. Transform settings apply to 
all histograms showing the selected measurement. 
  

Transform 

The transform can be set to Linear, Log, HyperLog, Hyperbolic sine, or VLog. 
  

Low Value 

This is the lowest value shown on the axis. 
  

B-Coefficient 

This value controls the linear portion of a HyperLog axis. The selected value is the number of 
channels on both sides of 0 that will be displayed as linear. The remaining portions of the 
HyperLog axis are display log-like. 
  

Auto-Adjust 

Enable this option if you want WinList to automatically adjust the B-Coefficient and Max 
Negative value for this parameter. Each time a new file is opened, WinList will readjust B and 
Max Negative settings. 
  

Auto-Zoom 

Auto-zoom allows you to eliminate unnecessary channels at the upper end of a parameter's 
dynamic range automatically. It is very useful for parameters like "Time" which only use a 
portion of the range, and for some instruments which store data in the lower portion of the 
range. Auto-zoom is set up independently for each parameter. 

Off: Turns off auto-zoom for the parameter. 

To highest used channel: Choose this option if you want WinList to eliminate empty 
channels on the upper end of the parameter. It is useful, for example, for a TIME parameter 
that typically only uses a small portion of the dynamic range of the parameter. 
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To fixed upper boundary: This option allows you to zoom to a specific channel for the 
upper boundary of the data. Use the associated Zoom Fixed Boundary edit box to set the 
channel for zooming. 

To percentile: This option allows you to zoom in on a specified percentile. If, for example, 
99% of your data is in the lower half of the dynamic range, it may be useful to ignore the 
remaining 1% of the data so that you can better visualize and analyze the 99%. Use the 
associated Zoom Percentile edit box to set the percentile for zooming. 
  

Save preferences 

When this option is enabled, the changes you make to the Transformations dialog are 
remembered. 
  

See also: 

Transformation Preferences 

Understanding Hi-res Data Files 
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Names and Resolutions 

  
This dialog box can be accessed from the Edit Data Source dialog box by clicking the 
Names and Resolutions push button. It allows the user to change the names of 
parameters, as well as set the number of log decades for any parameters. 
  

 
  
Parameter names are used by histograms on the axis labels. 
  
To edit a parameter name, select the parameter in the list box and enter the new name for 
the parameter in the Name edit box. You can enter a keyword in square brackets, e.g. 
[$P4S], to display information derived from the FCS file for the parameter name. 
  
The number of log decades for parameters is displayed for informational purposes.  The 
values can not be edited. 
  
Whenever a name is edited by the user, WinList "locks" the name so that it does not change 
until the user "unlocks" the name, or the number of parameters changes. Locked names are 
designated with an asterisk (*) next to the name in the list box. 
  
To manually lock or unlock a parameter name, select the parameter in the list box and click 
the Lock check box next to the name. If the check box is checked, the name is locked. 
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If you edit parameter names and you do not lock the edited entries, WinList will discard your 
edits the next time it updates the data source by replaying, opening a new file, or saying OK 
to the Edit Data Source dialog box. 
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Quantitation 

  
WinList provides complete support for converting results values from channel-based units to 
units representing a quantitative value. Some of the units commonly used for quantitation 
are Antibody Binding Capacity (ABC), Mean Equivalent Soluble Fluorescein (MESF), and 
Molecules Per Cell. The great advantage to converting results into quantitative values is that 
they become meaningful when compared with data from other instruments and other users. 
Standardization among users and labs becomes a much simpler task. 
  
If you have access to the quantitation calibration information, you can enter it manually into 
this dialog box. 
  
If your data files contain special keywords, WinList can automatically apply calibration 
information to the relevant parameters and convert results into quantitative units. The 
keywords WinList looks for are PnQS, PnQI. The first defines the slope for parameter n; the 
second defines the intercept for parameter n. Some instrument manufacturers, BD 
Biosciences for example, store these keywords when acquiring data if relevant controls have 
been run. 

The program can also automatically turn "TIME" into a quantitative parameter if there is a 
$TIMESTEP keyword in the data file. 
  

 

  

Detect 
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This option is normally checked, which tells WinList to automatically detect quantitation for 
the parameter. In this mode, WinList will look for quantitation keywords in the file and will 
apply the quantitation automatically.  Most parameters are safely left with Detect enabled. 

Uncheck this option if you want to enter you own slope and intercept values, or you do not 
want to detect quantitation keywords automatically. 
  

On 

If this option is checked, the parameter is enabled for quantitation.  The slope and intercept 
values will be used to convert the parameter transformation into quantitative units. 
  
Slope and Intercept 

The slope and intercept provide information on how to convert an ADC channel number to a 
quantitative value. The values are typically provided by the instrument or reagent 
manufacturer to allow you to convert from "channels" into some other quantitative unit. 
  

To compute your own slope and intercept values, you need to perform a linear regression of 
log (molecules per cell) versus channel numbers. WinList includes an Excel spreadsheet in 
the Samples folder that can be used to assist in this. See Using the Quantitation Spreadsheet 
for details. 

  

Slope Type 

The quantitative slope and intercept are typically defined using linear units. The $TIME 
parameter, for example, is a linear parameter, its slope is determined by the $TIMESTEP 
keyword, and the Slope Type should be "Linear". 

However, there are cases where the slope and intercept relate to log-transformed units. For 
example, with older FCS files that were encoded in log, the slopes and intercepts provided by 
manufacturers were typically log-based.  This means that they are applied to the log-
transformed data rather than the linear form of the data. 

Select the appropriate slope type for the quantitation for your files. If the quantitative 
information is supplied by a manufacturer, contact the manufacturer to determine whether 
the slope applies to linear units or log units. 
  

OK 

Click this button to accept the changes you have made and close the dialog. 
  

Cancel 

Click this button to cancel the changes you have made and close the dialog. 
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Using the Quantitation Spreadsheet 

  

WinList includes an Excel spreadsheet that can assist in using its quantitative features. Use 
this sheet to compute slopes and intercepts that will convert the axes in WinList to 
quantitative units, such as MESF. 

Typically, quantitation is set up with beads that have been assigned specific values by the 
bead manufacturer. When the bead sample is run on your instrument, there will typically be 
4 to 6 peaks for the marker being quantified. Those peaks are analyzed in WinList, and 
median values are then entered into the quantitation spreadsheet to compute quantitation 
slopes and intercepts.  Finally, the slope and intercept values are then entered in WinList to 
convert the axes to quantitative units. 

  

Step-by-step instructions: 

1. In WinList, open the data file for the calibration beads. Using a 1P histogram, find the 
median values for each bead peak. An example is shown below using QUANT.FCS in the 
Samples folder. 
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2. In Excel, open the WinlistQuantitationBead.xls spreadsheet found in the Samples 
folder. Select the appropriate sheet for the number of bead peaks in your sample.  In the 
example file, there are 4 beads so we select the 4-Bead sheet. 

  

 

  

3. Enter the ADC range (also called resolution) for the data file that you are analyzing.  In 
the example file, this is 10,000.  The sheet will compute the number of Decades represented 
by this value. 

  

 
  

4. Next, enter the median values for each bead peak from WinList. Then enter the MESF (or 
ABC) values provided by your quantitative bead manufacturer. 

  

 
  
The program will compute the slope and intercept using linear values and again using log 
values.  Typically, the linear slope and intercept are a little more accurate.  WinList can use 
either type. 
  
5. Type a value into the Testing section to see how the value converts to MESF units.  It's 
useful to test the bead linear median values and compare them with the MESF values for 
each peak.  They should be similar results. 
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Now you are ready to enter the slope and intercept values into WinList.   
  

6. Display the Edit Data Source dialog and choose Quantitation.   

  

 
  
7. In the Quantitation dialog, select the measurement that has the quantitation 
information.  Uncheck Detect, check On, copy and paste the linear slope and intercept 
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values from Excel, and select Linear-based for the type.  In the example, the slope of 10.44 
and intercept of -102.09 have been copied from Excel for the example file. 

 
  

8. Click OK. WinList will now display quantitative results and axes for the parameter.  Adjust 
the regions over the bead peaks, and the MedianX values should be close to the MESF values 
entered into the Excel sheet. 
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Compensation Toolbox 

  

 

  

This command is found on the Home tab of the ribbon bar, or in the Options menu when 
using the toolbar and menu display. The Compensation Toolbox allows you to control 
WinList's interactive N-Color Compensation™ and normalization.   
  
WinList's N-Color Compensation™ can handle any number of fluorochromes and compensate 
them for signal crossover. In many cases, compensation can be set up automatically, but you 
can still manually override compensation settings. Compensation can be manually adjusted 
using 2-parameter dot plots. 
  
If you have single-color controls as well as an unstained control file, you can use V-Comp™ 
to set up your compensation automatically.  
  
In order to set up compensation manually, you need a set of single-color control files, one for 
each fluorochrome you want to compensate. Using Interactive N-Color Compensation 
demonstrates this approach. 
  
WinList also supports reading compensation information directly from FCS files created by 
many popular cytometers, as well as files containing the FCS 3.1-compliant $SPILLOVER 
keyword. 
  

See also: 

Using Interactive N-Color Compensation™ 

Compensation Toolbox dialog 

Compensation Trace Lines 
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Compensation Toolbox dialog 

  

This dialog is displayed by clicking the Comp button on the ribbon bar or selecting 
Compensation Toolbox from the Options menu. It provides control over various 
components of the N-Color Compensation™ and the normalization system. 

  

 
  

 
  

The dialog is separated into several tabs that group similar features together. 
  

Compensation: Setup Tab 

Compensation: AutoComp Tab 

Compensation: Transforms Tab 

Compensation: Miscellaneous Tab 
  
  

OK 

Click this button to close the dialog. This does not turn compensation off, it simply hides the 
dialog. To turn compensation off, uncheck the Activate compensation checkbox. 
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Open 

Click this button to select a previously saved compensation file to apply to the current data 
source. 
  

Save 

Click this button to save compensation settings to disk for later use. 
  

Edit 

Displays the Edit Properties for Compensation System dialog. This dialog allows you to review 
and adjust settings in the compensation and normalization system. 
  

Reset 

Turns off compensation, clears the compensation matrix, and re-initializes all compensation 
and normalization properties. 
  

See also: 

Using Interactive N-Color Compensation™ 

Compensation Trace Lines 
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Compensation: Setup Tab 

  

 
  

Compensate list 

This list displays the parameters in the active data source. Items in the list will show On 
when they are enabled for compensation.  Click an item in the list to toggle it between off 
and On. 
  
Show plots for list 

This list determines which plots are displayed on the compensation page. Select a 
measurement in the list to display 2P plots with that measurement on the X-axis and each of 
the other compensation measurements on the Y-axis. If compensation has not been set up 
for the measurement, the program will also compute the appropriate slopes to compensation 
the measurement. "Trace lines" are used to set and display the slope and intercept for 
compensation. They only appear when the Activate option is not checked.  

Use this feature with single-color controls for each measurement involved with compensation. 
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Activate compensation 

Enables or disables the N-Color Compensation and normalization systems. When unchecked, 
compensation and normalization is turned off. When checked, compensation and 
normalization are turned on. 

Note: Trace lines disappear when compensation is activated. They are replaced by small + 
and - buttons.  
  

Show all trace lines 

With this option checked, trace lines are displayed on all plots showing compensation 
measurements.  If the Activate compensation checkbox is also checked, small + and - 
buttons are shown instead of trace lines. 
  

Compensation page 

In order to effectively work with WinList's compensation system, you need to display a 2P 
histogram for each combination of parameters that are enabled for compensation. Click this 
button to automatically create a new page with all of the 2P histograms required to set up 
compensation for the measurement selected in the Show plots for list.  The program will 
display a dialog allow you to select a gate to apply to all of the plots, and then switch to the 
compensation page. 

Use this button any time you want to assign a gate to plots on the Compensation page. 



Compensation: Setup Tab 

206 

  

See also: 

Compensation Tool Box 

Compensation: AutoComp Tab 

Compensation: HyperLog Tab 

Compensation: Miscellaneous Tab 
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Compensation: AutoComp Tab 

  

Settings on this tab in the Compensation Toolbox determine whether WinList will set up 
compensation automatically from keywords in the FCS file. The initial settings for the dialog 
are determined by Data Source Preferences and it can be set up differently for each data 
source in a protocol. 
  

 

  

Current State 

This section displays the current state of compensation.   

  

V-Comp™ Compensation 

This section provides quick access to the V-Comp stand-alone app, which can automatically 
compute compensation settings based on a set of single-color controls and an unstained 
control file.   

  

Open V-Comp setup 

Click this button to select a V-Comp setup that you have already created.  A File Open dialog 
will be displayed showing the folder where V-Comp setups are typically stored.  Select the 
setup you want to use and click Open, and WinList will read the setup file and apply the 
compensation. 
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Launch V-Comp 

If you have V-Comp installed on your computer, you can use this button to launch it directly 
from WinList.  This is useful when you want to create a new V-Comp setup or make edits to 
an existing setup. 

  

  

AutoComp from Keywords 

Many instrument vendors encode compensation information in the keywords of the FCS files 
they create. WinList can read and decode this information for many popular instruments. 

Disable Do not use compensation from keywords. 

Autocomp if not 
already set 

Use keyword compensation values unless there is 
already compensation set up by a previous file or 
manually by the user. 

Autocomp each file Use keyword compensation values for each file. 

  
  

See also: 

Compensation Tool Box 

Compensation: Setup Tab 

Compensation: Transforms Tab 

Compensation: Miscellaneous Tab 
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Compensation: Transforms Tab 

  

This tab in the Compensation Toolbox offers a number of convenient commands to adjust 
transform settings and to toggle between different transformations for all parameters in the 
data source. 
  

 
  
  

Optimize transforms 

This command triggers automatic adjustment of HyperLog, Hyperbolic Sine, and VLog 
transformations for selected parameters. A dialog is presented to allow you to choose which 
parameters to optimize. After selecting the parameters, click OK to begin the process. 

WinList will determine the best B-Coefficient and the Low Value for each of the selected 
parameters. 
  

Reset transforms 

This command resets the HyperLog™, Hyperbolic Sine, and VLog transformations for selected 
parameters. A dialog is presented to allow you to choose which parameters to reset. After 
selecting the parameters, click OK to begin the process. 

WinList resets the B-Coefficient and the Low Value for each of the selected parameters, 
based on preference settings. 
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Linear --> Log 

This command switches linear parameters to the default log transformation. A dialog is 
displayed to allow you to choose the parameters to convert. 

  

- -> Log 

This command switches log-like parameters to use the Log transformation. 
  

--> HyperLog 

This command switches log-like parameters to HyperLog™ transformation. 
  

--> Hyperbolic Sine 

This command switches log-like parameters to Hyperbolic Sine transformation. 

  

--> VLog 

This command switches log-like parameters to VLog transformation. 

  

Compensation Tool Box 

Compensation: Setup Tab 

Compensation: AutoComp Tab 

Compensation: Miscellaneous Tab 
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Compensation: Miscellaneous Tab 

  
  

 
  

Show normalization targets 

Enable this option to display graphical elements that allow you to set normalization. Targets 
appear when the Activate option is enabled. See Normalization Targets for more information. 

  

Compensation review 

This checkbox enables Compensation Review mode in WinList, a great tool for evaluating how 
well compensation matches the controls that were used to create it.  See Compensation Review 
Mode for a walk-through. 

  

Show digital errors 

When this option is enabled, the program draws dotted lines showing effects of digital error. 
The lines appear on 2P histograms that display parameters that are enabled for 
compensation in the Compensate list. Use the Advice button to see information about the 
sources of digital error in the data. 
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When analog data is converted to an integer, an error is introduced known as digital error. 
Normally this error is quite modest and presents little problem to cytometrists. However, 
when data is compensated, positive and negative errors are introduced that increase with 
parameter intensity. The digital error lines attempt to show the positive portion of the 
envelope of these error distributions for each parameter that is enabled for compensation. If 
intermediate intensity populations are present that tend to follow the digital error lines, it is 
possible that they are simply an artifact due to the effects of digital error. 
  
  
Log bias 

With the introduction of the HyperLog display, the Log Bias option is largely unnecessary. It 
remains an option for backward compatibility but is not recommended. 

When checked, WinList applies a log bias value to events that would fall on the axis, 
simulating the bias in log amplifiers on older analog flow cytometers. 
  

View Cross-over Matrix 

This command displays the cross-over (also known as spillover) matrix for the current 
compensation settings. The matrix can be copied to the clipboard for use in other software. 
  

Advice 

This command displays the Advice on Compensation dialog allowing you to view information 
about the compensation settings and sources of digital error in the data. 

  
  

Compensation Tool Box 
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Compensation: Setup Tab 

Compensation: AutoComp Tab 

Compensation: Transforms Tab 
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Compensation Trace Lines 

  

Trace Lines are graphical objects used to adjust N-Color Compensation in WinList. They 
appear on dual-parameter histograms when both parameters are enabled for compensation. 
The Compensation Toolbox controls these settings. 
  

 
  

When displayed, a trace line can be moved by clicking on one of its handles. The high-
intensity handle controls the slope of the trace line, and the low-intensity handle controls the 
intercept. 

  
The Trace line is essentially setting the slope and intercept of a line through the center of the 
linearized data. Adjusting the handle in the low-intensity area sets the intercept. The slope is 
determined by the position of the handle in the high-intensity area relative to the intercept. 
As you increase the channel position of the slope handle, you increase the amount of 
compensation to be applied to the data, especially in the middle- to high-intensity range. 
Increasing the channel position of the intercept handle increases the compensation applied to 
the low intensity data. 
  
In rare cases, you may need to apply more compensation than the trace lines normally 
permit. You can give greater freedom of movement to the trace lines by holding down the 
Shift key on the keyboard when moving its handles. This allows each trace line handle to 
move along two sides of the histogram, with slopes of greater than 1.0. 
When the compensation is activated, trace lines are hidden and replaced by small + and - 
buttons. These buttons can increase and decrease the compensation settings with 
compensation activated. 

  

See also: 

Using Interactive N-Color Compensation™ 

Compensation Toolbox 

Compensation Toolbox dialog 
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Compensation Notice dialog 

  

This dialog is displayed when a file with a different number of parameters is opened into a 
data source and some of the parameters in the data source are enabled for compensation. 
  

 
  

The first time WinList detects a change in number of parameters, it will display a dialog of 
choices for the user. The user can choose to maintain the existing compensation settings, to 
the extent that is possible, or to re-initialize the compensation system. The dialog has an 
option to not be displayed again, which applies to that data source. 
  

Keep the current compensation setup 

When this option is selected, the system makes temporary copies of all the compensation 
data structures. It then resizes the structures to suit the new number of parameters (larger 
or smaller), and copies what it can from the temporary structures. If the new file has more 
parameters, the new parameters will be turned off for compensation. If it has fewer 
parameters, the extra parameters are removed from the compensation setup. If 
compensation is turned on when this transition occurs, the compensation matrix will be 
reconstructed by inverting the crossover coefficients. 
  

Re-initialize the compensation setup 

When this option is selected, the system will turn off compensation, turn off the parameters 
selected for comp, and clear all of the crossover coefficients, normalization settings, and 
trace line settings. 
  

Show this dialog when the number of parameters changes in this data source. 
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Enable this option to display this dialog anytime a file with a different number of parameters 
is opened, assuming that some of the parameters are enabled for compensation. Uncheck 
this option to suppress the dialog from appearing again. 
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Edit Properties for Compensation 

  

This dialog is displayed when the Edit button in the Compensation Toolbox dialog is clicked. 
It allows you to edit many of the characteristics of the compensation and normalization 
system. 
  

 
  

The left-hand pane of the dialog displays a tree of compensation objects. The right-hand 
pane displays properties for the compensation object selected in the tree. When the dialog is 
initially displayed, general properties of the compensation system are shown. 
  

Compensation System 

This object shows general properties of the compensation and normalization system. 

Reset Compensation 

Check this option to reset the compensation trace lines so that the data is uncompensated. 
The compensation matrix is initialized for all parameters in the active data file. 
  

Reset Normalization 

Check this option to reset any normalization and restore the data to a non-normalized state. 
This affects normalization for all parameters in the active data file. 
  

Activate 
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Enables or disables the N-Color Compensation™ and normalization systems. When 
unchecked, compensation and normalization are turned off. When checked, compensation 
and normalization are turned on. 

Note: Trace lines disappear when compensation is activated. They are replaced by small + 
and - buttons. 
  

Hardware Compatible Comp 

When this option is enabled, the compensation matrix is constructed so that crossover is 
strictly subtractive. For example, these equations show hypothetical 3-color compensation 
with the Hardware option enabled: 

 

Notice that P3 is multiplied by 1.0 in the compensation of P3. This is also true for P4 in the 
P4 compensation, and P5 in the P5 compensation. 

When the Hardware option is disabled, the compensation signal can be greater than 1.0 in 
the associated compensation expression: 

 

Notice that change in the expressions. In this setting, the loss of a signal due to signal 
crossover is adjusted for in the compensation matrix. This will result in slightly higher 
intensities than seen with the Hardware option enabled. 
  

Show Digital Errors 

When this option is enabled, the program draws dotted lines showing effects of digital error. 
The lines appear on 2P histograms that display parameters that are enabled for 
compensation in the Params to Compensate list. Use the Advice button to see information 
about the sources of digital error in the data. 
  

Show Normalization Targets 

Enable this option to display graphical elements that allow you to set normalization. Targets 
appear when the Activate option is enabled. See Normalization Targets for more information. 
  

Restrict Auto-Positioning Logic 

When enabled, WinList uses a more restricted portion of histograms to determine how to 
automatically position compensation Trace Lines. For most cases, this option will have little 
effect on how the program positions the trace lines. In some cases where there is significant 
signal crossover, enabling this option can improve the auto-positioning. 
  
  

Signal Objects 
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Each parameter enabled for compensation has an associated Signal object in the tree control. 
When you select a Signal object, the following properties appear in the properties pane. 

Normalization Factor 

This field shows the current normalization factor applied to the selected signal parameter. 
The default value is 1.0, which means that the parameter has no normalization applied. You 
can enter a specific factor to apply, or use the Normalization Targets to adjust normalization 
graphically. 

  
  
  

Detector Objects 

Each Signal object contains Detector objects, one for each of the other parameters that is 
enabled for compensation. When you select a Detector object, the following properties 
appear. 

Cross-over coefficient 

This value represents the fraction of the Signal object parameter that is spilling over into this 
detector in the compensation system. A value of 1.00 (100%) is displayed for the detector 
associated with the signal parameter. A fractional value between 0.00 and 1.0 is displayed for 
the other detector objects. For example, a CD56-PE detector for a CD56-PE signal will display 
a value of 1.00. If 20% of a CD19-FITC signal is spilling into a PE detector, a value of 0.20 
will be displayed for the PE detector of the CD19-FITC signal. 
  

Compensation coefficient 

This read-only field shows the fraction of the signal to add or subtract from the detector. It is 
computed in the construction of the compensation matrix and is not editable. 
  

Digital Error Position 

This read-only field displays the value between 0.0 and 1.0 that quantifies the digital error 
WinList computed for the parameter. Values of 0.85 and higher are relatively good, with little 
digital error. Values of 0.75 to 0.85 are fair. Values below 0.75 indicate that the parameter 
measurement contains a significant amount of digital error. 

Use the Advice dialog to understand the sources of digital error. 



Advice on Compensation dialog 

220 

Advice on Compensation dialog 

  

This dialog presents information about compensation, normalization, and digital error for the 
active data file. Review the information in this dialog to determine the characteristics of 
compensation and the sources of digital error in your system. 
  

About Digital Error 

When analog data is converted to an integer, an error is introduced known as digital error. 
Normally this error is quite modest and presents little problem to cytometrists. However, 
when data is compensated, positive and negative errors are introduced that increase with 
parameter intensity. The digital error lines in WinList attempt to show the positive envelop of 
these error distributions for each parameter that is enabled for compensation. If intermediate 
intensity populations are present that tend to follow the digital error lines, it is possible that 
they are simply an artifact due to the effects of digital error. 
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Normalization Targets 

  

When compensation is Active and Show Normalization Targets is enabled in the 
Compensation Toolbox, WinList displays graphical objects to make it easy to set 
normalization for one or more parameters. The objects appear on 2P histograms. 

Normalization allows you to change the location of populations in the data, usually to some 
normalized location. For example, suppose your lab routinely positions a bead population so 
that the median is at 10^2 for a log parameter. You open one file and find that the 
population is lower than usual because one of the gain settings was not quite right. You can 
use WinList's normalization to move that bead population to the correct location. Keep in 
mind, however, that WinList will reposition all of the data, not just the one population. 

Use normalization with great care, and with a full understanding of what you are doing and 
why you are doing it. It cannot correct data that has been overcompensated or incorrectly 
stained. It should not be used to make a weak fluorochrome appear to be a bright 
fluorochrome. 
  

 
  

To set normalization, first drag the target object by grabbing the large, yellow outer portion 
with the mouse. Drag the entire object so that the center cross-hairs are located on the 
center of the population that you want to move. 
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Next, drag the green center of the target to the place where you want to move the 
population. 

 
  

When you release the mouse, the normalization is applied to the data. 
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To reset the normalization, use the Edit button on the compensation toolbox, and choose the 
Reset Normalization option. 
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Histogram Windows 

  

Histogram windows belong to the data source that creates them. They are moveable and 
sizable within the data source. They can display 1P, 2P, and 3P data in a variety of graphical 
formats. Most data analysis begins with the creation of histograms and defining regions on 
the histograms. 
  

 
  

Click the mouse on an axis label to select a different parameter for that axis.  When the 
mouse is over the axis label, click the small triangle next to the label to select a different 
transformation for the parameter.   

  

A toolbar is positioned on the right edge of the histogram window to provide quick access to 
many common commands. For details, see Histogram Toolbar. 
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For quick access to commonly used histogram options, WinList displays the Histogram 
Context menu by clicking the right mouse button on a histogram. The histogram toolbar also 
provides access to this menu. 
  

When you click the left mouse button within a histogram, several things may happen. If there 
is an object that can be moved or edited at that location, the object will be activated. Holding 
the mouse button down on an object will allow you to drag the object to a new location. If 
there is not an object under the mouse, the action is determined by the selected region 
creation mode. See the section on the Histogram Toolbar for more on region creation modes. 
  

Close histogram windows by clicking the "X" button in the upper right corner. When a 
histogram window is closed, any regions it contains are also deleted. 
  
Histogram windows can display 1, 2, or 3 parameter data from a listmode data source. They 
can also display information from other Windows programs if they are linked with a Dynamic 
Data Exchange (DDE) connection. See Edit Remote for more on DDE links. 
  

Regions used for gating and statistics are drawn directly on histogram windows. 
  
Q or QuadStat Button 

When a two-parameter histogram is created, a button appears in the lower left-hand corner 
labeled Q. Click this button to create a QuadStat and results window for it. Delete QuadStat 
regions by clicking on the region label, then pressing the Delete key on the keyboard. See 
Regions for more information on the QuadStat and other region types. 
  
I or Information Button 

When you have put a one parameter or two parameter histogram in remote mode (DDE 
connection with another Windows application), under some circumstances you will see an I 
button in the lower left hand corner of the histogram window. If the remote application sent 
text back to WinList, you will see the I button. 
  

The button is also displayed for subtracted histograms. If you press the I button, a pop-up 
information window will appear that will allow you to scroll through the results. 
  
3D Button 

On the 3D version of WinList, two- and three-parameter histogram windows also contain a 
3D button in the lower left-hand corner. When this button is clicked, WinList displays a 3D 
Viewer window for the histogram. See WinList 3D Version Notes for more information. 
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Histogram Toolbar 

  

This toolbar appears inside the right edge of the active histogram window. Each icon 
represents a tool, described below. 
  

 
  

Region Modes 

The first group of tool buttons is used to select a region drawing mode, with only one mode 
active at a time. Regions are drawn by pressing and holding the left mouse button when the 
cursor is inside the histogram, and moving the mouse to define the size and shape of the 
region. For 1P histograms, only the Select and Range modes are supported. 2P Histograms 
support Select, Freehand, Rectangle, Ellipse, and Contour modes. Currently, no region 
drawing is supported for 3P histograms. 
  

Select mode 

In this mode, regions can be selected and moved, but new regions are not created when the 
left mouse button is clicked on the histogram. 

  

Range (not shown, 1P histograms) 

The Range tool appears on 1P plots to draw a range region.  Click, hold, and drag to create a 
range in a 1P histogram.  

  

Freehand mode 
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Click, hold, and drag to create a freehand region in a 2P histogram. To complete the region, 
release the mouse button on the starting vertex of the region. Alternatively, click and hold for 
1 second to define the first vertex, and then release the button. Define additional vertices by 
clicking the mouse. 
  

Rectangle mode 

Click, hold, and drag to define the boundaries of a rectangular region in a 2P histogram. 
  

Elliptical mode 

Click, hold, and drag to define the boundaries of an elliptical region in a 2P histogram. 
  

Contour mode 

With a Contour region, a bounding rectangle is defined with the mouse, just as with 
Rectangle mode.  Once that rectangle is defined, WinList computes a contour on the data 
within that rectangle.  Each time the data in a histogram changes, the contour region will 
recompute based on the data in that rectangle.   
  
  

NStat region 

This button initiates the creation of an NStat region in a 2P histogram. An NStat is similar to a 
QuadStat, except that it can have any number of rows and columns, and its vertices can be 
moved independently to change the shape of the array. 
  

Zoom in 

Click the button to define a zoom area on the histogram. The histogram enters "zoom" mode. 
Click inside of the histogram and drag to define the zoom area. When the mouse is released, 
the histogram displays only the portion within the zoom area. 
  

Reset zoom 

Use this button to reset the zoom on a histogram. 
  

Gate 

This button displays a list of the gates that can be applied to the histogram. Select an item in 
the list to apply a gate to the histogram. 
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Context Menu 

This button displays the histogram Context menu containing additional commands relevant to 
the histogram. 
  

Hide 

This button hides the histogram toolbar. The toolbar will reappear when the histogram is 
reactivated by clicking on its titlebar. 
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Histogram Context Menu 

  

 
  

This menu is displayed when the right-mouse button is clicked on a histogram, or by 
choosing the Context menu button on the histogram toolbar. It displays a list of common 
commands related to histograms. 
  

Copy 

Copy the histogram graphic to the clipboard. The graphic can then be pasted into a report or 
another application. 
  

Clone 

This command creates an identical copy of the histogram, with the same parameters and 
graphic settings. Note, it does not duplicate any regions within the histogram. 
  

Clone with regions 
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Creates an identical copy of the histogram, like Clone, but also duplicates the regions.  The 
duplicated regions will have new region indexes. 

  

Edit 

Display the Edit Histogram dialog. 
  

Graphics 

Display the Edit 1P Graphics, Edit 2P Graphics, or Edit 3P Graphics dialog, depending on the 
histogram type. 
  

Transformations 

Display the Edit Transformations dialog to change the transformation(s) for the parameters 
displayed in the histogram. 
  

Make Bigger 

This command incrementally increases the size of the histogram by 50%. 
  

Make Smaller 

This command incrementally decreases the size of the histogram by 50%. 
  

Add to Report 

Add a linked copy of the histogram to the active report. The linked object on the report will 
update whenever the histogram's data changes. 
  

Add to MultiGraph 

Add a static copy of the histogram to the active MultiGraph. 
  

Subtract 

Currently only supported for 1P histograms, this option displays the Histogram Subtraction 
dialog to set up a Super-Enhanced D-Value subtraction. 
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Swap Axes 

This option appears in the 2P histogram context menu. It swaps the parameters displayed on 
the X and Y axes. 
  

Annotate 

Insert a text annotation into the histogram. The text can be edited, moved and sized 
  

Insert 

Insert one of the graphic objects into the histogram. The object can be edited, moved and 
sized. 
  

Move to Page 

Move the histogram to another page of the data source. See Data Source Windows for more 
information about pages. 
  

Copy to Page 

Copy the histogram to another page of the data source. See Data Source Windows for more 
information about pages. 
  

Show on additional pages 

Display the histogram on other pages of the data source. This makes it easier to see gating 
strategies across pages in the data source. See Data Source Windows for more information 
about pages. 
  

Copy Data 

Copy the histogram data as a tab-delimited table of values to the clipboard. This is a 
convenient way to copy data into a spreadsheet or statistics application for further analysis. 

  

Save as Text 

This option saves the histogram as a tab-delimited text file so that it can be imported into 
other applications, such as speadsheets. 
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Save as Graphic 

This option saves the histogram graphic in one of many common graphic formats. 
  

Print 

Print the histogram. 
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Create Histogram 

  

There are several ways to create a new histogram in WinList: from ribbon bar or menu, by 
drawing the histogram window, or by using the Create Multiple Histograms dialog. 
  
The ribbon bar has several buttons on the Home tab that create 1P, 2P, and 3P histograms 
on the active data source.  These will show the last-used parameters, by default.  You'll find 
additional commands on the Insert tab that allow you to create dot plots, density plots, and 
contour plots quickly. If you are using the toolbar and menu interface, you'll find the Create 
Histogram command in the Create menu. 
  

Histograms can also be created by clicking and dragging the mouse in an empty portion of a 
data source window to define the size and location of a histogram. After defining the area, 
release the mouse button to display the Edit Histogram dialog and to choose the parameters 
to display. 
  

 
  

You can draw a gated histogram in a similar manner by first clicking on the Cascade Gate 
hotspot on an active region. The hotspot will change from red to green. As you draw the 
histogram, text will be displayed to show how the histogram will be gated. 
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See also: 

Histogram Windows 

Create Multiple Histograms 
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Create Multiple Histograms 

  

This command displays the Create Histograms dialog box and provides a fast and efficient 
way to create a set of histograms. 
  

 
  

The dialog has a tab for 1P, 2P, and 3P histograms. The initial tab that is shown is the 2P 
Histograms tab. 
  

Selection Methods 

Selection on the 1P Histograms tab is fairly obvious: highlight one or more parameters in the 
X Axis listbox and click Add to List. If you click Add to List more than once, you can create 
more than one copy of the histogram to allow different gating strategies. 

For 2P Histograms, there are a variety of ways to select parameters. The X Axis and Y Axis 
listboxes allow multiple selections, and when the Add to List button is clicked, the program 
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generates a list entry for all combinations of the parameters selected in the X and Y lists. For 
example, if you want Side Scatter vs Forward Scatter and Side Scatter vs CD45, you can 
select Side Scatter in the X Axis list, and both Forward Scatter and CD45 in the Y Axis list and 
click the Add to List button. 

If there is a set of parameters for which you want to see all possible plots, you can select the 
parameters in the X Axis list, and then check the Combinations mode checkbox. In this 
mode, the Y Axis list is grayed out. All combinations of the selected parameters are added to 
the list when you click Add to List. 

The 3P Histograms list works in a similar manner, but does not include the Combinations 
mode option. 
  

Add to List 

This button generates one or more entries in the Histograms list, based on the selected items 
and the selection mode. Click the button more than once to create additional copies of the 
selected items. 

Note: If all of the items that you want to create are of the same type (e.g. 2P histograms) 
and can be selected at the same time, it is not necessary to click the Add to List button. 
When the OK button is clicked, the selected items will be used to generate the histograms. 
  

Resolution 

This drop-down list allows you to select the resolution for the histograms. Select a resolution 
before clicking the Add to List button. 
  

Delete 

This button deletes the selected items in the Histograms list. 
  

Up/Down 

These buttons allow you to change the order of items that have been added to the list. Select 
one or more items in the list and click Up to move them up in the list, or Down to move them 
lower in the list. 
  

OK 

Click the button to close the dialog and create the selected items. 
  

Cancel 
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Click the button to close the dialog and cancel the creation of multiple histograms. 
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Edit Histogram 

  

This dialog box is displayed by choosing Edit Histogram in the histogram's context menu or 
by double-clicking on the histogram window's title bar. 
  

 
  

Name 

This field displays the name of the histogram, based on the selected parameters. You can 
also enter FCS keywords in this field surrounded by square brackets [ ]. When the OK button 
is clicked, WinList will evaluate the name, looking for keywords and replacing them with 
keyword values. For example, if the listmode file opened has a keyword $PROJ which has a 
value of Unstimulated Control, entering the name [$PROJ] as the histogram name would 
display Unstimulated Control on the title bar of the histogram. 
  

ID 

This field displays the ID for the histogram. Each histogram must have a unique ID. 
  

Type 

Select the radio button for the number of parameters you want the histogram to display. 
Based on this selection, other elements of the dialog are enabled or disabled. 
  

Parameter drop-down lists 

Select the parameters for each axis that you want to display. If you have created calculated 
parameters, they will appear at the end of the list of parameters. 
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Resolution drop-down lists 

Select the resolution for each parameter in the histogram. Options will range from 2 up to 
the full resolution of the data at acquisition, to a maximum of 65536 channels. In 2 and 3 
parameter histograms, you may vary the resolutions for each parameter independently. 
Higher resolutions generally require more of the computer's memory. 
  

Remote check box 

Check this box to enable the Edit Remote push button and establish a link with another 
Windows application using Dynamic Data Exchange (DDE). If a remote link is already 
established, you can use this check box to toggle between showing local data and remote 
data. 
  

Remote button 

If the Remote check box is checked, this button becomes available. Click the button to start 
or edit a connection with another application. For details, see Edit Remote dialog box. 
  
Gate 

This button displays a dialog box which allows the assignment, creation, and editing of gates. 
See Edit Gates for more information. 
  
Subtract 

This button displays a dialog box that allows a histogram to be subtracted from the active 
histogram. See Subtract Histogram for more information. 
  
Graphics 

This button allows editing of the histogram's graphical display. It leads to the Edit 1P 
Graphics, Edit 2P Graphics , or Edit 3P Graphics dialog box. 
  

OK 

Click this button to confirm the changes to the histogram and close the dialog box. 
  

Cancel 

Click this button to abandon changes to the histogram, and close the dialog box. 
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Edit Remote 

  

This dialog box allows the user to establish connections with other Windows applications 
using Dynamic Data Exchange, or DDE. Once a connection is made, WinList can interact with 
the other application whenever data changes. This can be useful for automatic databasing 
and reporting, for exporting WinList graphics, for allowing other applications to process 
WinList's results, or virtually any interchange with other programs. 
  

 
  

The requirements for remote links are listed below: 

1. The other application must support DDE. 

2. You must know the DDE topics that the application supports. 

3. The application must be in the computer's search path or it must already be running 
when WinList attempts to make a connection. 

4. The application must provide DDE "Server" support. That is, it must be able to respond 
to requests and instructions from other programs, in this case WinList. 

  

Examples of other programs with which WinList can communicate are ModFit LT, Microsoft 
Excel, and Microsoft Word. This is not a complete list, as many other applications also 
support DDE. 
  

The dialog box has three critical areas: Link To, Topic, and Commands. These fields name 
the application to connect with, the topic used for the connection, and the internal and 
external commands to execute. 
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The Update group box determines when the link will be updated. All buttons relate to 
editing commands to send. 
  

Link To 

This drop-down list box contains a list of several programs that you may commonly want to 
connect to. If the program you want to connect with is listed, select it from the list. If not, 
select Other from the list and type in the name of the program. 
  

Topic 

A default topic is filled in for you if the Link To field contains a program known to WinList. If 
no topic is shown or you want to change the topic, you can edit this field. The topic you 
supply must be a topic the other application supports. 
  

Commands 

This section is comprised of an edit box and a list box. The commands which appear and 
those you enter must either be internal WinList commands, or external commands which the 
other application will execute. 
  

Internal commands are listed in the DDE Commands section. They instruct WinList to 
perform some function. For example, PASTE(metafile) instructs WinList to paste a metafile 
(picture) from the clipboard and display it instead of the histogram graphics or results 
information. 
  

External commands must be enclosed in square brackets [ ]. Inside the square brackets 
enter the command that the other application will execute. For example, if a connection is 
established with Microsoft Excel, the command [ACTIVATE("SHEET1")] instructs Excel to 
make a spreadsheet called Sheet1 the active spreadsheet. Notice that the command is 
surrounded by square brackets to let WinList know that the command is an External 
command. 
  

As you enter commands, click the Add button to append the command to the list, or use the 
Insert or Replace buttons. Commands are executed in the order in which they are listed. 
  

Add 

Click this button to add the command in the Commands to Send edit box to the end of the 
list of commands. 
  

Insert 
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Click this button to insert the command in the Commands to Send edit box in front of the 
currently selected command. 
  

Delete 

Click this button to remove the selected command from the list box. 
  

Replace 

Click this button to replace the selected command in the list box with the command in the 
Commands to Send edit box. 
  

Open 

This option allows you to retrieve a DDE command file previously saved to disk. The 
command file opened from disk will replace the one in memory. 
  

Save 

This option allows you to save a DDE command file to disk. You can reuse the command file 
by using the Open option. Several results or histogram windows may use a command file 
stored on disk at the same time. 
  

OK 

Click this button to accept changes to the dialog box and make connection with the remote 
application. WinList will inform you if it cannot make connection. 
  

Cancel 

Click this button to discard changes made to the dialog box. 
  

Update 

Select an option to tell WinList how often to update the link with the other application. When 
it updates the link, WinList will run through all of the commands in the Commands to Send 
list, executing the internal commands and sending the external commands to the other 
(remote) application. Selecting When data changes will cause WinList to update the link 
whenever WinList changes the data related to the histogram or results window. Selecting On 
Replay tells WinList to wait until one of the options in the Replay menu has been selected. 
If you choose to update On Command, the link will be updated when you select Update 
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Remote Links from the macro menu, or when the equivalent command is encountered in 
running a WinList macro. 
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Edit 1P Graphics 

  

This dialog allows you to change the graphical display of a 1P histogram. 
  

 
  

Styles 

Fill histogram 

This check box determines whether this histogram is filled with color or drawn as an outline. 
The default setting for this comes from Preferences - Graphics. 
  
Line Style 
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This option allows you to assign a line type to the border of the 1P histogram. Six line types 
are supported. Click the scroll bars to select a new style. As you click, the new style is 
displayed for previewing. 
  

Coloring mode options 

Overlay style 

When a color gating mode is used (i.e. Color by Gate Hierarchy or Color by Gate 
Combinations), a 1P histogram can display population subsets. The subsets can be stacks or 
overlays. Use this option to select how to display subsets for the 1P histogram. 
  

Scaling 

Scaling channel 

Enter a channel number to define where the program will start looking for the peak channel 
in the histogram. This is useful if your data has an accumulation of events in low channels 
that should not be considered when looking for the peak. WinList uses the peak height to 
scale the histogram when the Auto Scale option is enabled. 
  
Y Scale 

If the Auto Scale is enabled, this edit box displays the highest peak value for the histogram. 
To set a value manually, uncheck the Auto Scale option, and then enter a number to set the 
highest value on the Y-axis of the histogram. 
  
Auto Scale 

If checked, WinList sets the vertical, y-axis scale of the histogram to the highest peak value. 
It will look for peaks starting at the channel set in Scaling channel. If Auto Scale is 
unchecked, the number in the Y Scale edit box determines the scale of the y-axis of the 
histogram. 
  

Zoom 

Zoom low X 

This value defines the lowest parameter value that is shown in the histogram. Values that are 
below this are ignored. 
  

Zoom high X 

This value defines the highest value shown in the histogram. Values above this are ignored. 
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General 

Major Tics 

Enter an approximate number of major tics you want to appear on the axes. Major tics are 
always divisible by 10, so the actual number of major tics may not be equal to the value 
entered here. 
  

Minor Tics 

Enter the approximate number of minor tics you want to display. The actual number of 
displayed will be 2, 5, 10 or a multiple of 10. 
  

Grids 

This check box allows you to turn on or off the display of grids that appear on the major tic 
intervals. If the box is checked, grids will be displayed. 
  

Hide button 

Check this option to hide the "Info" button. Info buttons appear in histograms that have 
remote links or histogram subtraction results. 
  

Apply to all 

When this option is enabled, the settings for the selected histogram will be applied to all 
other 1P histograms when the OK button is clicked. 
  

OK 

Click this button to accept the changes you have made and close the dialog box. 
  

Cancel 

Click this button to exit with no changes made and close the dialog box. 
  

Apply 

Click this button to apply the changes you have made and keep the dialog box open. 
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Edit 2P Graphics 

  

This dialog allows you to change the graphical display of a 2P histogram. It is divided into 4 
sections in the tree on the left of the dialog: 2P Graphics, Dots, Density, and Contours. 
  

 
  

2P Graphics 

Zoom 

Zoom low X 

This value defines the lowest X parameter value that is shown in the histogram. Values that 
are below this are ignored. 
  

Zoom high X 

This value defines the highest X value shown in the histogram. Values above this are ignored. 

  

Zoom low Y 
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This value defines the lowest Y parameter value that is shown in the histogram. Values that 
are below this are ignored. 
  

Zoom high Y 

This value defines the highest Y value shown in the histogram. Values above this are ignored. 
  

Tics and Grids 

Major Tics 

Enter an approximate number of major tics you want to appear on the axes. Major tics are 
always divisible by 10, so the actual number of major tics may not be equal to the value 
entered here. 
  

Minor Tics 

Enter the approximate number of minor tics you want to display. The actual number 
displayed will be 2, 5, 10 or a multiple of 10. 
  

Grids 

This check box allows you to turn on or off the display of grids that appear on the major tic 
intervals. If the box is checked, grids will be displayed. 
  

Hide button 

Check this option to hide the "I" or "Q" button. QuadStat buttons are typically displayed on 
2P histograms. Info buttons appear in histograms that have remote links or histogram 
subtraction results. 
  

Apply to all 

When this option is enabled, the settings for the selected histogram will be applied to all 
other 2P histograms when the OK button is clicked. 
  
  

Dots 

Enable this option to display dot density display. 
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This option will uncheck automatically if Color Density is enabled on the next pane. Some Dot 
properties are shared with Color Density: Dot size, Dot order, Number, Show all dots, and 
Dot Filter. Changing them in one place will also change them in the other. 
  
Dot size 

This option controls how large each event (or dot) will be on the screen and printer. A size of 
0 will display the smallest unit on the device. Other sizes are in points, a unit of 0.35 mm or 
1/72 in. 
  
Number 

Enter the number of dots you want to display in the histogram window. 

Note: The actual number of dots displayed may be less than the number you enter. If there 
are fewer events in the data than you specify, or if the packet size is less than the number of 
dots, fewer dots will appear. 

In the second case where the packet size is smaller than the number of dots, you can display 
the full number of dots by replaying data for that histogram, or you can adjust the packet 
size to store the entire listmode file. See Edit Program Controls for further discussion of 
packet size. 
  

Show all dots 

By checking this option, all events will be displayed in the 2P histogram after replaying. See 
the note above for more on showing all dots. 
  
Dot Filter 

This option provides a means for visually eliminating dots in low-frequency channels of the 
plot. WinList will hide dots in any channel with fewer than the selected number of events. 
  
Dot order 

When using color event gating, this option controls the order in which dots are drawn. 
Unsorted draws dots in their natural event order based on the listmode acquisition. Low 
frequency on top draws the dots for the smallest populations last so that they can be seen on 
top of populations that have many events. It is useful for visualizing rare events. High 
frequency on top draws the dots for the largest populations last. It may be used to visually 
clean up low frequency events. 

  

Color Density 

Enable this option to display color-density dots. 

This option will uncheck automatically if Dots are enabled on the previous pane. Some Dot 
properties are shared with Color Density: Dot size, Dot order, Number, Show all dots, and 
Dot Filter. Changing them in one place will also change them in the other. 
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Some Contour properties are shared with Color Density: Probability interval and Colors. 
Changing them in one place will also change them in the other. 
  

Colors 

Color mode 

Choose either Color gradient or Rainbow mode. Color Gradient mode transitions from a 
starting color to an ending color as the number of events increases. Rainbow mode uses a 
set of colors which blend to define the color density levels. 
  

Gradient start color 

Choose a color to use as the starting color for color density dots and contours in Color 
Gradient mode. Click the color button to select a color 
  

Gradient end color 

Choose a color to use as the ending color for color density dots and contours in Color 
Gradient mode. Click the color button to select a color 
  

Rainbow colors 

Select the number of rainbow colors for Rainbow mode. By default this is 5. 
  

Edit rainbow colors 

Use this option to select colors used for Rainbow mode. 
  

Contours 

Enable this option to display probability contours. 

Some Contour properties are shared with Color Density: Probability interval and Colors. 
Changing them in one place will also change them in the other. 
  

Show outlier dots 

To display dots that fall outside the first contour, check this option. The "Dots" section of this 
dialog controls the properties of the dots, such as size and number. 
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NOTE: If Enable contours and Show outlier dots are checked, the only dots drawn will be 
those that fall outside of the first contour level. To also draw dots that are inside the 
contours, uncheck the Show outlier dots option and check the Enable dots option above. 
  

Probability interval 

This value determines the probability used to compute contours. The default value draws 5% 
probability contours. With this setting, the largest contour level will contain 95% of the 
events in the histogram, the next level will contain 90%, and so on. 

  

Base Contour 

This dropdown list selects the level of the lowest, or base, contour. The level is selected as a 
percentage of events that it will include. The highest percentage, 99%, will include 99% of 
the events in the histogram. The lowest value for Base Contour is 90%. 
  

Line weight 

Choose a line weight for the contour border. The value is in points, a unit of 0.35 mm or 1/72 
in. 
  

Fill contours 

When this option is checked, contours will be filled with colors defined in the Colors section. 
When unchecked, the contour is unfilled. 
  

Smooth 

Enable this option to smooth the histogram data used to create the contours. This creates 
contours that have fewer vertices and a rounder appearance. 
  

Smoothing span 

If the Smooth data option is enabled, this value determines how many channels are used in 
the smoothing algorithm. Using more channels creates rounder contours. 
  

Colors 

See the description of Color Density Colors for details. 



Edit 2P Graphics 

252 

  

OK 

Click this button to accept the changes you have made and close the dialog box. 
  

Cancel 

Click this button to exit with no changes made and close the dialog box. 
  

Apply 

Click this button to apply the changes you have made and keep the dialog box open. 
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Edit 3P Graphics 

  

This dialog allows you to change the graphical display of a 3P histogram. 
  

 
  

Dots and plot 

Dot size 

This option controls how large each event (or dot) will be on the screen and printer. A size of 
0 will display the smallest unit on the device. Other sizes are in points, a unit of 0.35 mm or 
1/72 in. 
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Number 

Enter the number of dots you want to display in the histogram window. 
  

Show all dots 

By checking this option, all events will be displayed in the 3P histogram after replaying. See 
the note above for more on showing all dots. 
  

Lines 

When this option is enabled, line gray lines are drawn from each dot to the base plane. When 
displaying 1000 dots or fewer, this is useful to identify the position of dots. 
  

Background plots 

When this option is enabled, a bivariate dot plot is drawn for the 3 background planes. 
  

General 

Major Tics 

Enter an approximate number of major tics you want to appear on the axes. Major tics are 
always divisible by 10, so the actual number of major tics may not be equal to the value 
entered here. 
  

Minor Tics 

Enter the approximate number of minor tics you want to display. The actual number 
displayed will be 2, 5, 10 or a multiple of 10. 
  

Grids 

This check box allows you to turn on or off the display of grids that appear on the major tic 
intervals. If the box is checked, grids will be displayed. 

  

Zoom 

Zoom low X 
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This value defines the lowest X parameter value that is shown in the histogram. Values that 
are below this are ignored. 
  

Zoom high X 

This value defines the highest X value shown in the histogram. Values above this are ignored. 

  

Zoom low Y 

This value defines the lowest Y parameter value that is shown in the histogram. Values that 
are below this are ignored. 
  

Zoom high Y 

This value defines the highest Y value shown in the histogram. Values above this are ignored. 

  

Zoom low Z 

This value defines the lowest Z parameter value that is shown in the histogram. Values that 
are below this are ignored. 
  

Zoom high Z 

This value defines the highest Z value shown in the histogram. Values above this are ignored. 
  

Apply to all 

When this option is enabled, the settings for the selected histogram will be applied to all 
other 3P histograms when the OK button is clicked. 
  

OK 

Click this button to accept the changes you have made and close the dialog box. 
  

Cancel 

Click this button to exit with no changes made and close the dialog box. 
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Apply 

Click this button to apply the changes you have made and keep the dialog box open. 
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Subtract Histogram 

  

This dialog box allows the user to perform histogram subtraction, where the control 
(negative) histogram is selected and subtracted from the current active (test) histogram. The 
dialog box can be accessed through the Edit Histogram dialog box, or from the histogram 
popup menu that appears when the right mouse button is clicked on a histogram. Only 1-
parameter histograms are supported. 
  

Often the two histograms are in separate listmode files; the control histogram is in one and 
the test histogram in another. In order to subtract one from the other, both files must be 
opened at the same time. One way to accomplish this is to set up a protocol with two data 
sources. Use the Duplicate Data Source option in the Create menu to easily set up a second 
data source. 
  

When activated, WinList will change the graphical display of the target histogram so that the 
outline of the original histogram appears, and the histogram resulting from the subtraction is 
displayed in the foreground. The title bar of the histogram will indicate that subtraction is on. 
A sample display is shown below. 

 
  

When the subtract histogram command is selected, the following dialog box appears. 



Subtract Histogram 

258 

 
  

To subtract a histogram from the current histogram, select the negative control histogram 
that you want to subtract from the list box. All 1-parameter histograms in all open data 
sources will appear in the list box. Make sure that the Enable Histogram Subtraction 
option is checked and then click OK. 

To disable histogram subtraction, clear the check from the Histogram Subtraction On 
check box. 
  

There are times when you may receive a warning indicating that the histograms may be 
reversed.”  This message alerts you to a condition in the subtraction routine where the 
control histogram may have more "positives" than the positive histogram. Check to make 
sure you have not accidentally subtracted the positive histogram from the negative histogram 
or made a similar selection mistake. If you are certain that you are subtracting the correct 
histogram, the warning can be safely ignored. 
  

Enable Histogram Subtraction 

This option determines the state of histogram subtraction. When checked, subtraction is 
enabled. When unchecked, subtraction is disabled. It is checked automatically each time you 
display the subtraction dialog. 
  

Histogram ID 
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This field displays the WinList ID of the histogram to subtract that is currently selected in the 
list box. 
  

Data Source ID 

This field displays the WinList ID of the data source owning the histogram that is currently 
selected in the list box. 
  

Histogram list box 

Displays a list of all 1-parameter histograms. 
  

OK 

Accepts changes and closes the dialog box. 
  

Cancel 

Exits with no changes and closes the dialog box. 
  
  

Statistical results of the subtraction can be viewed by clicking the I button in the lower left 
corner of the histogram window. When clicked, an information window will appear displaying 
several statistics as described below: 

 
  

These results are also available for databasing. 
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Subtracted Control File 

This field displays the name of the data source, the histogram ID, and the name of the 
subtracted control histogram. 
  
DValue (% Max. difference) 

In determining the difference between the test and control histograms, both are converted 
into cumulative histograms and normalized to a scale from 0 to 100. The point of maximum 
difference is found and the percent difference is calculated. Since the scale of the cumulative 
histograms is 0 to 100, the maximum difference is actually a percentage. 
  
% Positives (SED Method) 

This statistic uses the Super-enhanced DMax (SED) method to determine a more 
accurate percentage of the test histogram that is positive, or what portion remains after 
histogram subtraction. The method was presented at ISAC in 1996 as Enhanced Normalized 
Subtraction (ENS), and was further improved to become SED. Contact Customer Support for 
other references and a white paper on this method. 
  

Median Positives (linear) 

This field displays the statistical median for the positive distribution computed using the SED 
method. It is in linear ADC units. 
  

Median Control (linear) 

This field displays the statistical median for the control histogram. It is in linear ADC units. 
  

Positive-Control Intensity Ratio 

This field displays the ratio of the linearized positive median to the linearized control median. 
It provides an indication of the relative intensities of the positive and control distributions. 

  

Mann-Whitney U Test Results 

WinList computes the Mann-Whitney U Test for additional "Area-under-the-curve" (AUC) 
statistics for histogram subtraction. Detailed info on this test can be found in this wiki article. 
This provides another indication of the difference between two distributions - the test and 
control histograms. 

The key statistic is the "Area-under-the-curve", or AUC. AUC is non-parametric and ranges 
from 0 to 1, such that if the histograms are the same AUC = 0.5.  If test histogram shifts to 
the right, AUC will increase towards a value of 1.0, and if the test histogram shifts to the left, 
AUC decreases towards a value 0.0. The AUC as a metric gives both the proportion of 

https://en.wikipedia.org/wiki/Mannâ��Whitney_U_test


WinList User Guide 

261 

difference between histograms and direction of shift. AUC seems to be very robust and not 
affected by noise. 
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Information Windows 

  

When a histogram window is remotely linked to another program and it has received textual 
information, an Information window can display the textual or graphical information. For 
example, if a DNA histogram in WinList is linked to ModFit for analysis, ModFit will send back 
a graphic as well as its analysis results. 

WinList indicates that remote information is available for a window by displaying a button 
labeled with the letter I in the lower left hand corner of the histogram window. 
  

The Information window is also available when a histogram has subtraction results to display. 
See Histogram Subtraction for details. 
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Index Analysis 

  

The Index Analysis window is a special display for parameters that contain index-like 
data.  Some plate-sorting cytometers create index parameters that indicate which well on the 
sort plate each event went into.  The Index Analysis window is a great tool for viewing and 
investigating that information. 

  

 

  

An Index Analysis window can be created for any index-like parameter in the FCS file.  There 
are controls for setting the number of rows and columns to display, as well as how to label 
the rows and columns.  In some cases, the FCS file may contain keywords to help the Index 
Analysis window figure out how to display the rows and columns.  See Edit Index Analysis for 
details. 

  

You can create "groups" of related wells on an Index Analysis window, much like regions on 
a histogram except that groups can contain locations that are not next to one another.  In 
fact, each group you create has an associated region so that you can display statistics for it 
in a Results window as you would with other regions.  See Index Analysis Groups for 
information on creating and editing groups. 
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Index Analysis plots can display the color-event information from regions in other 
histograms.  You can also choose to color events based on the groups in the Index Analysis 
window. 
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Edit Index Analysis 

  

This dialog is displayed when creating or editing an Index Analysis window. 

  

 

  

Parameter 

Choose the parameter in the FCS file that you want to display in the Index Analysis 
window.  It is best if this parameter contains index-like information - whole numbers in the 
range defined by the number of rows and columns. 

  

Rows and Columns 

When you create a new Index Analysis window, you can edit the number of rows and 
columns.  If the file you are analyzing has indexing keywords, this information will be filled in 
automatically for you.  If it does not have keywords, create enough rows and columns to 
accommodate the range of values for the parameter.  For example, if your parameter has 
128 possible values, make sure that rows * columns = 128.  In the illustration, the parameter 
has 96 possible values, so 8 rows by 12 columns will display all the possible values. 

  

Row and Column Labels 

You can label the rows and columns with letters or numbers to easily identify a particular well 
in the grid. 

  

Grid Origin 
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The grid origin determines where the first index value is located on the window. 
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Index Analysis Groups 

  

"Analysis Groups" in an Index Analysis window are the equivalent of "regions" in a histogram 
window.  An analysis group identifies a set of wells in the Index Analysis window, and you 
can report statistics and perform event coloring with analysis groups just as you would with a 
region in a histogram. 

  

In the image below, there are 2 groups defined.  The red-colored boxes represent group R1, 
which is named "Good Cells".  This group contains 5 wells on row A and 4 more wells on row 
C.  The green-colored boxes represent group R2, named "Bad Cells". 

  

 

  

Creating a Group 

With an Index Analysis window created, use the Create Group tool in its toolbar to start a 
new group of wells. 
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This will display the Edit Group dialog, which identifies the results region associated with the 
group.  You can type an alias and pick a color for the group you are creating in this dialog. 

With the Edit Group dialog open, click and drag the mouse over the wells that you want to 
include in the group.  If you want to add cells that are not next to one another, press and 
hold the Ctrl key on the keyboard before you click the mouse. 

When you have finished with selection of wells, click the Done button to close the Edit Group 
dialog. 

  

Editing a Group 

Once a group has been created, you can edit the group by clicking on any one of its 
wells.  This will display the Edit Group dialog.  Just as with creating a group, you can select 
wells, change the alias and edit the color of the group.  If you want to add cells that are not 
next to one another, press and hold the Ctrl key on the keyboard before you click the 
mouse. 

When you have finished selecting wells, click the Done button to close the Edit Group dialog. 

  

Deleting a Group 

To delete a group, right-click the mouse on any well in the group and select Delete from the 
context menu. 

  

Creating Results for a Group 

To create results for a group, right-click the mouse on any well in the group and select 
Create Results in the context menu.  The statistics that can be displayed are limited to 
frequency-based statistics; intensity and position statistics are not computed for Index 
Analysis groups. 

  

Using a Group to Gate other Histograms 

Sometimes it is useful to see where the wells in a group appear in other histograms.  One 
method for doing this is to use the group to gate another histogram.  Right-click on a group 
and select Cascade Gate from the context menu, and then click the title bar of the 
histogram you want to gate on the group.  The histogram will show only those events that 
are in the wells selected in the group. 
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3D Histogram Viewing 

  

WinList 3D can create high quality OpenGL 3D images from any 2P or 3P histogram. The 3D 
images are displayed in separate windows, and can be easily rotated and scaled. This feature 
generates wonderful publication graphics and greatly enhances the ability to visualize your 
data. 
  

Each 2P and 3P histogram displays a small "3D" button in the lower left corner of the 
histogram window. To display the 3D viewer for a histogram, simply click the 3D button and 
a 3D Viewer window will appear. 
  

You can set a preference for the type of 3D display that is created when you click the 3D 
button. See 2P Graphics Preferences and 3P Graphics Preferences for details. 
  

2P histograms display an Iso3D image of the histogram data. For details on the display 
options for Iso3D displays, see the 2-Parameter Display Options. 
  

3P histograms display 3D clouds, dots, or spheres. For details on the 3-parameter display 
options, see 3-Parameter Display Options. 
  

Zoom settings that you make on the histograms will be used by the 3D viewer window. 
  
  

For more on the 3D Viewer, see: 

Using the 3D Viewer 
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Using the 3D Viewer 

  

The 3D viewer can display 2- or 3-parameter data in a number of different formats. The 
colors that are applied to the 3D data are same as those shown in the standard display. 
Zoom settings that you make on the histograms will be used by the 3D viewer window. The 
3D viewer provides additional flexibility, allowing rotation and zooming on the data display. 
  

For details on the Iso3D display options for 2-parameter data, see 2-Parameter Display 
Options. 

 
  

For details on the 3D display options for 3-parameter data, see 3-Parameter Display Options. 
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Displaying Additional Controls and Options 

The viewer has small arrows on its left, right, and bottom edges. Click or hover the mouse on 
one of the arrows to display the controls that it contains. 
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Editing Properties 

Click or hover the mouse on the small arrow on the right edge of the viewer window to 
display the properties sheet. The property sheet contains a tree of objects and a property list 
for the selected object in the tree. You can also click the pencil icon on the viewer toolbar to 
display the properties sheet. See 2-Parameter Display Options or 3-Parameter Display 
Options for details on properties. 
  

Rotate the image 

Click, hold, and drag on the viewer window. The image in the window will rotate as you drag 
the mouse. Release the mouse button to complete the rotation. You can also use the rotation 
wheels contained in the property sheet at the bottom of the viewer window. 
  

 
  
  

Animate the image 
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When you enable the Animate checkbox at the top of the viewer, the image will rotate. You 
can control the direction and speed of rotation by using the mouse. Click, drag, and release 
to set the speed and direction. 
  

Save the image 

Click the Save icon on the viewer toolbar to save the 3D image as a graphic file on disk. A 
dialog is displayed to set the size and resolution of the image. Adjust the properties as 
needed and then click OK. The Save Image dialog is displayed to select a name and format 
for the image. 
  

Print the image 

Click the Print icon on the viewer toolbar to print the image. 
  

Copy the image 

Click the Copy icon on the viewer toolbar to copy the image to the clipboard. 
  

The Home position 

Click the Home icon to return the image to its default rotation and position. 
  

Drag and Drop 

Use the Drag button on the toolbar to begin a drag-and-drop operation. Click the button, 
drag it to the destination (e.g. a Report window), then release the button to finish the action. 
  

See also: 

3D Viewer: Additional Controls 
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3D Viewer: Additional Controls 

  

Mouse Button Controls 

The mouse buttons can be used in the 3D Viewer as described in the table below. 

Left Spin (rotate the virtual trackball) 
  

<SHIFT> + Left Pan (translate up/down/left/right) 
  

<CTRL> + <SHIFT> + Left Zoom in and out 
  

Right Mouse Display the Viewer Popup Menu 
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3D Viewer: 2-Parameter Display Options 

  

This property sheet allows you to change how the 3D-viewer window displays 2-parameter 
data. 
  

 
  

A pushpin at the top of the sheet allows you to pin the sheet open. The small "x" allows you 
to close the sheet. 
  

The tree control at the top determines which set of properties are shown in the bottom 
section. Select an item in the tree to view and edit its properties. 
  

Iso 3D Scene 

Contour Properties 
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Minimum Count 

Use this control to filter out low-level populations. Those that have fewer events than this 
value will not be drawn on the plot. 
  

Auto Scale Frequency 

When checked, the frequency axis is automatically scaled based on the data. 
  

Maximum Frequency 

When Auto Scale Frequency is not checked, the this field sets the height of the frequency 
axis. 
  

Background Color 

Select a background color for the viewer. 
  

Show Rotation Point 

Enable this option to see the point at the center of rotation. 
  

Use Perspective 

Enabled by default, this property determines whether perspective is applied to the 3D 
rendering. 
  

Copy/Save/Print Options 

Custom Size Width & Height 

These values control the width and height for graphics when copied, saved, or printed. 
  

Image Resolution 

This field controls the resolutions for graphics when copied, saved, or printed. 
  

Use White Background 



WinList User Guide 

277 

Enable this option to use a white background when copying, saving, or printing. 
  

Contour Base 

Show Base 

Enable this option to show the base plane of the contour plot. 
  

Base Color 

Choose a color for the base plane. 
  

Percent Transparency 

Choose a transparency for the base. 
  

All Contours 

These settings apply to ALL of the subset contours. Individual contours can be customized 
with different settings. 
  

Contour Line Type 

Select an option for displaying contour lines. 
  

Minor Tic Contours 

When contour lines are enabled, this option will draw contour lines for the minor tic levels. 
  

Contour Line Color 

Choose a color for the contour lines. 
  

Percent Transparency 

Choose a transparency for all contours. 
  

Contours 
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Use these objects to customize individual clusters. To change the settings for all contours at 
once, select the All Contours object in the tree. 
  

Contour Line Type 

Select an option for displaying contour lines. 
  

Minor Tic Contours 

When contour lines are enabled, this option will draw contour lines for the minor tic levels. 
  

Contour Line Color 

Choose a color for the contour lines. 
  

Percent Transparency 

Choose a transparency for all contours. 
  

Contour Color 

The property displays the color used by the cluster.  It is control by the gate dialogs in the 
main application. 
  

Axes 

Show Box 

Enable this option to show the 3D box. 
  

Box Line Weight 

Choose a line weight for the 3D box. 
  

Box and Axis Color 

Choose a color for the 3D box and axis. 
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Y, Y, Z Axis 

  
Show 

Choose an option for the axis display. 
  
Axis Color 

Select a color for the axis. 
  
Label Font 

Select a font for the axis label. 
  
Number Font 

Select a font for the axis numbers. 
  
Axis Line Weight 

Select a line weight for the axis. 
  

Axis Label Properties 

Axis Label 

Edit the text for the axis label. 
  

Update Axis Label 

Select an option for how the axis label is updated. 
  

Axis Label Style 

Choose a label style. 3D Fixed maintains the same label orientation as the plot is rotated. 
3D Facing Viewer rotates the labels to face the viewer and remain readable as the plot is 
rotated. 
  

Horizontal Alignment 

Choose an alignment for the labels. 
  

Axis Number Style 
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Choose a style for the axis numbers. 3D Fixed maintains the same label orientation as the 
plot is rotated. 3D Facing Viewer rotates the labels to face the viewer and remain readable 
as the plot is rotated. 

  

Show Exponent Only 

When enabled, only the exponent is shown on the axis for log-like transforms. 

  

Axis position 

Select a position for the axis. 
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3D Viewer: 3-Parameter Display Options 

  

This property sheet allows you to change how the 3D-viewer window displays 3-parameter 
data. 
  

 

  

A pushpin at the top of the sheet allows you to pin the sheet open. The small "x" allows you 
to close the sheet. 
  

The tree control at the top determines which set of properties are shown in the bottom 
section. Select an item in the tree to view and edit its properties. 

  

3D Clusters Scene 
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Background Color 

Select a background color for the viewer. 
  

Show Rotation Point 

Enable this option to see the point at the center of rotation. 
  

Use Perspective 

Enabled by default, this property determines whether perspective is applied to the 3D 
rendering. 
  

Copy/Save/Print Options 

Custom Size Width & Height 

These values control the width and height for graphics when copied, saved, or printed. 
  

Image Resolution 

This field controls the resolutions for graphics when copied, saved, or printed. 
  

Use White Background 

Enable this option to use a white background when copying, saving, or printing. 
  

Dots/Spheres/Clouds 

Display Mode 

Select the type of 3D display to use: Dots, Spheres, or Clouds. 
  

Dots/Spheres Properties 

Enter the number of events to display for dots and spheres. 
  

Cloud Properties 
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Probability 

Select a probability threshold for the cloud display. This value is much like a contour in 2P 
space, in this case defining a 3P surface. Larger values include more events inside the cloud 
and result in a larger surface. 
  

Necessary Events 

This determines the minimum number of events that a cluster must contain in order for a 
cloud to be generated for it. 
  

All Clusters 

These settings are applied to ALL clusters. Individual clusters can be customized with 
different settings. 
  

Dot/Sphere Size 

Select a size for dots or spheres. 
  

Percent Transparency 

Choose a transparency for all clouds. 
  
  

Clusters 

Dot/Sphere Size 

Select a size for dots or spheres. 
  

Percent Transparency 

Choose a transparency. 
  

Cluster Color 

Choose a color for the cluster. 
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Axes 

Show Box 

Enable this option to show the 3D box. 
  

Box Line Weight 

Choose a line weight for the 3D box. 
  

Box and Axis Color 

Choose a color for the 3D box and axis. 

  

Y, Y, Z Axis 

  
Show 

Choose an option for the axis display. 
  
Axis Color 

Select a color for the axis. 
  
Label Font 

Select a font for the axis label. 
  
Number Font 

Select a font for the axis numbers. 
  
Axis Line Weight 

Select a line weight for the axis. 
  

Axis Label Properties 

Axis Label 

Edit the text for the axis label. 
  

Update Axis Label 

Select an option for how the axis label is updated. 
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Axis Label Style 

Choose a label style. 3D Fixed maintains the same label orientation as the plot is rotated. 
3D Facing Viewer rotates the labels to face the viewer and remain readable as the plot is 
rotated. 
  

Horizontal Alignment 

Choose an alignment for the labels. 
  

Axis Number Style 

Choose a style for the axis numbers. 3D Fixed maintains the same label orientation as the 
plot is rotated. 3D Facing Viewer rotates the labels to face the viewer and remain readable 
as the plot is rotated. 

  

Show Exponent Only 

When enabled, only the exponent is shown on the axis for log-like transforms. 

  

Axis position 

Select a position for the axis. 
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3D Output Options Dialog 

  

This dialog controls the size and resolution of the image generated when printing or saving to 
disk. 
  

 
  

  

Custom Size Width and Height 

Enter values for Width and Height, in inches. 
  

Image Resolution 

Select a resolution for the output. The resolution is the number of dots per inch (DPI). Keep 
in mind that as you increase the resolution, the size of the image increases, and the memory 
demands on your computer can become very great. You may want to try a low resolution 
first to see how long rendering takes and to assess the quality of the output. Increase the 
resolution gradually until you reach the quality you desire. 
  

Use white for background 

Check this option to render the image with a white background. Clear the check if you want 
to use a black background as seen in the viewer. 
  

OK 

Click this button to accept the settings in the dialog. 
  

Cancel 
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Click this button to cancel any changes. 
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Edit Spot 

  

This dialog box can be brought to the screen by choosing Spots from the View tab of the 
ribbon bar or Edit Spots in the Edit menu. 
  

 
  

What is a spot? 

Spots are graphical elements that you can use to mark locations in histograms. Each Spot 
stores its location for each parameter in the listmode file, so the spot becomes an n-
dimensional placeholder. You can use spots to identify peak positions or cluster locations in 
one file, and then read a test file into the program and see how the positions have changed. 
They are useful when working with software compensation to see how clusters move when 
compensation is applied. 
  

Positioning the Spot 

After a spot is created and the dialog closed, the spot can be positioned with the mouse by 
clicking and dragging the center of the spot. 
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Add 

To create a new spot, click the Add button. Any number of spots can be created. When a 
new spot is created, the Edit Properties for Spot dialog is displayed to allow the spot to be 
named and a color selected. 
  

Delete 

To delete a spot, select it in the list and click the Delete button. 
  

OK 

Click this button to close the dialog. 
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Open/Save 

You can save a set of spots to a file on disk by clicking the Save button. Use the Open button 
to reopen a saved spot file. 
  

Properties 

If a spot is selected in the list, the Properties button will display the Edit Properties for Spot 
dialog to allow editing of the spot’ s description and color. 

If nothing is selected in the list, the properties dialog for all spots is displayed. This dialog 
allows you to show or hide all spots. 
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Edit Properties for Spot 

  

This dialog is displayed by double-clicking a spot, or from the Edit Spots dialog. 
  

 
  

Description 

Type a description, if desired. The description is not displayed except in this dialog. 
  

Color 

Click this button to choose a color for the spot. The standard color selection dialog is 
displayed. 
  

Size 

Spots can be of different sizes. The size field is a percentage of the histogram area. So, a 
value of 10 causes the spot to be 10% of the width and height of the histogram. 
  

Relative positions 

The spot keeps track of its position in each parameter of the listmode file. The positions are 
in percentage units, so a value of 50.0 positions the spot at the halfway point in the 
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parameter. These values can be edited directly, or you can use the mouse to move the spot 
graphically. 
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Regions 

  

WinList can create a number of different types of regions.  Each is created in a different way 
as described below. 

The way regions are moved, resized, and deleted is common to all region types. Move a 
region by clicking on the region's label, and then dragging the label to a new location. To 
move the label without moving the region, click on the left portion of the region label, called 
the hotspot, and drag the label. 
  

 
  

Resize a 1P or 2P region by clicking on the region's label to activate the region. Sizing 
handles are displayed. Click on one of the handles and drag it with the mouse to adjust the 
size of the region. 
  

 
  

Delete a region by clicking on the region label, and then pressing the Delete key on the 
keyboard. You can also delete regions (except for NStat regions) by dragging the region label 
off the left edge of the histogram and releasing the mouse. 
  
  

1P Region Creation 
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To define a new region in 1P histograms, click on the histogram title bar to activate it. This 
will also display the histogram toolbar. Make sure that the Range tool is selected in the 
histogram toolbar. Click and draw on the histogram to define the left and right boundaries of 
the range, and release the mouse button when finished. 
  

1P regions can automatically position themselves relative to the median of the histogram that 
contains them. The attribute can be enabled in the Edit Properties for 1P Region dialog box. 
  

2P Region Creation 

In 2P histograms, you can define many types of regions, including free-hand, contour, 
rectangular, elliptical, and NStat. To create a new region, first click on the histogram's title 
bar to activate it and show the histogram toolbar. Choose the type of region you want from 
the toolbar that appears on the right side of the histogram. 
  

To draw a free-hand region, select the Free-hand tool, then click, hold, and drag the mouse 
to create additional points. Finish the region by releasing the mouse on the first point that 
was created. Free hand regions can also be created using the point-and-click technique to 
define each point in the region. Start this method in the same way described above, and then 
click the mouse button for each point you want to define. Finish the region by clicking on the 
first point that was created. 
  

To create a rectangular region, select the Rectangle tool. Click and hold the mouse button 
to create the first corner of the rectangle. Move the mouse and release the button to define 
the opposite corner of the rectangle. 
  

To create an elliptical region, select the Ellipse tool. The ellipse is created in the same way 
as the rectangle region described above. 
  

To create a contour region, select the Contour tool. With a Contour region, a bounding 
rectangle is defined with the mouse, just as with the Rectangle tool.  Once that rectangle is 
defined, WinList computes a contour on the data within that rectangle.  Each time the data in 
a histogram changes, the contour region will recompute based on the data in that rectangle. 
  

To size a 2P region, first click on the region label to activate the region. Sizing handles will 
appear around the perimeter of the region. Drag a handle to resize the region. 
  

To rotate a 2P region, first click on the region label to activate the region. Along with sizing 
handles, a small double-headed arrow will appear to the right of the region's center. Drag 
this handle to rotate the region. 
  

The Edit Properties for 2P Region dialog is displayed when you double-click a 2P region label. 
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A 2P region can also display all or some of its vertices, allowing you to adjust one or more 
points in the region. To display the vertices, display the Edit Properties for 2P Region dialog 
and enable the Show Vertices option. Each vertex point can be moved with the mouse. 
  

2P regions can automatically position themselves relative to the median of the histogram that 
contains them. This attribute can be enabled in the Edit Properties for 2P Region dialog box. 
  
  

NStat and QuadStat Region Creation 

An NStat region is an array of adjacent regions with a defined number of rows and columns 
on a 2P histogram. A QuadStat region is a particular type of NStat region with 2 rows and 2 
columns. NStats are very useful when you need a set of adjacent regions that must move 
together. 
  

To create an NStat region, click the NStat tool in the histogram toolbar. The NStat Properties 
dialog is displayed, allowing you to select the number of rows and columns for the NStat. 
Select the options you want for the NStat and click OK to finish the creation process. 
  

 
  

The Edit Properties for NStat Region dialog is displayed when you double-click an NStat 
region label. Click on the region label and press the Delete key to delete these regions. 
  

An NStat region can display its vertices, allowing you to adjust individual points in the region. 
To display the vertices, display the Edit Properties for NStat Region dialog and enable the 
Show Vertices option. Each vertex point can be moved with the mouse. 
  
  

Region Array Creation 
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To create an entire set of individual, independent regions at once on a histogram, use the 
Create Region Array option in the Create menu. This command can create sets of 1P or 2P 
regions, depending on what histogram is active at the time. 
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Edit Regions 

  

 

  

This command is found on the Home tab of the ribbon bar, or in the Options menu when 
using the toolbar and menu display. 

  

The Edit Regions dialog box displays a list of the regions that have been created in the 
active data source. It can be used to delete regions, link regions together, and to save and 
open regions from disk. 
  

 
  

The region list box is a multiple select list box, which means that any number of regions can 
be selected at once. To select regions that are not adjacent in the list, hold the Ctrl key 
down on the keyboard while clicking on the Region name. 
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Applies to 

The data source that this region dialog relates to is shown here. 
  

Name 

This field shows the name of the selected region. 
  
Alias 

This edit box allows you to enter an alias name for the selected region. The name can be 
displayed in results windows to make region identification easier. You can also display the 
region name or alias when you draw regions on histograms, so you can edit the Alias to more 
meaningful names such as Lymphs or Monos. 

In addition, region aliases can be FCS or internal keywords. Any part of an alias that is 
surrounded with square brackets [ ] will be evaluated as a keyword. See Internal Keywords 
for more on keywords. 

Statistic 

This field shows the statistic that the selected region will display in its label. No statistic, 
Percent Gated, Percent Total, and Region Events are the statistics that can be selected. 

  

Region list box 

This list box shows all regions that have been created. This is a multiple selection list box, so 
more than one item may be selected at a time. Each time a selection is made, the alias for 
the first selected item is displayed in the Alias edit box. 
  
Delete 

This command deletes the selected regions. 

  
Restore 

This command restores a deleted region from the Undo buffer. 

  
Clear 

This command clears a deleted region from the Undo buffer so that it is no longer associated 
with the histogram. 

  

Links 



WinList User Guide 

299 

Click this button to link one or more regions together, or to view existing region links. The 
Edit Region Links dialog is displayed. 
  

Reset Aliases 

This command changes all the current aliases to their default values. 
  

Open/Save 

These buttons allow you to save and retrieve regions. When regions are opened from disk, 
they replace the ones currently in memory. WinList will attempt to re-establish histogram, 
results windows, and linking associations. 
  

OK 

Click this button to accept the changes made and close the dialog box. 
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Edit Properties for 1P Region 

  

This dialog can be displayed by double-clicking the mouse on the label of a 1P region, or by 
right-button clicking on the label and choosing Edit Properties. 
  

Default properties for regions are set in the dialog found in the Preferences dialog, found in 
the Options menu. 
  

 
  
  

Elements in the tree 

Region 

Select the region in the tree on the left to edit the properties of the region. 

  

Label 

Choose Label in the tree on the left to edit the font, background color, and transparency for 
the region label. 
  

Properties 
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Show Name 

Enable this checkbox to display the name of the region. 
  

Show Alias 

Enable this checkbox to display the alias of the region. 
  

Alias 

This edit box allows you to edit the alias of the region. 
  

Show Statistic 

Select a statistic to display in the region label. No statistic, Percent Gated, Percent Total, and 
Region Events are the statistics that can be selected. 
  

Line color 

Click this button to choose a different color for the region. 
  

Line weight 

Select a line weight from the list of options. Larger values are heavier line weights. 
  

Allow delete 

With this option enabled, the region can be deleted by the user. To prevent a region from 
being deleted, uncheck this option. 
  

Region style 

Select the style for the 1P region: Bar with legs, Bar with tics. 

  

Auto-positioning 

Auto-position 
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Enable this option when you want the region to automatically adjust its position relative to 
the data in the histogram. The region will center itself on the X median or mode value, 
depending on the selection in the Auto-position method option below. When you move a 
region with the auto-position property enabled, you offset its auto-position location relative 
to the data. When the data changes in the histogram containing the region, the region will 
adjust its position relative to the new data. 

The auto-position property will be disabled in a few circumstances where it is invalid. When a 
region is used in a self-gate on the histogram in which it resides, the property is disabled. 
Similarly, if a region is a dependent linked region, the property is disabled. 
  

Auto-position method 

This option determines what statistic is used when the auto-positioning is enabled for a 
region. The center of the region is positioned on the specified value. Choose Center on 
histogram median if you want to track the central tendency of the data or Center on 
histogram mode to track the location of highest frequency events.  Choose Include lower 
percent to position the region to include events on the low intensity end of the histogram, or 
Include upper percent to include the high intensity events.  Choose Center on region median 
or Center on region mode to track the central tendency of the data within the region, not the 
entire histogram. 
  

X Percent 

If Auto-Position is enabled and the method is Include lower percent, enter the percentile 
value where the right leg of the region should be positioned. The left leg will be set at the 
origin. 
If Auto-Position is enabled and the method is Include upper percent, enter the percentile 
value where the left leg of the region should be positioned. The right leg will be set at the 
upper boundary. 
  

OK 

Click this button to accept changes and close the dialog box. 
  

Cancel 

Click this button to close the dialog box and cancel changes. 
  

Help 

Click this button to display on-line help for this dialog. 
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1P Region Context Menu 

  

This menu is displayed by right-clicking a 1P region label. It provides commands that relate 
to the region. 
  

Edit Properties 

Choose this command to display the Edit Properties dialog for the 1P region. 
  

Create Results 

This command creates a Results window to display statistics for the region. 
  

Highlight events in Rn 

This is a toggle option that can be enabled for one region at a time. When enabled, the 
events that are in the region will be highlighted in all histograms.  Highlighting, by default, 
displays these events larger and blinking. See Region preferences for highlight properties. 
  

Color events in Rn only 

This is a toggle command that enables or disables coloring using this region only.  It is a 
convenient way to explore where the events that are in the region appear in all other 
histograms.  Selecting the option once will enable coloring for the region.  Selecting it again 
(or choosing it for another region) will turn off the function.   
  

Stick to Neighbor Regions 

This command scans the vertices of the region to see if any are overlapping vertices from 
neighboring regions.  For any vertex that overlaps another region's vertex, a linkage is made 
so that if either vertex is moved, both are moved. Sticky regions make it possible to create a 
set of adjacent regions that maintain adjacency even if you move one region, or a vertex of a 
region. See Sticky Regions and Magic Contours for more info. 

  

Region Links... 

This command displays the Edit Region Links for the region to allow this region to control the 
size and shape of other regions, and vice versa. 
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Delete 

This command deletes the region, if it is not locked. 
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Edit Properties for 2P Region 

  

This dialog can be displayed by double-clicking the mouse on the label of a 2P region, or by 
right-clicking the label and choosing Edit Properties. 
  

Default properties for regions are set in the dialog found in the Preferences dialog, found in 
the Options menu. 
  

 
  

Elements in the tree 

Region 

Select the region in the tree on the left to edit the properties of the region. 

  

Label 

Choose Label in the tree on the left to edit the font, background color, and transparency for 
the region label. 
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Properties 

Show Name 

Enable this checkbox to display the name of the region. 
  

Show Alias 

Enable this checkbox to display the alias of the region. 

  

Alias 

This edit box allows you to edit the alias of the region. 

  

Show Statistic 

Select a statistic to display in the region label. No statistic, Percent Gated, Percent Total, and 
Region Events are the statistics that can be selected. 
  

Line color 

Click this button to choose a different color for the region. 
  

Line weight 

Select a line weight from the list of options. Larger values are heavier line weights. 
  

Allow delete 

This option determines whether a region can be deleted by the user. When enabled, regions 
can be deleted by clicking on the region label and pressing the Delete key on the keyboard. 
Some regions can also be deleted by dragging them off the left or bottom edge of the 
histogram. Uncheck this option to protect a region from being deleted accidentally. Any 
region can be deleted using the Region List dialog box, even if the Allow delete option is 
disabled. 
  

Vertices 
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Show resizing handles 

Enable this option to display resize handles on the region when it is active. Resize handles 
form a bounding rectangle around a region and can be used to adjust size or shape of a 
region. The handles are hidden when the region is not selected. 
  

Show vertices 

Enable this option to display the individual points that comprise the region. When displayed, 
the vertex points can be moved individually. 
  

Number of vertices 

This option allows you to choose how many of the region vertices to display when the Show 
Vertices option is enabled. Choosing 0 displays all vertices. Other choices include 5, 10, and 
20 vertices. By displaying a subset of the vertices, it is possible to adjust regions with many 
vertices using just a few control points. 
  

Vertex size 

This option determines the size of the region's vertices, if they are displayed. 
  

Change shape 

This option allows you to change the shape of an existing region to either an ellipse or a 
rectangle. 
  

Auto-positioning 

Auto-position 

Enable this option when you want the region to automatically adjust its position relative to 
data in the histogram. The region will center itself on the X and Y medians or modes, 
depending on the selection in the Auto-position method option below. When you move a 
region with the auto-position property enabled, you offset its auto-position location relative 
to the data. When the data changes in the histogram containing the region, the region will 
adjust its position relative to the new data. 

The auto-position property will be disabled in a few circumstances where it is invalid. When a 
region is used in a self-gate on the histogram in which it resides, the property is disabled. 
Similarly, if a region is a dependent linked region, the property is disabled. 
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Auto-position method 

This option determines what statistic is used when the auto-positioning is enabled for a 
region. The center of the region is positioned on the specified value. Choose Center on 
histogram median if you want to track the central tendency of the data or Center on 
histogram mode to track the location of highest frequency events.  Choose Include lower 
percent to position the region to include events on the low intensity end of the histogram, or 
Include upper percent to include the high intensity events.  Choose Center on region median 
or Center on region mode to track the central tendency of the data within the region, not the 
entire histogram. 
  

X Percent, Y Percent 

If Auto-Position is enabled and the method is Include lower percent, enter the percentile 
value where the top and right sides of the region should be positioned. The left and bottom 
edges will be set at the origin. 
If Auto-Position is enabled and the method is Include upper percent, enter the percentile 
value where the left and bottom edges of the region should be positioned. The top and right 
edges will be set at the upper boundary. 
  

OK 

Click this button to accept changes and close the dialog box. 
  

Cancel 

Click this button to close the dialog box and cancel changes. 
  

Help 

Click this button to display on-line help for this dialog. 



WinList User Guide 

309 

2P Region Context Menu 

  

This menu is displayed by right-clicking a 2P region's label. It provides commands that relate 
to the region. 
  

Edit Properties 

Choose this command to display the Edit Properties dialog for the 2P region. 
  

Create Results 

This command creates a Results window to display statistics for the region. 
  

Highlight events in Rn 

This is a toggle option that can be enabled for one region at a time. When enabled, the 
events that are in the region will be highlighted in all histograms.  Highlighting, by default, 
displays these events larger and blinking. See Region preferences for highlight properties. 
  

Color Rn Only 

This is a toggle command that enables or disables coloring using this region only.  It is a 
convenient way to explore where the events that are in the region appear in all other 
histograms.  Selecting the option once will enable coloring for the region.  Selecting it again 
(or choosing it for another region) will turn off the function. 
  

Show Resize Handles 

Enable this option to show the resizing handles for the 2p region. 

  

Show Vertices 

Enable this option to show the vertices of the 2p region. 

  

Stick to Neighbor Regions 

This command scans the vertices of the region to see if any are overlapping vertices from 
neighboring regions.  For any vertex that overlaps another region's vertex, a linkage is made 
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so that if either vertex is moved, both are moved. Sticky regions make it possible to create a 
set of adjacent regions that maintain adjacency even if you move one region, or a vertex of a 
region. See Sticky Regions and Magic Contours for more info. 

  

Conform to Other Regions 

This command adjusts the vertices of the region so that they do not overlap other 2P regions 
in the histogram. Vertices of this region that are inside of other regions are eliminated, and 
vertices of other regions that are inside of this region are added. 

  

Region Links... 

This command displays the Edit Region Links for the region to allow this region to control the 
size and shape of other regions, and vice versa. 
  

Delete 

This command deletes the region, if it is not locked. 



WinList User Guide 

311 

Edit Properties for Contour Region 

  

This dialog can be displayed by double-clicking the mouse on the label of a Contour region, 
or by right-clicking the label and choosing Edit Properties. 
  

Default properties for regions are set in the dialog found in the Preferences dialog, found in 
the Options menu. 
  

 
  

Elements in the tree 

Region 

Select the region in the tree on the left to edit the properties of the region. 

  

Label 

Choose Label in the tree on the left to edit the font, background color, and transparency for 
the region label. 
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Properties 

Show Name 

Enable this checkbox to display the name of the region. 
  

Show Alias 

Enable this checkbox to display the alias of the region. 

  

Alias 

This edit box allows you to edit the alias of the region. 

  

Show Statistic 

Select a statistic to display in the region label. No statistic, Percent Gated, Percent Total, and 
Region Events are the statistics that can be selected. 
  

Line color 

Click this button to choose a different color for the region. 
  

Line weight 

Select a line weight from the list of options. Larger values are heavier line weights. 
  

Allow delete 

This option determines whether a region can be deleted by the user. When enabled, regions 
can be deleted by clicking on the region label and pressing the Delete key on the keyboard. 
Some regions can also be deleted by dragging them off the left or bottom edge of the 
histogram. Uncheck this option to protect a region from being deleted accidentally. Any 
region can be deleted using the Region List dialog box, even if the Allow delete option is 
disabled. 
  

Contour Region 
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Contour Probability 

This field determines the size of the contour region, with a probability value ranging from 
0.01 (smallest) to 0.99 (largest).  With a larger probability value, more events are included. 
  

Smoothing 

This field controls the smoothness of the contour region, with a larger value creating a 
smoother region. 
  

Show resizing handles 

Enable this option to display resize handles on the region when it is active. Resize handles 
form a bounding rectangle around a region and can be used to adjust size or shape of a 
region. The handles are hidden when the region is not selected. 

  

Auto-positioning 

Auto-position 

Enable this option when you want the region to automatically adjust its position relative to 
data in the histogram. The region will center itself on the X and Y medians or modes, 
depending on the selection in the Auto-position method option below. When you move a 
region with the auto-position property enabled, you offset its auto-position location relative 
to the data. When the data changes in the histogram containing the region, the region will 
adjust its position relative to the new data. 

The auto-position property will be disabled in a few circumstances where it is invalid. When a 
region is used in a self-gate on the histogram in which it resides, the property is disabled. 
Similarly, if a region is a dependent linked region, the property is disabled. 
  

Auto-position method 

This option determines what statistic is used when the auto-positioning is enabled for a 
region. The center of the region is positioned on the specified value. Choose Center on 
histogram median if you want to track the central tendency of the data or Center on 
histogram mode to track the location of highest frequency events.  Choose Include lower 
percent to position the region to include events on the low intensity end of the histogram, or 
Include upper percent to include the high intensity events.  Choose Center on region median 
or Center on region mode to track the central tendency of the data within the region, not the 
entire histogram. 
  

X Percent, Y Percent 
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If Auto-Position is enabled and the method is Include lower percent, enter the percentile 
value where the top and right sides of the region should be positioned. The left and bottom 
edges will be set at the origin. 
If Auto-Position is enabled and the method is Include upper percent, enter the percentile 
value where the left and bottom edges of the region should be positioned. The top and right 
edges will be set at the upper boundary. 
  

OK 

Click this button to accept changes and close the dialog box. 
  

Cancel 

Click this button to close the dialog box and cancel changes. 
  

Help 

Click this button to display on-line help for this dialog. 
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Edit Properties for NStat Region 

  

This dialog can be displayed by double-clicking the mouse on the label of an NStat region, or 
by right-button clicking on the label and choosing Edit Properties. 
  

Default properties for regions are set in the dialog found in the Preferences dialog, found in 
the Options menu. 
  

 
  

Elements in the tree 

Region 

Select the region in the tree on the left to edit the properties of the region. 

  

Label 
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Choose Label in the tree on the left to edit the font, background color, and transparency for 
the region label. 
  

Properties 

NStat label 

This list allows you to choose what to display for the movable region label. Choose from 
Name, Alias, or both Name and alias. 
  

Alias 

This edit box allows you to edit the alias of the region. 
  

Label 

Choose this item in the tree on the left of the dialog to edit the font, background color, and 
transparency for the region label. 
  

Sub region label 

This list allows you to choose what to display for the sub region labels. Choose from Name, 
Alias, or both Name and alias. The sub region label appears in the corner of the subregion 
and is not movable. 

  

Show Statistic 

Select a statistic to display in the region label. No statistic, Percent Gated, Percent Total, and 
Region Events are the statistics that can be selected. 

  

Allow delete 

This option determines whether a region can be deleted by the user. When enabled, regions 
can be deleted by clicking on the region label and pressing the Delete key on the keyboard. 
Some regions can also be deleted by dragging them off the left or bottom edge of the 
histogram. Uncheck this option to protect a region from being deleted accidentally. Any 
region can be deleted using the Region List dialog box, even if the Allow delete option is 
disabled. 

  

Enable gates 
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Enable this option to turn on gates that are associated with each sub region of the NStat. 
Normally, WinList does not turn off N-Stat subregions for gating. If you want to use an N-Stat 
in a gate expression, this option needs to be enabled. 

  

Lines 

Line color 

Click this button to choose a different color for the region. 
  

Line weight 

Select a line weight from the list of options. Larger values are heavier line weights. 
  

Vertices 

Show vertices 

Enable this option to display the individual points that comprise the region. When displayed, 
the vertex points can be moved individually. 
  

Vertex size 

This option determines the size of the region vertices, if they are displayed. 
  
  

Auto-positioning 

Auto-position 

Enable this option when you want the region to automatically adjust its position relative to 
data in the histogram. For NStat regions, the auto-positioning is always performed based on 
an X and Y percentile value that you enter. 
  

X Percent, Y Percent 

If Auto-Position is enabled, enter the X and Y percentile values for positioning the NStat. The 
left-most column of the NStat is positioned at the X Percentile, and the bottommost row is 
positioned at the Y Percentile value. 
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Import partitions 

This option allows region partitions to be imported from file on disk. It is designed to work 
with ModFit LT's capability to export partitions from the Proliferation Wizard. The format of 
the file is tab-delimited ASCII. An example is shown below: 
  

 
  

When the Import option is used to read a partition file, the NStat region boundaries are 
adjusted to match those defined in the partition file. This allows WinList to take advantage of 
a proliferation analysis in ModFit LT, to perform additional analysis on the daughter 
populations and their relationship to other markers. 
  

OK 

Click this button to accept changes and close the dialog box. 
  

Cancel 

Click this button to close the dialog box and cancel changes. 
  

Help 

Click this button to display on-line help for this dialog. 
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NStat Context Menu 

  

This menu is displayed by right-clicking an NStat region label. It provides commands that 
relate to the region. 
  

Edit Properties 

Choose this command to display the Edit Properties dialog for the NStat region. 
  

Create Results 

This command creates a Results window to display statistics for the region. 
  

Show Vertices 

Enable this option to show the vertices of the NStat region. 

  

Region Links... 

This command displays the Edit Region Links for the region to allow this region to control the 
size and shape of other regions, and vice versa. 

  

Delete 

This command deletes the region, if it is not locked. 
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Edit Region Links 

  

The Edit Regions Links dialog box is used to create links between regions. Linked regions 
take on the same shape and position. The link can be bidirectional, where a change in either 
region affects the other. They can also be one-way links. One region can be linked to many 
others. 

A region in one data source can be linked to a region in another, allowing you to set up 
identical gating conditions in both. 
  

 
  

Show regions in data source: 

Select a data source from this dropdown to view/edit the links for its regions. 
  

Select a region: 

In the list on the left, select one region. Once selected, the list on the right fills with 
compatible regions that are or can be linked to the selected region. 
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Select regions to link: 

When a region is selected from the list on the left, this list fills with compatible regions that 
are or can be linked to the selected region. Click a region to select it. Press the Ctrl key and 
click to select more than one region. 

Regions with an asterisk (*) are linked to the selected region.  Regions are not linked until 
one of the link buttons below is clicked. 
  

Only matching parameters: 

With this option enabled, only regions in histograms with identical parameters to the source 
region will be displayed in the list. 
  

One-way link 

 

Click this button to link the region on the left to the regions selected on the right. The link is 
a one-way link, meaning that when the left-hand region is moved or resized, the other 
regions will move and resize accordingly. 
  

Two-way link 

 

Click this button to link the region on the left bidirectionally to the regions selected on the 
right. The links are two-way links, meaning that when either region is moved or resized, the 
other will move and resize accordingly. 
  

Unlink 

 

This push button will unlink the selected regions. 
  

Clear All Links 

This push button will unlink the all regions. 
  

OK 

To put away the Link Regions dialog box, select this push button. 
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Create Region Array 

  
This menu option displays the Create Region Array dialog box, which is used to create one or 
more rectilinear regions. Use this dialog when you want to create a set of regions spanning a 
given range of channels. 
  
The main difference between a region array and an NStat region is that the region array 
creates a set of separate regions. Each region in the region array can be moved 
independently. The NStat is a collection of regions that are always adjacent and can be 
moved as a collection. See Regions and Edit Properties for NStat Region for more about 
NStat regions. 
  
The dialog provides control over the number of regions, starting and ending channels, and 
the spacing between the regions. A result window can be created automatically for the 
regions. 
  

 
  
  

Create a results window 
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Enable this option if you want WinList to create a results window with the statistics for the 
regions created. Clear the check if you do not want a results window. 
  

Number of regions 

Enter the number of regions you want to create in a given direction. For single-parameter 
histograms, enter the number to create on the X-axis. For two-parameter histograms enter 
both X-axis and Y-axis values. 
  

Starting at 

Enter the value where the first region will begin. Values are in the same units shown on the 
axis. 
  

Ending at 

Enter the value where the last region will end. Values are in the same units shown on the 
axis. 
  

Space between 

If you want the regions to be separated, enter a value in this edit box. The value is in units 
representing a percentage of the axis, and the same value is used between all regions. 
  

OK 

Choose this option to create the region or regions defined by the dialog box. 
  

Cancel 

Choose this option to cancel the dialog box without creating any regions or results. 
  

Some of the content of the dialog depends on the properties of the active histogram. If a 2-
parameter histogram is active, options are displayed for X-Axis and Y-Axis as shown above. If 
a 1-parameter histogram is active, only the X-axis options are displayed. In addition, if the 1-
parameter histogram contains an FCOM calculated parameter, a special option is added to 
the dialog. 
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Create a region array for the FCOM peaks 

This option only appears if the active histogram is 1-parameter containing an FCOM 
calculated parameter. It creates a region array for the FCOM histogram, with annotated 
region labels and color event gating options. See FCOM Region Array options for details. 
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FCOM Region Array Options 

  

This dialog is displayed by the Create Region Array dialog to create an array of regions 
specially designed for FCOM calculated parameters. It is only available when the active 
histogram is a 1P-histogram containing an FCOM parameter. 
  

 
  

Color by Gate Hierarchy: 

Enable this option if you want to use the FCOM peaks to color the dots in histogram. Since 
FCOM peaks are discrete phenotypes, it is often very useful to use them for color gating so 
that the populations can be seen in the context of all other histograms. 
  

Gate Colors: 

If you enable color-event gating with the option above, the colors used for each gate can be 
selected with this option. 
  

Gate Aliases 

The FCOM parameter uses gates to create phenotypes. The Gate Aliases edit boxes allow you 
to give the gates more descriptive names. For example, if G1 identifies CD20 positive cells 
and G2 is CD10 positive cells, you might type "CD20" and "CD10" respectively as the gate 
aliases. It is best not to include the "positive" or "negative" in the alias, and short aliases are 
more practical than long ones. 

The program will create region aliases from the gate aliases you enter. Each peak in the 
FCOM histogram will have one region associated with it, and the region's alias will identify 
the phenotype. The region aliases created for the example given above would be: 
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CD20- CD10- 

CD20+ CD10- 

CD20- CD10+ 

CD20+ CD10+ 
  

 
  

Obviously, if the FCOM parameter involves more gates, the need for short aliases becomes 
even greater. 
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Edit Gates 

  

 

  

This command is found on the Home tab of the ribbon bar, or in the Options menu when 
using the toolbar and menu display. 

  

This dialog manages gates for one data source. You can redefine gates, change colors, 
assign them to histograms, save and open them from disk. 
  

 
  

Applies to 

The data source that this gate dialog relates to is shown here. 
  

Equation 
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This field contains the gating expression. See Writing a gate containing a Boolean 
region expression below for a detailed explanation. 
  

And, Or, and Not Buttons 

These buttons aid in the writing of Boolean equations. If you push the And button, a & will 
be inserted at the current location in the Equation edit box. The Or button inserts the | 
character and the Not button inserts the ! character. 
  

Alias 

Each gate can have an alias. The alias is the name that appears when the gate is shown in 
other locations in the program. 
  

Activation 

This field controls how WinList activates the gate. 

"Enable automatically" will turn the gate on when all of the regions referenced by the 
Equation have been created. The gate will be disabled if any of the regions are missing. 

"Always enabled" causes the gate to remain enabled even if some of the regions in its 
Equation are missing. 
  

Gate List box 

The gate name, equation, activation, and color assignment are shown in this list box. The 
number of gates is set in the Edit Program Controls dialog box. 

Click an entry in the list to select the gate for editing. 

Click the color swatch to select a new color for the gate. Double-clicking the gate will toggle 
it between "Enable automatically" and "Always enabled". 

To assign a gate to one or more histograms, select the gate in the listbox and click the 
histogram title bars. 
  

Enable cascade gating to create and adjust gates 

This check box turns the Cascade Gate system on and off. When Cascade Gating is on, gate 
expressions are automatically adjusted based on the gates that are applied to different 
histograms and the regions in those histograms. 
  

Color 
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Selects a color for the selected gate. 
  

Reset All 

This option puts the system in its default condition where all gates are off and are associated 
with R1, R2, ... Rn respectively. 
  

Open 

This option retrieves the contents of the gate list from disk. 
  

Save 

The contents of the gate list box can be saved to disk when this option is selected. This 
option may be useful if you have created a number of complex gates and you don't want to 
waste time re-creating them each time. It is important to realize that this option does not 
save the regions themselves (see Region List) and it does not save the actual absolute colors 
(see Show/Edit Palette). 
  

Cancel 

The Cancel button allows you to exit with no changes. 
  

OK 

Click OK to accept the changes you have made. 
  

Apply 

This button acts like the OK button, except that the dialog remains open. 
  

Writing a gate containing a Boolean region expression 

Normally when working with the gates, each gate is assigned a single region. For example, 
gate 1 or G1 is assigned to region 1 or R1. This initial setup can be changed extensively to 
better serve your gating needs. When a histogram is assigned a gate, say G1, and that gate 
is associated with R1 and the gate is active, the program will only allow those events that are 
inside R1 to be displayed in the gated histograms. 
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While this system allows some powerful gating, you can perform much more complex 
analytical gating. For example, if you wanted a histogram to be gated on two regions, say R1 
and R2, and you wanted the histogram associated with this gate to have access to events 
that satisfy both regions, you could create a gate associated with the expression R1 & R2. 
The & symbol tells WinList to look only at events that satisfy both R1 AND R2. Click the And 
button to insert the & symbol in an expression. 
  

The Boolean expression can be quite complex and may involve several regions. If you 
wanted to look at events that satisfy either R1 or R2, you would click the Or button. The 
expression would be written as R1 | R2. 
  

Occasionally it is important to look at events that are NOT within a particular region. To do 
this we use the ! operator. For example, to look at events that are not in R1, one would write 
!R1. 
  

The gate expression can be made much more complex if needed by nested parentheses. For 
example, the gate expression 
  

 !(R1&R2) | R3 

is true for events that do not satisfy both R1 and R2 or that satisfy R3. As you can see, these 
Boolean expressions can be quite powerful. A typical use of complex gates is to find rare 
events that satisfy a number of gating criteria. You can create a gate such as R1&R2&R3&R4 
and turn on event coloring just for this gate. The events that satisfy all these regions will be 
highlighted by the gate color. 
  

You can also use other gates in your gate expressions (as long as they do not create circular 
references). This is a convenient way to make your gate expressions more readable. For 
example, suppose that gate G1 is defined as (R1&R2)&!(R3&R4). We can use G1 as a 
shorthand for the expression in other gates: 
  

G2 = G1 & R6 

  

which expands to 
  

((R1&R2)&!(R3&R4)) & R6 

  

when it is evaluated. 
  
In summary, WinList's Boolean operators include & (AND), | (OR), and ! (NOT). The 
operands are the regions defined as R1, R2, ... Rn. The steps to create a more complex 
gate expression are to first choose the gate that needs to be redefined, then to write the 
Boolean expression in the edit box, and finally to press the Replace button. To assign that 
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gate to a particular histogram, click the histogram's title bar with the gate you want selected 
in the Edit Gates dialog box. When the OK button is selected, the new gate will be applied 
to all the gated histogram. You can save the gates at any time for future use by using the 
Save option. 
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Gate Statistics 

  

The Gate Statistics window can be display for each data source. It contains a list of the active 
gates arranged by hierarchy, along with statistics for each gate.  The gate Alias is used to 
identify the gates. 
  

 
  

The window can be displayed by right-clicking the data source and selecting Gate Statistics 
from the Data Source Context menu. 

  

The content of the Gate Statistics window can be edited with the Edit Properties for Gate 
Statistics dialog. 
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Edit Properties for Gate Statistics 

  

This dialog controls the content of the Gate Statistics window. 

  

 

  

Auto-size 

Enable this option to auto-size the Gate Statistics window to fit the content. 

  

Ledger style 

When this option is enabled, the Gate Statistics window uses alternating white and gray 
background for each line. 

  

Statistics 

#Events 

Displays the number of events in the gates. 
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%Total 

Displays number of events as a percentage of total events in the gate. 

  

%GrandParent 

Displays number of events as a percentage of the grandparent gate. 

  

%Parent 

Displays number of events as a percentage of the parent gate. 

  

Parameter Stats 

This button displays the Edit Parameter Stats dialog, which allows selection of parameters 
statistics to be computed for each gate. 

  

Additional Options 

Equation 

Displays the gate equation in the Gate Statistics window. 

  

Unclassified 

Displays "Unclassified" statistics for each level of the gate hierarchy. Unclassified events are 
those that do not belong in any gate at that level. 

  

Overlapped 

Displays "Overlapped" statistics for each level of the gate hierarchy. Overlapped events are 
those that belong to more than one gate at that level. 
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Edit Parameter Stats 

  

This dialog is displayed from the Edit Properties for Gate Statistics dialog. 

  

 

  

This dialog is used to select parameter statistics to be computed for each gate. It provides an 
easy method to collect parameter intensity statistics for gates without having to create 
histograms. 

  

Any number of parameter statistics can be selected.  The statistics are computed for every 
active gate and displayed in the Gate Statistics window. Stats are also available to be 
databased and added to reports. 

  

Parameters 

Lists the parameter for the current data file.  Select one or more parameters for which you 
want to compute a gate statistic. 

  

Statistics 

Select the statistic that you want to compute for the selected items in the Parameters 
list.  Available statistics are mean, median, SD, and CV%. 

  

Parameter Stats List 



WinList User Guide 

337 

This list shows the parameter stats that have been added. 

  

Add to List -> 

When this button is clicked, the current Statistics selection is added for each of the 
parameters selected in the Parameters list to the Parameter Stats List. 

  

Remove from List 

Use this button to remove the selected items in the Parameter Stats List. 

  

OK 

Closes the dialog and stores the changes. 

  

Cancel 

Closes the dialog and discards any changes. 
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Palette 

  

 
  
This command is found on the Options tab of the ribbon bar, or in the Options menu when 
using the toolbar and menu display. 
  
The Edit Palette dialog box is used to display and edit the colors used by gates, 
background, and axes. 
  

 
  

View inverse palette 
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Enable inverse palette mode. 
  

Brightness 

Select the brightness level to use for generating palette colors. After selecting a level, use the 
Reset colors button to regenerate the palette. 
  

Reset colors 

Regenerate the colors in the palette. 
  

Background color 

The color used for background of histograms, results, etc. Click the button to select a 
different color. 
  

Axis color 

The color used for drawing the axis and tics. Click the button to select a different color. 
  

Gate colors 

A set of colors used for gates. Click the button to select a different color. 
  

Open 

Open a palette file from disk. 
  

Save 

Save a palette file to disk. 
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Inverse Palette 

  

This option is found in the View tab of the ribbon bar, or the View menu when using toolbar 
and menu. 

  

Inverse Palette is a great visualization aid. When you select this command, histograms and 
result windows switch the foreground and background colors - effectively inverting the color 
palette. You can quickly switch between white and black background, which is often used to 
enhance the small, outlier populations. 
  

Normal palette Inverse palette 

 
 

  
  

Preferences determine whether the inverse palette mode is used by reports, for printing, and 
when copying to the clipboard. 
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Color Modes 

  

 

  

The Home tab of the ribbon bar includes a drop-down control that allows you to select 
different coloring modes for WinList. Color modes mostly affect 2P histograms that are 
display Dots, but also have an impact on 1P and 3P histograms. 

Four color modes are available: 
  

Color by Gate Hierarchy 

This is the default coloring mode. In this mode, dots are assigned the color of the last gate in 
the gate hierarchy that they belong to. Typically, this means that the dot color is the color of 
the most refined subset. See Edit Color by Gate Hierarchy for additional details. 
  

Color by Histogram Gate 

In this mode, dots are assigned the color of the gate that is applied to the histogram. This 
mode makes it easy to see how a histogram has been gated. 
  

Color by Gate Combinations 

Similar to Color by Gate Hierarchy, this mode adds colors of the gates that classify the dots. 
It creates new colors for events that fall into more than one gate. This mode works well 
when only a few gates are used and there is not much overlap between them. See Edit Color 
by Gate Combinations for details. 
  

Color by Parameter Value 

In this mode, one parameter is selected to be used to color dots. The intensity of that 
parameter for each event determines the color of dots representing that event. It effectively 
adds information from a third parameter to every 2P histogram. See Edit Color by Parameter 
Value for details. 
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Edit Color by Gate Hierarchy 

  

 

  

The Home tab of the ribbon bar includes a drop-down control that allows you to select 
different coloring modes for WinList. In this coloring mode, dots are assigned the color of the 
last gate in the gate hierarchy that they belong to. Typically, this means that the dot color is 
the color of the most refined subset. 
  

 
  

The gate hierarchy is displayed in a list, with a color for each gate shown. 

To change the color of a gate, click the color swatch next to it. The palette of colors is 
displayed, including an "X". Selecting "X" will disable coloring for that gate. 

Use the Save and Open buttons to store and recall customized color sets. 
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Edit Color by Gate Combinations 

  

 

  

The Home tab of the ribbon bar includes a drop-down control that allows you to select 
different coloring modes for WinList.  In this mode, an event is colored based on all of the 
gates that it belongs to. So if an event belongs to more than one gate, a new color is created 
for the gate combination. This mode works well when only a few gates are used and there is 
not much overlap between them 
  

 
  

Active gates appear in the Available Gate list. They can be included for coloring by using the 
Add button. Once a gate is added, click the color swatch next to the gate to choose color for 
it. 

The Customize Color Combinations button allows further control over the color used for 
overlapping gates. 
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Customize Color Combinations 

  

This dialog box provides full control of the coloring of dots in 2P and 3P histograms when 
using Color by Gate Combinations. You can choose a color for each cluster created by the 
color gates. 
  

For example, with gates G1 and G2 enabled for Gate Combinations mode, there are 4 
clusters created: G1- G2-, G1- G2+, G1+ G2-, and G1+ G2+. Each cluster represents a 
unique set of events. This dialog provides a way of viewing and editing the color of each of 
these clusters. 
  

 
  

Search 

This control allows you to search for the phenotype of the gate combination. As you type the 
combination (e.g. G1+G2-), the matching entry is selected in the list 
  

Combination List 

This list displays all gate combinations for the selected gates. Click the color swatch next to a 
list item to change its color. 
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OK 

Click this button to accept changes and close the dialog box. 
  

Cancel 

Click this button to cancel the changes and close the dialog box. 
  

Reset All 

Click this button to restore cluster colors to the default settings and close the dialog. 
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Edit Color by Parameter Value 

  

 

  

The Home tab of the ribbon bar includes a drop-down control that allows you to select 
different coloring modes for WinList.  In this mode, one parameter is selected to be used to 
color dots. The intensity of that parameter for each event determines the color of dots 
representing that event. It effectively adds information from a third parameter to every 2P 
histogram. 
  

 

  

In the example below, CD20 was selected as the parameter, with dark blue representing low 
CD20 transitioning to red for high CD20.  We have set the starting point for the transition at 
channel 100, so anything below 100 will be dark blue. The ending point for the transition to 
red is at 100,000, so anything above that will be red. Note that the coloring appears in the 
CD10 vs CD34 plot to help identify the low and high intensity CD20 events. 
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Select a parameter from the Parameters list. The intensity of the selected parameter will be 
used to color the dot for each event. 

Choose the number of color levels with the Colors control. 

Colors can be changed by clicking the color swatch for an entry in the Colors list. 

Select Gradient Colors to use a 2-color gradient, or Palette Colors to select a specific set 
of colors to use. 

Edit the Starting at value to set the channel where the transition begins. Any events below 
this value will be colored with the first color. 

Edit the Ending at value to set the change where the transition ends.  Any events above this 
value will be colored with the last color. 
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Results Windows 

  

 

  

To create a results window, click the Results button on the Home tab of the ribbon bar.  If 
WinList is set up to use a menu and toolbar, choose Results from the Create menu. 

  

Results windows display statistics for regions and are displayed on top of histogram and data 
source windows. They can be positioned in any convenient location, including outside of the 
confines of the main window. 

  

 A new, results window will appear and the Edit Results dialog will be displayed to allow 
selection of regions and statistics. 
  

 
  

A single results window can display information for any number of regions simultaneously. 
Users can choose which statistics appear and whether they are column- or row-oriented 
using the Edit Results dialog box. 
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Results Context Menu 

  

This menu is displayed when the right-mouse button is clicked on a results window. It 
displays a list of common commands related to results windows. 

  

 
  
  

Copy 

Copy the results in tab-delimited text format to the clipboard. The text can then be pasted 
into a report or another application. 
  

Copy (no header) 

This command is similar to Copy, except that the column names for the results are omitted. 
  

Edit 

Display the Edit Results dialog. 
  

Save 

Use this command to save the results as a text file on disk.  The standard Save dialog is 
displayed.. 
  

Print 

Use this command to print the results window to the current printer. 

  

Database Wizard 
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This command initiates a wizard that simplifies the task of adding statistics from a Results 
window or the Gate Statistics window to a database. See Database Wizard for details. 
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Create Results 

  

Results windows are used to display statistics for one or more regions. It most cases, the 
results relate to a single data source and file. However, you can add results from any data 
source to a Results window. 
  

To create a results window, choose the Create Results menu option. The Edit Results 
dialog box appears, enabling you to calculate and display one or more region's results in a 
window. The function of each item in this dialog box is described in the Edit Results dialog 
box. 
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Edit Results 

  

This dialog box appears when creating or editing a results window. It allows the user to 
choose what statistics will be displayed and for which regions. You can also establish remote 
links with other programs through this dialog box. 
  

One of the important concepts relating to WinList's results has to do with the sampling of 
events involved with the calculations. Normally, WinList uses a sample of the data, called a 
packet, for performing calculations and displaying statistical and graphical information. The 
number of events in the sample packet is set in Edit Program Controls. As the packet size 
increases, so does the number of events evaluated by WinList. 
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If you want to see statistics for the entire data file, you need to use one of the options in the 
Replay menu to re-read the data, or click the Replay Data Source button on the Toolbar. 
  

Name 

The ID and name of the Results window are shown. An edit box displays an editable name 
up to 250 characters long. The name can include FCS Keywords, in which case WinList will 
extract the keyword values from the data file for display as the results window's name. See 
Appendix B: Internal Keywords for more information. 
  

Show regions in data source: 

This dropdown contains a list of all data source windows. Select a data source from the list to 
see the regions that have been created in that data source. Then select the regions you want 
to appear in this Results window. 

You can select regions from any number of data sources to be included in the results 
window. 
  

Region list 

This list displays the regions that are created in the selected data source. Select the region 
you want to include in this results window. 
  

Fields 

ID Field 1 and 2 

If ID Field1 or ID Field2 check boxes are checked, WinList displays the contents of the edit 
boxes next to these check boxes at the top of the results window. If the content of the edit 
box is braced by square brackets (e.g. [$SAMPLE]), WinList will search the keywords of the 
current file for a match. If it finds a matching keyword, the value of the keyword will be 
displayed within the results window. This option is handy to identify file-specific information 
about the current data source. 
  
Data Source Alias 

When this field is checked, the name of the data source window will appear to the left of 
each region in the result window. This is useful when one results window is used to display 
results from several data sources. 

  

Total Events 
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This option displays the total number of events currently used by WinList. This number is 
normally Packet Size number of events or the number of events in the data file. In order for 
WinList to display and analyze the total number of events in the data file, replay the data 
using one of the options in the Replay menu whenever you want to update the statistics. For 
more information on Packet Size, see Edit Program Controls. 
  
Gated Events 

This option displays the number of events that passed through the gate assigned to the 
histogram containing the region. If there is no gate, this number will equal Total Events. 
See the discussion of Total Events above for the effect of Packet Size on the number of 
events considered. 
  
Region Events 

This option displays the number of events that fall within the region. See the discussion of 
Total Events above for the effect of Packet Size on the number of events considered. 
  
Region Alias 

This option displays the region's alias name for each region in the results window. Region 
alias names can be edited in the Region List dialog box. 
  
Percent Total 

This option displays the number of events within the region as a percentage of Total 
Events. See the discussion of Total Events above for the effect of Packet Size on the number 
of events considered. 
  
Percent Gated 

This option displays the number of events within the region as a percentage of Gated 
Events. See the discussion of Total Events above for the effect of Packet Size on the number 
of events considered. 
  
% Select Gate 

This option has two elements: a checkbox to enable or disable it, and a drop-down list of all 
active gates. Similar in concept to Percent Gated, this option allows you to choose any gate 
on which to compute percentages for the regions in the results window. Since this statistic 
can be selected for regions that do not have an obvious relationship to the selected gate, it is 
important to understand how this computation is performed. 
  

If the region represents a child gate of the selected Gate in the gating hierarchy, the statistic 
is very simple.  It is the number of events in the region, multiplied by 100 and divided by the 
number of events in the selected Gate.  This is the typical case. 
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However, if the region is not a child gate of the selected gate, the statistic is a little more 
complicated.  The numerator of this statistic is the number of events in the region. The 
denominator is the number of events in the selected Gate, which may not be the same as the 
number of events in the region associated with the selected Gate. 
  

 
  

If the region whose results are being computed is contained in a data source that does not 
own the gate in % Select Gate, the statistic will show 0.00 regardless of the number of 
events in the region or in the gate. 
  
  
Mean X and Mean Y 

This option displays the X and Y arithmetic mean for the selected regions. The units reported 
are linearized units. The computation will be slightly different for log parameters when the 
Use Geometric Mean option is toggled on or off.  
  
Median X and Median Y 

This option displays the X and Y median for the selected regions. The units reported are 
linearized units. 
  
Median ADC X and Median ADC Y 

This option displays the X and Y median in ADC units. 
  
Mode X and Mode Y 

This option displays the X and Y mode for the selected regions. The units reported are 
linearized units. 
  
StdDevX and StdDevY 
This option displays the X and Y standard deviation for the selected regions. The units 
reported are linearized units. 
  
CVX and CVY 
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This option displays the X and Y percent coefficient of variation (CV) for the selected regions. 
  

LowHighX and LowHighY 

This option displays the low and high X and Y values for the selected regions. The units 
reported are linearized units. 
  
CC 
This option displays the correlation coefficient for the selected regions. 
  
Use Geometric Mean 

If a parameter is displayed on a log scale, this option controls whether the mean value is an 
arithmetic or geometric mean. A geometric mean calculates the arithmetic mean of the log 
data, and then linearizes the result. With the option unchecked, the mean is computed on 
linearized data. 
  
Use Robust SD 

The Robust SD is a variation on the SD calculation that is less influenced by outlier events. 
When enabled, the SD and CV computations use the Interquartile Range method for the 
computation. This is equivalent to BD Biosciences' rSD and %rCV computation. 

  

Other options 

Fields in Columns 

When checked, the results window will display statistics, or fields, in columns. Each row will 
represent a different region. If unchecked, regions are in columns, and a different statistic 
appears in each row. 
  
Auto Sizing 

If this option is checked, WinList will automatically calculate the size that the results window 
needs to be in order to display the selected statistics and re-size the window as necessary. If 
the option is not checked, WinList will not adjust the results window's size. 
  

Save Preference 

Click this button to keep the current settings as default settings for all results windows. 
  

Remote checkbox 

This check box, in conjunction with the Edit Remote button, allows WinList to establish a 
Dynamic Data Exchange (DDE) link with another Windows application. If checked, the Edit 
Remote button is enabled. 

https://en.wikipedia.org/wiki/Interquartile_range
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Edit Remote 

Click this button to establish a remote link with another application, or to edit the script used 
for that connection. See Edit Remote for more details on Remote links and DDE. 
  

OK 

Click this button to accept all changes and close the dialog box. 
  

Cancel 

Click this button to exit the dialog box with no changes. 
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Database Wizard 

  

This command simplifies the task of adding the statistics from a Results window or the Gate 
Statistics window to a database. 
  

To use the command, first activate a Results window or Gate Statistics window by clicking its 
title bar. Then, right-click the window to display its context menu and choose Database 
Wizard. A wizard dialog appears. 

  

 

  

Click Next to display the next pane in the wizard. 
  

 
  

In this pane, select a database to which you want to add statistics. Additional options allow 
you to display and activate the database when the wizard finishes. 
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Click Next to display the next pane in the wizard. 
  

 
  

This pane provides options related to how the new fields are added to the database. Options 
allow you to replace any fields that are already there, or to append new fields. In addition, 
you can choose whether to remove any records that are already in the database or keep 
them. 
  

Click Finish to complete the wizard. 
  

See also: 

Databasing with WinList 

Edit Properties for Database 
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Overlay Windows 

  

 

  

To create a new overlay window, click the Overlay button on the Home tab of the ribbon 
bar.  If you are set up to use a menu and toolbar instead, choose Overlay from the Create 
menu.   

  

Overlay windows are a great tool for graphically comparing a set of 1P or 2P plots.  You can 
set up different views and select a wide variety of graphical options.  Overlays organize plots 
- typically from different files - so that you can easily see the similarities and differences 
among them. 

  

A new, empty overlay window will appear. 
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To add a plot to an overlay, drag a histogram by the icon on the left side of its toolbar and 
drop it onto the overlay.  The first plot that is added to an overlay determines whether it is a 
1P or 2P overlay window.  It also determines the axes that will be displayed.  If you 
subsequently add a plot with different parameters than the first plot, the overlay will ask if 
you really intend to do so. 

  

To remove a plot from an overlay, click the item in the legend to select it.  Then, right-click 
and choose Delete Item from the context menu. 

  



Overlay Windows 

362 

To change the order of items in the overlay, click the item that you want to move in the 
legend, and then drag the item to the desired order in the legend.  When the mouse is 
released, the overlay will redraw with items in the new order. 

  

To edit the properties of the overlay or overlay items, right-click the overlay and choose Edit 
from the context menu.  The Edit Overlay dialog will be displayed.  This is where you can 
choose the kind of overlay you want and set the graphical properties. 
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Overlay Context Menu 

  

The overlay context menu is displayed when the right mouse button is clicked on an overlay 
window.   

  

 

  

If an item is selected in the legend and that item is right-clicked, an additional entry appears 
in the menu allowing the selected item to be deleted. 

  

 

  

Copy 

This command copies an image of the overlay to the clipboard in bitmap and picture 
(metafile) formats.  The image can be pasted into other applications. 

  

Edit 

This command displays the Edit Overlay dialog to set the display properties for the overlay. 

  

Add to report 
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This command adds the overlay to a report.  The report item is actively linked to the overlay 
so that as changes are made to the overlay, they automatically appear in the report. 

  

Save 

This command allows the overlay to be saved to disk in a number of popular graphics file 
formats.   

  

Print 

This command prints the overlay to the active printer. 

  

Delete Item 

This command deletes a selected item from the overlay. 
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Edit Overlay 

  

This dialog determines the display properties for an overlay window.  It is accessed by 
double-clicking an overlay title bar, or by right-clicking the overlay and choosing Edit from 
the context menu. 

  

The options shown in the dialog differ, depending on whether the overlay is for 1P or 2P 
plots.  The image below shows the 2P overlay dialog. 

  

 

  

Overlay Properties 

View 

There are 4 viewing modes for overlay windows. 
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Offset 

 

Offset overlapped 

 

Left-to-right 
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Overlaid 

 

  

  

X Label 

This is the label that appears on the X axis of the overlay. 

  

Y Label 

This is the label that appears on the Y axis of the overlay. 

  

1P Overlay Properties 

Filled Histograms 

Enable this option to draw 1P histograms filled with the selected color.  Disable the option to 
draw 1P histograms with no fill. 

  

Y Scale 

Choose Absolute or Normalized.  In Absolute scaling mode, each 1P histogram in the 
overlay is drawn to its actual height, and the Y axis scale of the overlay is based on the 
tallest histogram in the overlay.  In Normalized scaling, each 1P histogram is drawn to 100% 
of its own scale - they will all appear to have the same height - and the Y axis switches to 
show a 0 to 100 scale.  Normalized scaling is useful when you are more interested in the 
intensity shifts of the overlay items rather than the actual areas. 

  

Absolute Normalized 
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Transparency 

This value determines the transparency of the plots.  A value of 0 makes the plots completely 
transparent; a value of 255 makes the plots opaque. 

  

Line Weight 

Select a line weight for the outline of the 1P plot. 

  

2P Overlay Properties 

Display 

The 2P overlay can display Dots or Contours for the plots.  Contours will draw faster and 
are somewhat easier to interpret.   

  

2P Contour Properties 
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These properties are used when Contours is the selected Display option.  The color assigned 
to each item in the overlay is used as the base color for the contours.  Colors transition to 
white for the highest contour. 

  

Probability interval 

This option determines the number of contours that will be drawn, based on the separation 
between them. 

  

Base contour 

This option determines the probability for the lowest contour. 

  

Fill contours 

Enable this option to fill the contours with color.  Disable the option to draw unfilled contours. 

  

Smooth 

Enable this option to smooth the contours.   

  

Smoothing span 

With Smooth enabled, this setting controls how much smoothing is applied.  Higher values 
create smoother contours, but show less detail. 

  

Transparency 

This value determines the transparency of the contours.  A value of 0 makes the plots 
completely transparent; a value of 255 makes the plots opaque. 

  

Line Weight 

Select a line weight for the outline of the contours. 

  

2P Dot Properties 
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These properties are used when Dots is the selected Display option.  The color assigned to 
each item in the overlay is used for the dots. 

  

Dot size 

Select a size for the dots. 

  

Number 

Select the number of dots to display for each overlay item. 

  

Regions 

These properties determine whether regions are included in the overlay. 

  

Show regions 

Enable this option to show the regions for the overlay items. 

  

Region line weight 

Select the line weight for regions. 

  

Region color 

Select the color to use for the region line. 

  

  

Fonts 

Legend font 

Select a font to use for the legend. 

  

Label font 
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Select a font to use for the axis labels. 

  

Number font 

Select a font to use for the numbers on the axes. 

  

Region font 

Select a font to use for the region labels in the plots. 

  

Display Options 

Show legend 

Enable this option to display the legend with colors and item names on the overlay.  The 
legend appears at the bottom of the overlay window.  It is also used to re-order items in the 
overlay. 

  

Show X axis 

Enable this option to display the X axis. 

  

Show Y axis 

Enable this option to display the Y axis. 

  

Show grid 

Enable this option to show a grid based on the major tics of the axes. 

  

X-axis size, Y-axis size 

These options are only used for Left-to-right viewing mode.  They control how much of the 
width or height of the plot area is used by the axis.  By default, these are 80% (0.80).  You 
can manually edit these values to change the perspective in Left-to-right viewing mode.  You 
can also edit these directly on the Left-to-right overlay window by moving the small handles 
at the right side of the plot. 
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Edit Properties for Overlay Item 

  

This dialog determines the display properties for an item in an overlay window.  It is 
accessed by double-clicking an overlay title bar, or by right-clicking the overlay and choosing 
Edit from the context menu.  Select the item you want to edit from the tree on the left of the 
dialog. 

  

 

  

The first entry in the property list shows the source FCS file and the parameter(s) that the 
plot is displaying.  These are not editable; they are determined at the time the item is added 
to the overlay. 

  

Label 

This field shows the label that appears on the legend for the item.  It can be edited. 

  

Color 

Select the color to associate with the item.  This color appears on the legend, and is used to 
draw the item.  If the item is a 1P plot, the selected color determines the line and fill 
color.  For 2P plots showing contours, the color is used as the base contour color, 
transitioning to white at the highest contour.  The color is used to draw dots in dot plots. 

  

Fill contours 
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2P overlays only: this determines whether contours will be filled for this item. 

  

Transparency 

Sets the transparency level for the item, with 0=transparent and 255=opaque. 

  

Line weight 

Sets the weight of lines in this item. 

  

Dot size 

2P overlays only: this determines how large dots are for 2P items.. 

  

Line style 

1P overlays only: this determines the style of the line used to outline 1P plots. 

  

Source 

This entry is not editable.  It displays the histogram and data source IDs that this item is 
associated with. 

  

Update when histogram changes 

Enable this option if you want the overlay item to update in the overlay when the source 
histogram changes. 
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MultiGraph Windows 

  

 

  

To create a MultiGraph window, click the MultiGraph button on the Home tab of the ribbon 
bar.  If you are set up to use a menu and toolbar instead, choose MultiGraph from the Create 
menu.  The Edit MultiGraph dialog will be displayed. 

  

These windows allow you to display multiple histograms and results.  The items in a 
MultiGraph are static - they do not change when a new file is opened or a gate is changed. 
MultiGraphs can display a mix of single, dual, and three parameter histograms and results in 
several different views. Additionally, MultiGraphs can be saved to disk, opened from disk, and 
added to at any time. They can also be exported in PDF format. 
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MultiGraph graphic elements are stored in Windows "metafile" format, also called "picture" 
format. Results window information is stored as text. Each element is like a picture snap-
shot: once added, an element in a MultiGraph does not change even if the histogram it 
represents changes. 
  

If a MultiGraph is in Tiled mode, you can move its elements by clicking the left mouse button 
on the item to move, holding the button down, and dragging the element to a new location 
in the MultiGraph. When you release the button, the MultiGraph will be re-drawn with the 
elements in their new locations. 
  

The MultiGraph context menu is displayed when you click the right mouse button on a 
MultiGraph. Options appearing in the menu allow you to copy or delete a single element or 
the entire MultiGraph, edit the MultiGraph, print the MultiGraph, and more. 

  

To edit a MultiGraph, double-click the title bar. 
  

To configure the default characteristics of MultiGraphs, use the Preferences command in the 
Options menu. 
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MultiGraph Context Menu 

  

This context menu is displayed when the right mouse button is clicked on a MultiGraph 
window.   

  

 

  

Copy Element 

This command appears in Tiled view.  It copies the selected MultiGraph item to the clipboard 
as a graphic or text object. 

  

Delete Element 

This command appears in Tiled view.  It removes the selected item from the MultiGraph. 

  

Copy 

This command copies the MultiGraph to the clipboard in graphic format. 

  

Edit 

This command displays the Edit MultiGraph dialog to edit the elements and the style of the 
MultiGraph. 

  

Save Graphic 

This command displays the Save As dialog to save the MultiGraph to disk in one of several 
popular graphic formats. 



WinList User Guide 

379 

  

Export to PDF 

This command displays the Save As dialog to export the MultiGraph to disk in PDF format. 

  

Print 

This command prints the MultiGraph to the current printer. 

  

Clear 

This command clears all elements from the MultiGraph, leaving an empty MultiGraph window. 
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Edit MultiGraph 

  

A MultiGraph is a window that can display multiple histograms and results windows in 
various arrangements. The histograms can be from different data sources, and they can be a 
mix of 1, 2, and 3 parameter. MultiGraphs can be saved to disk, reopened and new 
histograms and results windows can be added to them, making them useful for archival 
storage. Each histogram in the MultiGraph may have a label assigned to it which can be 
positioned anywhere in the MultiGraph window. You can choose from several different views 
of the histograms, and change the views easily. See Create MultiGraph for more 
information. 
  
To display this dialog, choose Edit from the MultiGraph context menu or double-click the 
MultiGraph's title bar. 
  

 
  

  

Name 

Enter a name for the MultiGraph window. You can enter text, or type a keyword enclosed in 
square brackets. 
  

Available Items 
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Displays a list of all histograms in all data sources currently opened in WinList, as well as the 
results windows. This is a multiple selection list box, so you can select the name of the 
histograms and results windows you want, drag the mouse in the list box to select a range, 
then click the Add button to add those histograms to the Selected Items list. An additional 
entry, BLANK, allows you to insert a placeholder with no graphic. This can be useful if you 
have a wide results window and want to allow it more room on the MultiGraph in a tiled view. 
  

MultiGraph Items 

Displays a list of histograms existing in the MultiGraph and those you want to add to it. It is a 
multiple select list box. You can click the left mouse button and multiple select the 
histograms you want to remove or edit. The first three characters in each entry of this list 
indicate the states of the Axes and Regions check boxes. The MultiGraph entries will 
include or exclude the X and Y-axes, and any regions that are within the histograms based 
on these characters. For example, if an entry in Selected Histograms starts with A-R, axes 
and regions will be included in the MultiGraph. 
  

Add 

This button copies the histograms currently selected in the Available Items list box into the 
MultiGraph Items list box. As histograms are added, the state of the check boxes Axes 
and Regions is also copied for each item added. 
  

Remove 

This button deletes the highlighted items from the MultiGraph Items list box and 
subsequently from the MultiGraph. 
  

Insert 

Use this button to add items from the Available Items list box in front of the currently 
selected item in the MultiGraph Items list box. 
  

Axes, Regions 

These check boxes determine whether x and y axes, and regions will be displayed for items 
as they are added to the MultiGraph Items list box. If Axes is checked, the letter A will 
appear as the first character in the MultiGraph Items entry. If it is not checked, a hyphen 
(-) will appear. Similarly, R will appear for regions. Once the OK button is clicked, these 
options become permanent for the selected histograms. 
  

Viewing Options 
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Radio buttons allow you to select from several viewing arrangements: Left to Right, which 
stacks the histograms from the upper left to the lower right, Right to Left, which stacks 
from upper right to lower left, Overlay, which allows histograms to be superimposed on one 
another, and Tiled, which provides a row-column arrangement. If you select Tiled, the Col 
and Rows edit boxes allow you to control the row-column arrangement. Setting Rows to 0 
will fit all elements of the MultiGraph onto one page. Setting Rows to a positive number will 
display a maximum of that many rows per page, in some cases creating a multiple page 
printout. For Left to Right and Right to Left, the edit box Grids allows you to lay down 
evenly spaced grid lines connecting the bases of the histograms. 
  

Label 

This group of controls allows you to enter a label for each item and to determine its size and 
position on the MultiGraph. The label may include up to 80 characters of text. 

Labels can include any FCS keywords embedded in the data file and internal WinList 
keywords. Keywords must be surrounded by square brackets []. Keywords are only evaluated 
at the time the elements are created. 

See Internal Keywords for more on keywords. 

Examples of labels: 

[HISTOGRAM] [GATE] [DATE] 

 displays name of the histogram, the gating information, and today's date 

[FILE] contains [R('3,PERCENT')] percent positives 

 displays the name of the file and the percent of region R3. 

[$SAMPLE] [$PROJ] 

 displays the FCS keyword values for $SAMPLE and $PROJ. 
  

Label position and width 

The X and Y positions and the width can be entered in these edit boxes. The numbers are in 
percentage of the windows where 0 percent x and y is the lower left corner of the window, 
and 100 percent x and y is the upper right. X and Y positions determine the origin of the 
label. The width, again in percent, determines how wide the label can extend. Usually, the 
width and the x position values should not add up to more than 100 or the label will spill out 
of that histogram's portion of the MultiGraph. 
  

Save and Open 

These push buttons allow you to save MultiGraphs to disk, or reopen existing MultiGraphs. 
Opening a MultiGraph from disk will replace any histograms in the current MultiGraph. 
  

OK 
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Click OK when you've made your changes and selections and the new MultiGraph elements 
will be generated. The amount of time to generate a MultiGraph depends on how many 
elements you have selected and how complicated each one is. 
  

Cancel 

The Cancel button allows you to undo the changes you have made. In some cases it is 
grayed out, indicated that you cannot cancel the operation. This occurs if you are editing an 
existing MultiGraph and you remove one or more of the histograms from the Selected 
Items list box. Removing existing items is not a recoverable operation. 
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Open MultiGraph 

  

This command displays the File Open dialog to select a MultiGraph from disk.  It is found in 
the File (Application) menu of the Ribbon bar. 
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Export MultiGraph Graphics 

  

 

  

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu. 

  

This menu options allows you to save the active MultiGraph as a graphic file on disk. The 
graphic can be saved in a number of popular graphics formats, including WMF, BMP, JPG, 
TIF, PNG, or GIF. 
  

Navigate to the folder in which you want to save the graphic by double-clicking on items in 
the tree. Enter a name for the file in the File edit box and choose the graphic format by using 
the Save as Type drop down menu. Click Save to save the graphic to disk, or Cancel to exit 
the process. 
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Export MultiGraph PDF 

  

 

  

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu. 

  

This option saves the active MultiGraph window as a PDF file. 
  

Navigate to the folder in which you want to save the graphic by double-clicking on items in 
the tree. Enter a name for the file in the File edit box. Click Save to save the graphic to disk, 
or Cancel to exit the process. 
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Add Histogram to MultiGraph (Ctrl A) 

  

This is a shortcut used to add the active histogram to the currently selected MultiGraph. It 
allows the user to bypass the Edit MultiGraph dialog box. If there is no histogram to add or 
no MultiGraph present, the option does nothing. 

The histogram is added using the current settings of the Edit MultiGraph dialog box for 
Axes and Regions, as well as labels and label positions. 
  

See also: 

Edit MultiGraph 
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Add Results to MultiGraph (Ctrl R) 

  

This is a shortcut used to add the active results window to the currently selected MultiGraph. 
It allows the user to bypass the Edit MultiGraph dialog box. If there are no results to add 
or no MultiGraph present, the option does nothing. 
  

See also: 

Edit MultiGraph 
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Add Blank to MultiGraph (Ctrl K) 

  

This is a shortcut used to add a " blank" place holder to the currently selected MultiGraph. It 
allows the user to bypass the Edit MultiGraph dialog box. A blank is an element for which 
there is no graphic or text, but which occupies space like any other element in the 
MultiGraph. 
  

See also: 

Edit MultiGraph 
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Add Info to MultiGraph (Ctrl I) 

  

This option allows you to add the text contained in the active histogram's Info window, if 
there is one, to the currently selected MultiGraph. Info windows appear when doing 
histogram subtraction, or if the histogram has a remote DDE connection with another 
application that has returned text to the histogram. When a button with the letter I appears 
in the lower left of a histogram window, you can click the button to display the histogram's 
Info window. 

Use this option to add histogram subtraction results and remote DDE results to a MultiGraph. 
  

See also: 

Edit MultiGraph 
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Report Windows 

  

 
  

To create a report window, click the Report button on the Home tab of the ribbon bar.  If you 
are set up to use a menu and toolbar instead, choose New from the Report menu. 

  

Reports are used to create multi-page documents that can contain histograms, results, alerts, 
and many other kinds of information that WinList generates. The elements added to a report 
can come from different data sources, and can automatically update when the source objects 
change. 
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Elements can be added to reports by dragging-and-dropping them onto the report, or by 
using a command from the toolbar or menu. Once added, objects can be moved and resized 
using the mouse. See Drag and Drop for details. 

  

Right-click the mouse on an element of the report to see additional commands that can be 
performed on the selected element.  The commands shown will differ depending on the type 
of object selected. 

  

Reports can be saved to and opened from disk files. They can also be exported in PDF 
format, a convenient means for sharing reports with others who may not have access to 
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WinList. You can create and open any number of reports, providing a simple mechanism for 
producing internal and external versions of reports. 
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Report Toolbar 

  

This toolbar is attached to the inside-top of each report window. Its icons initiate commands 
commonly used on reports. 
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See individual report menu commands for details. 
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Report Context Menu 

  

This context menu is displayed when the right-mouse button is clicked on a report.  The 
menu also lists commands commonly used on reports, many of which are also accessed from 
the report toolbar. 
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See individual report menu commands for details. 
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New Report 

  

 

  

This command creates a new, empty report window. 

  

To create a report window, click the Report button on the Home tab of the ribbon bar.  If you 
are set up to use a menu and toolbar instead, choose New from the Report menu. 
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Open Report 

  

 

  

This command displays the Open Report dialog to select a report to open from disk. 
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Save Report 

  

 

  

This command displays the Save Report dialog to save the active report to disk. 
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Print Report 

  

 

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu.  It is also found on the toolbar for the active Report window. 
  

Use the Printer Setup option in the File menu to set print options. 
  

Several options in the Preferences dialog affect the print report option. They appear in the 
Print Preferences dialog box and control margins, orientation, and more. 
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Export Report PDF 

  

 

  

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu. 

  

This command displays the Export PDF dialog to save the active report as a PDF file. PDF 
stands for Portable Document Format, and is a standard format for exchanging information 
containing graphics and text. It is very useful for creating archival reports or for sharing 
analysis results with others. 
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Export Report Graphic 

  

 

  

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu. 

  

This command displays the Save Report Graphic dialog to save the active report as a graphic 
file. The graphic can be saved in a number of popular graphics formats, including WMF, BMP, 
JPG, TIF, PNG, and GIF. 
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Report Page Menu 

  

This command displays the page menu. The command is available in the report toolbar at the 
top of each report window. 
  

 
  

This menu allows you to add, rename, and delete pages in the report. It also provides 
commands to navigate to pages. Note: you can also navigate to pages by clicking on the title 
bar of the report, and then using the PgUp and PgDn keys on the keyboard. 
  

Add Page 

This command creates a new, blank page in the report and displays a dialog that allows you 
to name the page. 
  

Rename Page 

This command displays a dialog that allows you to rename a page. 
  

Copy Page 

This command copies all of the objects on the current page to another page in the report. 
The Choose Page dialog is displayed to allow you to select the page to copy to. 
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Clear Page 

This command removes all of the objects on the page, leaving a blank page. 
  

Delete Page 

This command deletes the current page of the report and all of the objects on the page. 

  

Page Setup 

This command displays the Page Setup dialog, which determines page size and margins. 
  

Next Page 

This command navigates to the next page in the report. The PgDn key is a shortcut for this 
command. 
  

Previous Page 

This command navigates to the previous page in the report. The PgUp key is a shortcut for 
this command. 
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Report Zoom 

  

 

  

This drop-down provides options for zooming in or out on the active report. The default 
setting, Auto, scales the report height to fit the report window. Other settings select specific 
magnifications for the report page. 
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Active Links 

  

 

  

This command toggles the "active link" state for all linked objects on the report. When the 
button is in a pressed state, the linked histograms and results objects on the report will 
update whenever the windows to which they are linked change. When the button is up, 
linked objects do not update automatically and will display information from the last time 
they updated. 

If you want to save a report for a specific experiment and you do not want it to update when 
you re-open it, toggle the button to the "up" state before saving it. 

If you are about to perform a number of actions on a large data file and you do not want 
objects to update during that process, toggle the active links button to the "up" state before 
performing the actions. Once you've finished, you can re-enable active links by pressing the 
button again. 

This command is also available in the report context menu. 
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Snap to Grid 

  

This command is found in the Report Context menu.  It controls whether objects on a report 
are aligned to a user-defined grid when moving or sizing. The grid size is set in the Reporting 
Preferences pane of the Preferences dialog. 
  

Enable this item to force objects to align to the snapping grid. 

Uncheck the command to allow objects to move freely on the report page. 
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Insert Histogram Link 

  

 

  

This command is found in the Report Context menu.  It adds a histogram link object to the 
current page of a report. Histogram link objects display a picture of a histogram. Because the 
object is linked to a histogram, it updates whenever the histogram changes. 
  

A dialog is displayed that allows you to select the specific histogram that you want to link the 
object to. 
  

 
  

Select the data source from the drop-down list, and then select the histogram from the 
listbox. 
  

Caption 

This option control determines whether the histogram object shows a caption. The caption 
can contain the histogram name, gate, the name and gate, or nothing at all. 
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Graphic quality 

This option controls the quality of the histogram graphics generated when the object updates 
on the report. Lower quality settings will produce graphics that require less memory, draw 
faster, and print faster. Perfect quality requires the most memory and draws the slowest, but 
produces the best output possible from the program. Experiment with this setting to find a 
suitable quality for your purposes. 
  

Update options 

Select how you want this object to update. By default, the object updates automatically 
whenever the associated data changes. You can also set the object to update when a specific 
condition is met, or not to update at all. Updating can also be controlled by placing the object 
in a Condition Area object on the report. 
  

There are two other methods you can use to add histogram links to a report. 

1. You can drag and drop a histogram onto the report. See Report Windows for details. 

2. You can use the histogram context menu Add to Report command. 

  

Transparent background 

Enable this option if you want the object to have a transparent background on the 
report.  This is useful if the object will be on top of another object that you want to show 
through. 
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Insert Results Link 

  

 

  

This command is found in the Report Context menu.  It adds an object linked to a results 
window to the current page of a report. Results link objects display the textual information 
shown in the Results window. Because the object is linked to a results window, it updates 
whenever the results window changes. 
  

A dialog is displayed that allows you to select the specific results window that you want to 
link the object to. 
  

 
  

Select the results window you want to link to from the listbox. 
  

Update options 

Select how you want this object to update. By default, the object updates automatically 
whenever the associated data changes. You can also set the object to update when a specific 
condition is met, or not to update at all. Updating can also be controlled by placing the object 
in a Condition Area object on the report. 
  

There are two other methods you can use to add results window links to a report. 

1. You can drag and drop a results window onto the report. See Report Windows for details. 

2. You can use the results context menu Add to Report command. 
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Insert Keywords 

  

 
  

This command is found in the Report Context menu.  It adds a keyword object to the current 
page of a report. Keyword objects display textual information derived from analysis results 
and FCS keywords in the listmode data files. Keyword objects update when the values for 
keywords they contain change. 
  

A dialog is displayed that allows you to select the keywords that you want to display. 
  

 
  

Keyword Group 

The Keyword Group tree displays groups of keywords. When you select a node in the tree, 
the keywords for that group are displayed in the Available Keywords list. 
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Available Keywords 

This list shows the keywords that are available for the item selected in the Keyword Group 
tree. The list is a multiple-selection list; any number of keywords can be selected and added 
to the report object. 
  

To add keywords from this list to the keywords that you want to display, use one of these 
methods: 

1. Drag and drop keywords from this list into the Edit and Format edit box. 

2. Select the keyword you want to add, and then click the Add button. 
  

Selected Keywords 

This edit control displays the keywords that have been selected for display on the report. 
When the Edit radio button is selected, you can directly edit keyword labels. For example, 
suppose that you have added the keyword "R1.%Gate" and you want the label to read "T 
Cells (% of Live Cells)". You would select the text "R1.%Gate" and type "T Cells (% of Live 
Cells)". 
  

Update options 

Select how you want this object to update. By default, the object updates automatically 
whenever the associated data changes. You can also set the object to update when a specific 
condition is met, or not to update at all. Updating can also be controlled by placing the object 
in a Condition Area object on the report. 
  

Add 

Click this button to add keywords selected in the Available Keywords list to the Edit and 
Format control. Keywords that are added will be displayed on the report. 
  

Properties 

This button displays the Edit Properties for Text dialog, to allow you to choose a font and 
other characteristics of the object. 
  

Edit/Preview 

These radio buttons determine whether the Edit and Format control shows editable keywords 
or a preview of what the report object will display. 
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OK 

Click OK to accept the changes to the object and close the dialog. 
  

Cancel 

Click Cancel to discard the changes to the object and close the dialog. 
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Insert Alert 

  

 

  

This command is found in the Report Context menu.  It adds an alert object to the current 
page of a report. An alert object is linked to an alert that is defined in Edit Alerts, and shows 
the current state of the alert. 
  

A dialog is displayed that allows you to select an alert that you want to link the object to. 
  

 
  

This dialog also allows you to select two colors for the text of the alert: one color for when 
the alert is True, and another for when it is False (i.e. the alert condition has not been met). 
You can use the Properties button to choose a font for the alert object. 
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Insert Gate Legend 

  

 
  

This command is found in the Report Context menu.  It adds a gate legend object to the 
current page of the report.  This object relates to the Gate Statistics window for a data 
source. 
  

 
  

The gate legend displays a list of all active gates. For each gate, the gate color, gate alias, 
and statistics are displayed. 
  

Use the Edit Gates dialog to edit gate colors, aliases, and expressions. 
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Insert Condition Area 

  

 

  

This command is found in the Report Context menu.  It adds a rectangular "conditional 
update" object to the report. Anything that falls within the conditional update object will only 
update if the condition specified is satisfied. 
  

 

  

Updating 

Update Option 

Select how you want objects placed in this condition area to update. By default, objects 
update automatically whenever the associated data changes. You can also set the object to 
update when a specific condition is met, or not to update at all. 
  

Update Condition 

Edit the condition for this area to update. 
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Tiling 

A condition area object can automatically tile elements that fall within its boundaries.  Tiling 
is performed on-demand by right-clicking on the condition area object and choosing a tiling 
option from the context menu. 

  

Rows 

Enter the number of rows in the tiling arrangement that you want this area to have. 

  

Columns 

Enter the number of columns in the tiling arrangement that you want this area to have. 

  
  

Coloring 

Fill Color 

If the object is not set to Transparent, this is the color that is used to fill the area. 
  

Border Color 

Select a color for the border of the area. 
  

Border Size 

Select a size for the border. Selecting -1 will disable the border. 
  

Transparent 

When this option is enabled, the fill color is ignored. 
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Edit Condition 

  

This dialog is used to define an update condition for some kinds of report objects. 
  

 
  

Conditions are based on keyword values. Keyword values can be extracted from the FCS files 
being analyzed, from regions, from user equations, or from user keywords. 
  

To create a condition 

1. Select a keyword from the Keywords tree. The selected keyword will appear in the 
Keyword edit control and its current value is also displayed. 

2. Select how the keyword will be evaluated by choosing an Operator. Common 
mathematical operators, as well as string operators, are available in the list. 

3. Enter or edit the Test value. 
  

The test value is compared with the current value using the selected operator. If the 
condition represented by the expression is TRUE, the condition is met and the update will 
proceed. If the condition evaluates as FALSE, the update will be suppressed. 
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Insert MultiGraph Link 

  

 

  

This command is found in the Report Context menu.  It adds an object linked to a MultiGraph 
window to the current page of a report. A MultiGraph link object displays the content of a 
MultiGraph window. Because the object is linked, it updates whenever the MultiGraph 
window changes. 
  

A dialog is displayed that allows you to select the specific MultiGraph window that you want 
to link the object to. 
  

 
  

Select the MultiGraph window you want to link to from the listbox. A checkbox is provided 
that determines controls whether the new object will update automatically as the MultiGraph 
window changes. 
  

You can also drag and drop a MultiGraph window onto the report to create a MultiGraph link 
object. See Report Windows for details. 
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Insert Info Window 

  

 

  

This command is found in the Report Context menu.  It adds an object linked to a 
histogram's Info window to the current page of a report. An Info window link object displays 
the content of an Info window. Because the object is linked, it updates whenever the Info 
window changes. 
  

A dialog is displayed that allows you to select the histogram that owns the Info window. 
  

Select the data source from the drop-down list, and then select the histogram from the 
listbox. A checkbox is provided that determines controls whether the new object will update 
automatically as the Info window changes. 



WinList User Guide 

423 

Insert Text 

  

 
  

This command is found in the Report Context menu.  It adds a text object to the report. The 
object can be moved, sized, and edited. 
  

See Edit Properties for Text for details. 
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Edit Properties for Text 

  

This dialog allows you to edit the text, font, background, and other properties of a text report 
object. 
  

 
  

Text 

Edit the text to display in the object. If the text has more than one forced line, a text edit 
dialog can be displayed by clicking in the edit box and pressing the Enter key. 
  

Font 

Use this button to select the font to use for the text object. 
  

Background 

Select a background color for the text with this object. If the Transparent option is enabled 
below, this color is ignored. 
  

Transparent 
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When enabled, the graphics under the text object will visible. Disable this option to display 
text on a solid background. 
  

Alignment 

Choose the alignment option for the text object. 
  

OK 

Choose this button to close the dialog and accept the changes. 
  

Cancel 

Choose this button to close the dialog and discard any changes you may have made. 
  

Help 

Choose this button to display online help for the dialog. 
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Insert Line 

  

 

  

This command is found in the Report Context menu.  It adds a line object to the report. The 
object can be moved, sized, and edited. 
  

See Edit Properties for Line for details. 
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Edit Properties for Line 

  

This dialog allows you to edit the properties of lines and arrows. 
  

 
  

Line color 

Select the color to use for the object. 
  

Line weight 

Enter a line weight to use for the object. This value is in points, a unit of 0.35 mm or 1/72 in. 
  

Head arrow 

Choose the size for the arrow at the head of the line. Size of 0 disables the head arrow. 
  

Tail arrow 

Choose the size for the arrow at the tail of the line. Size of 0 disables the tail arrow. 
  

OK 

Choose this button to close the dialog and accept the changes. 
  

Cancel 
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Choose this button to close the dialog and discard any changes you may have made. 
  

Help 

Choose this button to display online help for the dialog. 
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Insert Arrow 

  

 
  

This command is found in the Report Context menu.  It adds an arrow object to the report. 
The object can be moved, sized, and edited. 
  

See Edit Properties for Arrow for details. 
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Edit Properties for Arrow 

  

These options are the same as those for line objects. See Edit Properties for Line for details. 
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Insert Ellipse 

  

 

  

This command is found in the Report Context menu.  It adds an ellipse object to the report. 
The object can be moved, sized, and edited. 
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Edit Properties for Ellipse 

  

This dialog allows you to change the properties of an ellipse report object. 
  

 
  

Fill Color 

Choose a fill color for the object. 
  

Border color 

Choose a color for the edge of the object. 
  

Border size 

Choose a thickness for the border of the ellipse. A size of -1 turns off the border. 
  

Transparent 

Check this option to display the object without any fill color. 
  

OK 

Choose this button to close the dialog and accept the changes. 
  

Cancel 

Choose this button to close the dialog and discard any changes you may have made. 
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Help 

Choose this button to display online help for the dialog. 
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Insert Rectangle 

  

 

  

This command is found in the Report Context menu.  It adds a rectangle object to the report. 
The object can be moved, sized, and edited. 
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Edit Properties for Rectangle 

  

 
  

Color 

Choose a fill color for the object. 
  

Border color 

Choose a color for the edge of the object. 
  

Border size 

Choose a thickness for the border of the object. A size of -1 turns off the border. 
  

Transparent 

Check this option to display the object without any fill color. 
  

OK 

Choose this button to close the dialog and accept the changes. 
  

Cancel 

Choose this button to close the dialog and discard any changes you may have made. 
  

Help 
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Choose this button to display online help for the dialog. 
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Insert 3D Histogram Link 

  

This command is found in the Report Context menu.  It adds a link to a 3D window to the 
current page of a report. 3D Histogram link objects display a picture of a 3D window. 
Because the object is linked, it updates whenever the 3D window changes. 
  

A dialog is displayed that allows you to select the specific histogram that you want to link the 
object to. Choose the histogram that owns the 3D window you want to add. 
  

 
  

Select the data source from the drop-down list, and then select the histogram from the 
listbox. A checkbox is provided that determines controls whether the new object will update 
automatically as the histogram changes. 
  

Select how you want this object to update. By default, the object updates automatically 
whenever the associated data changes. You can also set the object to update when a specific 
condition is met, or not to update at all. Updating can also be controlled by placing the object 
in a Condition Area object on the report. 

  

You can also drag and drop a 3D window onto the report to create a 3D link object in the 
report. See Report Windows for details. 
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Copy (Report Toolbar) 

  

 

  

This command is found in the Report Context menu.  It copies either the whole report or the 
selected object to the clipboard. 
  

If an object is selected, it is copied to the clipboard in its native format. Text objects are 
copied as text. Object containing graphics or a mix of graphics and text are copied as 
bitmaps. 
  

If no object is selected on the report, the entire report is copied in bitmap format. 
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Paste (Report Toolbar) 

  

 

  

This command is found in the Report Context menu.  It will attempt to paste the data into 
the report. 
  

If the clipboard contains text formatted data, a new text object is inserted and the data is 
pasted into it. 
  

If the clipboard contains a compatible graphic format, a new graphic object is inserted and 
the date is pasted into it. 
  

If more than one compatible format is available in the clipboard, the program displays a 
dialog to allow you to select the format you want to paste. 

  



Bring to Front 

440 

Bring to Front 

  

 

  

This command is found in the Report Context menu.  It is enabled when an object is selected 
in the report. It will move the selected object in front of (i.e. on top of) all other objects in 
the report. 
  

The command is disabled if no object is selected. 
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Send to Back 

  

 

  

This command is found in the Report Context menu.  It is enabled when an object is selected 
in the report. It will move the selected object behind (i.e. in back of) all other objects in the 
report. 
  

The command is disabled if no object is selected. 
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Add Histogram to Report 

  

This command is found in the Report Context menu.  It adds the active histogram window to 
the active report. The histogram object on the report is located in a default position and size. 
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Add Results to Report 

  

This command is found in the Report Context menu.  It adds the active results window to the 
active report. The results object on the report is located in a default position and size. 
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Edit User Keywords 

  

 

  

This command is found on the Edit tab of the ribbon bar, or in the Edit menu when using the 
toolbar and menu display.  It allows the user to create and modify user-defined keywords. 
  

 
  

User-defined keywords allow you to enter information that is not otherwise available to 
WinList, and to use the information for display and computation of other expressions. WinList 
can prompt for a new value when a new file is opened, when a file is replayed, or never. 

User-defined keywords can be databased and added to reports. They can also be used in 
User Equations, as part of arithmetic expressions. They are stored with protocols and 
protocol bundle files. 

Click the Add button to create a new user keyword. The Edit Properties for User Keyword will 
be displayed allowing you to create a name, default value, and prompt for the keyword. You 
can also set when WinList should update the keyword. 
  

See also: 

Edit Properties for User Keyword 
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Edit Properties for User Keyword 

  

This dialog edits the properties for a user-defined keyword. 
  

 
  

Keyword name 

Type a name for the keyword. This name is used to identify the keyword when it is used in 
the database, reports, or user equations. 
  

Keyword value 

Enter the value for this keyword. This can be a text or a number. If the keyword is intended 
to be used in a user equation, the value should be a number. 
  

Prompt 

This is the prompt that is displayed when WinList needs to update this keyword. It can be 
any helpful message. 
  

Update option 

Never update: this option suppresses updates for the keyword. The value will remain 
unchanged. 
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Update on new file: this option causes WinList to prompt for a new keyword value whenever 
a new file is opened. 

Update on replay: this option causes WinList to prompt for a new value when one of the 
Replay options is used. 
  

See also: 

Edit User Keywords 
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Edit Equations 

  

 

  

This command is found on the Edit tab of the ribbon bar, or in the Edit menu when using the 
toolbar and menu display.  User equations are used to compute new statistics that WinList 
does not otherwise compute. Any numeric information that WinList stores can be used in 
mathematical expression, and user-defined information can be included too. 
  

 
  

Create a new equation by clicking Add, or edit an existing equation using the Edit button. 
The Edit Equation dialog is displayed to define the equation. 

Equations can be saved to disk and opened in other protocols, so that complex expression do 
not have to be re-entered manually. 
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Edit Equation 

  

WinList equations can be used to compute new values based on other information in the 
analysis setup.  Regions, gates, keywords, and built-in functions are available to the equation 
editor.  Parentheses allow grouping of terms in the expression. 

  

This dialog is designed to make it easy to create your own equations. The layout is like a 
calculator, with the addition of a number of special function buttons on the right. 
  

 
  

Fields 

Label 

The label is used as a name for the equations. This is how the equation is identified in other 
parts of WinList, like reports, alerts, and keywords. 
  

Equation 

The equation can be directly edited in this edit control. Values that are surrounded by square 
brackets [ ] contain keywords. Math symbols, numbers, parentheses can also be used in this 
control. 
  

Calculator buttons 
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As you click one of the calculator buttons, its value is inserted into the Equation edit box at 
the location of the cursor. 
  

Region Stat 

To include a region statistic in the equation, use the Region Stat button. A tree with all region 
keywords is displayed. Select the statistic you want and click OK. The region statistic will be 
inserted into the equation. 
  

Gate Stat 

To include a gate statistic in the equation, use the Gate Stat button. A tree with all gate 
keywords is displayed. Select the statistic you want and click OK. The gate statistic will be 
inserted into the equation. 
  

FCS Keyword 

To include an FCS keyword in the equation, use the FCS Keyword button. A tree with all FCS 
keywords is displayed. Select the keyword you want and click OK. The keyword will be 
inserted into the equation. 

Note: you should only use keywords that have number values. The program will attempt to 
convert text values to numbers, but the result of that conversion is not predictable. 
  

User Keyword 

If you have created user-defined keywords, they can be added to the equation using this 
button. 
  

F(x) 

The F(X) button displays a list of math functions that can be used in the equation. The 
selected function is inserted at the current location in the equation. Its arguments need to be 
filled in with appropriate values. 
  

OK 

Click OK to save the changes to the equation. 

Cancel 

Click Cancel to discard changes. 
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Edit Alerts 

  

 
  

This command is found on the Edit tab of the ribbon bar, or in the Edit menu when using the 
toolbar and menu display.  It allows you to define and edit alert conditions that WinList will 
monitor. Alerts are defined by selecting a region statistic or other keyword from a list, 
choosing a logical operator, and entering a test value or another keyword. An Alert can 
compare keywords, statistics, and constant values.  For example, an alert can test to see if 
the number of events in region R1 is less than events in R2.  Instead of comparing with R2, it 
could compare with a constant value, like 250. 

  

WinList can database alert conditions when it batch processes files, so that you can keep a 
record of any results that trigger the alert. In addition, you can choose to have WinList pause 
and display an alert dialog box when an alert triggers. 
  

 
  

To create a new alert, click the New button and fill in the fields described below. 
  

To edit an alert, select the alert in the listbox and edit the fields. 
  

Alert Name 
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Enter a name for the alert. This name is displayed when the alert is triggered, so it is useful 
to enter a name that relates to the alert condition. 
  

Applies to 

Select the data source that the alert applies to. Each alert relates to only one data source. 
  

Condition 

The Condition contains three parts: a left-hand value, a logical operator, and a right-hand 
value. The left- and right-hand values can be region statistics, keywords, or constant values 
that you enter.  Click the ... button next to a condition field to select a keyword from a 
list.  Choose a logical operator with the dropdown list in the middle of the condition.  And 
again, click the ... button to select a keyword for the right-hand value. If the condition 
described by the expression is true during analysis, WinList will trigger the alert. 
  

Alert Keyword 

This is a user-defined keyword that WinList will use to store the alert in a database. 
  

Alert Text 

This text will be used as the value for the alert keyword if the alert is triggered. 
  

Show alert prompt 

Enable this field if you want WinList to pause and display a warning dialog whenever the alert 
condition is triggered. 
  

 
  
  

Alert Listbox 
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This list contains all alerts currently defined. To edit an alert, select it in the list and then edit 
its fields. 
  

New 

Click this button to create a new alert condition. This adds an entry to the alert listbox and 
selects it for editing. 
  

Delete 

This command deletes the currently selected alert in the alert listbox. 
  

Open 

This command displays a File Open dialog to select a previously saved set of alerts. When an 
alert file is selected and opened, the alerts in the file replace any that were previously 
displayed in the alert listbox. 
  

Save 

This command displays the File Save dialog, allow you to save the currently defined alerts to 
a file on disk. 
  

OK 

Close the dialog and accept the changes. 
  

Cancel 

Close the dialog and discard the changes. 
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Replay 

  

 

  

The Replay command can be found on the Home tab of the ribbon bar, or on the main 
toolbar when using menus and toolbars.  It provides several ways to re-read data into data 
source windows. Use these options to do the following: 

- Trigger the saving of a database record. See Databasing with WinList for more. 

- Display all data events in single parameter histograms. 

- Display all data events in dual and three parameter histograms after enabling the Show 
all dots option in the dual or three parameter Graphics dialog boxes. See also Edit 2P 
Graphics and Edit 3P Graphics . 

- Update display and statistics for gating if Auto Update in the Replay menu is turned 
off. See also Auto-update. 

- Trigger a remote link that is set to update on replay. See also Edit Remote. 

  

WinList is normally working with a packet of events from the data source, not the entire data 
source. This allows the instantaneous update of statistics and graphics as you manipulate 
regions and gates. The packet is only a sample of events from the entire data source, 
though, and there are times when you want to see all of the events, or statistics relevant to 
all events. This is when you will use Replay options. 
  

See also: 

Auto-update 

Replay Active Histogram 

Replay Active Data Source 

Replay All Data Sources 
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Replay All Data Sources 

  

 

  

This command replays data for all histograms in all data sources. 

The Replay command can be found on the Home tab of the ribbon bar, or on the main 
toolbar when using menus and toolbars. 

When this option is selected, any active databases will attempt to save a record. See 
Databasing with WinList for more. 
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Replay Active Data Source 

  

 

  

This command replays data for all histograms in the active data source. 

The Replay command can be found on the Home tab of the ribbon bar, or on the main 
toolbar when using menus and toolbars. 

When this option is selected, any active databases will attempt to save a record. See 
Databasing with WinList for more. 
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Replay Active Histogram 

  

 

  

This command replays data for the active histogram in the active data source. 

The Replay command can be found on the Home tab of the ribbon bar, or on the main 
toolbar when using menus and toolbars. 

When this option is selected, any active databases will attempt to save a record. See 
Databasing with WinList for more. 
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Enrich Data Source 

  

 

  

This command is used to process a data source through a user-selected gate, selecting only 
the events that are in the gate into the sample packet that WinList uses for analysis. It is 
most useful for analyzing low-frequency populations (e.g. B-cells). 

The Enrich command can be found on the Options tab of the ribbon bar, or on the main 
toolbar when using menus and toolbars. 

When you select the command, a list of the active gates is displayed. Select the gate you 
want to enrich on. The data file will be re-read, this time selecting on the events "In" the 
selected gate. 

To cancel the enriched analysis, select the option again and choose Ungated from the list. 
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Auto-update 

  

 

  

When this option is checked, Auto-update is enabled. Each time you move a region, the 
program will update results for the region and associated gates.  This is the normal operating 
mode for WinList. 
  

When this option is not checked, you can move regions without triggering the update of 
results, gates, and histograms. It can be useful when you need to adjust more than one 
region in a protocol that takes a long time to update.  When the option is enabled (checked) 
again, the program will update any results, gates, and histograms. 
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Update Now 

  

This command appears in the Replay menu in Toolbar mode.  It is displayed on the Options 
tab of the Ribbon bar.  It can be triggered by the shortcut Ctrl-J. 

  

When selected this command tells WinList to reanalyze the current data in the packet and 
update results and graphics.  It can be used after a Replay command to revert WinList to 
packet-mode operation. 
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Update Remote Links 

  

This command is found on the Options tab of the ribbon bar, or the Options menu when not 
using the ribbon bar. 

The command updates "remote links" for histograms and results windows if they are set to 
update On Command (see Edit Remote dialog box). It has no effect on other remote links 
nor on windows which have no remote connections. 
  
This option is useful for remote connections to database programs. It gives the greatest 
control over when information will be exchanged between a WinList window and some other 
application. For example, suppose a results window has a remote DDE link with Microsoft 
Excel to database results. Setting the link to update On Command will allow you to adjust 
regions, replay the data, even open a new file, without causing the link to update. Once you 
have the data on the screen the way you want to database it, selecting Update Remote Links 
will initiate the update process. 
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Scale to Fit 

  

 

  

This command is found on the Home tab as well as the View tab of the ribbon bar.  When 
WinList is configured to use the classic toolbar and menu interface, the command is found in 
the Window menu. 

  

Scale to Fit adjusts all data source windows proportionally to fit into the main application 
window. The command automatically scales the histograms of each data source to fit the 
new space of the data source, too. 

  

You can click the down-arrow on the button to select Scale to Fit for histogram windows in 
the current data source. 
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Tile 

  

 

  

This command is found on the Home tab as well as the View tab of the ribbon bar.  When 
WinList is configured to use the classic toolbar and menu interface, the command is found in 
the Window menu. 

  

Select Tile to fit all data sources in a grid format. Histograms contained in the data sources 
are automatically rearranged in a tiled format. 

  

You can click the down-arrow on the button to select Scale to Fit for histogram windows in 
the current data source. 

  



WinList User Guide 

463 

Vertical 

  

 

  

This command is found on the View tab of the ribbon bar.  When WinList is configured to use 
the classic toolbar and menu interface, the command is found in the Window menu. 

  

Select Vertical to arrange data source windows vertically, in a single column. Histograms 
contained in the data sources are automatically rearranged in a tiled format. 
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Horizontal 

  

 

  

This command is found on the View tab of the ribbon bar.  When WinList is configured to use 
the classic toolbar and menu interface, the command is found in the Window menu. 

  

Select Horizontal to arrange data source windows horizontally, in a single row. Histograms 
contained in the data sources are automatically rearranged in a tiled format. 
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Close All 

  

 

  

This command is found on the View tab of the ribbon bar.  When WinList is configured to use 
the classic toolbar and menu interface, the command is found in the Window menu. 

  

This option performs the same function as the New Protocol command. WinList will close all 
data source, histogram, MultiGraph, results, and report windows. It also resets other settings 
to defaults. 
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Show All 

  

 

  

This command is found on the View tab of the ribbon bar.  When WinList is configured to use 
the classic toolbar and menu interface, the command is found in the Window menu. 

  

Select Show All to display any hidden windows of the selected type and ensure that they 
are within the viewable area of the screen. 
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Hide All 

  

 

  

This command is found on the View tab of the ribbon bar.  When WinList is configured to use 
the classic toolbar and menu interface, the command is found in the Window menu. 

  

Select Hide All to hide all windows of the selected type from view. The windows are not 
destroyed by this command; they are only hidden. 
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Next - Previous Data Source 

  

 

  

This command is found on the View tab of the ribbon bar.  When WinList is configured to use 
the classic toolbar and menu interface, the command is found in the Window menu. 

  

These commands are useful when you have more than one data source window open.  It 
allows you to navigate the data source windows easily. 
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Print Screen (Ctrl Shift P) 

  

 

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu. 

  

Print Screen perform a high-speed bitmap screen dump to a graphics printer. The printout 
will display the visible contents of WinList's window. 
  

Use the Printer Setup option in the File menu to set print options. 
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Print Report 

  

 

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu.  It is also found on the toolbar for the active Report window. 
  

Use the Printer Setup option in the File menu to set print options. 
  

Several options in the Preferences dialog affect the print report option. They appear in the 
Print Preferences dialog box and control margins, orientation, and more. 
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Print MultiGraph (Shift P) 

  

 

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu.   
  

This command draws the current MultiGraph to the printer. The print margins set in Print 
Preferences are used and a border is placed around the MultiGraph.  The Fast Printing 
preference controls how MultiGraphs are printed. 

  

If the MultiGraph is in Tiled mode and you have specified a fixed number of rows, the page 
is divided up into columns and rows and each cell will have a fixed size. If there are fewer 
than rows X columns MultiGraph elements, there will be empty space left on the page. If 
there are greater that rows X columns elements, multiple pages will be printed. If Rows is set 
to zero (0), all elements of the tiled MultiGraph will be scaled to fit on a single page. 
  

All other views of MultiGraphs produce single pages when printed. 
  

Use the Printer Setup option in the File menu to set print options. 
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Print Overlay 

  

 

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu.   

  

Choose this command to print the active overlay window to the current printer. The print 
margins set in Print Preferences are used and a border is placed around the overlay. 

  

Use the Printer Setup option in the File menu to set print options. 
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Print Histogram 

  

 

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu.   

  

Select this option to print the current histogram to the printer. The print margins set in Print 
Preferences are used and a border is placed around the histogram. 
  

Use the Printer Setup option in the File menu to set print options. 
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Print Data Source 

  

 

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu.   

  

This command prints all of the histograms contained on the current page of the active data 
source window. The arrangement of histograms is scaled to fit the printed page. 
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Print Results 

  

 

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu.   

  

Select this option to print the text of the currently selected results window to the printer. 
  

Use the Printer Setup option in the File menu to set print options. 
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Printer Setup 

  

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu.   

  

Select this option to display the printer setup dialog box. In the dialog box you may select a 
printer that you want WinList to use, as well as the orientation you want to use. The specific 
dialog box will vary somewhat depending on the operating system your computer is running. 
  

WinList will use the selected printer as its default printer until you change this setting, even if 
you change your default printer in the Windows Control Panel. 
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Create Batch 

  

 

  
This dialog is displayed by choosing the Batch button on the Home tab of the ribbon bar.  If 
you are showing toolbar and menu, it is found in the File menu.  This function is disabled 
until there is an FCS file open in WinList. 
  

A batch is a group of listmode files that will be processed through a WinList analysis protocol. 
The Open Batch Files dialog allows you to select the files you want to analyze, and to assign 
them to different data source windows. After you select files with this dialog, you can 
navigate through them with Get Next Batch and Get Previous Batch commands, or use the 
batch toolbar that appears at the bottom of the main window. 
  

If your protocol has more than one data source window, WinList can automatically associate 
a file with a particular data source. You can group the files into convenient analysis groups, 
based on the outline level shown in the Batch list. Use Level > and Level < to change the 
indentation level of items in the batch list. 
  

The Create Batch command displays 2 dialogs side-by-side: the Edit Batch dialog and the Add 
Batch Files dialog. 
  

 
  

Edit Batch contains the list of all files already added to the batch, and the Add Batch Files 
dialog is used to add files to the batch. Settings in the Edit Batch dialog determine how files 
will be added. As files are added, they are automatically assigned to a data source based on 
rules that you set up in the Edit Batch dialog. 
  

Simple Batch 
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In the simplest case, when you add files to the batch they are sorted based on File Name or 
File Date. If your analysis setup has one data source window, all of the selected files will be 
read into that data source. With more than one data source window, files are assigned 
sequentially to the data source windows in the analysis setup. 
  

More Sophisticated Batch 

You can also select and assign files based on keywords that are contained in them. FCS files 
use keywords to contain information about the sample, the case, the tube in the panel, and 
many other useful properties. Any keyword in your files can be used to select files and assign 
them to the appropriate data source window. 

For example, suppose you have a 3-tube panel, and that your files include keywords 
"SAMPLE ID" to identify the case and "TUBE NAME" to identify which tube in the panel the 
file represents. You set up three data source windows in WinList, one for each tube in the 
panel. Then you can tell the Edit Batch dialog that you want to select files By Keywords, 
and click the Customize button to select the keywords to use. 
  

 
  

In the Customize Add by Keywords dialog, you would select "SAMPLE ID" for the keyword 
that identifies a group of files (a panel), and "TUBE NAME" as the keywords that identifies a 
file within the group. You would select "Assign each file to the associated data source 
window", and then choose or enter the keyword values for "TUBE_NAME" that relate to each 
data source. Here's an example of that set up: 
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By taking the time initially to set up file selection By Keywords, you can save time and 
reduce selection errors during your day-to-day analysis. 
  

Controls in the dialog 
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Batch List 

This shows the current list of files and data source to which each will be assigned. 

To change the target data source, select one or more items in the list and change the 
selection in the Open into dropdown control. 

To change the indentation level, select one or more items and use the < and > buttons. 

To remove items from the list, highlight the items and click Remove. 
  

Open into 

This drop-down control lists the current data source names. Changing the selection will 
change the data source for the items selected in the Batch List. 
  

Level > 
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This option increases the level of all selected batch files by one. 
  

Level < 

This option decreases the level of all selected batch files by one. 
  

Up & Down 

Select one or more items and click Up or Down to change the order of items in the Batch 
List. 
  

Add Files 

Insert Files 

These buttons are disabled when the Add Batch Files dialog is displayed. If you close the 
Add Batch Files dialog, use Add Files or Insert Files buttons to display the dialog and 
select additional files. 
  

OK 

Click this button to save the Batch List entries close the dialog. 
  

Cancel 

Click this button to cancel changes in the dialog. 
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Batch toolbar 

  

This toolbar appears when more than one listmode file is selected in the Open dialog. It 
provides a simple tool for navigating through the batch of files. 
  

 
  

As you navigate through the batch, the actions and options in the Edit Batch Options dialog 
are performed on each file that is opened. This allows you to perform a series of automatic 
operations just by moving to another batch item, such as acquiring all events, running a 
macro, or printing. The function of each button is described below. 

  

 

Display the Edit Batch Options dialog. 

 

Add files to the batch. 

 

Go to the first file in the batch. 

 

Go to the previous file in the batch. 

 

Redo the current file in the batch. 

 

Go to the next file in the batch. 

 

Go to the last file in the batch. 

 

Select a specific batch item to open. 

 

Auto-advance through the batch. 

 

Stop the auto-advance process. 

 

Pause/continue batch processing. 



WinList User Guide 

483 

Edit Batch Options 

  

This dialog can be accessed from the batch toolbar by clicking the left-most button. It is also 
found by clicking the down-arrow on the Batch button on the Home tab of the ribbon bar.  It 
controls the actions that are performed as each file in the batch is read. 
  

 
  

Batch files 

This option displays the Open Batch Files dialog to select or modify files for the batch. 

  

Batch options 

This option selects either Basic or Custom Scripts mode for batch processing. 

In Basic mode, processing options are selected using the checkboxes and other controls 
shown in this dialog. 

In Custom Scripts mode, you can create custom scripts of actions for each "level" in the 
batch list outline shown in the Open Batch Files dialog. Custom scripts can perform all of the 
same operations as Basic mode processing, as well as additional commands. You can also set 
the order of operation and include things like user prompts with Custom Scripts. See Edit 
Scripts for details. 
  

Custom scripts 

In Custom Script mode, use the Edit button to view and edit the custom scripts you have 
created for your batch. 
  

Replay Options 

Replay on Open 

When enabled, the FCS file will be replayed as soon as it is opened. Replaying a file allows 
the statistics and graphics to represent the entire data file. 
  

Replay on Advance 

This dropdown contains several choices related to replaying the batch processor is about to 
move to the next file in the batch. 
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No: No replay action is taken when a new batch file is opened. 

Replay active data source: WinList replays the active data source and computes statistics 
on the full listmode file. This option also triggers any active databases to store a new record. 

Replay all data sources: WinList replays all data sources and computes statistics on the 
full listmode file. This option also triggers any active databases to store a new record. 
  

Macro 

Run macro 

Enable this option if you want to run a WinList macro after each batch file is opened. If you 
want to perform detailed tasks that are not directly supported with options in this dialog, use 
the Run macro and Macro name fields to perform a custom task. 
  

Update remote links 

When this option is enabled, WinList will update all Remote connections for Result and 
Histogram windows. 
  

Macro name 

When the Run macro option is enabled, this option allows you to select the macro that you 
want to run. Click the button, navigate to the folder containing the macro, and select the 
macro. 
  

Protocol Save 

Save protocol 

There are several options for saving protocols: Don't save protocol, Save XML protocol, 
and Save protocol bundle. When one of the saving options is selected, the other 
properties in the Protocol Save section also need to be set. 
  

Save protocol in data path 

Enable this option to store the protocol in the same path as the data file that is being 
analyzed. When not enabled, the protocol is saved in the path specified by Protocol Path. 
  

Confirm protocol names 
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Enable this option to be prompted to confirm the protocol name before it is saved by the 
batch processor. 
  

Protocol name prefix 

This field contains text that is used for naming protocols. It can contain a mix of text and 
keywords; keywords are enclosed in square brackets. The default name prefix is 
"Protocol_[BATCHINDEX]", which will name a protocol based on the index of the file in the 
batch list. 
  

Protocol path 

Select a path for storing protocols. This path is ignored if Save protocol in data path is 
enabled. 
  

Reports 

Save reports 

Enable this option to save reports after each batch file is loaded. Reports will be 
automatically named based on the Report name prefix below. 
  

Save reports in data path 

Enable this option to store the reports in the same path as the data file that is being 
analyzed. When not enabled, the report is saved in the path specified by Report Path. 
  

Confirm report names 

Enable this option to confirm and/or edit report names prior to saving. 
  

Report name prefix 

Enter text to use as the first part of each report name. This can contain internal and file 
keywords by enclosing the keyword in square brackets. For example, to name the reports 
based on FCS file name for the active data source, you might use Report_[FILE], excluding 
the quotation marks. See Internal Keywords for other keywords that can be used for this 
purpose. 
  

Report path 
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Choose the location in which to save reports. This path is ignored if Save reports in data 
path is enabled. 
  

PDF Export 

Export PDFs 

Enable this option to save reports in PDF format after each batch file is loaded. Reports will 
be automatically named based on the PDF name prefix below. 
  

Save PDF in data path 

Enable this option to store the PDF reports in the same path as the data file that is being 
analyzed. When not enabled, the PDF is saved in the path specified by PDF Path. 
  

Confirm PDF names 

Enable this option to confirm and/or edit PDF file names prior to saving. 
  

PDF name prefix 

Enter text to use as the first part of each PDF report name. This can contain internal and file 
keywords by enclosing the keyword in square brackets. The default name prefix is 
Report_[BATCHINDEX]” , which will name PDF based on the index of the file in the batch 
list. 
  

PDF path 

Choose the location in which to save PDF reports. This path is ignored if Save PDF in data 
path is enabled. 
  

Printing 

Print report 

Print screen 

Print MultiGraphs 

When selected, WinList performs the print operation after each file is opened. 
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Always show toolbar 

Normally, WinList hides the batch toolbar when the batch list is empty. Enable this option to 
always show the batch toolbar. 
  

Save Preferences 

If this option is enabled, the choices made in the dialog are stored as preferences. 
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Edit Scripts 

  

This dialog is accessed from the Edit Batch Options dialog when you choose Custom Scripts. 
It allows the batch processing scripts to be customized. 
  

 
  

WinList automatically creates a batch processing script for each level in the outline of files in 
the batch file list. Levels are used to differentiate how you want to process files. For example, 
you can have files on Level 1 simply read in and update the results, while files on Level 2 will 
cause reports to be saved and printed. 
  

To edit a script for a level, select it in the list and click Edit. 

Use the Open and Save buttons to save collections of customized scripts so that you can 
reuse them in other protocols. Scripts are also saved as part of the protocol and protocol 
bundle file formats. 
  

See also: 

Edit Script 

Edit Batch Options 
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Edit Script 

  

This dialog allows you to edit the commands for a batch processing script. There is one batch 
processing script for each level in the outline of files in the batch file list. 
  

 
  

The left listbox contains a list of all commands that are available. The list on the right side 
contains the commands that the script will execute. 

To add a command to a script, select the command in the list on the left and click Add. 

To replace a command, select the new command in the list on the left and the command to 
replace in the list on the right, then click Replace. 

To change the order of a command in the script, select the command and use the  and 

 buttons. 

To edit the properties for a command in the script, select the command and click Edit or 
Properties. The Edit Batch Command dialog will be displayed. 
  

See also: 

Edit Batch Command 

Edit Scripts 

Edit Batch Options 
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Edit Batch Command 

  

This dialog allows you to edit the properties for a batch command. 
  

 
  

Each batch command has its own unique properties. For example, commands that relate to 
saving files typically have properties that allow you to set the path and file name, and 
commands that pause have properties that allow you to specify a prompt to display to the 
user. 

To edit the properties for a batch command, double-click the command in the Edit Script 
dialog, or select the item and click the Properties button. 
  

See also: 

Edit Script 

Edit Scripts 

Edit Batch Options 
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Next Batch Files (Ctrl B) 

  

Note: This function is disabled until there is a data source open in WinList. 
  

Note: The batch toolbar provides another method for moving through batch files. It 
automatically appears at the bottom of the main window when more than one file is in the 
batch. 
  

The Next Batch Files menu option will open one group of FCS files from the batch list into 
the data sources. A group of files is defined by the outline Level in the Edit Batch dialog. 
Typically, a group represents a panel of files for an analysis setup. 

The option Previous Batch Files backs up one group of files in the batch list. 
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Previous Batch Files (Shift B) 

  

Note: This function is disabled until there is a data source open in WinList. 
  

Note: The batch toolbar provides another method for moving through batch files. It 
automatically appears at the bottom of the main window when more than one file is in the 
batch. 
  

This option backs up one group of files in the batch list. It is the converse of Next Batch Files. 
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Databasing with WinList 

  

This section introduces the concepts and functions needed to work with WinList's database 
features. It is more of a discussion than a tutorial, however there are examples to clarify 
some aspects of the system. 

WinList has a simple, yet powerful database engine that allows you to store large amounts of 
data easily in one or more database files. You can view databases from within the program, 
manually add, delete, and replace records, and select the fields you want to store in each 
database. The databases are created in a simple, text format known as tab-delimited ASCII 
text, which can be read by common database and spreadsheet programs. These features 
give you a great deal of flexibility in choosing what information to store, where to store it, 
and how to integrate the information into other database systems. 
  
  
  

How do you create a database? 

Set up WinList with a protocol before you create or edit a database. This includes opening 
one or more data source files, selecting the histograms you want to work with, creating 
regions and gates, and displaying results. You can set up a separate database for each 
protocol you use, one database for everything you do with the program, or anything in 
between. 

  

It's important to have an FCS file open and regions defined before you create a 
database.  The information available to the database depends on what you have set 
up on the screen. 

  

 

  

Databases are accessible from the Edit tab on the ribbon bar. Click the Setup button in the 
Databases group to display the Edit All Databases dialog. 
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There is one database, "Database1", created by the program automatically. This database 
will not store anything until you tell the program what information you want to save. To do 
so, you need to select the database in the list and click the Edit button. You can also double-
click on the item in the list to do this. 
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The Edit Keyword Map dialog is displayed. The left side of this dialog presents the 
information available to store, and the database fields already added are shown on the right. 
The two controls on the left are the Keyword Groups tree and the Keywords list. The right-
hand list is the Keyword-Database Map, showing the fields you will store in the database. 
Initially, the right-hand list is empty. 
  
  

What can you database? 

WinList allows you to database virtually any statistic it generates, as well as keyword 
information from the files that you analyze. The tree in the top left of the dialog can be 
expanded to display branches of keywords. To open a branch of the tree, double-click on it 
with the mouse. 

  

Sometimes it's easier to create a database directly from Results windows that you 
have already created.  The Database Wizard makes that an easy task by 
automatically adding fields for the selected Results window. 
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As you select a branch in the tree, the list below the tree will fill with the objects beneath the 
branch. For example, when you double-click to open the Region keywords branch, the 
Keywords list below the tree will fill with a folder for each region that has been created. 
These also appear in the tree because they are branches that can be expanded further. File 
keywords come from the FCS keywords for each data source; System keywords are items like 
current date, and current time. 
  

 
  

When you see an item in the Keywords list that you want to database, select it and click the 
Add button. One or more fields will be created, depending on what you have selected to add. 
Here is the important thing to understand about adding items to the database: everything 
contained in the selected item will be added to the database. This means that if you select 
the File keywords, the Region keywords, and the System keywords list items and click Add, 
everything that WinList can store for the current Protocol will be added to the database. 
  

There is a downside to this simplicity. It is very easy to create a database with much 
more information than you want or need. In fact, you can create a database that 
other programs will not read because it has too many fields. 
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In most cases, you probably want to store most of the Region keywords, but rarely would 
you want to store all of the File keywords. File keywords come from the files you are 
analyzing, and many of them are meaningless to anything except the program that created 
the files. For example, storing how many bytes each parameter for each event uses in the 
listmode file is not useful information, in most cases. On the other hand, keywords that 
identify the sample, experiment, and file name will be useful to database. 

Another reason you would not want to store all the File keywords is the limitation that most 
database and spreadsheet programs impose. Other programs usually will not read a database 
with more than 255 fields of data. If, for example, your files contained 100 keywords and you 
set up a protocol with 10 data sources open at once, there would be 1000 keywords available 
to you in the File keywords branch. Reading such a database is well beyond the capabilities 
of most other programs. Since it is likely that you will want to open WinList databases with 
other software, avoid creating databases with more than 255 fields. 

A better solution, if you need to store more information, is to break the storage into several 
smaller databases. This is possible because WinList can work with any number of database 
files simultaneously. 

The field names initially assigned when you click the Add button are designed to help you 
know what keyword has been added. For example, all of the keywords relating to Region R1 
are prefixed with "R1:", so you can differentiate "MeanX" for regions R1 and R2 easily. 

File keywords are prefixed with the data source id. 
  
  

Editing fields 

You can edit the names for the fields after they are added to the Keyword-Database Map list, 
if you wish. Click once on the field name to select it. After a brief pause, click slowly again. 
An edit control will appear around the field name, allowing you to type a new name for the 
field. 

To remove one or more fields from the database, select the fields in the Keyword-Database 
Map and click the Delete button. 

To replace an existing field with a new keyword, select the new field in the Keywords list and 
the one to replace in the Keyword-Database Map list. Then, click the Replace button. The 
name of the field will not change, only the keyword used to evaluate the field. 

If you need assistance understanding the dialog, click the Help button to display the on-line 
help. 

When you have finished selecting information to store in the database, click the OK button to 
close the Edit Keyword Map dialog. 
  
  

What files are created? 

When you select keywords to store in a database, WinList creates three or four files on disk 
to manage the database. The files are created in the WinList application folder by default. 
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However, you can choose another location by editing the database's properties, discussed 
below. 

First, a file is created to store a "map" of keywords to database fields. The map file name 
uses the name of the database object and appends ".map" to it. For "Database1", the map 
file is named "Database1.map". 

Next, the program creates or revises the actual database file. This is the tab-delimited, ASCII 
text file that you may open in other database or spreadsheet programs. The database file 
name uses the database object name and appends ".txt" to it. This file is readable in virtually 
any program that can open unformatted text. The first line of the file contains the names of 
the fields separated by tabs; it is known as the database header or definition. Each 
subsequent line contains a record of information. 
  

If the database already exists on disk, WinList will automatically create a backup of 
the database before overwriting the existing one. The backup file will have the same 
name as the database, with " backup" appended to it. 

  

Finally, the program creates a text file called a "key" file. This is a text file that explains the 
database and mapping files. You can open this file in a text editor to review the structure of 
the database you have created. Its name is based on the database object name, with 
"key.txt" appended to it. 
  
  

How do you activate the database? 

Once a database has been defined, there are several additional properties you can specify. 
These properties determine whether the database is active, whether it will prompt you before 
saving a record, whether or not you want to see the records in a database viewer, and where 
you want to store the database. 

To edit these properties for a database, select the database in the Edit All Databases dialog 
box and click the Properties button. The Edit Properties for Database dialog will be displayed. 
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The properties are enabled or disabled with simple check boxes. Path selection is initiated by 
clicking the Database Path Folder button. 

In order to store records of information in a database, it must be "active". To make a 
database active, check the Active checkbox in the Edit Properties dialog. Database records 
are saved when you click the Replay button on the ribbon bar, or when you click the Replay 
options in the Replay menu. Additionally, you can save a record at any time by choosing Save 
Current Results from the Edit menu, or by clicking the "+" button on the database viewer. 

If the Prompting checkbox is checked, WinList will display a message each time it is about to 
save a record to the database. You can choose at that time whether or not you want to save 
the record. If Prompting is disabled, the database will save a record without prompting. 

To view the database while you work with WinList, check the Viewer checkbox in the Edit 
Properties for Database dialog. A database viewer window will be created and displayed. The 
database viewer can be moved, resized, and scrolled horizontally or vertically. It has a 
toolbar that provides some additional manual database functions. See the topic Database 
Viewer for more information. 
  
  

How do you rename or create additional databases? 

It is useful to rename a database so that its name relates to its purpose. For example, if you 
have an activation study for which you have created a WinList protocol called "Activation", it 
makes sense to name the database "Activation" as well. 

To rename a database, display the Edit All Database dialog box by selecting Edit Databases 
from the Edit menu. Click once to select the database you want to rename. After a brief 
pause, click again on the object to display an edit box in the Name column. Type the new 
name for the database. 
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The name you type must contain only alphabetic, numeric, or space characters, and must be 
at least 4 characters shorter than the maximum file name length for the operating system 
you are using. If a file with the new name already exists, you will be given a chance to 
overwrite the existing file, use the existing file, or cancel the operation. 

When you want to create an additional database, select the first database in the Edit All 
Databases dialog and click the Copy button. This will create an identical database to the one 
copied, but will give the database a new name. 

Each database has its own map of keywords to fields, and its properties determine whether it 
is active, prompting, and showing a viewer. 
  
  

Making the databases open automatically when WinList starts 

If you would like to open the database setup each time the program starts, enable the Auto-
open check box. 

 
  
  

Links: 

Edit Databases 

Edit Keyword Map 

Edit Properties for All Databases 

Edit Properties for Database 
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Edit Databases 

  

This dialog allows you to add, delete or edit one or more databases. 
  

The Edit Databases dialog can be displayed by choosing Setup on the Edit tab of the ribbon 
bar.  If you are using the toolbar interface, it is found in the Edit menu. 
  

 
  

Overview 

WinList can have one or more databases defined at any time. The database format is ASCII-
formatted, tab-delimited database. Any FCS keyword or analysis result can be mapped to a 
database field. A complete description of the functionality of the database system can be 
found in the Databasing with WinList tutorial. 
  

Edit 

If a Database is selected, this option shows the Edit Keyword Map dialog box. You can also 
double-click on the Database item to activate this option. 
  

Copy 
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If a Database is selected, this option creates a new Database. You may edit the name of the 
database by clicking on the name, and after a brief pause, clicking again. The name will then 
appear in an edit box. 
  

Delete 

If any Databases, other than the first one, are selected, this option will delete the Databases. 
  

Open 

Opens a file containing a set of database definitions previously saved. 
  

Save 

Save the database definitions to a disk file. 
  

Properties 

If no Database is selected, clicking on Properties will show the Edit Properties for All 
Databases dialog box. If a Database is selected, clicking on Properties will show the Edit 
Properties for Database dialog box. 
  

Help 

Show this help topic. 
  

OK 

Put away the Edit All Databases dialog box. 
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Edit Properties for All Databases 

  

Choosing Edit Databases from the Edit menu, then clicking the Properties button can display 
the Edit Properties for All Databases dialog. Note: Make sure nothing is selected in the Edit 
All Databases list when clicking the Properties button. 
  

 
  

Overview 

The dialog is displayed when the Properties button is clicked in the Edit All Databases dialog, 
and no databases are selected in the list. It allows you to perform action on all of the defined 
databases at once. 
  

Activate all 

Activates all databases. When a database is active, it can store records of information as you 
analyze files in WinList. 
  

De-activate all 

Disables all databases. No database will store information until it is reactivated. 
  

Delete files 

Removes all database files on disks for databases in the Edit All Databases dialog. This is a 
convenient file management button, but should be used with great caution. Make sure you 
have adequate backup copies of important databases before using this option. 
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OK 

Close the dialog and accept changes. 
  

Cancel 

Since the options in this dialog box are immediate, Cancel is the same as clicking OK. 
  

Help 

Show this help topic. 
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Edit Properties for Database 

  

Purpose 

To activate, display, and set other attributes of a database. 
  

The Edit Properties for Database dialog can be displayed by choosing Edit Databases from 
the Edit menu, selecting the database you want, then clicking the Properties button. If the 
Database Viewer is displayed, clicking a button on the viewer's toolbar can also access this 
dialog. 
  

 
  

Overview 

Each database can be activated independently in WinList. Additionally, the database can be 
set for prompting or automatic mode, and a viewer window can be displayed. This dialog also 
allows you to set the path for the database. 
  

Active 

Check this option to activate the database. When the database is active, it will attempt to 
store a record each time an analysis is performed. Uncheck this option to disable a database; 
records will not be saved in databases that are not active. 
  

Prompting 
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Check this option if you want the program to prompt you each time it is ready to save a 
record. The prompt will allow you to confirm or cancel the saving of the record into each 
active database. Uncheck this option to store the information without prompting. 
  

Viewer 

Check this option to display a Database Viewer for the database. The viewer displays the 
fields in columns and each row represents a record in the database. Additional options are 
available on the viewer window. 
  

Viewer font size 

Choose a font size to use in the database viewer. Choose a larger font to make the text 
easier to read, or a smaller font to view more information in the same space. 
  

Choose database 

This option allows you to choose an existing database on disk. Click the "Link to" button. A 
file selection dialog box will appear, allowing you to navigate to the existing database and 
select it. Linking to an existing database will rename the database in memory to match the 
one selected on disk, and the associated database map on disk will be loaded as well. 
  

Change location 

This option allows you to change the path for the defined database. Click the "Path" button 
to display a Choose database location dialog. Navigate to the location in which you want to 
store the database. 

If a database of the same name already exists in that folder, you will be offered three 
choices. First, you can choose to overwrite the database with the one you have defined. 
Secondly, you can choose to use the database that exists in the new location, replacing the 
structure you have defined in memory. This is convenient when you have a database already 
defined that you want to use. Finally, you can choose to cancel the action. 
  

Neutralize pathway 

This option is useful when you need to move a database to another installation of WinList. 
When the button is clicked, WinList copies the database to the application folder. It then 
empties the internal variable that stores the pathway to the database. This allows the 
program to open the database from the application folder on any installation. 
  

OK 
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Save property settings and put away the Edit Properties for Database dialog box. 
  

Cancel 

Close the dialog and discard any changes you have made. 
  

Help 

Show this help topic. 
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Edit Keyword Map 

  

Purpose: Select the information you want to save in a database. See Databasing with WinList 
for more on databases. 
  

The Edit Keyword Map dialog can be displayed by choosing Setup from the Edit tab on the 
ribbon bar, selecting the database you want to edit, then clicking the Edit button. If the 
Database Viewer is displayed, clicking a button on the viewer's toolbar can also access this 
dialog. 
  

 
  

Overview 

Each database in WinList has its own structure, made up of a set of keywords to database 
and a matching set of fields in a database. The Edit Keyword Map dialog controls how the 
keywords are "mapped" to fields in the database. 
  

Keyword Groups 
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This tree expands to display all of the available groups of keywords. A branch of the tree can 
be expanded by double-clicking the mouse on it. Select a branch of the tree by clicking once 
on it. Elements contained in the selected branch are displayed in the Keywords list below the 
tree. 
  

Keywords 

This list is used to select the keywords you want to store in the database. It shows elements 
contained in the selected branch of the Keywords Groups tree above. The list allows multiple 
selections. Two types of elements are displayed in the Keywords list: keywords and folders. 
When you select one or more keywords in the list and click Add, the selected keywords will 
be added to the database. When you select one or more folders in the list and click the Add 
button, all of the branches and keywords beneath those folders in the tree are added to the 
database. It is very important to understand the practical limitations of databasing before 
adding folders of keywords to the database. See the discussion in Databasing with WinList for 
more on proper selection of information to database. 
  

Keyword-Database Map 

This list displays the fields, keywords, and keyword paths currently in the database. This list 
allows multiple selections. The first column showing the field name can be edited; other 
columns are for display only. To edit a field name, click once on the field to select it, then 
click again after a moment to enter edit mode. 
  

Database Info 

This section displays the file name of the database, the number of fields defined, the limit for 
number of fields, and the number of records currently stored in the database. 
  

Delete 

Click this button to delete the fields selected in the Keyword-Database Map list from the 
database. The button will be grayed if no fields are selected in the list. 
  

Up/Down 

Use these buttons to change the order of fields in the Keyword-Database Map list. The Up 
button moves the selected items toward the beginning of the record definition, and the Down 
button moves them toward the end. The buttons will be grayed if no fields are selected in the 
list. 
  

Add 
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Click this button to add the keywords and folders selected in the Keywords list to the 
database definition shown in the Keyword-Database Map list. Fields are named automatically 
to show the source of the information. You can also double-click on a keyword to add it to 
the definition. 
  

Replace 

The option is available when you select an item in the Keywords list and an item in the 
Keyword-Database Map list. It allows you to map a new keyword to an existing field in the 
database. 
  

OK 

Save changes to the database. If records already exist in the database, the structure of the 
records will be revised to match the new structure you have defined. 
  

Cancel 

Close the dialog and discard any changes you have made. 
  

Help 

Show this help topic. 
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Database Viewer 

  

Purpose: Display the contents of a database. 
  

The Database Viewer can be displayed by choosing to show the viewer in the database 
properties. To do so, choose Edit Databases from the Edit menu, select the database you 
want, and then click the Properties button. In the Edit Properties for Databasen dialog, 
enable the viewer and click OK. 
  

 
  

Overview 

This window can be displayed for any database you have created. The viewer displays the 
fields defined in the database as column headings. Each record in the database is shown as a 
row of information. The window can be scrolled horizontally and vertically if there is 
information out of view. Each column can be resized by dragging the partition between the 
column headings with the mouse. 
  

 
  

At the top, a toolbar provides buttons to manually add, delete, replace and delete all records. 

Click the "+" button to add the current analysis information to the database. 

Click the "-" button to delete the selected records from the database; if the button is grayed, 
there are no records selected. 

Click the replace button to store the current analysis into an existing record in the database. 

Click the trash can button to delete all records in the database. You will be prompted to 
confirm this action. 
  

Additional buttons toggle the database on and off, display the Edit Keyword Map dialog, 
display the Edit Properties for Database dialog, and backup the database. 
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See Databasing with WinList for more on databases. 
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Auto-open databases 

  

 

  

When this option is selected, WinList saves the database configuration when you exit the 
program, and automatically reopens the database when the program is started. 
  

With this option checked, databases and database viewers are automatically opened and 
restored to the state they were in when the program was last used. 
  

If you uncheck this option, you will need to use the Edit Databases command to open the 
databases that you want to use with the program. 
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Add Record (Ctrl D) 

  

This command allows you to manually trigger any open, active databases to save the current 
results as a new record. Normally, database records are saved when you click the Replay 
button or use one of the options in the Replay menu. 
  

The command is found on the Edit tab of the ribbon bar.  Pressing Ctrl D on the keyboard is 
a shortcut for this command. 
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Copy (Ctrl C) 

  

 

  

Select this option to copy the active histogram, results, or report window to the clipboard. A 
histogram will be copied as a bitmap and a metafile by default, two formats that many other 
programs can paste as pictures. The format(s) used can be changed using Copy Special. 
  

Click the title bar of the window you want to copy before using the command. 
  

Pressing Ctrl -C on the keyboard is a shortcut for the Copy command. 
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Copy Special 

  

 

  

This option displays a dialog box, which allows full control over what is copied to the 
clipboard and in what format(s) it is copied. 
  

 
  

The name of the object that will be copied is displayed at the top of the dialog. 
  

Copy 

This drop down list allows you to choose what type of window to copy. The name of the 
active object appears just above the drop down list. 
  

Size 

This drop down list provides a list of target sizes for the Bitmap or Picture copy. For best 
results, choose the size that best matches the size of the image that you want to paste. 
  

DPI 

DPI, or Dots-Per-Inch, is a measure of graphic resolution. Higher DPI settings produce finer 
graphic output, and demand more memory of the computer as well. Choose a DPI setting 
that provides good quality for your use. For example, Screen resolution is usually plenty for 
in-house documents, but publications may want 1200 DPI for the highest quality printed 
output. 
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Palette 

WinList supports normal and "inverse mode" palettes for viewing histograms and result 
windows. This option allows you to copy an object in the current mode or a specific palette 
mode. 
  

Formats 

Text 

This format is available for copying Results windows to the clipboard. 
  

Bitmap 

Bitmap format is a pixel-by-pixel representation of the selected window, also referred to as a 
raster image. The dimensions and resolution of the bitmap depends on the settings for Size 
and DPI. 
  

Picture 

This format is only available for histogram windows. Picture format is a vector-based image 
format (Windows metafile) that can be resized without a loss of image quality. The optimal 
dimensions and resolution of the picture depends on the settings for Size and DPI. 
  

Show Axis 

With this option checked, the histogram axis is enabled in the copy operation. If unchecked, 
the data area of the histogram is copied, without displaying the axis tics and labels. 
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Paste (Ctrl V) 

  

 

  

This command allows you to paste a picture or text object from the clipboard into the active 
histogram or report. The option is available if the clipboard contains bitmap, metafile, or text 
formats. The pasted object can be moved and sized on the histogram or report window. 
  

Note: To paste an object into a Report window, use the Paste button on the report toolbar or 
press Ctrl-V after activating a report window. 
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Drag and Drop 

  

WinList supports a number of drag and drop operations that simplify common functions. 
  

Drag and Drop Object onto Reports 

Many objects in WinList can be dragged onto report windows to simplify adding the object to 
the report. 
  

To drag and drop a histogram, MultiGraph, or results window onto a report, position the 
mouse over the drag hotspot on the title bar, press and hold the mouse button, and drag the 
window onto the report. When you release the mouse button, a linked object will appear on 
the report. 
  

The drag hotspot is the left corner of the title bar of a window. When you position the mouse 
over this spot, the cursor will change to indicate the Drag and Drop functionality. 

 

  

The drag hotspot on the upper left corner of the data source window will drag the entire 
contents of the window onto the report. 

  

 

  
  

Drag and Drop Files onto WinList 

When you drag files from the operating system onto WinList's main window, WinList 
attempts to determine what kind of file you have dropped and open it appropriately. 

You can locate files using Windows Explorer or My Computer on the PC, select them with the 
mouse, and drop them onto the application. Protocol and macro files (wlx, mac, and wlb) are 
opened and run. Report files (wlr) and MultiGraphs (mg) are opened in a new report window. 
  

You can drop a compensation file (cmp) onto a data source to automatically apply the 
compensation settings to it. 
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Other file types are treated as FCS listmode files and the program attempts to open them. If 
you drop files onto an existing data source window, WinList will assume that you want to add 
these files to the batch list for that data source window. If you drop files onto the main 
application window, WinList will attempt to open the first one as a new data source window, 
and then add the remaining files to the batch for this new data source. 
  

Note: When selecting files for drag and drop, the file under the mouse cursor will be the first 
file added. In most cases, you should make the selection and then press and hold the mouse 
on the first file to begin the drag and drop operation. 
  

 
  



WinList User Guide 

521 

Export Listmode 

  

 

  

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu. 

  

Use this command to create a new listmode file based on the current file.  A gate can be 
applied to restrict the events in the exported data file. You can save original parameters as 
well as calculated parameters, either compensated or uncompensated.  Output formats 
include FCS or text file format. 

  

When the Export Listmode command is selected, a dialog box is displayed. 
  

 
  

The Parameters to save list box shows the parameters available to save. Select 
parameters in this list that you want in the new listmode file. 

  

The Output Options group includes several controls the determine how the data is written 
into the new file.   
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Three types of data can be saved: Uncompensated linear, Compensated linear, or 
Compensated log. In most cases, Uncompensated linear format is the best choice. With 
this option, compensation information is stored in keywords so that other software can read 
the new file and apply compensation dynamically. If you need to read the new file into 
software that does not perform compensation, use Compensated linear format. In a few rare 
cases, you might use Compensated log format to save the log-transformed compensated 
data. 

  

The file can be saved as FCS format or Text format. FCS format is Flow Cytometry 
Standard format, compatible with most flow cytometry software programs. Text format is 
tab-delimited text, useful for exporting to database and spreadsheet programs. 

  

You can save ungated data or apply one of the active gates to the data as it is being 
saved. 
  

The program can save all events from the source file, or sample a specified number of 
events. Sampling will divide the number of events in the source file by the number of events 
you want to sample, and use that value to select events to write into the new file. 

  

Enable the Include gate hierarchy ID option to store gate identification as a parameter. 
The gate's ID becomes another parameter in the output file. 

  

After making the selections for parameters and output options, press OK. When the file save 
dialog box appears, type the file name in the edit box and click Save. Use the Cancel button 
close the dialog without saving. 



WinList User Guide 

523 

Export Merge Files 

  

 

  

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu. 

  

Use this command to create a new listmode file that is a concatenation of a set of FCS 
files.  A gate can be applied to restrict the events in the exported data file. You can save 
original parameters as well as calculated parameters, either compensated or 
uncompensated.  Output formats include FCS or text file format. 

  

This option does not create missing parameters or synthesize data to fill in missing 
parameters.  It concatenates files into one, combined, new file.  You can include all the 
events from all files, or sample a number of events from each. 

  

When the Export Merge Files command is selected, a dialog box is displayed. 

  

 

  

Many of these options are the same as those in the Export Listmode dialog box.  See that 
topic for descriptions. 
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Additionally, the Merge Files dialog includes checkboxes to include merge file ID and to 
verify parameters match across the files in the merge. 

  

The Add button displays a File Open dialog to select the files that you want to merge. The 
Remove button will remove selected files from the Files to Merge list.  The Up and Down 
buttons allow the items in the merge file list to be rearranged. 

  

Once parameters and files are selected and output options are set, click the OK button to 
initiate the merge. 
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Export Histogram File 

  

 

  

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu. 

  

This command allows you to save the active histogram to disk in Flow Cytometry Standard 
(FCS) format. Choosing the option initiates the Save dialog box. 
  

Navigate to the folder in which you want to save the histogram by double-clicking on items in 
the tree. Enter a name for the file in the File edit box. By default the name is the same as the 
name appearing on the histogram's title bar. Click Save to store the histogram on disk, or 
Cancel to exit the process. 
  

Only one and two parameter histograms are supported by this option. 

  

See also: 

Export Listmode 
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Export Histogram Graphic 

  

 

  

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu. 

  

This menu option allows you to save the active histogram graphic as a file on disk. The 
graphic can be saved in a number of popular graphics formats, including WMF, BMP, JPG, 
TIF, PNG, or GIF. 

  

Navigate to the folder in which you want to save the graphic by double-clicking on items in 
the tree. Enter a name for the file in the File edit box and choose the graphic format by using 
the Save as Type drop down menu. Click Save to save the graphic to disk, or Cancel to exit 
the process. 
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Export MultiGraph Graphics 

  

 

  

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu. 

  

This menu options allows you to save the active MultiGraph as a graphic file on disk. The 
graphic can be saved in a number of popular graphics formats, including WMF, BMP, JPG, 
TIF, PNG, or GIF. 
  

Navigate to the folder in which you want to save the graphic by double-clicking on items in 
the tree. Enter a name for the file in the File edit box and choose the graphic format by using 
the Save as Type drop down menu. Click Save to save the graphic to disk, or Cancel to exit 
the process. 
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Export Report Graphic 

  

 

  

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu. 

  

This command displays the Save Report Graphic dialog to save the active report as a graphic 
file. The graphic can be saved in a number of popular graphics formats, including WMF, BMP, 
JPG, TIF, PNG, and GIF. 
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Export MultiGraph PDF 

  

 

  

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu. 

  

This option saves the active MultiGraph window as a PDF file. 
  

Navigate to the folder in which you want to save the graphic by double-clicking on items in 
the tree. Enter a name for the file in the File edit box. Click Save to save the graphic to disk, 
or Cancel to exit the process. 
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Export Report PDF 

  

 

  

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu. 

  

This command displays the Export PDF dialog to save the active report as a PDF file. PDF 
stands for Portable Document Format, and is a standard format for exchanging information 
containing graphics and text. It is very useful for creating archival reports or for sharing 
analysis results with others. 
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Export Results 

  

This command is found in the File (Application) menu of the ribbon bar.  When WinList is 
configured to use the classic toolbar and menu interface, the command is found in the File 
menu. 

  

This command allows you to save the active results window to disk in tab-separated text 
format. Choosing the option initiates the Save dialog box. 
  

Navigate to the folder in which you want to save the results by double-clicking on items in 
the tree. Enter a name for the file in the File edit box. By default the name is the name 
appearing on the results window's title bar. Click Save to store the results to disk, or Cancel 
to exit the process. 
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Macros 

  

 

  

Macro commands are found on the Macro tab of the ribbon bar.  When WinList is configured 
to use the classic toolbar and menu interface, the commands are found in the Macro menu. 

  

Macros are command scripts that can be used to automate things that you do repeatedly in 
WinList.  They can be "recorded" as you perform a set of tasks, then saved to disk so that 
they can be "played" later.  You can also directly edit macros to create customized processes. 

  

All macro-related commands are found on the Macro tab of the ribbon bar. 
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Record 

  

Macro commands are found on the Macro tab of the ribbon bar.  When WinList is configured 
to use the classic toolbar and menu interface, the commands are found in the Macro menu. 

  

To begin recording a macro, click the Record checkbox on the Macro tab. A check mark will 
appear indicating that WinList is recording. In Record mode, the WinList functions you 
perform are recorded. You can record an entire sequence of operations, then uncheck the 
Record checkbox to stop recording. 
  

There are a few macro commands that cannot be recorded automatically in Record mode. 
Any of these commands may be added to a macro using the Edit macro command. 
  

See also 

Edit Macro 

Macro Commands 
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Run (Ctrl U) 

  
Macro commands are found on the Macro tab of the ribbon bar.  When WinList is configured 
to use the classic toolbar and menu interface, the commands are found in the Macro menu. 
  
When the Run option is selected, WinList begins executing commands from the macro stored 
in memory. The macro commands can be created with the Record, Open macro, or Edit 
macro options. When running macros, a Macro Status dialog box appears on the screen. The 
recorded macro commands are displayed, and as each command is executed, the list box 
highlights the current macro command. The Macro Status dialog box can be re-sized and 
moved to any convenient location on the screen. WinList will remember the size and location 
you select for the Macro Status dialog and use them the next time a macro runs. 
  
The dialog box contains three buttons: Pause, Continue, and Cancel. Click the Pause 
button to pause the macro.  This is useful when you need to adjust something before letting 
the macro continue. Click Continue to resume running the macro. 
  
To cancel the macro while it is running, select the Macro Status Cancel button. 
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Edit Macro 

  

Macro commands are found on the Macro tab of the ribbon bar.  When WinList is configured 
to use the classic toolbar and menu interface, the commands are found in the Macro menu. 

  

This command displays the Edit Macro dialog box used to edit the currently stored set of 
macros. 
  

 
  

Macro Command 

This field displays the currently select entry from either the Current Macro Command list box 
on the left or from the Available Commands list box on the right. WinList does not register 
any changes made to the command until you press Append, Insert, or Replace. Simply 
pressing the ENTER key will not store the edited command. 
  

Optional Parameter 

This field is used for parameters specific to particular macro commands. For details on valid 
parameters for each command, see Macro Commands. WinList does not register any changes 
made to the optional parameter until you press Append, Insert, or Replace. Simply pressing 
the ENTER key will not store the edited parameter. 
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Current Macro Commands 

This list box displays commands contained in the current macro. Use the vertical scroll bars 
immediately to the right of the list box to see commands not currently in view. To select a 
command for editing, select it in the list. Once selected, the command portion will appear in 
the Macro Command field and the parameter portion, if any, will appear in the Optional 
Parameter edit box. 
  

Available Commands 

This list box contains all of WinList's macro commands. When a desired command is selected, 
it is displayed in the Macro Command field. If a desired command is not in view, scroll in the 
list box. 
  

Append 

The Append push button appends the contents of the Macro edit boxes to the end of the list 
of commands. 
  

Insert 

The Insert push button inserts the contents of the Macro edit boxes above the current 
selected command list box entry. 
  

Replace 

The Replace push button replaces the contents of the Macro edit boxes with the current 
selected command list box entry. 
  

Delete 

The Delete push button deletes the current selected command list box entry. 
  

Delete All 

The Delete All push button deletes all the command list box entries. 
  

OK 
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The OK push button puts away the Edit Macro dialog box and saves any changes made. To 
permanently store the changes to disk, use the macro Save As menu selection. 
  

Cancel 

The Cancel push button puts away the Edit Macro dialog box without saving any changes 
that might have been made. 
  

See also: 

Macro Commands 
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Macro Commands 

  
Most macro commands are equivalent to mouse operations and menu selections you make. 
They are stored during macro recording. However, there are a few commands that are only 
available to you from within the Edit Macro dialog box, e.g. ResetMacroLine, Step, and 
NoStep. 
  

Note: Currently a maximum of 8000 macro lines is supported. 
  

If you record a complex macro and view it with the Edit Macro dialog box, you will be 
presented with a list of command lines that may at first be unfamiliar. It is the purpose of 
this section of the manual to explain what these commands do and what their arguments 
mean and perhaps give you some tips on when to change them. Some commands such as 
AppMessage and HistMessage have a format that is really only relevant to Windows and are 
best created by recording. The numbers associated with the commands shown below are the 
order in which they were implemented and the order they appear in the Macro Command list 
box. For the purpose of explaining their functionality, we will arrange them into more 
meaningful groups. The following are the currently supported macro commands for WinList: 
  

1 SetPath [*.*][D:\winlist\] 

2 SelectFile bag101.fcs 

The SetPath command sets the search wild card for current File IO dialog box (e.g. *.*) 
and sets the pathway to the files of interest (e.g. D:\winlist\). The square brackets are 
mandatory because they allow WinList to parse the two sections of the command correctly. 
Also the terminating "\" in the path is required. The SelectFile command generally follows 
the SetPath command if you are recording a File IO selection. Its argument is simply the 
file selected. If the file has no suffix a period must be placed after the name (e.g. 100222.). 

It's important to realize that WinList uses the same File IO dialog box for several functions 
(e.g. File Data Source selection, Gate selection, Palette selection, Region 
selections, etc.); therefore, these commands must be presented to WinList when the File 
IO box is on the screen. The best way of doing this is to use the record macro option. If you 
do, you will always be assured that these commands are presented to WinList at the proper 
time. A useful technique in modifying these macro commands is to insert a Pause command 
right after the SelectFile command and then delete the SetPath and SelectFile 
commands. WinList will stop the macro when it reaches the Pause command and then you 
can manually select the file of interest and then continue on with the macro by pressing the 
Continue button on the Macro Status dialog box. It's an easy way of making a macro that 
is file-specific to be more general. There are, however, more powerful ways of doing this with 
WinList's Batch features. 
  

3 PushFileButton 

No longer implemented. 
  

4 PutLBAway 
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If you put away the keyword or parameter list box, this command will be recorded. It is 
usually not necessary because WinList will put it away for you automatically. 
  

5 HistEntry 1 1 2 0 64 H_P1_P2 

This command is important and may be one that you want to later modify so let's go through 
it in some detail. This command is recorded when you are selecting which histograms to 
automatically create in a Data Source. The first number indicates the type of histogram 
(0=single parameter, 1=dual parameter, and 2=three parameter). The next three 
numbers (e.g. 1 2 0) indicate which parameters are selected. In the example, we have a 
dual parameter histogram and the X-axis will be parameter 1 and the Y-axis will be 
parameter 2. The third parameter is not used for dual parameter but is used for three 
parameter histograms. The next number (e.g. 64) indicates what resolution to use for the 
histogram. Finally, the ending text is the name of the histogram (e.g. H_P1_P2). After a 
macro is written, you might want to change the resolutions of some of the histograms. All 
you need do is to find the HistEntry command that corresponds to the histogram to change 
and then edit the resolution portion of the command. Another typical change might be to add 
another histogram. Just insert another HistEntry command and you're done. 

The following group of commands activates the designated window in WinList. WinList uses a 
double naming technique for finding a particular window. Every window has a numeric id as 
well as a name. We use both methods for finding a particular Window so that your macro has 
the best chance of finding the appropriate window even if the name of the Window has 
changed. The id follows the name in the command arguments. Therefore, in all the Activate 
commands both the name and id are specified. If WinList can't find the id, it then tries to find 
the window with the designated name. 
  

6 ActivateHistogram [bag101.fcs][1][H_P1_P2][1] 

Activates histogram window id 1 with name H_P1_P2 in data source id 1 named 
bag101.fcs. 

7 ActivateDataSource [bag101.fcs][1] 

Activates the data source window that has an id of 1 or a name of bag101.fcs. The square 
brackets are required. 

8 ActivateResult [R1 H_P1_P2][1] 

Activates the results window that has an id of 1 or a name of R1 H_P1_P2. The square 
brackets are required. 

9 ActivateMultiGraph [MGraph-1][1] 

Activates the MultiGraph window that has an id of 1 or a name of MGraph-1. The square 
brackets are required. 

Whenever a window is sized or moved and macro record is on, one or more of the following 
macro commands is generated. The format of all the arguments is the same. The first 
number is the id of the window and the second two numbers are either the position (Move) 
or size (Size) of the x and y coordinates of the window. The units are in client units which 
are pixels relative to the upper left-hand corner of the parent window. The Size commands 
have an additional argument which is 0 if normal sizing is taking place, 1 if the window is 
becoming an icon, or 2 if the window is maximizing. 
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10 SizeHistogram 1 367 386 0 

11 MoveHistogram 1 346 4 

12 SizeDataSource 1 788 444 0 

13 MoveDataSource 1 0 0 

14 SizeResults 1 112 111 0 

15 MoveResults 1 4 42 

16 SizeMultiGraph 1 459 245 0 

17 MoveMultiGraph 1 295 230 

      

18 DialogBox Button {FileIO_OK}1 0 
0 

This command is used many times in macros. It enables the macro to set all the types of 
objects found in dialog boxes. For example, the Button part of the argument tells WinList to 
press a button. The FileIO_OK is simply descriptive text for you and is not interpreted by 
WinList. You do however need to have some description and it must be braced with the curly 
brackets. The next number tells WinList what button to press. The next two fields are not 
used for buttons but have meanings for other dialog box objects. The different types of 
objects supported by this command are INTEGER, RADIO BUTTON, CHECK BOX, 
BUTTON, LIST BOX, MLIST BOX, CLIST BOX, and STRING. It's really not important for 
you to know all the details for each of these command variants. If you do ever want to 
modify one, just record a small macro that sets the dialog box the way you want and then 
examine it. 
  

19 AppMessage CreateFile WM_COMMAND 60 0 

This is a very common macro command that issues a Windows message to the WinList 
application. Any selection of a menu item creates this command. The first part of the 
argument list is a description of the command invoked (e.g. CreateFile). The second 
argument is a Windows-related parameter that indicates the type of message being sent to 
Windows and its arguments. The 60, for example, tells Windows that this is menu item 60. 
We recommend not changing this parameter without first contacting Technical Support. 
  

20 SetPaletteID 4 

This command is relevant only when the Edit Palette dialog box is on the screen. It sets the 
palette id that can be edited. Currently WinList supports only 16 colors in its default palette. 
  

The next set of macro commands is only relevant to macro processing. Except for the Pause 
command, all of these macro commands need to be inserted into the set of macro 
commands either with the Edit Macro dialog box or by a text editor. 
  

21 Pause Choose the appropriate file to open 



WinList User Guide 

541 

When executed, the Pause command temporarily suspends further macro processing and 
then displays the text for 5 seconds. The macro system will hold in this state until you press 
the Continue button in the Macro Status dialog box. Typical uses of Pause are to add 
manual selection capability to a macro or to simply communicate with the user. You can 
insert Pauses into the macro by either selecting the Pause menu option in the Macro menu 
or by inserting the Pause command from the Edit Macro dialog box. 
  

22 Step Turns step debugging on 

37 NoStep Turns step debugging off 

The Step and NoStep commands can help you work through complex macros. If you insert 
a Step command in a macro, the macro will stop after each macro command is executed and 
will wait for you to press the Continue button in Macro Status. The NoStep command 
simply turns this stepping mode off. A very powerful feature of the Macro Status dialog box 
is that in a paused state, you can highlight another macro command; when Continue is 
pressed the macro will begin running from the selected command. Thus, when you are in 
Step mode you can pick and choose which commands to execute. 
  

27 Remark 

The function of this macro command is simply to document the various sections of a macro. 
The macro processor simply skips this command when it is executing. 
  

29 ResetMacroLine 0 

The ResetMacroLine command is a powerful macro processing command that should be 
used very carefully. When this command is executed by the macro processor, the argument 
is used to reset the macro counter. Thus, if a 0 is in the argument, the macro counter is 
reset to 0 and the macro processor begins executing the macros starting at the beginning. 
This cycle will repeat indefinitely until you Pause or Abort using the Macro Status dialog 
box. There is another way for the macro processor to break the infinite cycle set up by 
ResetMacroLine. If you have recorded the command 

19 AppMessage GetNextBatch WM_COMMAND 15 0 

by executing the GetNextBatch menu option under File, WinList will set an internal flag if 
there are no more batch files that need processing. If the macro processor executes the 
ResetMacroLine and that batch file flag is set, it will continue with the next macro 
command. This construction enables you to create a very powerful macro system. For 
example, 

19 AppMessage GetNextBatch WM_COMMAND 15 0 

... other processing here, analysis, printing, etc. 

29 ResetMacroLine 0 

... further processing perhaps. 

The above lines enable you to open up a series of batch files from the Open Batch Files 
dialog box and then to run this one macro. The system will analyze all the batch files 
automatically until there are no more batch files in the queue. The system will then continue 
through the ResetMacroLine command and do some further processing. This is the method 
we recommend for automating your listmode processing. 
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The following group of macro commands controls the creation, movement, sizing, and 
deletion of all regions in WinList. Because of the complexity of the arguments for these 
commands, we highly suggest you create them by recording. Only under very special 
circumstances should you attempt to edit them. 
  

23 StartRegion 1/R2/CD4/1/19 

When a region is being manipulated, this command is issued first. The first argument (e.g. 1) 
is the type of region being created (0=1P range, 1=2P region, 3=First Quad stat, 
4=2nd,3rd, and 4th Quad stat). The next argument is the name of the region (e.g. R2). 
The next argument is the region's alias (see Region List, e.g. CD4). The next argument is the 
region's numeric index (e.g. 1) and the last argument is the number of points that will be in 
the region (e.g. 19). If there is already a region defined (e.g. R2), it will be erased from the 
screen and deleted from memory. 
  

24 AddToRegion 0/24/51 

This macro command is issued for each point in the region defined in the StartRegion 
macro command. The first argument (e.g. 0) is the 0th or first point, the next argument is 
the x value in the parent histogram channel units (e.g. 24) and the last argument is the y 
value (51). 
  

25 ApplyRegion 1/bag103.fcs/1/H_P1_P2/1 

This macro command creates and displays the region. The arguments are the region index 
(e.g. 1), the data source name (e.g. bag103.fcs), the data source id (e.g. 1), the histogram 
name (e.g. H_P1_P2), and finally the histogram id (e.g. 1). 
  

26 RegionNameSize 1/24/55/30/58 

This command sets the position and size of the region's name. The arguments are the region 
index (e.g. 1), the left corner (e.g. 24), the bottom left corner (e.g. 55), the right corner 
(e.g. 30), and the upper right corner (e.g. 58). 
  

The following commands are Windows oriented messages and have rather obscure 
arguments. It is best that you simply record these and leave it at that. The only argument 
that may be of importance to you is the descriptive argument. These commands are typically 
generated when you delete the window using mouse actions. 

28 HistMessage HistCommand/273/1/8624 

30 ResultsMessage DeleteResults/16/0/0 

31 DataSourceMessage DeleteDataSource/16/0/0 

32 MultiGraphMessage DeleteMultiGraph/16/0/0 

33 InfoMessage DeleteInfo/16/0/0 

      

34 ScaleHistogram 1411 
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When a 1P histogram is re-scaled and we are in record mode, this command will be issued. 
The argument (e.g. 1411) is the new maximum Y-scale for the histogram. 
  

35 SetPrintArea 0/0/765/424 

This command sets the print area for the report printing options of WinList. The arguments 
are the upper left-hand x-value (e.g. 0) and y-value (e.g. 0) and the lower right-hand X-
value (e.g. 765) and Y-value (e.g. 424). 
  

36 SetSpot 1/1/416/2/512 

The SetSpot command sets the current spot to the positions specified in the argument list. 
The arguments are the histogram type (0=1P, 1=2P; e.g. 1), the parameter number (e.g. 
1), the value for this parameter in ADC resolution (e.g. 416), the next parameter number 
(e.g. 2), and its value (e.g. 512). 
  

38 ModifyUserCounter 1,1 

This command changes the value of one of the user-programmable counters by the amount 
specified as the argument to the command. The first number in the argument specifies which 
of five counters to modify (1,2,3,4 or 5), and the second part of the argument specifies the 
amount to change the counter. The counter can be accessed as an internal keyword 
[COUNTERn], where n is a number from 1 to 5 identifying which counter you want to 
access. The [COUNTERn] keyword can be used for naming results windows, MultiGraphs, and 
any other places where internal keywords are accessible. The counter will be increased by 
the amount specified if no sign is present; it will be decreased by the amount if the minus 
sign (-) is specified. For example, ModifiyUserCounter with 1,3 as an argument will increase 
Counter#1 by 3. Using 3,-2 as an argument will decrease the Counter#3 by 2. 
  

39 ResetUserCounter 1 

This command sets the value of one of five user-programmable counters to zero (0). The 
argument specifies which counter to reset. The counter can be accessed as an internal 
keyword [COUNTERn] for naming results windows, MultiGraphs, and any other places 
where internal keywords are accessible. See also command #38: ModifyUserCounter. 
  

40 NextBatchItem 

This command tells WinList to process the next available batch item in the list. This command 
is particularly valuable in creating complex looping commands that involve the RepeatUntil 
command, (see below). 
  

41 RepeatUntil LL <Keyword><Condition><Value> 

The arguments to the RepeatUntil command are: 

LL: is the absolute macro line number, 

<Keyword>: is usually either [COUNTERn] (see above), [LEVEL] which returns the level of 
the current batch item, [NEXTLEVEL] which returns the level of the next batch item, 
[FINISHBATCH] which returns 1 if the last batch item has been processed, or [NEWLEVEL] 
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which returns 1 if the next batch item level is different from the current level, otherwise it 
returns 0. 

<Condition>: is one of the following conditions: "<","<=","==",">",">=". 

<Value>: is some integer number. 

There can be intervening blanks between these tokens. A simple example of the use of 
RepeatUntil is shown below: 

0 NextBatchItem 

1 RepeatUntil 0 [NEXTLEVEL]==1 

2 RepeatUntil 0 [FINISHBATCH]==1 
  

Suppose you have created a batch list that looks like: 

 

When you run the macro it will open the first file, 1543303 and assign it to datasource #1. 
Since this first line is at level 1 (no indentation), when we get to the next line, RepeatUntil 0 
[NEXTLEVEL]==1, the [NEXTLEVEL] finds the level of the next entry in the batch list which is 
2. Since [NEXTLEVEL]==1 is false under that condition, the RepeatUntil loops to the 
designated line number (#0). The macro executes another NextBatchIndex and hits the 
RepeatUntil again. This time, however, [NEXTLEVEL]==1 is true and the macro drops down 
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to the next macro line (RepeatUntil 0 [FINISHBATCH]==1). This line checks to see if we are 
done with the batch. In this case, we are not done so it jumps to macro line #0 again. 

The pattern repeats until we are done with the batch. Keep in mind that you can create any 
number of levels in the batch list box so you can do some pretty complicated stuff 
automatically. We've created some fairly powerful examples of this looping capability. If you 
let us know you are interested in obtaining copies, we'll send them to you. 
  

42 GetResourceFiles <Name> 

When played, instructs WinList to open the stored palette, regions, and gates. <Name> is 
any legal DOS filename excluding the "." and suffix. This command is automatically 
generated by the Save Protocol command. 
  

43 ClearProtocol 

When played, instructs WinList to initialize the protocol. This is a dangerous command. It 
should only be used if you need to ensure that WinList is in a default starting condition. The 
Save Protocol command automatically generates this command. 
  

4
4 

SetProtoco
l 

<Version><maxRegions><maxGates><maxSpots><maxColo
rs> 

<maxParams><dataPacketSize> 

When played, instructs WinList to set the protocol with the above specifications for the 
resources. This is a dangerous command. It should only be used if you need to ensure that 
WinList is in a default starting condition. The Save Protocol command automatically 
generates this command. 
  

45 SetWindowName <Type>,<Name> 

When played, instructs WinList to set the <Type> window's name to <Name>. The current 
active window is the one edited. <Type> can be PROTOCOL, DATASOURCE, 
HISTOGRAM, RESULTS, or MULTIGRAPH. The <Name> field can be a name of the 
window or a keyword that when evaluated results in the name (e.g. [SAMPLE]). 
  

46 ClearMultiGraph 

When played, instructs WinList to clear the contents of the current MultiGraph. 
  

47 Echo <Status> 

When <Status> is set to OFF, histograms, results, and MultiGraphs will not be repainted on 
the screen. When <Status> is ON, the program automatically repaints all windows on the 
screen. This macro command is useful in speeding up macro playing especially if there are 
numerous events in each two parameter histogram. If you are inserting a Pause command 
within a dialog box, make sure the state of Echo is On; otherwise, you will not see the dialog 
box after the Pause executes. 
  

48 GetNumberRegions <counter id> 
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This command takes as its argument a number which identifies a counter id, and sets that 
counter to the number of regions in the active histogram. For example, if the active 
histogram has 4 regions in it, GetNumberRegions 5 will set user counter 5 equal to 4. It can 
be used for creating looping macros which loop depending on the number of regions in a 
histogram. 
  

49 UpdateRemoteLinks 

This command has no arguments. When executed, this command will initiate the DDE scripts 
for all histogram and results windows which have remote connections set to update On 
Command. Scripts are executed in order of lowest data source-histogram window id to 
highest data source-histogram window id, then results windows from lowest id to highest. 
  

50 ExecuteMacro <macro name> 

This command opens a macro file, <macro name> and runs the macro. It allows you to 
chain macros together. A macro which is opened and run with the ExecuteMacro command 
does not return to the macro from which it was executed. To use the command, select it 
from the Available Commands list in the Edit Macro dialog box, enter the macro name as its 
optional parameter, and append it to your macro. If you insert ExecuteMacro in the body of a 
macro, any macro lines following it will not be executed. 
  

51 PositionRange rangeNum/type/lowBoundary/highBoundary 

This command can be used to reposition a region on a single parameter histogram. It 
positions one leg of a single parameter region in the lowest channel between lowBoundary 
and highBoundary. 

rangeNum: Identifies the region. It must be a 1 parameter region. R1 corresponds to a 
rangeNum of 1. 

type: Identifies whether the left side (0) or the right side (1) is being repositioned. 

lowBoundary: Starting point for the search. The value is in units of percent of X-axis 
resolution. This allows the same command arguments to be used with listmode files of 
different resolution parameters. 

highBoundary: Ending point for the search. The value is in units of percent of X-axis 
resolution. This allows the same command arguments to be used with listmode files of 
different resolution parameters. 
  

52 Save Compensation 
File 

<file path name> 

53 Open Compensation 
File 

<file path name> 

54 Save Equation File <file path name> 

55 Open Equation File <file path name> 

56 Save Cluster File <file path name> 

57 Open Cluster File <file path name> 
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Commands 52 through 57 allow compensation, calculated parameters, and cluster definitions 
to be saved to disk and opened from disk. 
  

58 SetActiveObject type, id, name 

This command can be used to activate different objects. Presently, histogram and data 
source objects are the only supported values for type. The values for id and name represent 
the object's ID and name, shown in the titlebar. Once activated, you can send other 
commands and change object properties using the SetProperty and DoCommand commands 
below. 
  

59 SetProperty property, type, value 

This command changes properties for the active object. Presently, histogram objects are the 
only supported objects. Determine the possible values for property by recording a macro that 
edits the properties of an object, and then looking at the SetProperty lines in the macro. 
Type and value should be determined in the same manner. 
  

60 DoCommand command, option 

This command can instruct an object to do certain operations. Presently, histogram objects 
are the only supported objects. The object that receives the DoCommand should be activated 
with a SetActiveObject command prior to using DoCommand. 

Histograms support two commands. 

UpdateObject command has no option. It causes a histogram to update and redraw. 

EditObject command can be used with no option to display the Edit Histogram dialog box, or 
it can be used in the form EditObject,Graphics to display the Edit Graphics dialog for the 
histogram. Note, there are no spaces in this form, just a comma to separate EditObject from 
Graphics. 
  

61 reserved   

62 Open Names File <file path name> 

Command 62 opens files for the Names and Resolutions dialog box. When saving protocols, a 
names and resolutions file is automatically saved if you have used the Names and 
Resolutions dialog to edit parameter names or log decades. 
  

63 Close Report   

This command closes the active report file. There are no arguments to the command. 

   

64 Open Report <file path name> 

Command 64 opens the specified report file. When saving protocols, reports are 
automatically saved and a command is added to the protocol to open the report. 
  

65 reserved   

66 Open Alerts <file path name> 
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Command 66 opens the specified alerts file. This command is automatically generated when 
you save a protocol if you have created alert conditions. 
  

67 reserved   

68 Open Acquisition 
Settings 

<file path name> 

Command 68 opens a file containing the settings in the Acquisition dialog for the Cytometer 
Plug-in-enabled version of WinList. 
  

69 Set Color Mode <mode> 

This command selects a color display mode for the active data source. Currently support 
values for <mode> are listed below. 

Value Meaning 

0 Color by Gate Color 

1 Color by Gate Combinations 

2 Color by Parameter Value 

3 Color by Gate Hierarchy 

  

70 Open Protocol <file path name> 

71 Save Protocol <file path name> 

Commands 70 through 71 allow protocols to be saved to disk and opened from disk. 
  

72 Save Protocol Bundle <file path name> 

This command is used to save the current setup as a protocol bundle. 
  

73 reserved   

74 Open Compensation 
Database 

<file path name> 

Command 74 opens a compensation database file for use by WinList's compensation 
database system. 
  

75 Open Palette File <file path name> 

This command is used to open a palette file to set the colors used by gates. 
  

Important Macro Tips 

When editing macros, save the revised macro frequently under a new name and test the 
changes you make incrementally. It is much easier to debug your changes if you have only 
made a few at a time. 
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Use the Close All Windows menu option at the beginning of a macro if you want to be certain 
that the macro starts with a clean slate. Even if no other windows are open when you start 
recording the macro, you can still record the command to close all windows. When the macro 
is run, the command will be ignored if no other windows are open. 
  

We suggest that when you are creating a complex macro you should break it up into logical 
sub-units. For example, record a macro that simply arranges the screen to your design 
specifications. Record another macro that sets up all the regions. When macros are in smaller 
sub-units, they become more manageable and easier to edit. You can use a word processor 
to concatenate all the macros together or you can use the multiple macro capability of Open 
Macro to run all the pieces at one time. The latter is probably the best choice because it gives 
you the most flexibility. 
  

See also: 

Edit Macro Toolbox 
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Open 

  

Macro commands are found on the Macro tab of the ribbon bar.  When WinList is configured 
to use the classic toolbar and menu interface, the commands are found in the Macro menu. 

  

WinList displays the standard file open dialog box, allowing you to navigate to a drive and 
directory and enter a name for the macro file. 
  

Click the Open button to read the macro from disk. 
  

Click Cancel to cancel the dialog. 
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Save 

  

Macro commands are found on the Macro tab of the ribbon bar.  When WinList is configured 
to use the classic toolbar and menu interface, the commands are found in the Macro menu. 

  

WinList displays the file save dialog box, allowing you to navigate to a drive and directory 
and enter a name for the macro file. 
  

Click the Save button to store the macro in the folder on disk. 
  

Click Cancel to cancel the dialog. 
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Clear 

  

Macro commands are found on the Macro tab of the ribbon bar.  When WinList is configured 
to use the classic toolbar and menu interface, the commands are found in the Macro menu. 

  

Selecting the Clear command will clear the current macro from memory. It has the same 
function as the Delete All button in the Edit Macro dialog box. 

  

If the macro was saved to disk, the disk file is not affected by this action. 



WinList User Guide 

553 

Macro Batch 

  

Macro commands are found on the Macro tab of the ribbon bar.  When WinList is configured 
to use the classic toolbar and menu interface, the commands are found in the Macro menu. 

  

This menu option is used to select a set of macros that you want WinList to run in sequence. 
  

 
  

Path 

This displays the complete pathway to the directory containing the macro files. To choose a 
new path, click the "..." button. 
  

Macro List 

The macro list box contains all the files in the selected pathway. Files are displayed 
alphabetically. On the right is a vertical scroll bar that can be used to find the files not 
displayed in the box. Clicking on the up or down arrow in the bar scrolls entries in that 
direction. To open a particular macro, click the left button of the mouse once on the file in 
the list box, and then click the Open button. The dialog box will disappear from the screen 
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shortly after the Open button is pressed. Alternately, double-clicking on a macro name will 
open the macro, close the dialog box, and run the macro. 
  

Open 

Selecting this option opens the macro selected in the macro list box and closes the Open 
Macro dialog box. Alternately, double-clicking on a macro name in the Macro List will open 
the macro, close the dialog box, and run the macro. 
  

Cancel 

The Cancel button closes the Open Macro dialog box without opening a macro. 
  

Batch List 

This listbox displays the macros that you have added to the macro batch using the Add 
button. These macros will run in sequence when the Run Batch button is clicked. 
  

Add 

Clicking the Add button copies the highlighted files in the Macro list box into the Batch list 
box. 
  

Delete 

Select this option to remove all files highlighted from the Batch list box. 
  

Delete All 

Click this button to clear the macro batch list box. 
  

Run Batch 

Clicking the Run Batch button launches, in sequence, each macro listed in the Batch list box. 
The Open Macro dialog box will be hidden during the batch execution, but a Batch Status 
dialog box will display the number of macros left in the batch, and allow canceling of the 
batch. 
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Change Macro Paths 

  

Macro commands are found on the Macro tab of the ribbon bar.  When WinList is configured 
to use the classic toolbar and menu interface, the commands are found in the Macro menu. 

  

This command provides a simple method for revising macros to run from a different folder or 
disk. 
  

Macros and legacy protocol macros contain many references to specific files on disk. The 
listmode files that are used by protocols, the compensation files, and many others are 
identified by complete pathways. This can create problems when you need to run a macro or 
open a protocol from a different location on your computer. To resolve this problem, the 
Change Macro Paths command changes all pathways in the macro or protocol to a new path 
that you select. 
  

To use this command, follow these steps. 

1. Copy all of the files used by the protocol or macro into the new location. It is important to 
place all of the files, include the data files that are used directly by the protocol, in one folder 
in the new location. 

2. Using the Open command in the Macro menu, read the macro from the new location into 
WinList. Do not use the Open Protocol command for this purpose, because the macro will still 
refer to the old locations. 

3. Choose the Change Macro Paths command. The Change Macro Paths dialog will appear. 
  

 
  

4. If the path shown in the New Path edit field is not the path you want to use, click the 
Choose button to select a new path. 

5. Click the OK button to change the pathways in the macro to the new path. The program 
will change all pathways in the macro to the new path. 

6. If you want to store these changes to disk, use the Save command in the Macro menu to 
re-save the file. 
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Pause Macro 

  

Macro commands are found on the Macro tab of the ribbon bar.  When WinList is configured 
to use the classic toolbar and menu interface, the commands are found in the Macro menu. 

  

This option can be selected while recording a macro to record a Pause command in the 
macro. After recording a Pause command, a custom message can be defined using the Edit 
Macro dialog box. 
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Show Macro Toolbox 

  

Macro commands are found on the Macro tab of the ribbon bar.  When WinList is configured 
to use the classic toolbar and menu interface, the commands are found in the Macro menu. 

  

This command displays or hides the Macro Toolbox. The Macro Toolbox is a popup window 
with programmable buttons on it. The buttons can be hooked up to macros or protocols files 
on disk.  When a toolbox button is pushed, the associated macro or protocol file is opened, 
and if it's a macro file, the macro runs. It is especially useful for running macros that 
automate commonly performed operations. 

  

 
  

Once the Macro Toolbox is displayed, you can move it to any convenient location on the 
screen. Its position will be stored by WinList so that each time you run the program, the 
toolbox will appear where you left it. 
  

You can control the number of buttons and the macros associated with them by using the 
Edit Macro Toolbox dialog box. 
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Edit Macro Toolbox 

  

Macro commands are found on the Macro tab of the ribbon bar.  When WinList is configured 
to use the classic toolbar and menu interface, the commands are found in the Macro menu. 

  

Select this command to program WinList's Macro Toolbox. The Macro Toolbox is a popup 
window that contains programmable buttons. The buttons can be "hooked up" to macros 
stored on disk so that when a button is pushed, the associated macro is executed. It is 
especially useful for running screen setup macros and macros that automate commonly 
performed operations. 
  

The Show Macro Toolbox menu option allows you to display or hide the toolbox. 
  

To program the toolbox, first adjust the number of rows and columns to suit your needs and 
click the Set size button. Next, select the first line in the list box below and click the Select 
macro button. From the file list, select a macro you want to assign to a button and click 
"Select.”  The macro you selected will be assigned. Continue assigning macros in this 
manner until all of the macros you want in the toolbox have been assigned to a button. Then 
click OK to display and use the toolbox. You can drag the toolbox to any location on the 
screen. 

  

 
  

Rows 
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Enter a number, 1 or greater, to determine the number of rows of buttons you want to 
display in the Macro Toolbox. 
  

Columns 

Enter a number, 1 or greater, to determine the number of columns of buttons you want to 
display in the Macro Toolbox. 
  

Note: The maximum number of buttons (Rows X Columns) is 100. 
  

Elements 

This field displays the number of buttons that will be displayed in the macro toolbox (rows X 
columns). 
  

Set size 

Click this button to change the toolbox rows and columns settings. The number of items in 
the list box will increase or decrease depending on whether the size is increasing or 
decreasing. 
  

Id 

The ID is the button associated with a macro.  Buttons on the toolbox are labeled with the 
ID. 
  

Name 

This edit box displays the name of a macro assigned to the button. You may edit this field, 
keeping the name's length under 30 characters. The name entered here is displayed in the 
Macro Toolbox title bar as you move your mouse over the buttons. By default, WinList will 
use the macro's name on disk as its toolbox name. 
  

Macro 

This edit box displays the name of the macro file on disk. It is filled in automatically if you 
select the macro using the Select Macro button described below. 
  

Pathway 
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This edit box displays the pathway of the macro file on disk. It is filled in automatically if you 
select the macro using the Select Macro button described below. 
  

Select macro 

Clicking this button will display a file list dialog box. You can select a macro using this dialog 
box, and the selected macro will be assigned to the currently selected toolbox id in the list 
box. 
  

Delete 

Click this button to remove a macro assignment from the list. 
  

OK 

Click this button after you have finished making your edits to the Macro Toolbox. The 
changes you make will be accepted and the Macro Toolbox will be displayed after the Edit 
Macro Toolbox dialog is closed. 
  

Cancel 

Select this button to exit with no changes made to the Macro Toolbox. 
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Edit Log 

  

 

  

This command is found on the Edit tab of the ribbon bar, or in the Edit menu when using the 
toolbar and menu display. 

  

The Edit Log dialog box allows you to view and set properties for session logging. Logging 
can be used to help Technical Support resolve problems with your software. 

  

To display the Edit Log dialog with the ribbon bar interface, click Logging on the Edit 
tab.  With the menu & toolbar interface, choose Log from the Edit menu. 
  

You can turn logging on and off by pressing the F2 key on the keyboard. The application title 
bar will indicate when logging is enabled. 
  

See Edit Log and Edit Properties for Log for more information. 
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Edit Log 

  

This dialog allows you to view the WinList log file, if logging is enabled. 
  

 
  

OK 

Click this button to close the dialog and accept any changes. 
  

Cancel 

Click this button to close the dialog and discard changes. 
  

Properties 

Click this button to display the Edit Properties dialog for the logging object. 
  

See also Edit Properties for Log and Logging. 
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Edit Properties for Log 

  

This dialog allows you to control the properties of the WinList logging function. Logging can 
be used to create a list of actions that you performed using the program, and can assist 
Technical Support in trouble-shooting problems. Normally, this option should be disabled. 
  

 
  

Active 

Check this option to enable the logging function. WinList will create a file named WListLog.txt 
in the WinList 3D folder under the user's documents. The file will store operations you 
perform as you work with the program. 
  

Logging Level 

Choose between Basic and Debugging.  Debugging level includes all the Basic information 
plus additional logging to help trouble-shoot problems. 
  

Size limit 

Select the size limit for the logging file. 
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Full Error Report 

Enable this option to create a more detailed error report for VSH technical support.  The error 
report will also be larger on disk. 

  

Use Custom Path 

Enable this option to specify the location where you want log files to be stored. 

  

Custom Log Path 

When Use Custom Path is enabled, this property specifies the location of the log files. 

  

Clear 

Click this button to clean out the log file. 
  

See also Logging and Edit Log. 
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Preferences 

  

 

  

To display the dialog, choose Preferences from the File (Application) menu or the 
Options tab of the ribbon bar.  In the menu & toolbar interface, the command is in the 
Options menu. 

  

The Preferences command displays a dialog box that is used to set up default values for 
many options in WinList. 

  

The dialog displays a tree of categories on the left. Click a category item in the tree to view 
and edit its properties. 
  

 
  

Open 

Choose this command to open a WinList preferences file from disk. All of the preferences in 
the stored file will be read and used to set preferences for the program. 
  

Save 
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Choose this command to save the WinList preferences as a file. This file can be used to 
configure WinList on different computers to use the same settings. 
  

Save preferences 

Enable this option if you have opened a preference file with the Open command above and 
you want to store the new preferences so that they will be used the next time you start 
WinList. 
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Histogram Preferences 

  

To display the dialog, choose Preferences from the File (Application) menu or the 
Options tab of the ribbon bar.  In the menu & toolbar interface, the command is in the 
Options menu. 

  

These preferences apply to all histogram types. 
  

 
  

Show Create Histograms dialog 

When enabled, the Create Histograms dialog is displayed whenever a new data source is 
created. 
  

Show gate expression 

When enabled, the gate expression appears in the title bar of each histogram 
  

Keep histograms square 

When enabled, the window arranging commands will always keep histograms windows 
square. 
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Multiple selection 

When enabled, you can select more than one histogram window by pressing the Ctrl key on 
the keyboard.  This can be used for moving and sizing histograms, as well as for drag-and-
drop and some graphics properties. 

  

Histogram line weight 

Choose a weight of the line used to draw 1P histograms. Sizes are in 1/2 points, (a point is 
0.35 mm or 1/72 in). 
  

Axis line weight 

Choose a weight of the line used to draw axis borders and tics. Sizes are in 1/2 points, (a 
point is 0.35 mm or 1/72 in). 
  

Grid line weight 

Choose a weight of the line used to grids on histograms. Sizes are in 1/2 points, (a point is 
0.35 mm or 1/72 in). 
  

Histogram border 

Choose how much space to allow between the graphics and the window border for all 
histograms. 
  

Graphic Output 

Graphic size 

The value specifies the virtual size for a histogram window when creating a picture (metafile) 
of the histogram to copy to the clipboard. When you paste the picture into another 
application and display it at the specified size, it will look best at the target size you select 
here. Enter a larger value to reduce the size of fonts in the picture relative to other aspects 
of the histogram, or a smaller size to increase the fonts. 

See also MultiGraph Preferences for setting the target size for images added to MultiGraphs. 
  

Graphic DPI 
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This property specifies the dots-per-inch, or DPI, used when copying a histogram graphic to 
the clipboard or saving it to disk.  Higher values provide better quality output but require 
more memory. 
  

Graphic format 

This property determines the file format used when saving graphics to disk. Choose the 
format that you most commonly use. 

  

Colors 

Palette mode 

This property determines what palette mode is used when histograms are copied, printed, or 
updated on a report. 

Use normal palette uses the normal background and foreground colors, Use inverse 
palette uses the reverse background and foreground colors, and Use current view will use 
same palette mode that is currently displayed. 
  

Copy background color 

Enable this property if you want the background color of histograms included when the 
histogram is copied. 
  

Grid color 

Choose a color from the standard color dialog to use for grids on histograms. 
  

Save preferences 

When checked, these preferences will be stored as new default preferences when you click 
OK to close the dialog. If unchecked, changes are only applied to this session of the program. 
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1P Graphics Preferences 

  

To display the dialog, choose Preferences from the File (Application) menu or the 
Options tab of the ribbon bar.  In the menu & toolbar interface, the command is in the 
Options menu. 

  

These preferences apply to 1P histograms. Individual histograms can override these settings. 
  

 
  

Resolution 

Choose a desired histogram resolution for 1P histograms. 
  

Fill histogram 

When checked, histograms will be filled with color by default. Uncheck the option to display 
histograms without a fill. 
  

Coloring mode options 

Overlay style 
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This option determines how 1P histograms display in coloring modes Color by Gate 
Combinations and Color by Gate Hierarchy. 

"No subset overlays" displays a single polygon for the 1P histogram. 

"Overlay color subsets" draws additional polygons, one for each color. Each polygon is drawn 
from the baseline. 

"Stacked color subsets" draws additional polygons, one for each color. The first polygon is 
drawn from the baseline, and the bottom of the next polygon is the top of the previous 
polygon. 
  

Save preferences 

When checked, these preferences will be stored as new default preferences when you click 
OK to close the dialog. If unchecked, changes are only applied to this session of the program. 
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2P Graphics Preferences 

  

To display the dialog, choose Preferences from the File (Application) menu or the 
Options tab of the ribbon bar.  In the menu & toolbar interface, the command is in the 
Options menu. 

  

These preferences apply to 2P histograms. Individual histograms can override these settings. 
  

 
  

Resolution 

Choose a desired histogram resolution for 2P histograms. If the chosen value is greater than 
the resolution of the listmode file, the maximum resolution of the listmode file will be used. 
  

Dots and Density Plots 

Dots 

To display dots density by default, check this option. When the option is unchecked, dots will 
not be displayed on the histogram. 
  
Color density 

To display color density by default, check this option. When the option is unchecked, color 
density dots will not be displayed on the histogram. 
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Number of dots 

Enter the number of dots you want to display in the histogram window. 

Note: The actual number of dots displayed may be less that the number you enter. If there 
are fewer events in the data than you specify, or if the packet size you specify is less than 
the number of dots, fewer dots will appear. 

In the second case where the packet size is smaller than the number of dots, you can display 
the full number of dots by replaying data for that histogram, or you can adjust the packet 
size to store the entire listmode file. See Edit Program Controls for further discussion of 
packet size. 
  
Dot size 

This option controls how large each event (or dot) will be on the screen and printer. A size of 
0 will display the smallest unit on the device. Other sizes are in points, a unit of 0.35 mm or 
1/72 in. 
  
Dot order 

When using color event gating, this option controls the order in which dots are drawn. 
Listmode order draws dots in their natural event order based on the listmode acquisition. Low 
frequency on top draws the dots for the smallest populations last so that they can be seen on 
top of populations that have many events. It is useful for visualizing rare events. High 
frequency on top draws the dots for the largest populations last. It may be used to visually 
clean up low frequency events. 
  

Show all dots 

By checking this option, all events will be displayed in the 2P histogram after replaying. See 
the note for "Number of dots" above for more on showing all dots. 
  

Contour Plots 

Contours 

To display contours, check this option. Uncheck the option if you do not want contours to 
display. 
  

Show outlier dots 

To display dots that fall outside the first contour, enable this option. NOTE: When this option 
is enabled, the only dots displayed are those that fall outside the lowest or base contour. It 
effectively disables the Enable Dots option in the Dots and Density graphics section. 
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Probability interval 

This value determines the probability used to compute contours. 
  

Base Contour 

This dropdown list selects the level of the lowest, or base, contour. The level is selected as a 
percentage of events that it will include. The highest percentage, 99%, will include 99% of 
the events in the histogram. 
  

Line weight 

Choose a line weight for the contour border. The value is in points, a unit of 0.35 mm or 1/72 
in. 
  

Fill contours 

When this option is checked, contours will be filled with colors defined in the Colors section. 
When unchecked, the contour is unfilled. 
  

Percent Iso3D Translucency 

Select the default translucency to use for Iso3D displays. Higher values make the populations 
more translucent. 
  

Colors for Contours and Color Density 

Color mode 

For color density and contours, this option determines how colors are assigned to different 
levels. Color gradient mode assigns Gradient Start color to the first level and gradually 
changes colors to Gradient End color for the last level. Rainbow mode uses colors from 
WinList's color palette, starting with color 1 and sequentially selecting colors from the palette 
for each level. If there are more levels than colors, colors are repeated. 
  

Gradient Start color 

Choose a color to use as the starting color for color density dots and contours in Color 
Gradient mode. When you click the color button, the standard color selection dialog box is 
displayed. 
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Gradient End color 

Choose a color to use as the ending color for color density dots and contours in Color 
Gradient mode. When you click the color button, the standard color selection dialog box is 
displayed. 
  

Rainbow colors 

Select the number of rainbow colors to use in Rainbow color mode. The default, 5, serves 
most cases very well. 
  

Rainbow 1 - n 

Select a default color for each Rainbow mode level. 
  

Save preferences 

When checked, these preferences will be stored as new default preferences when you click 
OK to close the dialog. If unchecked, changes are only applied to this session of the program. 
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3P Graphics Preferences 

  

To display the dialog, choose Preferences from the File (Application) menu or the 
Options tab of the ribbon bar.  In the menu & toolbar interface, the command is in the 
Options menu. 

  

These preferences apply to 3P histograms. Individual histograms can override these settings. 
  

 
  

Resolution 

Choose a desired histogram resolution for 3P histograms. If the chosen value is greater than 
the resolution of the listmode file, the maximum resolution of the listmode file will be used. 
On PC versions that support the 3D viewer, it is recommended that you choose a value of 32 
channels. 
  

Dots 

Number 

Enter the number of dots you want to display in the histogram window. 
  
Dot size 
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This option controls how large each event (or dot) will be on the screen and printer. A size of 
0 will display the smallest unit on the device. Other sizes are in points, a unit of 0.35 mm or 
1/72 in. 
  

Lines 

When this option is enabled, gray lines are drawn from each dot to the base plane. When 
displaying 1000 dots or fewer, this is useful to identify the position of dots. 
  

3D 

3D style 

Select the default 3D display. 
  

Save preferences 

When checked, these preferences will be stored as new default preferences when you click 
OK to close the dialog. If unchecked, changes are only applied to this session of the program. 
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Print Preferences 

  

To display the dialog, choose Preferences from the File (Application) menu or the 
Options tab of the ribbon bar.  In the menu & toolbar interface, the command is in the 
Options menu. 

  

These preferences control various aspects of printing. 
  

 

  

Page Setup 

Page width 

Enter the page width, in inches. This setting is used when printing reports, histograms, and 
MultiGraphs. 
  

Page height 

Enter the page height, in inches. This setting is used when printing reports, histograms, and 
MultiGraphs. 
  

Margins 
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Top, Bottom, Left, and Right margins 

Enter the number of inches for each margin. These margins are used when printing reports, 
histograms, and MultiGraphs. 
  

Other 

Show Print Setup dialog 

Enable this option to display the Print Setup dialog prior to each print job. 
  

Print borders 

Enable this option if you want the program to print a line border around reports, histogram, 
and MultiGraphs. Clear the check to disable this option. 
  

Print names 

Enable this option to print the names of objects on reports, histograms, and MultiGraphs. 
  

Print Histogram size 

This option selects the page size to use for the Print Histogram command. 
  

Save preferences 

When checked, these preferences will be stored as new default preferences when you click 
OK to close the dialog. If unchecked, changes are only applied to this session of the program. 
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Font Preferences 

  

To display the dialog, choose Preferences from the File (Application) menu or the 
Options tab of the ribbon bar.  In the menu & toolbar interface, the command is in the 
Options menu. 

  

These preferences control the fonts that are used by WinList. Each font is selected by clicking 
the associated button to display the standard font dialog, choosing a font, and clicking OK. 
  

 
  

Axis numbers 

Choose the font used for histogram axis numbers. 
  

Axis labels 

Choose the font used for histogram axis labels. 
  

Regions 

Choose the default font used for region labels. Individual regions can override this font by 
editing region properties. 
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Results 

Choose the font used for result windows. 
  

MultiGraph 

Choose the font used for text in MultiGraph windows. 
  

Titles 

Choose the font used for titles when printing reports. 
  

Captions 

Choose the font used for captions of histogram report objects. 
  

Reset 

Click this button to reset all fonts to the default state for the program. 
  

Save preferences 

When checked, these preferences will be stored as new default preferences when you click 
OK to close the dialog. If unchecked, changes are only applied to this session of the program. 
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MultiGraph Preferences 

  

To display the dialog, choose Preferences from the File (Application) menu or the 
Options tab of the ribbon bar.  In the menu & toolbar interface, the command is in the 
Options menu. 

  

These preferences are used by MultiGraph windows. 
  

 
  

Name 

Enter the default name for the MultiGraph window. You can enter text, or type a keyword 
enclosed in square brackets. For example, [FILE] will cause a new MultiGraph to be named 
with the listmode file name of the active data source. 
  

Labels 

Label 

Enter the default label to use for graphical elements in a MultiGraph. 

Labels can include any FCS keywords embedded in the data file and internal WinList 
keywords. Keywords must be surrounded by square brackets [ ]. See Internal Keywords for 
more on keywords. 
  



WinList User Guide 

583 

Label position and width 

The X and Y positions and the width can be entered in these edit boxes. The numbers are in 
percentage of the windows where 0 percent x and y is the lower left corner of the window, 
and 100 percent x and y is the upper right. X and Y positions determine the origin of the 
label. The width, again in percent, determines how wide the label can extend. Usually, the 
width and the x position values should not add up to more than 100 or the label will spill out 
of that histogram's portion of the MultiGraph. 
  

Tiled view options 

Columns 

Enter the default number of columns for tiled MultiGraphs. 
  

Rows 

Enter the default number of rows for tiled MultiGraphs. If you want an unlimited number of 
rows on one MultiGraph page, enter 0 for rows. 
  

Center text 

Check this item to center results text in the element space. If unchecked, results text is left 
aligned. 
  

Clip text 

Check this item to keep results text from entering adjacent element space. 
  

Keep elements square 

When checked, the histogram elements in the MultiGraph will always be square, preventing 
distortion of the histogram graphics. The overall size of the elements may shrink with this 
checked, since the program will use the lesser of the X and Y element size to determine the 
space in which to draw. 
  

Element spacing 

Choose the amount of space, in pixels, to leave between elements in a MultiGraph. 
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Other options 

Picture creation size 

The value specifies the virtual size for a histogram window when creating a picture (metafile) 
of the histogram to add to the MultiGraph. Enter a larger value to reduce the size of fonts in 
the picture relative to other aspects of the histogram, or a smaller size to increase the fonts. 
Default value, 7.6 cm. or 3.0 in., works well in most cases. 
  

Dot size 

This option allows you to select a dot size to use when adding dot plots to the MultiGraph. 
The dot size can be the same as the histogram dot size, or you can choose a different 
setting. This may be useful if your MultiGraphs are not printing dots correctly to high-
resolution printers, in which case you would choose a larger dot size for the MultiGraph than 
what you have for the histograms normally. 
  

Histogram quality 

This option controls the quality of the histogram graphics that are generated when 
histograms are added to a MultiGraph. Lower quality settings will produce graphics that 
require less memory, draw faster, and print faster. Perfect quality requires the most memory 
and draws the slowest, but produces the best output possible from the program. Experiment 
with this setting to find a suitable quality for your purposes. 
  

Copy background color 

When enabled, the background color for histograms is copied with the histogram graphic. 
When this option is not enabled, the background color of the MultiGraph appears behind 
transparent histogram graphics. 
  

Text lines per element 

When copying an entire MultiGraph to the clipboard, this setting determines how to scale the 
font used for results window elements. Enter a value that is at least as big as the maximum 
number of rows for the results elements contained in the MultiGraph. 
  

Grid offset 

This option allows you to align grids for left-to-right and right-to-left view MultiGraphs. The 
value is the fraction of the MultiGraph window to offset the grids so that they align with the 
axes of the elements. Default value is 0.15. 
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Save preferences 

When checked, these preferences will be stored as new default preferences when you click 
OK to close the dialog. If unchecked, changes are only applied to this session of the program. 
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Region Preferences 

  

To display the dialog, choose Preferences from the File (Application) menu or the 
Options tab of the ribbon bar.  In the menu & toolbar interface, the command is in the 
Options menu. 

  

These preferences apply to regions created by WinList. Individual regions can override these 
preferences using the Edit Properties for Region dialog. 
  

 
  

General 

  

Associate with histograms 

When this option is enabled, a region becomes associated with the histogram in which it was 
originally created. If you delete the region, the program remembers the association and will 
only recreate the region in the same histogram. 

With the option disabled, you can delete a region from one histogram and recreate it in 
another histogram. 
  

Line color 
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Choose a color to use for region lines. 
  

Line weight 

Choose a line weight to use for region lines. The value is in points, a unit of 0.35 mm or 1/72 
in. 
  

Double-click action 

This option allows you to choose what happens when you double click on a region's label. 
Options include editing the region or creating a results window. 

  

Highlight Region Mode 

Highlight-this-region mode is enabled for a region by using the region's context menu.  It will 
highlight the region's events in all of the dot plot histograms. 

  

Increase dot size 

This field is the factor to increase 2P dots by when a region is in "highlight this region" mode. 

  

Animate region 

Enable this preference to blink the dots when a region is in "highlight this region" mode. 

  

Labels 

Show Name 

Enable this option to show the region's name (e.g. "R1") in the label for new regions. 
  

Show Alias 

Enable this option to show the region's alias (e.g. "Lymphocytes") in the label for new 
regions. 
  

Default alias 



Region Preferences 

588 

This option allows you to choose the default alias for regions. The alias can be displayed 
instead of or in addition to the region's name. 

  

Show statistic 

This option allows you to show a statistic in region labels, by default.  Choices include None, 
Percent Gated, Percent Total, and Region Events. 

  

Transparent label 

Enable this option to allow graphics under the region label show through. With the option 
disabled (unchecked), the region label is filled with a solid background color. 
  

  

Region Tools 

Restore Selection tool 

When this option is enabled, the region selection tool is reselected after you finish working 
with one of the region creation tools. This behavior is similar to how PowerPoint tools work. 
  

1P region tool 

Select the region tool for 1P histograms that you want selected each time WinList starts-up. 
For 1P regions, the options include the Select tool and the Range tool. These tools are found 
in the histogram toolbar and determine what happens when you click the mouse in a 1P 
histogram. 
  

2P region tool 

Select the region tool for 2P histograms that you want selected each time WinList starts-up. 
For 2P regions, the options include the Select, Freehand, Rectangle, Ellipse, and Contour tool. 
These tools are found in the histogram toolbar and determine what happens when you click 
the mouse in a 2P histogram. 
  

1P Regions 

1P region style 

Select a style to use when drawing 1P regions. Region options are available in the 1P Region 
Context Menu . 
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2P Regions 

Show resizing handles 

This option determines whether the resizing handles are automatically shown when a 2P 
region is activated. Note, you can always show resizing handles for individual regions by 
using the 2P region context menu. 
  

Show vertices 

This option determines whether vertices are shown when a 2P region is activated. 
  

Number of vertices 

This option controls the number of vertices that are displayed for 2P regions when you 
enable that option. Choose 0 to display all vertices for the region. Note, this does not affect 
the actual number of vertices for a region, only the number that are displayed. 
  

NStat Regions 

NStat label 

This list allows you to choose what to display for the NStat region labels. Choose from Name, 
Alias, or both. The label appears on the movable label for the NStat. Region options are 
available in the NStat Context Menu . 
  

Sub region label 

This list allows you to choose what to display for the sub region labels. Choose from Name, 
Percent gated, or both. The sub region label appears in the corner of the subregion and is 
not movable. 
  

Save preferences 

When checked, these preferences will be stored as new default preferences when you click 
OK to close the dialog. If unchecked, changes are only applied to this session of the program. 
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Results Preferences 

  

To display the dialog, choose Preferences from the File (Application) menu or the 
Options tab of the ribbon bar.  In the menu & toolbar interface, the command is in the 
Options menu. 

  

These preferences apply to results windows. 
  

 
  

Decimal places 

Choose the number of decimal places you want to display in results windows. 
  

Decimal separator 

Type the character that you want to use as the decimal separator. The default value is a 
period (.). 
  

Results background color 

Choose a color to use as the background for results windows. 
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Save preferences 

When checked, these preferences will be stored as new default preferences when you click 
OK to close the dialog. If unchecked, changes are only applied to this session of the program. 
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Transformation Preferences 

  

To display the dialog, choose Preferences from the File (Application) menu or the 
Options tab of the ribbon bar.  In the menu & toolbar interface, the command is in the 
Options menu. 

  

 
  

This preference section controls what parameters WinList will automatically convert from 
linear to log, and how that conversion will be performed. These preferences are most 
important for data files from newer, digital instruments, which store all parameters in linear 
form. 

WinList approaches this problem by making internal calculations to convert parameters from 
linear to log, and allowing you to set preferences to control which parameters are converted 
to log. You can override the preferences for individual data files. 
  

Number of Decades 

This option determines how many log decades WinList will transform the linear data values 
into. 

Choose Computed to allow the program to determine automatically the number of decades. 
With this option selected, the program computes the number of decades by taking the log of 
the ADC resolution of the parameter. For example, if the ADC resolution is 262144, the 
log10(262144) is approximately 5.42 decades. 
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Choose 4-decades to force the program to map the linear data into 4-decades. This can 
change the shape of distributions because the scaling is performed in linear space to map to 
10,000 linear units. 
  
  

Log-like Transforms 

Transformation 

This command displays the Edit Transformations dialog to edit transformations for all saved 
parameters. 

  

Default Transform 

This selects the default transform to use for log-like data: Log, HyperLog, Hyperbolic Sine, or 
VLog. 

  

Min Linear Option 

Determines how the low value for the axis will be determined: Percent of Max Linear or 
Percent of Area 
  

Percent of Max Linear 

When Min Linear Option is Percent of Max Linear, this field specifies the percentage to 
use.  This max value is multiplied by this field, and the negative of this is used for the low 
value of the axis. 
  

Percent of Area 

When Min Linear Option is Percent of Area, this field specifies the percentage of the 
measurement's area to use.  The negative of this is used for the low value. 

  

Percent Negative Boundary 

This value is used for parameters that have Auto-Adjust enabled for log-like transforms. The 
value represents the percentage of negative events that will be allowed to be off-scale in the 
log-like axis. For example, with the default value of 3.0 approximately 3% of negative events 
will pile up on the lowest displayed channel, and 97% of events will be visible after the Auto-
Adjustment is complete. 
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Color for Negatives 

Select a color to use for the negative portion of a HyperLog axis. 
  

Save preferences 

When this option is enabled, the changes you make to the Transformations dialog are 
remembered. 

You can override these settings for individual data files. 
  

See also: 

Edit Transformations 

Understanding Hi-res Data Files 
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Miscellaneous Preferences 

  

To display the dialog, choose Preferences from the File (Application) menu or the 
Options tab of the ribbon bar.  In the menu & toolbar interface, the command is in the 
Options menu. 

  

These preferences apply to various WinList objects. 
  

 
  

Application 

User Interface 

WinList provides two user-interface options: Toolbar & menu or Ribbon Bar.  The default 
interface is the Ribbon Bar.  For details on the differences between these interfaces, see Main 
Window, Toolbar, and Ribbon Bar. 

  

Threading 

Enable this option to improve performance on computers with multi-core processors.  Most 
users can leave this option enabled, and disable the option only if advised by tech support. 
  

Protocols 
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Auto-Backup protocols 

WinList can automatically save a backup of the work you are doing in the program.  This 
option allows you to choose how often to save a backup.  The backup files are automatically 
removed when the program closes normally.  If the program does not close normally, the 
backup files will be detected by the program when it starts up again, and it will offer to 
recover your work from the backup. 
  

Protocol Bundle Preference 

This preference determines what happens when WinList opens a protocol bundle that 
contains a preference file. 

"Don't use bundle preferences" will ignore the preference file that is in the bundle. 

"Prompt for bundle preferences" will ask the user whether the preferences from the bundle 
should be used. 

"Use bundle preferences" will use the preference file that is in the bundle without asking. 

  

Database Preference 

This preference determines what protocols do to databases when protocols are opened. 

"Do nothing" will ignore leave databases unchanged when a protocol is opened.. 

"Set database properties" will set the properties of databases when a protocol is opened.  For 
example, if "Database1" was active and showing the database viewer when the protocol was 
saved, the protocol can make sure the database is activated and the viewer is showing. 

  

Save Protocol Prompt 

When closing the program, WinList can detect whether there are unsaved changes in your 
protocol. This option controls whether or not the program alerts you that the protocol has 
changed. 
  

Save button 

The Save Protocol button on the main toolbar can behave like the Save Protocol command, 
the Save Protocol As command, or the Save Bundle command. Select the behavior for the 
button with this preference.  The program will need to be restarted for the change to take 
effect. 

  

V-Comp 
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V-Comp Setups 

This property contains the path to V-Comp setup files.  Typically, WinList can determine this 
path correctly without intervention.  However, if you store V-Comp setup files in a common 
location with other users, you may need to set this path explicitly. 

  

V-Comp App 

This property points to the V-Comp application, if you have it installed on your computer.  It 
allows WinList to launch V-Comp directly from the Compensation toolbox. 

  

Macro options 

Macro speed 

This option controls how fast macros and protocols playback. It is the minimum amount of 
time, in milliseconds, between each line of a macro. The default value is 10 milliseconds. 
  

Macro status 

This option controls whether or not the macro status dialog is displayed as a macro is played 
back. 
  

Remote Connections 

DDE Timeout 

This option determines how long WinList waits for a remote script command to complete. 
The default value is 10000 milliseconds. 

On some computers, the operating system waits for the full timeout period before 
completing. In these cases, experiment with lower settings for the DDE Timeout. On newer 
hardware, a setting of 1000 typically works fine, and it can save 9 seconds of unnecessary 
waiting for the transaction to complete. 
  

Save preferences 

When checked, these preferences will be stored as new default preferences when you click 
OK to close the dialog. If unchecked, changes are only applied to this session of the program. 



Data Source Preferences 

598 

Data Source Preferences 

  

To display the dialog, choose Preferences from the File (Application) menu or the 
Options tab of the ribbon bar.  In the menu & toolbar interface, the command is in the 
Options menu. 

  

These preferences apply to Data Source windows and listmode data files. 
  

 
  

Next File dialog 

This option determines what dialog you see when you use the Next File command to read a 
new FCS file into a data source.  The Windows file dialog is the standard file dialog you 
are familiar with, and this is the default option recommended for most users.  The Quick file 
dialog is a simplified dialog that displays faster and has limited choices.  It is most useful 
when files are in the same folder. 

  

Show Edit Data Source dialog 

Enable this option if you want the Edit Data Source dialog to be displayed when creating a 
new data source window with the Open Listmode Data Source command. 
  

Apply Dither 
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This option determines whether or not WinList applies a small dithering value to each event 
as it is read from disk. Dithering is used to spread values across histograms for better 
visualization. In theory, dithering corrects for a partial truncation that occurs on many 
instruments during acquisition. Dithering has virtually no impact on statistics. 
  

Alias 

Enter the keyword to use to set the alias for data sources. By default, the name of the FCS 
file that is opened is used. 
  

Parameter Names 

This preference determines what strategy WinList will use to assign names to the parameters 
in the data files you open. Choose Automatic to allow WinList to try to determine the best 
strategy. Other options allow you to specify various combinations of the $PnS and $PnN 
keywords that are stored in the data file. 
  

N-Color Compensation 

Auto-Compensation 

Some instrument manufacturers encode compensation settings directly into the FCS files that 
you read into WinList. If you want WinList to use the compensation settings that you set up 
on the instrument, you can enable one of the options provided in this list. 

  

Hardware compatible comp 

Enable this option to use the force compensation settings to behave like hardware-based 
compensation. This makes all values subtractive. 
  

Restrict Auto-Positioning Logic 

When enabled, WinList uses a more restricted portion of histograms to determine how to 
automatically position compensation Trace Lines. For most cases, this option will have little 
effect on how the program positions the trace lines. In some cases where there is significant 
signal cross-over, enabling this option can improve the auto-positioning. 
  

Adjustment Step 

Set the amount of change associated with the "+" and "-" compensation controls. 
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Add Crossover Keywords 

When enabled, WinList will add keywords to describe the crossover for all measurements 
involved in compensation.  Since this can create a lot of keywords, this option is disabled by 
default.  Only enable it if you need to store the crossover information in a database or add it 
to reports. 

  

FCS 

FCS Version 

Select the FCS version to use for FCS files that WinList creates. 
  

Import Keywords from XML File 

Import Keywords 

This option allows WinList to import additional keyword information from an XML file and add 
those keywords to the keywords from the current FCS file.  The XML file must be named the 
same as the FCS file, with ".xml" appended to it. 

There are three options for this: 

Don't import keywords: This option disables import of XML keywords. 

Import XML from FCS file 

path: 

With this option selected, WinList will look for an XML file in 

the same path as the FCS file.  For example, if the FCS file's 

name and path are "C:\Data\PatientFile123.fcs", the program 

would look for "C:\Data\PatientFile123.fcs.xml" for the 

keywords. 

Import XML from Alternate 

Path: 

With this option selected, WinList will look for an XML file in 

the path specified by the Alternate path preference below. For 

example, if the FCS file's name and path are 

"C:\Data\PatientFile123.fcs" and the Alternate Path is 

"D:\XML", the program would look for 

"D:\XML\PatientFile123.fcs.xml" for the keywords. 

  

Alternate Path 

This option is only used if Import XML from Alternate Path is selected for the Import 
Keywords property above.  The property defines where the XML files will be located.  Click 
the Choose button to navigate to a folder. 

  

Multiple Dataset Keywords 
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First Keyword 

Enter the name of a keyword to display when WinList detects an FCS file with more than one 
dataset in it.   

  

Second Keyword 

Enter the name of a keyword to display when WinList detects an FCS file with more than one 
dataset in it.   

  

Snap Properties 

Snap-to-grid 

With this option enabled, histograms are aligned to the data source grid when they are 
moved or sized. 
  

Grid spacing 

This option specifies the size of the snapping grid, in pixels. 
  

Grid color 

Choose a color for the snapping grid lines displayed in the data source. 
  

Background color 

Choose a color for the background of the data source. 
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Reporting Preferences 

  

To display the dialog, choose Preferences from the File (Application) menu or the 
Options tab of the ribbon bar.  In the menu & toolbar interface, the command is in the 
Options menu. 

  

These preferences apply to Report windows. 
  

 
  

Snap Properties 

Snap-to-grid 

With this option enabled, objects are aligned to the report grid when they are moved or 
sized. 
  

Grid spacing 

This option specifies the size of the snapping grid, in inches. 
  

Display Grid Properties 

Display Grid 
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Enable this option to show a grid on the report background. The display grid does not affect 
how objects are aligned automatically, but can be used for visual alignment of objects. 
  

Display grid spacing 

This option specifies the size of the display grid, in inches. 
  

Properties for Tile Object command 

Rows and Columns 

Enter the number of rows and columns that you want to create when the Tile command is 
selected for a report. 
  

Report Object 

Text object size 

This setting determines the size of text objects when they are added to a report. Note: 
Objects can be resized after they are initially created. 
  

Graphic object size 

This setting determines the size of graphic objects when they are added to a report. Note: 
Objects can be resized after they are initially created. 
  

Histogram quality 

This option controls the quality of the histogram graphics that are generated when linked 
histogram objects update on the report. Lower quality settings will produce graphics that 
require less memory, draw faster, and print faster. Perfect quality requires the most memory 
and draws the slowest, but produces the best output possible from the program. Experiment 
with this setting to find a suitable quality for your purposes. 
  

This preference can be overridden for individual histogram objects on a report, using the Edit 
Histogram Link dialog. 
  

Print quality 

This option controls the quality of used when printing reports. Select the resolution that 
provides the best speed and quality for your use. 
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Fast Printing 

With this option enabled, WinList renders graphics to bitmaps before sending them to the 
printer.  With most printers, this results in faster printing.  If your printer seems to print 
graphics from WinList slowly, compare printing speeds with the option on and off. 
  

Caption 

This option determines how captions will be displayed for histograms, by default. Individual 
histograms on reports can override this preference. 
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Edit Program Controls 

  

This dialog box can be brought to the screen by choosing Edit Program Controls in the 
Edit tab of the ribbon bar. In the menu & toolbar interface, the command is in the Edit 
menu. 

  

The settings within this dialog box control many of WinList's resources such as regions, 
gates, and the packet size. The settings have an impact on how much memory the 
program uses. 
  

 
  

  

Regions 

This field sets the initial number of regions allocated by WinList. The program will 
automatically allocate for more regions as needed. 
  

Gates 

This field sets the initial number of gates allocated by WinList. The program will automatically 
allocate for more gates as needed. 
  

Palette size 

This field sets the number of colors in WinList's color palette. The palette is used by gates 
and other graphical objects. 
  

Packet Size Limit 
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This field sets the limit on the packet size used for sampling your FCS files. When WinList 
creates a packet to store events from the FCS file, the packet will be at most Packet Size 
Limit. If the file contains fewer events than Packet Size Limit, or if memory is limited on the 
computer, the actual packet size will be less than Packet Size Limit. 

You can increase this value to work with more events from your file. Increasing the packet 
size also increases the amount of memory that may be used by the program, so you may 
need to experiment to find a value that works well for the computer you are using. Ideally, 
this value should be set to the number of events in the largest files that you open with 
WinList.  Practically, that may be greater than your computer can support. 

If the entire file cannot fit into memory at once, the program can display graphics and results 
for the entire file at any time by clicking the Replay button. 

After you change the Packet Size Packet, WinList automatically applies the change to data 
sources. 
  

Save 

Click this button to cause WinList to use the displayed settings each time the program is 
started. 
  

OK 

Click this button to close the dialog and apply any changes to open data sources. 
  

Cancel 

Click this button to exit with no changes. 
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Wildcards and Pathways 

  

 
  

This command is found on the Options tab of the ribbon bar. In the menu & toolbar 
interface, the command is in the File menu. 

  

This command initiates a dialog box that allows the user to set search criteria and pathways 
for various file types. 
  

 
  

Files of type 

Enter the FCS file specification that WinList will use to display listmode files. 
  

File Path 

This edit box displays the pathway where WinList will look for listmode data files. You may 
manually enter the pathway, or click the "..." button to display a dialog that allows you to 
pick a folder. The PC version uses a backslash (\) to separate parts of a path. 
  

Protocol Path 
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This is the default location for WinList protocols, bundles, and many other files that WinList 
reads and writes. You may manually enter the pathway, or click the "..." button to display a 
dialog that allows you to pick a folder. 
  

Report Path 

This is the default location for report files. You may manually enter the pathway, or click the 
"..." button to display a dialog that allows you to pick a folder. 
  

PDF Path 

This is the default location for PDF report files. You may manually enter the pathway, or click 
the "..." button to display a dialog that allows you to pick a folder. 
  

MultiGraph Path 

This is the default location for MultiGraph files. You may manually enter the pathway, or click 
the "..." button to display a dialog that allows you to pick a folder. 

  

Remember last used pathway 

If this option is checked, the program will automatically save the last location where you 
opened or saved data files. Uncheck this option if you want WinList to use the pathways you 
enter in this dialog each time it starts up. Check this option if you want it to use the last 
pathway you were in each time it starts. 
  

OK 

Click this button to accept changes to the dialog box. Changes will be used for the current 
session of WinList only. 
  

Save 

Click this button to accept changes to the dialog box and store them as default settings for 
WinList. 
  

Cancel 

Click this option to exit with no changes to the dialog box. 
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User Guide 

  

Help commands are found on the Help tab of the ribbon bar.  In the menu & toolbar 
interface, the command is in the Help menu. 

  

Selecting this menu option launches WinList's on-line help system and displays the index to 
the system. Most of WinList's documentation is available through this system. 
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Check for Updates 

  

This command is found on the Help tab of the ribbon bar.  In the menu & toolbar interface, 
the command is in the Help menu. 

Use this command to check the Verity Software House web site for program updates. It will 
launch your default browser and display a list of available updates for the version of WinList 
you are running. 
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About WinList 

  

This command is found on the Help tab of the ribbon bar.  In the menu and toolbar 
interface, the command is in the Help menu. 

  

Selecting this option displays WinList's opening banner dialog. This dialog displays 
information about the version of the program, the registered user, system information, and 
contact information for Verity Software House. 
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Research and Compliance Modes 

  

WinList can be set up to run in either a Research-Use-Only mode, or in Compliance mode. 
There are some differences in how the program operates in each mode. 

• Compliance mode depends on operating system user groups to control the level of 
access to program features. Research mode allows any user to perform any operation. 

• Compliance mode displays a login dialog when the WinList is starting up to verify the 
user and determine the group to which the user belongs. 

• Compliance mode enables logging so that there is a record of the activities of each user. 
Research mode can be run with logging enabled or disabled. 

• Compliance mode is designed to support clinical labs and can be part of a compliance 
plan for the US-FDA's 21 CFR Part 11 regulations. Research mode does not provide 
compliance with 21 CFR Part 11. 

• Both modes use the same intuitive interface and WinList engine. 

Setting Up Research Use Only Mode 

After initial installation, WinList will automatically be in Research mode. There is no further 
configuration required. 

To revert to Research mode after setting up Compliance mode, the user groups that were 
created for Compliance mode must be removed. Once the user groups are removed, the 
program will revert to Research mode. 

  

Setting Up Compliance Mode 

Setting up Compliance mode is something that should be performed by IT personnel. 

While it is not a complicated task, it requires administrative access rights and a clear 
understanding of user groups and permissions. It is therefore something that we strongly 
recommend be performed by the IT team at your institution. The task involves creating 
several required WinList user groups for your computer or domain, and then adding users to 
those groups. Once the groups are defined, the program automatically operates in 
Compliance mode. Click here for details. 

  

21 CFR Part 11 Compliance Matrix 

This matrix provides a simple summary of how WinList in Compliance mode helps you with 
21 CFR Part 11 compliance. Click here for details. 



WinList User Guide 

613 

Setting Up Compliance Mode 

  

Setting up Compliance mode should be performed by your IT team. It requires 
administrative rights and a clear understanding of your network operating system. 

The task involves creating several required WinList user groups for your computer or domain, 
and then adding users to those groups. Once the groups are defined, the program 
automatically operates in Compliance mode. 

  

WinList User Groups 

There are three (3) user groups for Compliance mode: WinListAdmins, WinListEditors, 
and WinListUsers.  Optionally, you can define an additional user group, 
WinListResearchers, for research users within the Compliance setting who are not 
restricted by Compliance requirements.   

The table below shows the features that group members can access.   

  

Feature WinListAdmins WinListEditors WinListUser WinListResearchers 
Run a 
batch of 
files 

Yes Yes Yes Yes 

Add & 
remove 
files from 
batch 

Yes Yes Yes Yes 

Open 
protocols Yes Yes Yes Yes 

Edit 
databases Yes Yes   Yes 

Create & 
edit 
protocols 

Yes Yes   Yes 

Edit 
logging 
options 

Yes     Yes 

Check for 
program 
updates 

Yes     Yes 

Edit 
preferences Yes     Yes 

  

Creating User Groups 
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The program requires at least one of the WinList user groups to be defined in order to run in 
Compliance mode.  WinList user groups can be defined for your computer or for your entire 
domain using tools provided by the operating system.  This is typically done by information 
technology personnel because it requires administrative rights.   

The advantage of defining the user groups at the domain (network) level is that the groups 
are defined for all computers on the domain at the same time.  If you define the user groups 
on an individual computer, those groups are available only on that computer. 

Below we describe how to create user groups on a Windows server or on a Windows 
compute as examples.  The specific methods you need to use may differ depending on the 
version of the operating system you are working with. 

After you have defined the user groups and added users to them, WinList will detect the 
groups when it starts up and operate in Compliance mode automatically. 

  

Windows Server User Groups 

Follow these steps to define user groups for an entire network or domain. Note: if you use 
this technique, you do not need to define user groups on each individual 
computer. 

• On a domain server, launch the "Active Directory Users and Computers" administrative 
tool. 

• Right click the "Users" folder in the left panel and choose New->Group.  The New Group 
dialog is displayed. 
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• Type WinListAdmins for the group name and click OK. 
• Once the group is created, double-click the group in the list to display the Properties for 

the group. 
• Click the Members tab and click Add to select members for the WinListAdmins 

group.  You should have at least one user in the WinListAdmins group. Members can be 
added by typing user names, or by using the dialog's search features. 
 

 
• Repeat this process for the WinListEditors, WinListUsers, and optionally 

WinListResearchers groups, adding appropriate users to each group. 
• Once the groups are created and users are added to them, the program will 

automatically use Compliance mode when it starts up and is connected to the domain. 

  

Windows Computer User Groups 

Follow these steps to define user groups for an individual Windows computer. Note, if you 
already defined user groups for your domain, you do not need to define the 
groups again for each computer. 
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• On a Windows 7 computer, right click Computer and choose "Manage". For Windows 8 
and newer, right click the Windows button (lower left) and choose "Computer 
Management".  The Computer Management app will display. 

• Expand "System Tools" and "Local Users and Groups" in the left panel. 
• Right click the "Groups" folder and choose "New Group".  The New Group dialog is 

displayed. 
 

 
• Type WinListAdmins for the group name and enter a description for the group. 
• Click Add to select members for the WinListAdmins group.  You should have at least 

one user in the WinListAdmins group.  Members can be added by typing user names, or 
by using the dialog's search features. 

• Click Create to create the new local user group. 
• Repeat this process for the WinListEditors, WinListUsers, and opytionally 

WinListResearchers groups, adding appropriate users to each group. 
• Once the groups are created and users are added to them, the program will 

automatically use Compliance mode when it starts up on that computer. 

  

See also: 

21 CFR Part 11 Compliance 
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21 CFR Part 11 Compliance 

  

WinList can be part of your lab's compliance strategy for 21 CFR Part 11 when it is setup and 
operated in Compliance mode.  It has been developed under a quality management system 
and validated with a suite of quality assurance tests. The table below summarizes how the 
key elements of Part 11 relate to WinList and its use in Compliance mode settings. 

  
Section Summary of Rule Compliance Strategy 

11.10 
Controls for closed 
systems 

WinList can be accessed only through the user 
interface; it is a closed system. 

11.10 (a) 
Validation and 
accuracy. 

WinList uses externally-generated data to validate its 
results and employs proprietary binary format, static 
PDF, and/or CRC methods to ensure valid files. 

11.10 (b) 
Record generation 
and readability 

WinList generates Xml-format protocol files, CRC-
checked log files, and static PDF that are human-
readable and machine-readable. 

11.10 (c) 
Record protection 
and retrieval 

Record retention and retrieval plan is managed by the 
laboratory’s file management practices. 

11.10 (d) Authorized access 
WinList uses the operating system’s user login 
validation, and user group membership determines 
permissions within the software. 

11.10 (e) Audit trails 
WinList employs a CRC-checked logging system with 
time stamps, and log files are preserved. Log files 
cannot be deleted by ordinary means. 

11.10 (f) 
Operational system 
checks 

WinList enables and disables portions of the UI to 
enforce permitted sequencing of steps and events. 

11.10 (g) Authority checks 
WinList uses the operating system user groups and 
login validation to assure authorized access. 

11.10 (h) 
Device checks and 
validity 

WinList performs validation checks on the FCS data 
files. 

11.10 (i) 
Education, training 
and experience 

WinList provides a User Guide, technical support, and 
tutorial videos to assist with the proper, intended use 
of WinList. Specific on-site training may be arranged. 

11.10 (j) Electronic signatures 
This is an individual laboratory requirement beyond 
the scope of use of WinList. 

11.10 (k) 
Systems 
documentation 

WinList version releases are accompanied by an 
updated User Guide. Verity employs document control 
procedures. 

11.30 
Controls for open 
systems 

WinList is designed as a closed system. 

11.50 
Signature 
manifestations 

WinList does not require or offer electronic signatures. 

11.70 Signature linking WinList does not require or offer electronic signatures. 

11.100 (a) 
Unique electronic 
signatures 

Your laboratory must ensure that electronic signatures 
are unique to each user on the network. 
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11.100 (b) Identity verification 
Each laboratory must verify its own employment 
records and IDs. 

11.100 (c) 
Signature 
verification 

Each laboratory must verify electronic signature 
eligibility with the FDA. 

11.200 
(a)(1) 

Two-component 
signing 

WinList does not require or offer electronic signatures. 

11.200 
(a)(2,3) 

Authenticity and 
falsification 

WinList does not require or offer electronic signatures. 

11.200 (b) Biometric signatures WinList does not utilize biometric IDs. 

11.300 (a) 
Controls for 
identification 

WinList uses the operating system user groups and 
login validation to assure unique user identities. 

11.300 (b) Identification aging 
The individual laboratory IT structure must control 
password checks and aging requirements. 

11.300 (c) 
External ID 
validation 

Not applicable. WinList does not utilize external 
tokens, cards, RFID, or other physical identity-
confirming devices. 

11.300 (d) Unauthorized use 
The individual laboratory IT structure must control 
login authenticity and manage safeguards to prevent 
unauthorized use. 

11.300 (e) 
External device 
testing 

Not applicable. WinList does not utilize external 
tokens, cards, RFID, or other physical identity-
confirming devices. 
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Cytometer Plug-in 

Cytometer Plug-in: Overview 

  

This option is only available if you have a Cytometer Plug-in supplied with WinList. 

  

When the Cytometer Plug-in Acquisition plug-in for WinList is installed with the program, 
WinList adds features that allow you to monitor data, acquire and sort data on an instrument 
with a supplied Cytometer Plug-in. 
  

Using WinList's powerful gating capabilities, it's fast and easy to create regions and define 
gates for sort decisions. With a one click, WinList transmits sort gates and N-Color 
Compensation to the Cytometer Plug-in, enabling extensive sort classifications. Events can 
even be color-coded in WinList based on how they actually sorted on the device. 

  

Next: 

Cytometer Plug-in: Monitoring 
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Cytometer Plug-in: Overview 

  

This option is only available if you have a Cytometer Plug-in supplied with WinList. 

  

When the Cytometer Plug-in Acquisition plug-in for WinList is installed with the program, 
WinList adds features that allow you to monitor data, acquire and sort data on an instrument 
with a supplied Cytometer Plug-in. 
  

Using WinList's powerful gating capabilities, it's fast and easy to create regions and define 
gates for sort decisions. With a one click, WinList transmits sort gates and N-Color 
Compensation to the Cytometer Plug-in, enabling extensive sort classifications. Events can 
even be color-coded in WinList based on how they actually sorted on the device. 

  

Next: 

Cytometer Plug-in: Monitoring 
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Cytometer Plug-in: Monitoring 

  

This option is only available if you have a Cytometer Plug-in supplied with WinList. 
  

WinList is automatically launched by the Cytometer Plug-in software.  It establishes a 
connection with the Cytometer Plug-in and has access to the parameters that are currently 
configured.  Communication flows in both directions, with the Cytometer Plug-in software 
sending data and commands to WinList, and WinList supplying information about sort gates 
and compensation.  As changes are made on one side, they are communicated to the other. 

  

Creating or Opening a Protocol 

When the Cytometer Plug-in software starts up, it displays the Create/Open Protocol 
dialog.  This dialog is used to create new protocols for WinList as well as to open protocols 
you saved previously. 

  

If you open an existing protocol, WinList will recreate the setup you had with histograms, 
regions, gates, and reports.  Sort gates are remembered and transmitted to the Cytometer 
Plug-in software. If you are creating a new protocol, define your histograms, regions, and 
gates as you normally would with WinList.  See WinList Basics for an introduction to this. 

  

WinList displays a special Cytometer Plug-in toolbar at the bottom of the data source 
window, and it begins to monitor data transmitted from the instrument. 
  

 
  

When monitoring, WinList continually updates the graphics and statistics with the latest data 
received from the Cytometer Plug-in. The toolbar and the data source title bar provide 
information about the sample and the number of events processed. WinList is not 
accumulating the data it receives in monitor mode; the most recent events are stored 
temporarily and they are replaced when new data is received. 
  

Most of WinList's features are available during monitor mode. You can draw regions, define 
gates, view statistics, set up N-Color Compensation, and much more. 
  

Next: 

Cytometer Plug-in: Acquiring Data 
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Cytometer Plug-in: Acquiring Data 

  
This option is only available if you have a Cytometer Plug-in supplied with WinList. 
  

Once WinList is monitoring an Cytometer Plug-in and you have a protocol defined, you can 
acquire data in just a few steps. 
  

To review and edit the properties of acquisition: 

1. Click the Acquisition Properties button on the Cytometer Plug-in toolbar at the bottom of 
the data source window. 
  

 
  

2. The Edit Acquisition dialog is displayed. Review and edit the properties for the acquisition, 
and then click OK. 
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To acquire data: 

1. Click the Acquire button on the Cytometer Plug-in toolbar. 
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2. Depending on the settings in the Edit Acquisition dialog, the Start Acquisition dialog may 
appear. If it does, you can edit the keyword values that will be stored in the file, and then 
click OK. 
  

 
  

During acquisition, you can use the Pause, Stop, and Restart buttons on the toolbar. See the 
Toolbar section for details on these commands. 
  

3. When the acquisition is complete, the Acquisition Complete dialog is displayed. In this 
dialog you can again edit the keywords that will be stored in the file, you can rename the 
output file, and you can review summary information about the acquisition. 
  



WinList User Guide 

625 

 
  

4. Click OK to close the dialog and finish the acquisition. 
  

More Info: 

Cytometer Plug-in: Sorting 
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Cytometer Plug-in: Sorting 

  

This option is only available if you have a Cytometer Plug-in supplied with WinList. 

  

WinList provides very flexible and powerful sorting control. Sort decisions are made by 
creating regions and gates on histograms, setting up N-Color Compensation, and using the 
Edit Sort dialog to transmit the sort decisions to the Cytometer Plug-in. 
  

Once the sort decisions have been sent to the module, they remain in effect until new sorting 
decisions are sent. If you modify or delete a region involved with sorting, you will be 
prompted to re-send the sort information to the Cytometer Plug-in.   
  

To create sort decisions: 

1. Create regions on histograms that identify the populations that you want to sort. See 
Regions for additional details. 
  

 
  

2. Click the Edit Sort button on the Cytometer Plug-in toolbar. 
  

 
  

3. In the Edit Sort dialog, associate the gates you created in step 1 with sort streams on the 
Cytometer Plug-in. Each gate should be assigned to only one sort stream. 
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4. Click the Send button to transmit the sorting regions, gate expressions, and N-Color 
Compensation to the Cytometer Plug-in and close the dialog. 
  

More Info: 

Edit Sort dialog 

Using Interactive N-Color Compensation 

Toolbar 
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Cytometer Plug-in: Toolbar 

  

This option is only available if you have a Cytometer Plug-in supplied with WinList. 

  

At the bottom of the data source window, the Cytometer Plug-in toolbar provides additional 
controls and status indicators related to the Cytometer Plug-in acquisition system. 
  

 
  

The left portion of the toolbar contains a set of buttons that control monitoring, acquisition, 
and sorting. These are described in the Toolbar Commands table below. 
  

Status panes indicate the name and associated color of the Cytometer Plug-in module, and 
information about monitoring, acquisition, and event rates. A progress meter appears during 
acquisition to indicate the status of the acquisition. 
  

Two LED indicators appear on the right of the toolbar. The first one turns green when a 
packet of information is received from the Cytometer Plug-in. It turns yellow when a packet 
is requested and the server does not supply one. The second LED turns green when WinList 
is processing a packet of data received from the server. 
  

Toolbar Commands 

Button Purpose 

 

WinList mode 
Stop the connection with the Cytometer Plug-in and 
enter WinList mode. 

 

Monitor 
Connect with the Cytometer Plug-in and request data. 
Real-time events are displayed. 
Events are not stored. 

 

Acquire 
Accumulate data from the Cytometer Plug-in and 
store it in an FCS file on disk. 
Real-time events are displayed. 
Events are stored. 

 

Pause 
Pause or un-pause acquisition 
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Real-time events are displayed. 
Events are not stored. 

 

Stop acquisition 
The Acquisition Complete dialog is displayed. 
Events that have been accumulated are stored in an 
FCS file on disk. 

 

Restart acquisition 
Events accumulated prior to restart are discarded and 
acquisition continues. 

 

Edit Acquisition 
Edit the acquisition properties, output paths, stop 
gate, etc. 
See Edit Properties of Acquisition for details. 

 

Edit Sort 
Edit the sort gate assignments, color event options, 
and send sort info. 
See Edit Sort for details. 
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Cytometer Plug-in: Edit Properties of Acquisition 

  

This option is only available if you have a Cytometer Plug-in supplied with WinList. 

  

This dialog allows you to configure the acquisition characteristics for the Cytometer Plug-in. 
You can choose preferences for most of these properties in the Cytometer Plug-in 
Preferences dialog. 
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Stop 

Stop Gate 

Select a gate to use for calculating the stop count. If you select a gate, the acquisition 
finishes when the number of events that satisfy the stop gate reaches the stop count. If no 
gate is selected, acquisition finishes when the number of events received reaches the stop 
count. 
  

Stop Count 

Set the stop count for acquisition. See comments on Stop Gate above. 
  

Save 

FCS File Prefix 

Enter an option prefix for the FCS files created during acquisition. This field can be left 
empty. 
  

FCS File Pathway 

Choose the location where FCS files are stored during acquisition. 
  

File Counter 

This is a simple counter that increments as files are acquired during a WinList session. You 
can edit the value to any number you want. 
  

Event sampling 

This value determines the rate at which events are sampled into the acquisition output file 
from the buffers received. The default setting is 1, which means that every event received 
will be stored. With a setting of 5, WinList would store every 5th event that it receives from 
the instrument. A setting of 500 would store 1 out of 500 events. This can be useful when 
running long acquisitions where you do not need to store every event. 
  

Pre-Acquisition 

Prompt Before 
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When this option is enabled, WinList will display a dialog before acquisition. The dialog allows 
the user to enter keywords for the sample. 
  

Post-Acquisition 

After Acquisition 

Choose what you want the program to do after you acquire a new file. Options include Enter 
WinList mode & Replay and Continue Monitoring. 
  

Prompt After 

When this option is enabled, WinList will display a dialog after acquisition that allows the user 
to enter keywords for the sample. 
  

Update Report Links 

When this option is enabled, WinList will automatically update all linked objects on reports 
when an acquisition finishes. 
  

Save Reports 

When this option is enabled, WinList will automatically save any open reports when an 
acquisition finishes. 
  

Save PDF Reports 

When this option is enabled, WinList will automatically save any open reports in PDF format 
when an acquisition finishes. 
  

Print Reports 

When this option is enabled, WinList will print open reports when acquisition finishes. 
  

Save Protocol Bundle 

When enabled, WinList will automatically save a protocol bundle for the newly acquired file 
after each acquisition. 
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User-Defined Keywords 

Keyword 1 

This field contains the name of the first user-defined keyword for the FCS file created during 
acquisition. 
  

Keyword 1 Description 

If you edit Keyword 1, it is a good idea to edit this field to describe the keyword that you 
have entered. This description is displayed to the operator when the system prompts for the 
keyword value. 
  

Keyword 1 Value 

Enter a default value for Keyword 1, or leave the field blank. 
  

Keyword 2 

This field contains the name of the second user-defined keyword for the FCS file created 
during acquisition. 
  

Keyword 2 Description 

If you edit Keyword 2, it is a good idea to edit this field to describe the keyword that you 
have entered. This description is displayed to the operator when the system prompts for the 
keyword value. 
  

Keyword 2 Value 

Enter a default value for Keyword 2, or leave the field blank. 
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Cytometer Plug-in: Edit Sort 

  

This option is only available if you have a Cytometer Plug-in supplied with WinList. 
  

This dialog allows you to make sorting decisions for the Cytometer Plug-in. No changes are 
made until the Send button is clicked. 
  

 
  

Sort Streams 

The top section of the dialog shows each sort stream that is defined on the Cytometer Plug-
in. 

To use a gate for a sort decision, select a gate from the drop-down list for the sort location 
you want. This will associate the gate expression with the Sort Stream decision. 

Sort streams that show "Unassigned" for the gate will not receive any events during the sort. 
  

Other Cells and Empty Drops 

The system allows you to capture all cells that are not identified by other gate assignments, 
as well as droplets that did not contain cells.  Any sort destination can be set to "Other Cells", 
"Empty Drops", or "Other Cells and Empty Drops". 
  

Send 

Click this button to transmit the sorting regions, sort gate expressions, and N-Color 
Compensation to the Cytometer Plug-in module. The dialog will close, and a message will be 
displayed to indicate whether or not the operation was successful. 
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Cancel 

Click this button to close the dialog without transmitting the sorting decisions. 
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Cytometer Plug-in: Preferences 

  

This option is only available if you have a Cytometer Plug-in supplied with WinList. 

  

This dialog displays settings that control various aspects of the Cytometer Plug-in acquisition 
system. 
  

 
  

Acquisition 

Cytometer Plug-in Connection 

This field defines how WinList connects to the Cytometer Plug-in.  This should be supplied by 
your Cytometer Plug-in manufacturer. 
  

Stop Count 
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Set the default stop count for acquisition. 
  

Resolution 

Select a resolution to use when writing acquired data to FCS files. 

  

File Naming 

FCS File Prefix 

Enter an optional prefix for the FCS files created during acquisition. This field can be left 
empty. 
  

Include Kw1 in File name 

Enable this option to include the Keyword 1 in the name of files you acquire. 
  

Include Kw2 in File name 

Enable this option to include the Keyword 2 in the name of files you acquire. 
  

FCS File Suffix 

Select an option for a file naming suffix. 
  

Pre-Acquisition 

Prompt Before 

When this option is enabled, WinList will display a dialog before acquisition. The dialog allows 
the user to enter keywords for the sample. 
  

Post-Acquisition 

After Acquisition 

This option determines what WinList will do following an acquisition. 

Choose Continue Monitoring to automatically switch back into monitoring mode. 
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Choose Enter WinList Mode and Replay to work with the data that has just been 
acquired. 
  

Prompt After 

When this option is enabled, WinList will display a dialog after acquisition. The dialog allows 
the user to enter keywords for the sample and shows summary information about the 
acquisition. 
  

Update Report Links 

When this option is enabled, WinList will automatically update all linked objects on reports 
when an acquisition finishes. 
  

Save Reports 

When this option is enabled, WinList will automatically save any open reports when an 
acquisition finishes. 
  

Save PDF Reports 

When this option is enabled, WinList will automatically save any open reports in PDF format 
when an acquisition finishes. 
  

Print Reports 

When this option is enabled, WinList will print open reports when acquisition finishes. 
  

Save Protocol Bundle 

When this option is enabled, WinList will automatically save a protocol bundle after acquiring 
an FCS file. 
  

Include Acquired File in Bundle 

When this option is enabled, WinList will include the newly acquired FCS file in the protocol 
bundle. 
  

User-Defined Keywords 
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Auto-close Dialog 

If enabled, WinList will automatically close the Post Acquisition dialog after a user-defined 
time passes. 
  

Auto-close Time 

Select the amount of time to keep the Post Acquisition dialog open before automatically 
closing it. 
  

Keyword 1 and 2 

This field contains the name of the first user-defined keyword. The default keyword name is 
$SMNO, which is a standard FCS keyword used to describe the specimen. 
  

Keyword 1 and 2 Description 

If you edit Keyword 1, it is a good idea to edit this field to describe the keyword that you 
have entered. This description is displayed to the operator when the system prompts for the 
keyword value. 
  

Keyword 1 and 2 Value 

Enter a default value for Keyword 1, or leave the field blank. 
  

Keyword 1 and 2 Separator 

This separator is used when adding this keyword to the file name. 
  

Real-Time Display 

Show LEDs 

Enable this option to display LEDs on the Cytometer Plug-in toolbar. 
  

Monitor Mode Events 

This setting determines the number of events WinList will try to show in histograms during 
Monitor mode. 
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Max Acquisition Dots 

During acquisition, it is possible for WinList to accumulate and display all of the events that 
are being acquired. In most cases, however, this is not helpful or practical because it requires 
more and more memory and new dots are drawn on top of existing dots. 

This setting limits the number of dots that 2P histogram will try to display during acquisition. 
  

Throughput Control 

Maximum Events Per Second 

Choose the maximum throughput allowed for the WinList/Cytometer Plug-in connection. In 
most cases this setting will not need to be changed. However, on slow network connections 
or slow computers, you may choose to lower this setting to ensure that the computer 
remains responsive. 
  

Save preferences 

Enable this option to save the settings as preferences. 
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Appendices 

DDE Commands 

  
Dynamic Data Exchange (DDE) provides a way for Windows programs to share data and 
interact with one another. WinList supports DDE as a client of other applications. In other 
words, it can request information and instruct other applications to do things. It does not 
support DDE as a server of information. 
  
When connecting WinList to other applications with DDE, there are several internal 
commands which WinList recognizes. These commands allow you to ship data to other 
programs and to retrieve data from them. Below is a list of the current internal DDE 
commands for WinList and an explanation of usage for each. 
  
POKE 
This command is used to send histogram or results data to another program in either TEXT 
format or VSH format. The syntax of the command is: 

POKE(externalRef, format, {optional internal reference} ) 

  
where externalRef is a reference the other application uses to determine where to put or how 
to use the data, and format is either TEXT, TEXTNOHEADER, or VSH. TEXT format is 
supported by most applications that can paste text from the clipboard. TEXTNOHEADER 
format is identical to TEXT except that it sends a result window's text as a table of 
information, without column headings. It can only be used with results windows. VSH is a 
Verity Software House binary data format, which provides a more efficient use of memory. It 
pertains only to histogram connections and should be used when interacting with other VSH 
products or with products known to support the format. 
The optional internal reference can be literal text or any keyword in the keyword tree. This 
allows you to send any kind of information that WinList knows about to the remote 
application. If a keyword is used for this option argument, it must be enclosed in curly braces 
{ }. Literal text does not need any special formatting. 
  
Examples: 

POKE(DATA,VSH) - used to send data to ModFit or IsoContour. 

POKE(R1C1:R64C64,TEXT) - used to send a 64 x 64 resolution histograms to Microsoft 
Excel in TEXT format. Note the reference tells Excel to put the data into the active 
spreadsheet at row-1 column-1 to row-64 column-64. 

POKE(RC:R[+6]C[+6],TEXTNOHEADER) - used to send a results window to Microsoft 
Excel in TEXT format, excluding the column headings and id fields in the results window. 
The reference tells Excel to put the data into the active spreadsheet at a location 
starting at the current row and column, and extending through 6 rows and 6 columns. 
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Relative references of this sort are very useful for adding results to a database without 
overwriting previous results. 

POKE(KEYWORDS,VSH,KEYWORDS) - used in a histogram connection to send keywords 
from the listmode file to a Verity application like ModFit LT 3.0 or greater. 

POKE(R1C1:R1C255,TEXT,KEYWORDS) - sends keywords from the listmode file to an 
application like Microsoft Excel. The format of the keywords is keyword followed by a 
tab character, then the keywordValue and another tab character. 

POKE(R1C1,TEXT,R1 Events) - sends the label "R1 Events" as text to an application like 
Microsoft Excel to place in row 1 column 1. 

POKE(R1C2,TEXT, {DS1:$DATE}) –  evaluates the string "{DS1:$DATE}" as a keyword, 
and then sends the result as text to an application like Microsoft Excel to place in row 1 
column 2. See Internal Keywords for a list of special internal keywords supported by 
WinList. 

POKE(R2C1,TEXT,{DS1.R1.%Gate}) - sends the %Gate statistic for R1 in data source 1 
to row 2 column 1 in Excel. 

POKE(R3C1,TEXT,{DS2:SPILL}) - sends the SPILL keyword value from data source 2 to 
row 3 column 1 in Excel. 

  
PASTE 
This command tells WinList to paste a copy of the contents of the Windows clipboard into the 
histogram or results window for display. The syntax is PASTE(format) where format is 
METAFILE or TEXT. METAFILE is a picture format supported by many Windows graphic 
programs and can be used by both Results and Histogram windows. TEXT format should only 
be used with Results windows. When WinList successfully completes the PASTE command, 
the pasted object will be displayed in the window. 
  
Examples: 

PASTE(METAFILE) is used to get a copy of a picture from the clipboard. It can be used 
both by Results and Histogram windows. 

PASTE(TEXT) is used to get a copy of text from the clipboard. It can be used only by 
Results windows. 

  
COPY 

This command tells WinList to copy the results or histogram window to the Windows 
Clipboard so that another application can paste it into its workspace. Its syntax is 
COPY(format) where format can be METAFILE, TEXT, or BITMAP. 
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Examples: 

COPY(METAFILE) is used to copy a picture of a histogram to the clipboard. It can be 
used only by Histogram windows. 

COPY(TEXT) is used to copy text to the clipboard. It can be used only by Results 
windows. 

COPY(TEXTNOHEADER) is used to copy text to the clipboard. It can be used only by 
Results windows. The only difference between this format and TEXT format is that 
TEXTNOHEADER strips off all lines up to and including the column headings. It is useful 
for databasing of results in another program using a DDE connection. 

  
SETREGIONRESULT 

This command tells WinList to set the value of a specific region's result to a value extracted 
from a remote application. Its syntax is SETREGIONRESULT("region reference","external 
request") where region reference is in R(n,stat) format and external request is a string which 
is requested from another application. For more information on R(n, stat) format, see 
Internal Keywords. External Request is expected to be a value number of the same type as 
the field it is copied to. 

  

Examples: 

 If connected to ModFit, SETREGIONRESULT("R(1,REGIONEVENTS)","A[1,0]") tells 
WinList to ask ModFit for the answer to "A[1,0]", and to put the result into the Region 
Events field for Region 1. 

  

PAUSE 

This command is supported by histograms. It displays a dialog with optional message and 
waits to proceed until the dialog is closed. The dialog appends "Press OK to continue or 
Cancel to stop the script." Its syntax is PAUSE(message) where message is optional text for 
the message. 

  

Example: 

PAUSE(Please check results in ModFit LT.) 

This command in a histogram script displays dialog "Please check results in ModFit LT. Press 
OK to continue or Cancel to stop the script." 
  

SLEEP 
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This command is used to allow WinList to "sleep" for a specified period of time. It is useful in 
cases where the remote application needs to perform some time-consuming task, which 
could cause the script to timeout. 

The command syntax is: 

SLEEP(milliseconds) 

For example, adding a script line 

SLEEP(2000) 

would cause WinList to sleep for 2 seconds. 
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Internal Keywords 

  

WinList allows users to access two types of keywords: FCS keywords stored in data files, and 
internal keywords that WinList calculates. 
  

Users can access keywords for histogram, MultiGraph, and results window titles, as well as 
text labels in MultiGraphs. Keywords are identified by surrounding specific words with square 
brackets [ ]. When WinList sees a keyword, it replaces it with the keyword's value. For 
example, [DATE] is an internal keyword that would display the current date. [$TOT] is an 
FCS keyword which tells how many total events were stored in the listmode file. Generally, 
when the user can edit a text field, keywords are available for those fields. 
  

WinList also supports mixed text and keywords. It is possible, therefore, to display a label for 
a MultiGraph that would display the date and time as follows: 

Date: [DATE] Time: [TIME] 

  

In this example, if the current date is 01-Mar-2013 and the time is 09:20:45, WinList would 
display: 

Date: 01-Mar-2013 Time: 09:20:45 

  

The internal keywords supported by WinList are listed below. 
  
[DATE]: Displays the current system date reported by your computer. 
[TIME]: Displays the current system time reported by your computer. 
[FILE]: Displays the filename of the active data source. 
[FILE,dsID]: Displays the filename of the data source with an ID of dsID. 
[FILEROOT]: Displays the base of the active data source file name. For example, if the file 
name is 190594.FCS, the FILEROOT keyword returns 190594, leaving off the file extension. 
[FILEROOT,dsID]: Displays the base of the filename for the data source with an ID of 
dsID.. 
[FILEPATH]: Displays the pathway to the active data source file. 
[FILEPATH,dsID]: Displays the pathway for the data source with an ID of dsID. 

[DEFAULTPATH]: Displays the pathway to protocols and other WinList file types. 

[HISTOGRAM]: Displays the name of the active histogram. 

[GATE]: Displays gate information of the active histogram. 
  

[COUNTERn]: Displays the current value of user-programmable counter n. This value can 
be changed with macro commands ModifyUserCounter and ResetUserCounter. See Edit 
Macro and Macro Commands for more on changing the counter's value. 
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[LEVEL]: Returns the level of the current batch item. 

[NEXTLEVEL]: Returns the level of the next batch item. 

[FINISHBATCH]: Returns 1 if the last batch item has been processed. 

[NEWLEVEL]: Returns 1 if the next batch item level is different from the current level. 

[BATCHINDEX]: Returns the index of the current file in the batch list. 
  

There are two forms of the following keyword, used to display a region result. Note that no 
spaces are permitted in the keyword syntax below. 

[R(n,stat)]: Displays a statistic stat for region n, where 

 n is the number of the region, and 

 stat is the textual name of the statistic as shown in the table below. 
  

[R(n,PCN,g)]: Displays the percent-of-gate statistic for region n and gate g, where 

 n is the number of the region, and 

 PCN is a literal that specifies the Percent of Gate N statistic, and 

 g is the gate ID of for the gate of interest. 
  

To display stat equals or 

Total events TOTALEVENTS TOT 

Gated events GATEDEVENTS GAT 

Region events REGIONEVENTS REG 

Percent Total PERCENT PCT 

Percent Gated PERCENTGATED PCG 

Name of the gate applied 
to the histogram 
containing region n 

GATENAME GTN 

Mean X MEANX MNX 

Mean Y MEANY MNY 

Median X MEDIANX MDX 

Median Y MEDIANY MDY 

Median X in ADC units MEDIANADCX MDADCX 

Median Y in ADC units MEDIANADCY MDADCY 

Mode X MODEX MOX 

Mode Y MODEY MOY 

CV X CVX CVX 

CV Y CVY CVY 
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Standard Deviation X STDDEVX SDX 

Standard Deviation Y STDDEVY SDY 

Low X LOWX LOX 

Low Y LOWY LOY 

High X HIGHX HIX 

High Y HIGHY HIY 

Correlation coefficient. CC CC 

Data source filename 
containing the region 

DS DS 

Name of the histogram 
containing the region 

HST HST 

  

For example, to display the percent of gate statistic for region R5, type: 

[R(5,PCG)] 

  

To display "percent of gate N" statistic for R6, where gate N is gate 2, type: 

[R(6,PCN,2)] 

  

Another group of keywords is used in DDE scripts and is specific to histogram windows. 
These keywords can be put into script statements and surrounded by curly brackets { }. 
WinList will replace them with histogram-specific information before sending the DDE 
command to the remote application. 
  

For example, to pass the parameter names of a two-parameter dot plot to IsoContour, you 
can enter [SetLabelText('3,{XNAME} -->')]. The portion of the command in curly 
brackets, XNAME, will be replaced with the name of the parameter on the X-axis, then the 
command will be sent to IsoContour. 
  

DDE keywords are listed below: 
  

For Histograms: 

{XNAME} displays the name of the X parameter (1st parameter) in a histogram 

{YNAME} displays the name of the Y parameter (2nd parameter) in a histogram 

{ZNAME} displays the name of the Z parameter (3rd parameter) in a histogram 



Reading Delimited Text Files 

648 

Reading Delimited Text Files 

  

WinList can convert certain text files into FCS listmode files so that they can be read and 
analyzed.  This provides a convenient way to read files from programs like Microsoft Excel 
and other applications that do not know about FCS file formatting. 

  

When WinList initially opens a data files, it tries to open it as an FCS format file.  If it 
determines the file is not FCS format and that it contains ASCII text characters, it will attempt 
to interpret the file as a comma-delimited or tab-delimited text file. 

  

In the first pass, the file is scanned for the first occurrence of a comma or tab character.  It 
will treat that first found tab or comma as the delimiter for the file. 

  

Next, the lines are scanned for non-numeric information that can be interpreted as keyword-
value pairs.  For example, "Experiment Name, Covid-19 Exp 21" would be interpreted as a 
keyword "Experiment Name" with a value of "Covid-19 Exp 21", and it would be added to the 
list of keywords for the file.  These lines are optional. 

  

Example of comma-delimited text file with keywords, header row, and event data: 

  

 

  

During this pass, the logic is also looking for a line that contains the names of the 
measurements - a header row. For example, "FSC,SSC,CD14 FITC,CD33 PE,CD45 
PerCP,Unused,CD34 - APC,Time" on a line would be interpreted as defining the names for 8 
measurements. 

  

Example of tab-delimited text file with header row and no additional keyword information: 
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When a line is read that contains only numerical values, it is interpreted as the beginning of 
event data.  It should have the same number of fields as the header row.  This line and all 
subsequent lines will be read as the event values for the file. 

  

If no formatting errors are encountered, the program will create an FCS file with the same 
name as the original file and the ".fcs" extension. The FCS file will then be read into WinList 
as it would normally read an FCS file. 

  

The FCS file is not removed by WinList when it is finished, so it may be read into other FCS 
file readers for further analysis. 
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